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Preface

How to Use This Guide

About the System  The guides listed below are shipped with the Applied Biosystems StepOne™ and
Documentation  StepOnePlus™ Real-Time PCR Systems (StepOne™ and StepOnePlus™ systems).

Guide Purpose and Audience PN
Applied Biosystems StepOne™ and Explains how to perform experiments on the StepOne and 4376786
StepOnePlus™ Real-Time PCR Systems StepOnePlus systems. Each Getting Started Guide functions as
Getting Started Guide for Genotyping both:
Experiments e A tutorial, using example experiment data provided with the
Applied Biosystems StepOne™ and Applied Biosystems StepOne™ Real-Time PCR Software 4376787
StepOnePlus™ Real-Time PCR Systems (StepOne ™ software).
Getting Started Guide for e A guide for your own experiments.
Presence/Absence Experiments Intended for laboratory staff and principal investigators who
Applied Biosystems StepOne™ and gesrigrmm experiments using the StepOne or StepOnePlus 4376785
StepOnePlus™ Real-Time PCR Systems Y '
Getting Started Guide for Relative
Standard Curve and Comparative Cy
Experiments
Applied Biosystems StepOne™ and 4376784
StepOnePlus™ Real-Time PCR Systems
Getting Started Guide for Standard Curve
Experiments
Applied Biosystems 7500/7500Fast, 4411937
StepOne™, and StepOnePlus™ Real-Time
PCR Systems Quick Reference Card for
Comparative C; Experiments and Studies
Applied Biosystems StepOne™ and Explains how to install and maintain the StepOne and 4376782
StepOnePlus™ Real-Time PCR Systems StepOnePlus systems.
Igz}‘zgat/on, Networking, and Maintenance Intended for laboratory staff responsible for the installation and
maintenance of the StepOne or StepOnePlus system
Applied Biosystems StepOne™ and 4376783
StepOnePlus™ Real-Time PCR Systems
Installation Quick Reference Card
Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative vii

Standard Curve and Comparative C; Experiments



Preface
How to Use This Guide

Guide Purpose and Audience PN

Applied Biosystems StepOne™ and Provides information about the reagents you can use on the 4379704
StepOnePlus™ Real-Time PCR Systems StepOne and StepOnePlus systems, including:

Reagent Guide ¢ An introduction to TagMan® and SYBR® Green reagents

e Descriptions and design guidelines for the following
experiment types:

— Quantitation experiments
— Genotyping experiments
— Presence/absence experiments

Intended for laboratory staff and principal investigators who
perform experiments using the StepOne or StepOnePlus
system.

Applied Biosystems StepOne™ and Explains how to prepare your site to receive and install the 4376768
StepOnePlus™ Real-Time PCR Systems StepOne and StepOnePlus systems.

Site Preparation Guide Intended for personnel who schedule, manage, and perform the

tasks required to prepare your site for installation of the StepOne
or StepOnePlus system.

Applied Biosystems StepOne™ Real-Time | Explains how to use the StepOne software to: NA

PCR Software Help e Set up, run, and analyze experiments using the StepOne and

StepOnePlus systems.
* Monitor networked StepOne and StepOnePlus instruments.
e (Calibrate StepOne and StepOnePlus instruments.

e \Verify the performance of StepOne and StepOnePlus
instruments with an RNase P run.

Intended for:

e Laboratory staff and principal investigators who perform
experiments using the StepOne or StepOnePlus system.

e Laboratory staff responsible for the installation and
maintenance of the StepOne or StepOnePlus system.

Assumptions This guide assumes that you:
+ Are familiar with the Microsoft Windows® XP operating system.
* Are familiar with the Internet and Internet browsers.
» Know how to handle DNA and/or RNA samples and prepare them for PCR.
* Understand data storage, file transfer, and copying and pasting.

* Have networking experience, if you plan to integrate the StepOne or StepOnePlus
system into your existing laboratory data flow.

Text Conventions  This guide uses the following conventions:
* Bold text indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

* [talic text indicates new or important words and is also used for emphasis.
For example:

Before analyzing, always prepare fresh matrix.

* A right arrow symbol ( » ) separates successive commands you select from a drop-
down or shortcut menu. For example:

Select File » Open.

viii Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative
Standard Curve and Comparative C; Experiments



Preface
How to Obtain More Information

User Attention  Two user attention words appear in Applied Biosystems user documentation. Each word
Words implies a particular level of observation or action as described below:

Note: — Provides information that may be of interest or help but is not critical to the use
of the product.

IMPORTANT! — Provides information that is necessary for proper instrument operation,
accurate reagent kit use, or safe use of a chemical.

Examples of the user attention words appear below:

Note: The Calibrate function is also available in the Control Console.

IMPORTANT! To verify your client connection, you need a valid user ID.

Safety Alert  Safety alert words also appear in user documentation. For more information, see “Safety
Words Alert Words” on page xiv.

How to Obtain More Information

Related Other StepOne and StepOnePlus System Documents

Documentation The documents listed in the table below are not shipped with the StepOne or

StepOnePlus instrument.

Document PN

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems 4376791
Installation Performance Verification Protocol

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems 4376790
Installation Qualification-Operation Qualification Protocol

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems 4376788
Planned Maintenance Protocol

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative iX
Standard Curve and Comparative C; Experiments



Preface
How to Obtain More Information

Documents Related to Genotyping Experiments

Document PN

Allelic Discrimination Pre-Developed TagMan® Assay Reagents Quick Reference 4312212

Card

Custom TagMan® Genomic Assays Protocol 4367671
Custom TagMan® SNP Genotyping Assays Protocol 4334431
Ordering TagMan® SNP Genotyping Assays Quick Reference Card 4374204

Performing a Custom TagMan® SNP Genotyping Assay for 96-Well Plates Quick 4371394
Reference Card

Performing a TagMan® Drug Metabolism Genotyping Assay for 96-Well Plates 4367636
Quick Reference Card

Pre-Developed TagMan® Assay Reagents Allelic Discrimination Protocol 4312214
TagMan® Drug Metabolism Genotyping Assays Protocol 4362038
TagMan® SNP Genotyping Assays Protocol 4332856

Documents Related to Presence/Absence Experiments

Document PN
DNA Isolation from Fresh and Frozen Blood, Tissue Culture Cells, and Buccal 4343586
Swabs Protocol
NucPrep® Chemistry: Isolation of Genomic DNA from Animal and Plant Tissue 4333959
Protocol
PrepMan® Ultra Sample Preparation Reagent Protocol 4318925
X Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative

Standard Curve and Comparative C; Experiments
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How to Obtain More Information

Documents Related to Relative Standard Curve and Comparative C; Experiments

Document PN
Amplification Efficiency of TagMan® Gene Expression Assays Application Note 127AP05
High-Capacity cDNA Reverse Transcription Kits Protocol 4375575
High Capacity RNA-to-cDNA Kit Protocol 4387951
High Capacity RNA-to-cDNA Master Mix Protocol 4377474
Custom TagMan® Gene Expression Assays Protocol 4334429
Primer Express® Software Version 3.0 Getting Started Guide 4362460
TagMan® Gene Expression Assays Protocol 4333458
User Bulletin #2: Relative Quantitation of Gene Expression 4303859

Documents Related to Standard Curve Experiments

Document PN
Amplification Efficiency of TagMan® Gene Expression Assays Application Note 127AP05
Custom TagMan® Gene Expression Assays Protocol 4334429
Primer Express® Software Version 3.0 Getting Started Guide 4362460
TagMan® Gene Expression Assays Protocol 4333458
User Bulletin #2: Relative Quantitation of Gene Expression 4303859
Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative Xi

Standard Curve and Comparative C; Experiments



Preface
How to Obtain More Information

Documents Related to the Reagent Guide

Document PN

Applied Biosystems High-Capacity cDNA Reverse Transcription Kits Protocol 4375575
Custom TagMan® Gene Expression Assays Protocol 4334429
Custom TaqgMan® Genomic Assays Protocol: Submission Guidelines 4367671
Custom TagMan® SNP Genotyping Assays Protocol 4334431
Power SYBR® Green PCR Master Mix and RT-PCR Protocol 4367218
Pre-Developed TagMan® Assay Reagents Allelic Discrimination Protocol 4312214
Primer Express® Software Version 3.0 Getting Started Guide 4362460
SYBR® Green PCR and RT-PCR Reagents Protocol 4304965
SYBR® Green PCR Master Mix and RT-PCR Reagents Protocol 4310251
TagMan® Drug Metabolism Genotyping Assays Protocol 4362038
TagMan® Exogenous Internal Positive Control Reagents Protocol 4308335
TagMan® Fast Universal PCR Master Mix (2X) Protocol 4351891
TagMan® Gene Expression Assays Protocol 4333458
TagMan® Gene Expression Master Mix Protocol 4371135
TagMan® Genotyping Master Mix Protocol 4371131
TagMan® SNP Genotyping Assays Protocol 4332856
TagMan® Universal PCR Master Mix Protocol 4304449
User Bulletin #2: Relative Quantitation of Gene Expression 4303859
Using TagMan® Endogenous Control Assays to Select an Endogenous Control 127AP08
for Experimental Studies Application Note

Note: For more documentation, see “How to Obtain Support” on page xiii.

Obtaining The StepOne Software Help describes how to use each feature of the user interface.
Information from  Access the Help from within the software by doing one of the following:
the Software Help . pess FI.
* Click @ in the toolbar.
+ Select Help » StepOne Software Help.

To find topics of interest in the Help:
* Review the table of contents.
+ Search for a specific topic.
» Search an alphabetized index.

Xii Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative
Standard Curve and Comparative C; Experiments



Preface
How to Obtain Support

Send Us Your Applied Biosystems welcomes your comments and suggestions for improving its user
Comments documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

IMPORTANT! The e-mail address above is only for submitting comments and
suggestions relating to documentation. To order documents, download PDF files, or for
help with a technical question, go to http://www.appliedbiosystems.com, then click the
link for Support. (See “How to Obtain Support” on page xiii).

How to Obtain Support

For the latest services and support information for all locations, go to
http://www.appliedbiosystems.com, then click the link for Support.
At the Support page, you can:

» Search through frequently asked questions (FAQs)

* Submit a question directly to Technical Support

* Order Applied Biosystems user documents, MSDSs, certificates of analysis, and
other related documents

* Download PDF documents
* Obtain information about customer training
» Download software updates and patches

In addition, the Support page provides access to worldwide telephone and fax numbers
to contact Applied Biosystems Technical Support and Sales facilities.

IMPORTANT! When directed to do so by this guide, or when you need to schedule
maintenance for your StepOne™ or StepOnePlus’" instrument (such as annual planned
maintenance or temperature verification/calibration), contact the Applied Biosystems
Care Center. To obtain a phone number for or to send an e-mail to the center, go to
http://www.appliedbiosystems.com/support/contact.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative xiii
Standard Curve and Comparative C; Experiments
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Preface

Safety Conventions Used in This Document

Safety Conventions Used in This Document

Xiv

Safety Alert
Words

Four safety alert words appear in Applied Biosystems user documentation at points in
the document where you need to be aware of relevant hazards. Each alert
word—IMPORTANT, CAUTION, WARNING, DANGER—implies a particular level
of observation or action, as defined below.

Definitions

IMPORTANT! — Indicates information that is necessary for proper instrument operation,
accurate reagent kit use, or safe use of a chemical.

A (o:.\UI{e]N] — Indicates a potentially hazardous situation that, if not avoided, may

result in minor or moderate injury. It may also be used to alert against unsafe practices.

AWARNING — Indicates a potentially hazardous situation that, if not avoided,

could result in death or serious injury.

A P\[e]F38 — Indicates an imminently hazardous situation that, if not avoided,

will result in death or serious injury. This signal word is limited to the most extreme
situations.

Except for IMPORTANTS, each safety alert word in an Applied Biosystems document
appears with an open triangle figure that contains a hazard symbol. These hazard
symbols are identical to the hazard symbols that are affixed to Applied Biosystems
instruments (see “Safety Symbols” on page xvi).

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative

Standard Curve and Comparative C; Experiments
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Symbols on Instruments

Examples

IMPORTANT! You must create a separate sample entry spreadsheet for each 96-well
plate.

‘ (o7.\V}i[e]'] CHEMICAL HAZARD. TagMan® Universal PCR Master Mix

may cause eye and skin irritation. Exposure may cause discomfort if swallowed or
inhaled. Read the MSDS, and follow the handling instructions. Wear appropriate
protective eyewear, clothing, and gloves.

AWARNING PHYSICAL INJURY HAZARD. During instrument operation, the

the heated cover and sample block can reach temperatures in excess of 100 °C.

A L[] ELECTRICAL HAZARD. Grounding circuit continuity is vital for

the safe operation. Never operate the system with the grounding conductor disconnected.

Symbols on Instruments

Electrical

Symbols Applied Biosystems instruments.

Symbol

Description

Symbol

The following table describes the electrical symbols that may be displayed on

Description

Indicates the On position of the
main power switch.

Indicates the Off position of the
main power switch.

CO-—

Indicates a standby switch by
which the instrument is switched
on to the Standby condition.
Hazardous voltage may be
present if this switch is on

L

S

Indicates a terminal that may be
connected to the signal ground
reference of another instrument.
This is not a protected ground
terminal.

Indicates a protective grounding

terminal that must be connected
to earth ground before any other
electrical connections are made
to the instrument.

Indicates a terminal that can

standby. o receive or supply alternating
current or voltage.
Indicates the On/Off position of a Indicates a terminal that can
push-push main power switch. = receive or supply alternating or
direct current or voltage.
Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative XV
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Symbols on Instruments

Safety Symbols The following table describes the safety symbols that may be displayed on
Applied Biosystems instruments. Each symbol may appear by itself or with text that
explains the relevant hazard (see “Safety Labels on Instruments” on page xvii). These
safety symbols may also appear next to DANGERS, WARNINGS, and CAUTIONS that
occur in the text of this and other product-support documents.

Symbol

Description Symbol Description

/N
AN

Indicates the presence of moving
parts and to proceed with
appropriate caution.

Indicates that you should consult
the manual for further information
and to proceed with appropriate

caution.
Indicates the presence of an

) electrical shock hazard and to
Indicates the presence of a hot proceed with appropriate caution.
surface or other high-temperature
hazard and to proceed with

appropriate caution.

Indicates the presence of a laser
inside the instrument and to
proceed with appropriate caution.

> B B

Environmental The following symbol applies to all Applied Biosystems electrical and electronic
Symbols products placed on the European market after August 13, 2005.

Symbol

=,
X
9
]

Description

Do not dispose of this product as unsorted municipal waste. Follow local
municipal waste ordinances for proper disposal provisions to reduce the
environmental impact of waste electrical and electronic equipment (WEEE).

European Union customers:

Call your local Applied Biosystems Customer Service office for equipment pick-up
and recycling. See http://www.appliedbiosystems.com for a list of customer
service offices in the European Union.

XVi Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative
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Safety Labels on Instruments

Safety Labels on Instruments
The following CAUTION, WARNING, and DANGER statements may be displayed on

Applied Biosystems instruments in combination with the safety symbols described in the
preceding section.

English Francais

CAUTION Hazardous chemicals. Read the ATTENTION Produits chimiques dangeureux.
Material Safety Data Sheets (MSDSs) before Lire les fiches techniques de sireté de

handling. matériels avant la manipulation des produits.

CAUTION Hazardous waste. Refer to ATTENTION Déchets dangereux. Lire les

MSDS(s) and local regulations for handling fiches techniques de sireté de matériels et la

and disposal. régulation locale associées a la manipulation
et I'élimination des déchets.

CAUTION Hot surface. ATTENTION Surface brilante.

DANGER High voltage. DANGER Haute tension.

WARNING To reduce the chance of electrical | AVERTISSEMENT Pour éviter les risques
shock, do not remove covers that require tool | d'électrocution, ne pas retirer les capots dont

access. No user-serviceable parts are inside. | |'ouverture nécessite |'utilisation d'outils.
Refer servicing to Applied Biosystems L’instrument ne contient aucune piéce
qualified service personnel. réparable par I’ utilisateur. Toute intervention

doit étre effectuée par le personnel de service
qualifié de Applied Biosystems.

CAUTION Moving parts. ATTENTION Parties mobiles.

DANGER Class 3B (lll) visible and/or invisible | DANGER Rayonnement visible ou invisible
LED radiation present when open and d’un faisceau LED de Classe 3B (Ill) en cas
interlocks defeated. Avoid exposure to beam. | d’ouverture et de neutralisation des
dispositifs de sécurité. Evitez toute
exposition au faisceau.

Locations of The StepOne and StepOnePlus instruments contain a warning at the location shown
Warnings below:

/A CAUTION HOT

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative Xvii
Standard Curve and Comparative C; Experiments
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General Instrument Safety

General Instrument Safety

A WG UII[e] PHYSICAL INJURY HAZARD. Using the instrument in a manner

not specified by Applied Biosystems may result in personal injury or damage to the
instrument.

Moving and A (.\I[e){] PHYSICAL INJURY HAZARD. The instrument is to be moved

Lifting the and positioned only by the personnel or vendor specified in the applicable site
Instrument preparation guide. If you decide to lift or move the instrument after it has been installed,
do not attempt to lift or move the instrument without the assistance of others, the use of
appropriate moving equipment, and proper lifting techniques. Improper lifting can cause
painful and permanent back injury. Depending on the weight, moving or lifting an
instrument may require two or more persons.

Moving and AWARNING Do not attempt to lift or move the computer or the monitor without

Lifting Computers the assistance of others. Depending on the weight of the computer and/or the monitor,
and Monitors moving them may require two or more people.

Things to consider before lifting the computer and/or the monitor:

» Make sure that you have a secure, comfortable grip on the computer or the monitor
when lifting.

» Make sure that the path from where the object is to where it is being moved is clear
of obstructions.

* Do not lift an object and twist your torso at the same time.
+ Keep your spine in a good neutral position while lifting with your legs.

+ Participants should coordinate lift and move intentions with each other before
lifting and carrying.

* Instead of lifting the object from the packing box, carefully tilt the box on its side
and hold it stationary while someone slides the contents out of the box.

Operating the  Ensure that anyone who operates the instrument has:

Instrument * Received instructions in both general safety practices for laboratories and specific
safety practices for the instrument.

* Read and understood all applicable Material Safety Data Sheets (MSDSs). See
“About MSDSs” on page xix.

Cleaning or A [o7\UI[e)\] Before using a cleaning or decontamination method other than those

Decontaminating recommended by the manufacturer, verify with the manufacturer that the proposed
the Instrument method will not damage the equipment.

xviii Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative
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Chemical Safety

Chemical Safety

Chemical Hazard AWARNING CHEMICAL HAZARD. Before handling any chemicals, refer to

Warning the Material Safety Data Sheet (MSDS) provided by the manufacturer, and observe all
relevant precautions.

AWARNING CHEMICAL STORAGE HAZARD. Never collect or store waste

in a glass container because of the risk of breaking or shattering. Reagent and waste
bottles can crack and leak. Each waste bottle should be secured in a low-density
polyethylene safety container with the cover fastened and the handles locked in the
upright position. Wear appropriate eyewear, clothing, and gloves when handling reagent
and waste bottles.

Chemical Safety To minimize the hazards of chemicals:

Guidelines * Read and understand the Material Safety Data Sheets (MSDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals or
hazardous materials. (See “About MSDSs” on page xix.)

» Minimize contact with chemicals. Wear appropriate personal protective equipment
when handling chemicals (for example, safety glasses, gloves, or protective
clothing). For more safety guidelines, consult the MSDS.

* Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For more safety
guidelines, consult the MSDS.

* Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer’s cleanup procedures as recommended in the MSDS.

+ Comply with all local, state/provincial, or national laws and regulations related to
chemical storage, handling, and disposal.

About MSDSs Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with
shipments of hazardous chemicals to new customers. They also provide MSDSs with the
first shipment of a hazardous chemical to a customer after an MSDS has been updated.
MSDSs provide the safety information you need to store, handle, transport, and dispose
of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure to

replace the appropriate MSDS in your files.

Obtaining The MSDS for any chemical supplied by Applied Biosystems is available to you free
MSDSs 24 hours a day. To obtain MSDSs:

1. Go to https://docs.appliedbiosystems.com/msdssearch.html

2. In the Search field of the MSDS Search page:

a. Type in the chemical name, part number, or other information that you expect
to appear in the MSDS of interest.

b. Select the language of your choice.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative Xix
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c. Click Search.

3. To view, download, or print the document of interest:
a. Right-click the document title.

b. Select:
* Open — To view the document

+ Save Target As — To download a PDF version of the document to a
destination that you choose

* Print Target — To print the document

4. To have a copy of an MSDS sent by fax or e-mail, in the Search Results page:
. Select Fax or Email below the document title.

a
b. Click RETRIEVE DOCUMENTS at the end of the document list.

2]

. Enter the required information.

d. Click View/Deliver Selected Documents Now.

Note: For the MSDSs of chemicals not distributed by Applied Biosystems, contact the
chemical manufacturer.

Chemical Waste Safety

Chemical Waste A (X[l HAZARDOUS WASTE. Refer to Material Safety Data Sheets and
Hazard local regulations for handling and disposal.

AWARNING CHEMICAL WASTE HAZARD. Wastes produced by Applied

Biosystems instruments are potentially hazardous and can cause injury, illness, or death.

AWARNING CHEMICAL STORAGE HAZARD. Never collect or store waste

in a glass container because of the risk of breaking or shattering. Reagent and waste
bottles can crack and leak. Each waste bottle should be secured in a low-density
polyethylene safety container with the cover fastened and the handles locked in the
upright position. Wear appropriate eyewear, clothing, and gloves when handling reagent
and waste bottles.

Chemical Waste To minimize the hazards of chemical waste:

Safety Guidelines * Read and understand the Material Safety Data Sheets (MSDSs) provided by the
manufacturers of the chemicals in the waste container before you store, handle, or
dispose of chemical waste.
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* Provide primary and secondary waste containers. (A primary waste container holds
the immediate waste. A secondary container contains spills or leaks from the
primary container. Both containers must be compatible with the waste material and
meet federal, state, and local requirements for container storage.)

* Minimize contact with chemicals. Wear appropriate personal protective equipment
when handling chemicals (for example, safety glasses, gloves, or protective
clothing). For more safety guidelines, consult the MSDS.

* Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For more safety
guidelines, consult the MSDS.

* Handle chemical wastes in a fume hood.
+ After emptying a waste container, seal it with the cap provided.

» Dispose of the contents of the waste tray and waste bottle in accordance with good
laboratory practices and local, state/provincial, or national environmental and health
regulations.

Waste Disposal If potentially hazardous waste is generated when you operate the instrument, you must:

* Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

* Ensure the health and safety of all personnel in your laboratory.

* Ensure that the instrument waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special handling, and
disposal limitations may apply.

Electrical Safety

A pJ:\\[e]33] ELECTRICAL SHOCK HAZARD. Severe electrical shock can

result from operating the StepOne or StepOnePlus instrument without its instrument
panels in place. Do not remove instrument panels. High-voltage contacts are exposed
when instrument panels are removed from the instrument.

Fuses AWARNING FIRE HAZARD. Improper fuses or high-voltage supply can

damage the instrument wiring system and cause a fire. Before turning on the instrument,
verify that the fuses are properly installed and that the instrument voltage matches the
power supply in your laboratory.

AWARNING FIRE HAZARD. For continued protection against the risk of fire,

replace fuses only with fuses of the type and rating specified for the instrument.
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Power A p\e]3i] ELECTRICAL HAZARD. Grounding circuit continuity is vital for

Overvoltage
Rating

LED Safety

the safe operation of equipment. Never operate equipment with the grounding conductor
disconnected.

A PLWNel3i] ELECTRICAL HAZARD. Use properly configured and approved

line cords for the voltage supply in your facility.

A pE\[e]1338 ELECTRICAL HAZARD. Plug the instrument into a properly

grounded receptacle with adequate current capacity.

The StepOne and StepOnePlus instruments have an installation (overvoltage) category of
11, and they are classified as portable equipment.

To ensure safe LED operation:

* The system must be maintained by an Applied Biosystems Technical
Representative.

 All instrument panels must be in place on the instrument while the instrument is
operating. When all panels are installed, there is no detectable radiation present. If
any panel is removed when the LED is operating (during service with safety
interlocks disabled), you may be exposed to LED emissions in excess of the
Class 3B rating.

* Do not remove safety labels or disable safety interlocks.

Biological Hazard Safety

XXii

General
Biohazard

&WARNING BIOHAZARD. Biological samples such as tissues, body fluids,

infectious agents, and blood of humans and other animals have the potential to transmit
infectious diseases. Follow all applicable local, state/provincial, and/or national
regulations. Wear appropriate protective equipment, which includes but is not limited to:
protective eyewear, face shield, clothing/lab coat, and gloves. All work should be
performed in properly equipped facilities using the appropriate safety equipment (for
example, physical containment devices). Individuals should be trained according to
applicable regulatory and company/institution requirements before working with
potentially infectious materials. Read and follow the applicable guidelines and/or
regulatory requirements in the following:

+ U.S. Department of Health and Human Services guidelines published in Biosafety
in Microbiological and Biomedical Laboratories (stock no. 017-040-00547-4;
http://bmbl.od.nih.gov)

* Occupational Safety and Health Standards, Bloodborne Pathogens (29
CFR§1910.1030; http://www.access.gpo.gov/ nara/cfr/waisidx_01/
29¢fr1910a_01.html).
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* Your company’s/institution’s Biosafety Program protocols for working
with/handling potentially infectious materials.

More information about biohazard guidelines is available at:

http://www.cdc.gov

Workstation Safety

Correct ergonomic configuration of your workstation can reduce or prevent effects such
as fatigue, pain, and strain. Minimize or eliminate these effects by configuring your
workstation to promote neutral or relaxed working positions.

ACAUTION MUSCULOSKELETAL AND REPETITIVE MOTION

HAZARD. These hazards are caused by potential risk factors that include but are not
limited to repetitive motion, awkward posture, forceful exertion, holding static unhealthy
positions, contact pressure, and other workstation environmental factors.

To minimize musculoskeletal and repetitive motion risks:
» Use equipment that comfortably supports you in neutral working positions and
allows adequate accessibility to the keyboard, monitor, and mouse.

* Position the keyboard, mouse, and monitor to promote relaxed body and head
postures.

Safety and Electromagnetic Compatibility (EMC) Standards

U.S. and The StepOne and StepOnePlus instruments have been tested to and comply with
Canadian Safety standard:

Standards .,/ 1010A-1/CAN/CSA C22.2 No. 1010.1-92, “Safety Requirements for Electrical
c UI. Equipment for Measurement, Control, and Laboratory Use, Part 1: General
sLjUs Requirements.”

UL 61010A-2-010/CAN/CSA 1010.2.010, “Particular Requirements for Laboratory
Equipment for the Heating of Materials.”

Canadian EMC This instrument has been tested to and complies with ICES-001, Issue 3: “Industrial,
Standard Scientific, and Medical Radio Frequency Generators.”

European Safety Safety

Sand EMC This instrument meets European requirements for safety (Low Voltage Directive
tandards 2006/95/EC). This instrument has been tested to and complies with standards EN 61010-
C € 1:2001, “Safety Requirements for Electrical Equipment for Measurement, Control and
Laboratory Use, Part 1: General Requirements.”

EN 61010-2-010, “Particular Requirements for Laboratory Equipment for the Heating of
Materials.”
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EN 61010-2-081, “Particular Requirements for Automatic and Semi-Automatic
Laboratory Equipment for Analysis and Other Purposes.”

EMC

This instrument meets European requirements for emission and immunity (EMC
Directive 2004/108/EC). This instrument has been tested to and complies with standard
EN 61326 (Group 1, Class B), “Electrical Equipment for Measurement, Control and
Laboratory Use — EMC Requirements.”

Australian EMC  This instrument has been tested to and complies with standard AS/NZS 2064, “Limits
Standards and Methods Measurement of Electromagnetic Disturbance Characteristics of Industrial,
Scientific, and Medical (ISM) Radio-frequency Equipment.”
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n Get Started

This chapter covers:

B About the StepOne™ and StepOnePlus™ Systems. . ....................... 2
B Supported Consumables . .. ...t 4
B About Relative Standard Curve and Comparative CT Experiments. . ........... 6
B HowtoUseThis Guide. .. ... ...ttt e 11
B About the Example Experiments . .............. .. ... .. iitiiinron... 12
B Example Experiment Workflow .. ........ ... ... .. .. ... .. .. .. . ... 18

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne™ Real-Time PCR Software by pressing
F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.
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About the StepOne™ and StepOnePlus™ Systems

There are two models available for this Real-Time PCR System:

System Features
Applied Biosystems StepOne™ Real-Time ¢ 48-well platform
PCR System (StepOne ™ system) e Three-color system
Applied Biosystems StepOnePlus™ Real- ¢ 96-well platform
Time PCR System (StepOnePlus™ system) « Four-color system

* VeriFlex™ sample blocks

The StepOne and StepOnePlus systems use fluorescent-based polymerase chain reaction
(PCR) reagents to provide:

» Quantitative detection of target nucleic acid sequences (targets) using real-time
analysis.

* Qualitative detection of targets using post-PCR (endpoint) analysis.

* Qualitative analysis of the PCR product (achieved by melt curve analysis that occurs
post-PCR).

About Data The StepOne and StepOnePlus systems collect raw fluorescence data at different points
Collection during a PCR, depending on the type of run that the instruments perform:

Run Type Data Collection Point

Real-time runs | Standard curve The instrument collects data following each
extension step of the PCR.
Relative standard
curve

Comparative Cy

(AAGy)
Post-PCR Genotyping The instrument collects data:
(endpoint) runs Presence/absence Before the PCR (For presence/absence

experiments, data collection before the PCR is
optional, but recommended.)

e (Optional) During the PCR. The instrument can
collect data during the run (real-time); collecting
data during the run can be helpful for
troubleshooting.

e After the PCR

Regardless of the run type, a data collection point or 7ead on the StepOne™ or
StepOnePlus™ instrument consists of three phases:

1. Excitation — The instrument illuminates all wells of the reaction plate within the
instrument, exciting the fluorophores in each reaction.

Notes
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2. Emission — The instrument optics collect the residual fluorescence emitted from the
wells of the reaction plate. The resulting image collected by the device consists only
of light that corresponds to the range of emission wavelengths.

3. Collection — The instrument assembles a digital representation of the residual
fluorescence collected over a fixed time interval. The StepOne'™ software stores the
raw fluorescent image for analysis.

After a run, the StepOne software uses calibration data (spatial, dye, and background) to
determine the location and intensity of the fluorescent signals in each read, the dye
associated with each fluorescent signal, and the significance of the signal.

About the Filters The StepOne and StepOnePlus systems use the following filters:

StepOne system StepOnePlus system
Filter Dye Filter Dye
1 | FAM™ dye 1 | FAM™ dye
SYBR® Green dye SYBR® Green dye
2 | JOE™ dye 2 | JOE™ dye
VIC® dye VIC® dye
3 ROX™ dye 3 TAMRA™ dye
NED™ dye

4 | ROX™dye

About the The StepOnePlus instrument contains six independently thermally regulated VeriFlex™
VeriFlex™  blocks to help you optimize your thermal cycling conditions. You can set a different
Technology temperature for one or more of the VeriFlex blocks, creating up to six different zones for
samples, or you can set the same temperature for each of the VeriFlex blocks.

For More For information on:

Information + The StepOne and StepOnePlus systems, refer to Applied Biosystems StepOne"

Real-Time PCR Software Help.

Note: To access the Help, select Help » StepOne Software Help from within the
StepOne software.

+ Genotyping experiments, refer to Applied Biosystems StepOne"" and StepOnePlus"™
Real-Time PCR Systems Getting Started Guide for Genotyping Experiments.

* Presence/absence experiments, refer to Applied Biosystems StepOne'" and
StepOnePlus" Real-Time PCR Systems Getting Started Guide for Presence/Absence
Experiments.

+ Standard curve experiments, refer to Applied Biosystems StepOne"" and
StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard Curve
and Experiments.

Notes
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Supported Consumables

StepOne System  The StepOne system supports the consumables listed below. These consumables are for
use with both standard and Fast reagents/protocols.

IMPORTANT! Use only Fast consumables (reaction plates, tube strips, and tubes) with
the StepOne and StepOnePlus systems, even when performing an experiment with
standard reagents.

Consumable Part Number
¢ MicroAmp® Fast Optical 48-Well Reaction Plate e 4375816
¢ MicroAmp® 48-Well Optical Adhesive Film e 4375323 and
4375928
¢ MicroAmp® Fast 8-Tube Strip e 4358293
¢ MicroAmp® Optical 8-Cap Strip e 4323032
* MicroAmp® Fast Reaction Tube with Cap e 4358297
e MicroAmp® Fast 48-Well Tray e 4375282
* MicroAmp® 48-Well Base Adaptor e 4375284
e MicroAmp® 96-Well Support Base e 4379590

Consumable

MicroAmp® Fast Optical 48-Well Reaction Plate
MicroAmp® Fast 48-Well Tray
MicroAmp® 96-Well Support Base

MicroAmp® Optical 8-Cap Strip
MicroAmp® Fast 8-Tube Strip

MicroAmp® Fast Reaction Tube with Cap
MicroAmp® 48-Well Optical Adhesive Film
MicroAmp® 48-Well Base Adaptor

I &G m m O O @ >» *

Notes
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StepOnePlus The StepOnePlus system supports the consumables listed below. These consumables are
System for use with both standard and Fast reagents/protocols.

IMPORTANT! Use only Fast consumables (reaction plates, tube strips, and tubes) with
the StepOne and StepOnePlus systems, even when performing an experiment with
standard reagents.

Consumable Part Number

¢ MicroAmp® Fast Optical 96-Well Reaction Plate with e 4346906 and
Barcode 4366932

* MicroAmp® Optical Adhesive Film e 4360954 and
4311971
e MicroAmp® Fast 8-Tube Strip e 4358293
* MicroAmp® Optical 8-Cap Strip e 4323032
¢ MicroAmp® Fast Reaction Tube with Cap e 4358297
e MicroAmp® 96-Well Tray for VeriFlex™ Blocks e 4379983
¢ MicroAmp® 96-Well Support Base e 4379590
* MicroAmp® Adhesive Film Applicator e 4333183
¢ MicroAmp® Cap Installing Tool (Handle) e 4330015

Consumable

MicroAmp® Fast Optical 96-Well Reaction Plate
MicroAmp® 96-Well Tray for VeriFlex™ Blocks

MicroAmp® 96-Well Support Base
MicroAmp® Optical 8-Cap Strip
MicroAmp® Fast 8-Tube Strip
MicroAmp® Fast Reaction Tube with Cap

@/ m m O O W > *

MicroAmp® Optical Adhesive Film

Notes
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About Relative Standard Curve and Comparative C;

Experiments

Real-Time PCR
Experiments

About Relative
Standard Curve
Experiments

Notes

Relative standard curve and comparative C (AACy) experiments are real-time PCR
experiments. In real-time PCR experiments:

* The instrument monitors the progress of the PCR as it occurs (Kwok and Higuchi,
1989).

» Data are collected throughout the PCR process.

» Reactions are characterized by the point in time during cycling when amplification
of a target is first detected (Saiki et al., 1985).

Note: In this guide, the term experiment refers to the entire process of performing a run
using the StepOne or StepOnePlus system, including setup, run and analysis.

The relative standard curve method is used to determine relative target quantity in
samples. With the relative standard curve method, the StepOne software measures
amplification of the target and of the endogenous control in samples, in a reference
sample, and in a standard dilution series. Measurements are normalized using the
endogenous control. Data from the standard dilution series are used to generate the
standard curve. Using the standard curve, the software interpolates target quantity in the
samples and in the reference sample. The software determines the relative quantity of
target in each sample by comparing target quantity in each sample to target quantity in
the reference sample.

Relative standard curve experiments are commonly used to:
» Compare expression levels of a gene in different tissues.

» Compare expression levels of a gene in a treated sample vs. an untreated sample.
» Compare expression levels of wild-type alleles vs. mutated alleles.

Components
The following components are required when setting up PCR reactions for relative
standard curve experiments:

* Sample — The sample in which the quantity of the target is unknown.

* Reference sample — The sample used as the basis for relative quantitation results.
For example, in a study of drug effects on gene expression, an untreated control
would be an appropriate reference sample. Also called calibrator.

» Standard — A sample that contains known standard quantities; used in quantitation
experiments to generate standard curves.

* Standard dilution series — A set of standards containing a range of known
quantities. The standard dilution series is prepared by serially diluting standards.

6 Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative
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* Endogenous control — A target or gene that should be expressed at similar levels in
all samples you are testing. The endogenous control is used to normalize
fluorescence signals for the target you are quantifying. Housekeeping genes can be
used as endogenous controls.

* Replicates — The total number of identical reactions containing identical samples,
components, and volumes.

* Negative Controls — Wells that contain water or buffer instead of sample template.
No amplification of the target should occur in negative control wells.

About The comparative C (AAC) method is used to determine the relative target quantity in
Comparative C;  samples. With the comparative C method, the StepOne software measures amplification
Experiments of the target and of the endogenous control in samples and in a reference sample.
Measurements are normalized using the endogenous control. The software determines
the relative quantity of target in each sample by comparing normalized target quantity in
each sample to normalized target quantity in the reference sample.

Comparative Cy experiments are commonly used to:
» Compare expression levels of a gene in different tissues.

» Compare expression levels of a gene in a treated sample vs. an untreated sample.
* Compare expression levels of wild-type alleles vs. mutated alleles.

Components

The following components are required when setting up PCR reactions for comparative
C experiments:

* Sample — The sample in which the quantity of the target is unknown.

* Reference sample — The sample used as the basis for relative quantitation results.
For example, in a study of drug effects on gene expression, an untreated control
would be an appropriate reference sample. Also called calibrator.

* Endogenous control — A target or gene that should be expressed at similar levels in
all samples you are testing. The endogenous control is used to normalize
fluorescence signals for the target you are quantifying. Housekeeping genes can be
used as endogenous controls.

* Replicates — The total number of identical reactions containing identical samples,
components, and volumes.

* Negative Controls — Wells that contain water or buffer instead of sample template.
No amplification of the target should occur in negative control wells.

Notes
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Relative Standard

Curve vs. C;experiments:
Comparative C;
Experiments

Consider the following when choosing between relative standard curve and comparative

Experiment
Type

Relative
standard curve

Comparative
Cr (AACy)

PCR Options

Notes

Description

Uses a standard curve to
determine the change in
expression of a target in a
sample relative to the same
target in a reference sample.
Best for assays that have
suboptimal PCR efficiency.

Uses arithmetic formulas to

determine the change in
expression of a target in a
sample relative to the same
target in a reference sample.
Best for high-throughput
measurements of relative gene
expression of many genes in
many samples.

Advantage

Requires the least amount of
validation because the PCR
efficiencies of the target and
endogenous control do not need
to be equivalent.

¢ Relative levels of target in
samples can be determined
without the use of a standard
curve, provided that the PCR
efficiencies of the target and
endogenous control are
relatively equivalent.

e Reduced reagent usage.

e More space available in the
reaction plate.

When performing real-time PCR, choose between:

 Singleplex and multiplex PCR (below)

and

* 1-step and 2-step RT-PCR (page 9)

Singleplex vs. Multiplex PCR

You can perform a PCR reaction using either:

Limitation

A standard curve must be
constructed for each target,
which requires more reagents
and more space in the reaction
plate.

e Suboptimal (low PCR

efficiency) assays may
produce inaccurate results.

e Before you use the
comparative C; method,
Applied Biosystems
recommends that you
determine that the PCR
efficiencies for the target
assay and the endogenous
control assay are
approximately equal.

+ Singleplex PCR — In singleplex PCR a single primer set is present in the reaction
tube or well. Only one target or endogenous control can be amplified per reaction.

or

e Multiplex PCR — In multiplex PCR, two or more primer sets are present in the
reaction tube or well. Each set amplifies a specific target or endogenous control.
Typically, a probe labeled with FAM™ dye detects the target and a probe labeled
with VIC® dye detects the endogenous control.

IMPORTANT! SYBR® Green reagents cannot be used for multiplex PCR.

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA™ dye
as a reporter or quencher with the StepOne system. TAMRA dye may be used as a

reporter or quencher with the StepOnePlus system.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative

Standard Curve and Comparative C; Experiments



Chapter 1 Get Started n

About Relative Standard Curve and Comparative Cy Experiments

. O BEm [ Target Primer Set
=
o 3 00 (O Endogenous Control
ey Primer Set
, ~~ cDNA
Singleplex PCR Multiplex PCR

1- vs. 2-Step RT-PCR

You can perform reverse transcription (RT) and PCR in a single reaction (1-step) or in
separate reactions (2-step). The reagent configuration you use depends on whether you
are performing 1- or 2-step RT-PCR:

* In 1-step RT-PCR, RT and PCR take place in one buffer system, which provides the
convenience of a single-tube preparation for RT and PCR amplification. However,
you cannot use Fast PCR Master Mix or the carryover prevention enzyme,
AmpErase® UNG (uracil-N-glycosylase), to perform 1-step RT-PCR.

o 2-step RT-PCR is performed in two separate reactions: First, total RNA is reverse-
transcribed into cDNA, then the cDNA is amplified by PCR. This method is useful
for detecting multiple transcripts from a single cDNA template or for storing cDNA
aliquots for later use. The AmpErase® UNG enzyme can be used to prevent
carryover contamination.

Note: For more information on AmpErase® UNG, refer to the Real-Time PCR Systems
Reagent Guide.

Notes
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Supported TagMan® and SYBR® Green Reagents

Reagents

Applied Biosystems offers TagMan® and SYBR® Green reagents for use on the StepOne

and StepOnePlus systems. Both reagent types are briefly described in the table below.

Reagent Type

Process

TagMan® reagents or kits
Description

TagMan reagents use a fluorogenic probe to
enable detection of a specific PCR product as
it accumulates during PCR cycles.

Advantages

¢ Increased specificity with the addition of a
fluorogenic probe.
e Provides multiplex capability.

e Preformulated assays, optimized to run
under universal thermal cycling conditions,
are available.

Limitations

Requires synthesis of a unique fluorogenic
probe.

SYBR® Green reagents
Description

SYBR Green reagents use SYBR® Green | dye,
a double-stranded DNA binding dye, to detect
PCR products as they accumulate during PCR
cycles.

Advantages

e Economical (no probe needed).

¢ Allows for melt curve analysis to measure
the Tm of all PCR products.

Limitations

Binds nonspecifically to all double-stranded
DNA sequences. To avoid false positive
signals, check for nonspecific product
formation using melt curve or gel analysis.

e (Can be used for either 1- or 2-step RT-PCR.

e (Can be used for either 1- or 2-step RT-PCR.

PCR and Detection of cDNA

a. Assay Components

Forward primer
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Step 1: Reaction setup
The SYBR® Green | dye
fluoresces when bound to
double-stranded DNA.

) Step 2: Denaturation

When the DNA is denatured into
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single-stranded DNA, the
SYBR® Green | dye is released and
the fluorescence is drastically reduced.

Step 3: Polymerization
During extension, primers
anneal and PCR product
is generated.

Step 4: Polymerization completed
SYBR® Green | dye binds to the
double-stranded product,

resulting in a net increase in
fluorescence detected by the
instrument.

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA dye as a
reporter or quencher with the StepOne system. TAMRA dye may be used as a reporter or
quencher with the StepOnePlus system.

Notes
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How to Use This Guide

Other Reagents

You can use other fluorescent-based reagents on the StepOne and StepOnePlus systems,
but note the following:

* You must design your experiment using Advanced Setup instead of the Design
Wizard. (See “Advanced Setup Workflow” on page 260.)

* For Applied Biosystems TagMan and SYBR Green reagents, the StepOne software
automatically calculates reaction volumes in the Reaction Setup screen.

For More For more information on real-time PCR experiments, PCR options, and reagents, refer to
Information the Real-Time PCR Systems Reagent Guide.

How to Use This Guide

This guide functions as both a tutorial and as a guide for performing your own
experiments.

Using This Guide By using the example experiment data provided with the StepOne software, you can use
as a Tutorial this guide as a tutorial for performing a relative standard curve or comparative C
experiment on a StepOne or StepOnePlus system. Follow the procedures in the
appropriate chapters:

Chapter
P d
Relative Comparative rocedure
Standard Curve Cr

2 6 Design the experiment using the Design Wizard in the
StepOne software.

3 7 Prepare the experiment, using the reagents and
volumes calculated by the Design Wizard in Chapter 2
(relative standard curve experiment) or Chapter 6
(comparative C; experiment).

4 8 Run the experiment on a StepOne or StepOnePlus
instrument (standalone or colocated layout).

5 9 Analyze the results.

For more information, see “About the Example Experiments” on page 12.

Using This Guide After completing the tutorial exercises in Chapters 2 to 9, you can use this guide to lead
With Your Own you through your own relative standard curve or comparative C; experiments. Each
Experiments procedure in Chapters 2 to 9 includes a set of guidelines that you can use to perform your
own experiments.

Notes

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative 11
Standard Curve and Comparative C; Experiments




Chapter 1 Get Started
About the Example Experiments

Additionally, you can use one of the other workflows provided in the StepOne software to
perform your experiments. The table below provides a summary of all the workflows
available in the StepOne software.

Workflow Description See...

Design Wizard | Set up a new experiment with guidance from the software. | Chapter 2 or
The Design Wizard walks you through best practices as Chapter 6
you create your own experiment. The Design Wizard is
recommended for new users.

Note: Design options are more limited in the Design
Wizard than in Advanced Setup.

Advanced Set up a new experiment using advanced options. page 260

Setup Advanced Setup allows design flexibility as you create
your own experiment. Advanced Setup is recommended
for experienced users.

QuickStart Run a new experiment with no plate setup information. If page 261
desired, you can add all design parameters after the run.

Template Set up a new experiment using setup information from a page 263
template.
Export/Import Import experiment designs from ASCII text files that page 265

contain experiment setup information.

About the Example Experiments

To illustrate how to perform relative standard curve and comparative C experiments, this
guide leads you through the process of designing, preparing, running, and analyzing an
example experiment. The example experiment represents a typical setup that you can use
to quickly familiarize yourself with the StepOne or StepOnePlus system.

Description of the The objective of the relative standard curve example experiment is to compare the
Relative Standard expression of the c-myc transcriptional factor (an oncoprotein that activates the
Curve Example transcription of growth-associated genes) in liver and kidney tissues.

Notes

12

Experiment In the relative standard curve example experiment:

* The samples are cDNA prepared from total RNA isolated from liver and kidney
tissues.

+ The target is human c-myc.

* The endogenous control is human glyceraldehyde-3-phosphate dehydrogenase
(GAPDH).

* The reference sample is RNA isolated from kidney tissue.

* One standard curve is set up for c-myc (target). The standard used for the standard

dilution series is a cDNA sample of known quantity prepared from RNA isolated
from lung tissue.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative
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About the Example Experiments

* One standard curve is set up for GAPDH (endogenous control). The standard used
for the standard dilution series is a cDNA sample of known quantity prepared from
RNA isolated from lung tissue.

* The experiment is designed for singleplex PCR, where the target (c-myc) and
endogenous control (GAPDH) assays are performed in separate wells.

* Reactions are set up for 2-step RT-PCR. The High-Capacity cDNA Reverse
Transcription Kit is used for reverse transcription; the TagMan® Fast Universal PCR
Master Mix is used for PCR.

* Primer/probe sets are selected from the Applied Biosystems TagMan® Gene
Expression Assays product line:

— For the target assay (c-myc), the assay ID is Hs00153408_m1
(RefSeq NM_002467.3).

— For the endogenous control assay (GAPDH), the assay ID is Hs99999905_m1
(RefSeq NM_002046.2).
Reaction Plate Layout

The relative standard curve example experiment was created for a StepOne instrument.
For the StepOne instrument, the software displays a 48-well reaction plate layout:

| [0 | show in wells ¥ | [BE view Legend ‘ |

i [ 2 [ 2 [ ] [ : [ 8 [ 7 [ ] J

L
A | [ e-mye [ -mye [ e-mye [ saron [ caroH [ capon m Drmy:EI m D,m,:m

Kidney Kidney Kidney Kidney

Liver Liver Liver Liver
8 Meme [0 saron [ saron [T capon Meme [ ecme [ omye [ saron

. Ficney Kickney [ emye Heme [Heme Hemye [Hempe Heme
(I sapon [ sapon 200 200 200 20 20

o |Heme Here Hene Heme Heme Heme Heme Heme
2 2 2 0.2 0.2 0.z 0.02 0.02

c |[Heme (S (S & sarou & saron [E saron [E sapon [E] sapon
200 200 200 k] k0 k0 2

[ e H saron [ saron [ saron [ saron [ saron [ saron [ saron
2 2 0.2 0.2 0.z 0.02 0.02 0.02

You can create the example experiment for a StepOnePlus instrument; however, your
reaction plate layout will differ from the 48-well reaction plate layout shown throughout
this guide. For the StepOnePlus instrument, the software displays a 96-well reaction plate
layout:

Notes
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About the Example Experiments

| Elshomeellsv | ViewLegend ‘ |

1 [z [ s [ 4 T s [ s [ 7 ] s [ e [ o [ w1 [ 1z ]

Liver Liver Liver Liver Liver Liver
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=
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2 0.02 002 0.02 200 200 200

Hosron [ oaron [ osron [ oaron [ oaron [ oaeon [osron [ oaron [ oaron [Hoaron [ oaron [H saron
20 2 2 2 02 02 0.2 0.02

20 20 0.02 0.02

[z e[ ~[m[oJTelm]=>

Description of the The objective of the comparative C example experiment is to compare the expression of
Comparative C; TP53 (a transcription factor that regulates other genes) in liver, kidney, and brain tissues.
Example

\ In the comparative C; example eriment:
Experiment © comparative Ly example exp

* The samples are cDNA prepared from total RNA isolated from liver, kidney, and
brain tissues.

» The target is TP53.

* The reference sample is brain.

* The endogenous control is human GAPDH.

» The experiment is designed for singleplex PCR, where the target (TP53) and
endogenous control (GAPDH) assays are performed in separate wells.

» Reactions are set up for 2-step RT-PCR. The High-Capacity cDNA Reverse
Transcription Kit is used for reverse transcription; the TagMan® Fast Universal PCR
Master Mix is used for PCR.

+ Primer/probe sets are selected from the Applied Biosystems TagMan® Gene
Expression Assays product line:

— For the target assay (TP53), the assay ID is Hs00153340_m1
(RefSeq NM_000546.2).

— For the endogenous control assay (GAPDH), the Human GAPD (GAPDH)
Endogenous Control kit (PN 4333764T) is used.

Reaction Plate Layout

The comparative CT example experiment was created for a StepOne instrument. For the
StepOne instrument, the software displays a 48-well reaction plate layout:

Notes
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About the Example Experiments

| mshowmv\lellsv | ViewLegend

]

1 [ 2 [ 3 [ 4 [ 5
& | [ rsa [ rsz [ 1psa [ caroH [ caron
Liver Liver Liver Liver Kidney
B [ resa apoH [T capon [T capon [ ess
Kidney Kidney Brain Brain Brain
C | [@ caron GAPDH [ esa [ resa [ resa
D
E
F

[ GaroH

Kidney

s

Brain

[ s2pon

EEE
7 [ 8
Liver Livar
- -
Kidney Kidney
- o
Brain Brain
GAPDH GAPDH

You can create the example experiment for a StepOnePlus instrument; however, your
reaction plate layout will differ from the 48-well reaction plate layout shown throughout
this guide. For the StepOnePlus instrument, the software displays a 96-well reaction plate

layout:

| mshcwinWeHsv | V\ewLegend

1 [ 2 [ s ]« [ s T s [ 7 ] 8 [ s ] 1o [ m 12|
Liver Liver Liver Liver Liver Liver
Al[dwss  [ss  [ess [ eapon [0 saron  [1] capon M= |[[wss [wss |0 caror | saron ([ caron
Kidney Kidney Kidnay Kidney Kidney Kidney Brain Brain Brain Brain Brain Brain
FlMwss |[Mrss [Mwss [oseon [oaron [oaron [@wss [[wss  [resa  [[oseon [ saron [T caron
s
D
E
F
G
H

Notes
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Description of the

About the Example Experiments

In the comparative C; example study:

Comparative Cy + 11 reaction plates (experiments) are used.

Example Study The cDNA was prepared from total RNA that was isolated from the following
11 samples:
Sample Name Sample Name
Placenta Spleen
Liver Stomach
Brain Heart
Lung Colon
Testes Ovary
Bladder
* 16 targets (assays) are used:

Target Assay ID No. Target Assay ID No.
18S# . Hs99999901_s1 CENPA . Hs00156455_m1
HPRT1# Hs99999909_m1 DCT Hs00157244_m1
uBCH* Hs00824723_m1 GABRD Hs00181309_m1
POLR2A¥ ' Hs001721 87_m1 PLA2G2A " Hs001 79898 _m1
ACTN2 Hs00153809_m1 SFPQ Hs00192574_m1
ATP1A2 Hs00265131_m1 SHH Hs00179843_m1
C1orf61 " Hs001 97247_m1 VCAM1 " Hs001 74239_m1
CD58 Hs00156385_m1 WNT2 Hs00608224_m1

F Can be used as an endogenous control.
* The reference sample is bladder.
* The endogenous control is 18S.
* Each experiment in the study was designed for singleplex PCR, where the target and
endogenous control assays are performed in separate wells.
* For each experiment in the study, reactions were set up for 2-step RT-PCR:
— The cDNA was reverse-transcribed from total RNA samples using High Capacity
RNA-to-cDNA Master Mix.
— The reactions were prepared using TagMan® Fast Universal PCR Master Mix
(2X).
Notes
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About the Example Experiments

Reaction Plate Layout

The comparative C; example study was created for a StepOne instrument. For the
StepOne instrument, the software displays a 48-well reaction plate layout:

| ElShUWIHWEHSV | VlewLegend | | | | |

You can create the example study for a StepOnePlus instrument; however, your reaction
plate layout will differ from the 48-well reaction plate layout shown throughout this
guide. For the StepOnePlus instrument, the software displays a 96-well reaction plate
layout.

About the In this getting started guide you will use six files:

. Example * In Chapters 2 and 6, you will create example experiment files that contain setup data
Experiment and (the Relative Standard Curve Example.eds file in Chapter 2 and the Comparative
Example SItDU(:y CT Example.eds file in Chapter 6). Save these files to the experiments folder on
ata

your computer at:
<drive>:\Applied Biosystems\<software name>\experiments\

* In Chapters 5 and 9, you will view results in example experiment files that contain
run data (the Relative Standard Curve Example.eds file in Chapter 5 and the
Comparative CT Example.eds file in Chapter 9). The data files for the example
experiments are installed with the StepOne software. You can find the data files for
the example experiments on your computer at:

<drive>:\Applied Biosystems\<software name>\experiments\examples
* In Chapter 10, you will:

— Create an example study file that contains setup data (the Comparative CT Study
Example.edm file). Save the file to the experiments folder on your computer at:

<drive>:\Applied Biosystems\<software name>\experiments

— View results in an example study file that contains run data (the Comparative CT
Study Example.edm). The data file for the example study is installed with the
StepOne software. You can find the data file for the example study on your
computer at:

<drive>:\Applied Biosystems\<software name>\experiments\examples

Notes
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Example Experiment Workflow

where:

* <drive> is the computer hard drive on which the StepOne software is installed. The
default installation drive for the software is the D drive.

» <software name> is the current version of the StepOne software.

Data Files in the Examples Folder

The examples folder contains several data files that you can refer to when you analyze
your own data, as listed in the table below. The data files are installed with the
StepOne software.

Note: Be sure to use the Relative Standard Curve Example.eds, Comparative CT
Example.eds, and Comparative CT Study Example.edm files when you perform the
tutorial procedures in this guide. The 96-Well Relative Standard Curve Example.eds and
96-Well Comparative CT Example.eds files are different examples of relative standard

curve and comparative C methods.

StepOne Instrument

Comparative CT Example.eds

Comparative CT Study Bio Replicates
Example.edm

Comparative CT Study Example.edm
Genotyping Example.eds

Multiplex Example.eds

StepOnePlus Instrument

96-Well Comparative CT Example.eds

96-Well Genotyping Example.eds

96-Well Multiplex Example.eds

Presence Absence Example.eds

96-Well Presence Absence Example.eds

Relative Standard Curve Example.eds

96-Well Relative Standard Curve
Example.eds

RNase P Experiment.eds

96-Well RNase P Experiment.eds

Standard Curve Example.eds

96-Well Standard Curve Example.eds

SYBR Example.eds

Example Experiment Workflow

Notes

18

96-Well SYBR Example.eds

The figure on page 19 shows the workflow for the relative standard curve and

comparative C example experiments.

The figure on page 20 shows the workflow for the comparative C example study.
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Relative Standard Curve Experiment
Start Experiment

v

Design the Experiment (Chapter 2)
Create a new experiment.
Define the experiment properties.
Define the methods and materials.
Set up the targets.
Set up the standards.
Set up the samples.
Set up the relative quantitation.

© N O~ Nd

Set up the run method.

9. Review the reaction setup.
10.0Order materials for the experiment.
11.Finish the Design Wizard.

Chapter 1 Get Started n

Example Experiment Workflow

Comparative C; (AAC;) Experiment
Start Experiment

v

v

Design the Experiment (Chapter 6)
1. Create a new experiment.

2. Define the experiment properties.
3. Define the methods and materials.
4. Set up the targets.

5. Set up the samples.

6. Set up the relative quantitation.

7. Set up the run method.

8. Review the reaction setup.

9. Order materials for the experiment.
10.Finish the Design Wizard.

Prepare the Reactions (Chapter 3)
Prepare the template.
Prepare the sample dilutions.
Prepare the standard dilution series.

o N~

Prepare the reaction plate.

v

Prepare the reaction mix for each target assay.

h 4

Prepare the Reactions (Chapter 7)
. Prepare the template.
. Prepare the sample dilutions.
. Prepare the reaction mix for each target assay.
. Prepare the reaction plate.

AW N =

Run the Experiment (Chapter 4)
Prepare for the run.
(Optional) Enable the notification settings.
Start the run.
Monitor the run.

I

Unload the instrument and transfer the data.

h 4

v

Run the Experiment (Chapter 8)
. Prepare for the run.
. (Optional) Enable the notification settings.
. Start the run.
. Monitor the run.

O b~ WON =

. Unload the instrument and transfer the data.

Analyze the Experiment (Chapter 5)
Section 1, Review Results:
. Analyze.
. View the standard curve.
. View the ampilification plot.
. View the gene expression plot/results table.
. Publish the data.
Section 2, Troubleshoot (If Needed):

1. View the analysis settings; adjust the
baseline/threshold.

a B~ WO N =

View the quality summary.
Omit wells.
View the multicomponent plot.

o oweDN

View the raw data plot.

h 4

v
End Experiment

Notes

Analyze the Experiment (Chapter 9)
Section 1, Review Results:
1. Analyze.
2. View the gene expression plot/results table.
3. View the amplification plot.
4. Publish the data.
Section 2, Troubleshoot (If Needed):

1. View the analysis settings; adjust the
baseline/threshold.

. View the quality summary.
. Omit wells.
. View the multicomponent plot.

a b~ ODN

. View the raw data plot.

A 4
End Experiment
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Example Experiment Workflow

Comparative C; (AAC;) Study
Start Study

v
Design the Experiment (Chapter 6)

h 4
Prepare the Reactions (Chapter 7)

v
Run the Experiment (Chapter 8)

v
Analyze the Experiment (Chapter 9)

v
Design and Analyze a Study (Chapter 10)
1. Design a study:

a. Create a study.
b. Define study properties.
c. Define replicates.

2. Analyze a study:

Q

. View the analysis settings.
. View the amplification plot.
. View the gene expression plot.
. View the replicate results data and well results data.
. View the multicomponent plot.
View the quality summary.
. Compare the analysis settings.
. (If needed) Omit wells from the analysis.

blish the data.

oSQ ™ 0 o O T

3.

)

v
End Study

Notes
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Design the Relative Standard
Curve Experiment

This chapter covers:

B Chapter OVeIVIEW . . . o vt e ettt e e e e e e 22
B Createa New Experiment. . .. ......... .. 23
B Define the Experiment Properties .. ........ ... .. .. ... .. .. .. .. ... ... 27
B Define the Methods and Materials . . ......... ... .. .. ... 30
B SetUpthe Targets. .. ..ot e e e e 32
B SetUpthe Standards. .......... ... . . i 35
B SetUpthe Samples. . ... 37
B Set Up the Relative Quantitation Settings . ...................c.cvuer.... 39
B SetUpthe RunMethod ........ ... .. .. . . . . 41
B Review the Reaction Setup. ........... i 43
B Order Materials for the Experiment . . ........... ... .. ... .. ... oo .. 50
B Finishthe Design Wizard . . ........ .. ... ... . . . 54

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne™ Real-Time PCR Software by pressing
F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Notes
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Chapter Overview

Chapter Overview

This chapter explains how to use the Design Wizard in the StepOne"™ software to set up
the relative standard curve example experiment. The Design Wizard walks you through
Applied Biosystems recommended best practices as you enter design parameters for the
example experiment.

Example The workflow for designing the example experiment provided with this getting started
Experiment guide is shown below.
Workflow
Note: Design the example experiment using the Design Wizard in the StepOne software.
When you design your own experiments, you can select alternate workflows (see “Using
This Guide With Your Own Experiments” on page 11).

Relative Standard Curve Experiment
Start Experiment

v
Design the Experiment (Chapter 2)

. Create a new experiment.

. Define the experiment properties.
. Define the methods and materials.
. Set up the targets.

. Set up the standards.

. Set up the samples.

. Set up the relative quantitation.

0o N O O~ W DN =

. Set up the run method.

9. Review the reaction setup.

10. Order materials for the experiment.
11. Finish the Design Wizard.

v
Prepare the Reactions (Chapter 3)

v
Run the Experiment (Chapter 4)

v
Analyze the Experiment (Chapter 5)

v

End Experiment

Notes
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Create a New Experiment

Create a New Experiment

Create a new experiment using the Design Wizard in the StepOne software.

Log Intothe 1. Double-click € (StepOne software) or select Start » All Programs » Applied
Software and Biosystems » StepOne Software » <software name>
Create an

: where <software name> is the current version of the StepOne software.
Experiment

2. In the Login dialog box, create a user name:

a. In the User Name field, enter EXAMPLEUSER. You cannot enter spaces in
the User Name field.

b. Click OK.

Loginas Guest [l Delets User(s)

3. From the Home screen, click (Design Wizard) to open the Design Wizard.

IF\lE Edit Instrument Analysis Tools Help I

[E] New Experiment - =] Open.. [ [ TJ_“ Send Experiment to Instrument... L_'r Download Experiment from Instrument.. &30 8

Notes
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Create a New Experiment

4. See “Software Elements” on page 25 for information on navigating within the
Design Wizard.

Design  When you design your own experiment, you can do one of the following in the Login
Guidelines dialog box:

* Log in as a new user — In the User Name field, enter a user name, then click OK.

Note: You cannot use the following characters in the User Name field: space,
forward slash (/), backslash (\), greater than sign (>), less than sign (<), asterisk (*),
question mark (?), quotation mark ("), vertical line (]), colon (:), or semicolon (;).

* Log in as an existing user — From the User Name dropdown menu, select an existing
user, then click OK.

* Log in anonymously — Click Log in as Guest.

Applied Biosystems recommends that you log in with a user name. If you log in with a
user name, you can set preferences in the software. The next time you log in to the

software with the same user name, the software uses the preferences you set as the
defaults.

IMPORTANT! If you log in to the software as a Guest, you cannot set preferences.

You can set preferences as follows:

* Save as the default checkboxes — Select the Save as the default checkboxes as
needed. The Save as the default checkboxes appear on the Home screen, on the
Export Data dialog box, and on several Analysis screens.

* Preferences dialog box — Select Tools » Preferences to open the Preferences dialog
box. In the Defaults and/or Startup tabs, change the preferences as desired.

» Preferences

a Enter a default sample volume for your experiments, select your default folders, and
selectthe type of instrument for the sofware to use by default

Sample Reaction val: |20 HL

Data Falder: S\pplied BiosysternsiStepOne Software v2 1lexperiments \

Import Folder: S\pplied BiosysternsiStepOne Software v2 1lexperiments \

Export Folder: \Applied BiosystemsiStepOne Software v2.1lexperiments

Instrument Type

ok || cancal

For More For more information, access the StepOne Software Help by clicking @ or pressing F1.
Information

Notes
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Create a New Experiment

Software The StepOne software elements for the Design Wizard are illustrated below.

Elements _ _ )
1. Menu bar — Displays the menus available in the software:

* File

« Edit

* Instrument
* Analysis

¢ Tools
* Help

2. Toolbar — Displays the tools available in the software:
* New Experiment
* Open
* Close
» Send Experiment to Instrument

* Download Experiment from Instrument

3. Experiment header — Displays the experiment name, experiment type, and reagents
for the open experiment.

4. Navigation pane — Provides links to all screens in the Design Wizard:
* Experiment Properties
* Methods & Materials
» Targets
» Relative Quantitation Settings
» Standards
* Samples
* Run Method
* Reaction Setup
* Materials List

Note: The Design Wizard initially displays the Quantitation - Standard Curve
experiment type. The available Design Wizard screens may change when you select
a different experiment type. For example, the Relative Quantitation Settings screen
is not displayed until you select the relative standard curve or comparative C
(AACy) experiment type.

5. Experiment tab(s) — Displays a tab for each open experiment.

Notes
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Create a New Experiment

1 IFi\e Edit Instrument Analysis Tools Help
[] New Experiment ~ 5 Open.. [

=] Close ‘;5_“ Send Experiment to Instrument... ’% Download Experimentfrom Instrument... | £

7 Reagents: Ta
experiment...

1A. Define: Experiment Properties Experiment Properties Help @)

1. Define
a Instructions: Enter an experiment name, selectthe instrumenttype, then selectthe type of experiment to design.

* Experiment How do you want to identify this experiment? = Required
Properties

* Experiment Name: Untitled

Barcode (Optional): ‘

User Name (Optional): ‘ |
2. SetUp Comments (Optional), ‘ |

Which instrument are you using to run the experiment?

[ StepCnePlus™ Instrument (96 Wells) ] { + StepCne™ Instrument (48 Wells) ]

<[>

Setup, run, and analyze an experiment using a 3-color, 48-well system

What type of experiment do you want to design?

[ « Quantitation ] [ Genotyping ] [ Presence / Absence ]

Desian a gene quantitation experiment to determine the amount of target nucleic acid sequence in a sample.

3. Order ( Optional)

- + Finish Designing Experiment

5 1 v o] Untitled <

Notes
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Define the Experiment Properties

Define the Experiment Properties

On the Experiment Properties screen, enter identifying information for the experiment,
select the instrument type, then select the type of experiment to design.

About the In the relative standard curve example experiment:

Example * The experiment is identified as an example.
Experiment

* The instrument selected to run the experiment is the StepOne instrument.
+ A MicroAmp® Fast Optical 48-Well Reaction Plate is used.
* The experiment type is quantitation.

Complete the 1. Click the Experiment Name field, then enter Relative Standard Curve Example.

Experiment
Properties Screen Note: The experiment header updates with the experiment name you entered.

2. Leave the Barcode field empty.

Note: The MicroAmp Fast Optical 48-Well Reaction Plate does not have a barcode.

3. Click the User Name field, then enter Example User.

4. Click the Comments field, then enter Relative Standard Curve Getting Started
Guide Example.

5. Select StepOne™™ Instrument (48 Wells).

Note: The example experiment was created for a StepOne instrument. You can
create the example experiment for a StepOnePlus instrument; however, your
reaction plate layout will differ from the layout shown in this guide. The software
displays a 48-well reaction plate layout for the StepOne instrument and a 96-well
reaction plate layout for the StepOnePlus instrument. To create the example
experiment for a StepOnePlus instrument, select StepOnePlus™ Instrument
(96 Wells).

6. Select Quantitation for the experiment type.

7. Click Next >.

Notes
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Notes
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Define the Experiment Properties

1A. Define: Experiment Properties Experiment Properties Help @

a Instructions: Enter an experiment name, selectthe instrument typs, then select the type of experiment to design

How do you want to identify this experiment? = Required

* Experiment Mame: | Relative Standard Curve Example |

Barcode (Optional) |

User Name (Optional) | Example User |
el ROl WL EV IR = ative Standard Curve Getting Started Guide Example| |

A
s

Which instrument are you using to run the experiment?

[ StepCOneFlus™ Instrument (96 Wells) ] ‘ ¥ StepCine™ Instrument (48 Wells) |

Setup, run, and analyze an experiment using a 3-color, 48-well system

What type of experiment do you want to design?

; ¥ Quantitation | { Genatyping ] { Presence / Absence ]

Design a gene guantitation experiment to determing the amount of target nucleic acid sequence in a sample.

Design  When you design your own relative standard curve experiment:

Guidelines  Enter an experiment name:

— The experiment name is used as the default file name.

— Enter a name that is descriptive and easy to remember. You can enter up to 100
characters in the Experiment Name field.

Note: You cannot use the following characters in the Experiment Name field:
forward slash (/), backslash (\), greater than sign (>), less than sign (<), asterisk
(*), question mark (?), quotation mark ("), vertical line (), colon (),
semicolon (;), and sign (&), percent sign (%), dollar sign ($), at sign (@),
circumflex (%), left parenthesis ( (), right parenthesis () ), or exclamation

point (!).

IMPORTANT! If you run the instrument in standalone mode from the
instrument touchscreen, you cannot enter more than 32 characters in the
Experiment Name field and you cannot include spaces in the name.

+ (Optional) If you use a MicroAmp® Fast Optical 96-Well Reaction Plate, enter a
barcode to identify the barcode on the PCR reaction plate. You can enter up to
100 characters in the Barcode field.

Note: The MicroAmp Fast Optical 48-Well Reaction Plate does not have a barcode.

* (Optional) Enter a user name to identify the owner of the experiment. You can enter
up to 100 characters in the User Name field.

* (Optional) Enter comments to describe the experiment. You can enter up to 1000
characters in the Comments field.
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* Select the instrument you are using to run the experiment:
— StepOne™ Instrument (48 Wells)
— StepOnePlus’” Instrument (96 Wells)

Note: You can use StepOne Software v2.1 or later to design experiments for both
the StepOne and StepOnePlus instruments. The instrument you select in the
Experiment Properties screen affects the reaction plate layout and materials list.

Note: To set the default instrument type, select Tools » Preferences, then select the
General tab (default). From the Default Instrument Type dropdown menu, select the
appropriate instrument. To change the default instrument type, you must be logged
into the software with a user name, not as a Guest. For more information, see the
“Design Guidelines” for logging in on page 24.

* Select Quantitation as the experiment type.

For More For more information on:

Information » Completing the Experiment Properties screen, access the StepOne Software Help by
clicking @) or pressing F1.
* Consumables, see “Supported Consumables” on page 4.
* Quantitation experiments, refer to the Real-Time PCR Systems Reagent Guide.

Notes
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Define the Methods and Materials

On the Methods & Materials screen, select the quantitation method, reagents, ramp
speed, and PCR template to use for the experiment.

About the In the relative standard curve example experiment:
E Exa_tmplei » The relative standard curve quantitation method is used.
Xperimen
P + TagMan® reagents are used.
* The Fast ramp speed is used in the instrument run.
* cDNA (prepared from total RNA isolated from liver and kidney tissues) is the
template type. Before using cDNA template, you must first perform reverse
transcription to convert the RNA to cDNA (see “Prepare the Template” on page 59).
Complete the 1. Seclect Relative Standard Curve as the quantitation method.
Methods & ©
Materials Screen 2. Select TagqMan® Reagents for the reagents.
3. Select Fast (~ 40 minutes to complete a run) for the ramp speed.
4. Select cDNA (complementary DNA) for the template type.
5. Click Next >.
1B. Define: Methods & Materials Methods & Materials Help 0/
n Instructions: Selectthe quantitation method, reagents, ramp speed, and type of template for the real-time PCR reactions
[ Standard Curve } | ¥ Relative S‘tandard Curve | { Comparative C1 (AACT) ]
1 With the relative standard curve method, you use standards, a refe‘rence sample, and an endogenous contral to determine the relative quantity of target sequence in a sample
Which reagents do you want to use to detect the target sequence?
2 i + TagMan® Reagants ‘ [ SYBR® Green Reagents ]
These real-time PCR reactions contain two primers and a TagMan® probe. The primers are designed to amplify the target sequence. The TagMan probe is designed to hybridize to
the target sequence and generate fluorescence signal when the target sequence is amplified
Which ramp speed do you want to include in the instrument run?
[ Standard (~ 2 hours to complete a run) } |( Fast (~ 40 mmul‘es to complete a run)|
3 H For optimal results using the Fastramp speed, Applied El\osy'stem‘s recommends using Fast reagents for your real-time PCR reactions.
What type of temlate do you want to use in the real-time PCR reactions?
4 } + cDNA (complementary DNA) | [ RNA ] [ 3DNA (genarmic DRA)
}Yuu are adding cDNAto the real-time PCR reactions. You have already performed reverse transcription to convert the RNA to cDNA.
Design  When you design your own relative standard curve experiment:

Guidelines * Select Relative Standard Curve as the quantitation method. The relative standard
curve method is used to determine relative target quantity in samples. When setting
up your reaction plate, the relative standard curve method requires targets,
standards, samples, a reference sample, and an endogenous control.

Notes
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* Select the reagents you want to use:

— Select TagqMan® Reagents if you want to use TagMan reagents to detect
amplification and quantify the amount of target in the samples. TagMan reagents
consist of two primers and a TagMan® probe. The primers are designed to
amplify the target. The TagMan probe is designed to hybridize to the target and
generate fluorescence when the target is amplified.

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA™ dye
as a reporter or quencher with the StepOne"” system. TAMRA dye may be used as a
reporter or quencher with the StepOnePlus™ system.

— Select SYBR® Green Reagents if you want to use SYBR Green reagents to
detect amplification and quantify the amount of target in the samples. SYBR
Green reagents consist of two primers and SYBR Green dye. The primers are
designed to amplify the target. The SYBR Green dye generates fluorescence
when it binds to double-stranded DNA. SYBR Green dye is often part of the
SYBR Green master mix that is added to the reaction. If you use SYBR Green
dye, select the Include Melt Curve checkbox to perform melt curve analysis of
the amplified target.

Note: You can use other fluorescence-based reagents on the StepOne and
StepOnePlus systems, but you must design your experiment using Advanced Setup
instead of the Design Wizard.

* Select the appropriate ramp speed for the instrument run:

— Select Fast (~ 40 minutes to complete a run) if you use fast reagents for the
PCR reactions.

— Select Standard (~ 2 hours to complete a run) if you use standard reagents for
the PCR reactions.
* Select the appropriate PCR template:

— Select cDNA (complementary DNA) if you are performing 2-step RT-PCR, and
you have already performed reverse transcription to convert the RNA to cDNA.
You are adding complementary DNA to the PCR reactions.

— Select RNA if you are performing 1-step RT-PCR. You are adding total RNA or
mRNA to the PCR reactions.

Note: To use the Fast ramp speed with RNA templates, you must design your
experiment using Advanced Setup instead of the Design Wizard.

— Select gDNA (genomic DNA) if you have already extracted the gDNA from
tissue or sample. You are adding purified genomic DNA to the PCR reactions.

For More For more information on:
Information » Completing the Methods & Materials screen, access the StepOne Software Help by
clicking @) or pressing F1.
» Using Advanced Setup, see “Advanced Setup Workflow” on page 260.
» Using the comparative C quantitation method, see Chapters 6 to 9 of this guide.

Notes
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Set Up the Targets

Using the standard curve quantitation method, refer to the Applied Biosystems
StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
Standard Curve Experiments.

TagMan and SYBR Green reagents, refer to the Real-Time PCR Systems Reagent
Guide.

PCR, including singleplex vs. multiplex PCR and 1-step vs. 2-step RT PCR, refer to
the Real-Time PCR Systems Reagent Guide.

Set Up the Targets

About the
Example
Experiment

Complete the
Targets Screen

Notes

On the Targets screen, enter the number of targets you want to quantify in the PCR
reaction plate, then set up the assay for each target.

In the relative standard curve example experiment:

L]

Two targets are quantified in the reaction plate.

The Set Up Standards checkbox is selected. When this checkbox is selected, the
software automatically displays the Standards screen after you complete the Targets
screen. In the Standards screen, you can set up a standard curve for each target assay
(see “Set Up the Standards” on page 35).

The Target 1 assay is set up for the target you are studying. For the example
experiment, this is human c-myc (an oncoprotein that activates the transcription of
growth-associated genes).

The Target 2 assay is set up for the endogenous control. For the example experiment
this is human glyceraldehyde-3-phosphate (GAPDH). GAPDH serves as the
endogenous control because its expression levels tend to be relatively stable.

. Click the How many targets do you want to quantify in the reaction plate? field,

then enter 2.

Note: The number of rows in the target assays table updates with the number you
entered.

Select the Set Up Standards checkbox to set up standards for both target assays.

Note: The Set Up Standards checkbox is selected by default.

Set up the Target 1 assay:
. Click the Enter Target Name cell, then enter c-myc.

a
b. From the Reporter dropdown menu, select FAM (default).

0

. From the Quencher dropdown menu, select NFQ-MGB (default).
d. Leave the default in the Color field.

Set up the Target 2 assay:
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a. Click the Enter Target Name cell, then enter GAPDH.

b. From the Reporter dropdown menu, select FAM (default).

c. From the Quencher dropdown menu, select NFQ-MGB (default).
d. Leave the default in the Color field.

5. Click Next >.

Note: For all targets, leave the (Optional) Enter Gene Name field blank. You can search
for the gene/assay ID when you order your materials (see “Order Materials for the
Experiment” on page 50).

2A_ Set Up: Targets Targets Help @
a Instructions: Enterthe number of targets to quantify in the reaction plate, then set up the assay for each target
1 * How many targets do you want to quantify in the reaction plate? ‘2
Foreach target assay in the reaction plate, select whether to set up standards, enter a target name, selectthe reporter and guencher to use to detectthe target, and select a target
color. (Optional) Enter a gene name, find Applied Biosystems gene expression assays, then select an assayto fill in the Assay 1D
Set Up Standa * Enter Target Name Reporter Guencher Color | AssayID (Optional) Enter Gene Mame and Click"F.
2 —H c-mye [[Fam vInwranes vl v|) I el I 3
Lo GAPDH | [Fam vnFomes v v|) I e 4
Design  When you design your own relative standard curve experiment:
Guidelines » Select the Set Up Standards checkbox. Applied Biosystems recommends that you
set up a standard curve for each target assay in the reaction plate.

* Identify each target assay with a unique name and color. You can enter up to 100
characters in the Target Name field.

» Select an endogenous control for each sample. The endogenous control is a target
that is present in all samples under investigation. It should be expressed equally in
all sample types, regardless of treatment or tissue origin (examples of endogenous
controls are B-actin, GAPDH, and 18S ribosomal RNA [18S rRNA]). The
endogenous control is used to normalize the PCR results; the endogenous control
corrects for variable sample mass, nucleic acid extraction efficiency, reverse
transcription efficiency, and pipette calibration errors. Note that:

— Each sample type (for example, each tissue in a study comparing multiple tissues)
requires an endogenous control.
Notes
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Notes

34

Set Up the Targets

— If samples are spread across multiple plates, each plate must have an endogenous
control. Additionally, every plate must include an endogenous control for every
sample type on the plate.

* Select the reporter dye used in the target assay. In the Methods & Materials screen

on page 30, if you selected:
— TagMan® Reagents, select the dye attached to the 5" end of the TagMan probe.
— SYBR® Green Reagents, select SYBR.

Select the quencher used in the target assay. In the Methods & Materials screen on
page 30, if you selected:

— TagMan® Reagents, select the quencher attached to the 3’ end of the TagMan
probe.

— SYBR® Green Reagents, select None.

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA dye as
a reporter or quencher with the StepOne system. TAMRA dye may be used as a
reporter or quencher with the StepOnePlus system.

For More For more information on:

Information

+ Completing the Targets screen, access the StepOne Software Help by clicking g) or

pressing F1.

+ Selecting an endogenous control, see the Application Note Using TagMan®™

Endogenous Control Assays to Select an Endogenous Control for Experimental
Studies.
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Set Up the Standards

On the Standards screen, enter the number of points and replicates for all standard curves
in the reaction plate. For each standard curve, enter the starting quantity and select the
serial factor.

About the In the relative standard curve example experiment:

Exa_.mple * One standard curve is set up for the target (c-myc). The standard used for the
Experiment standard dilution series is a cDNA sample of known quantity prepared from RNA
isolated from lung tissue.

* One standard curve is set up for the endogenous control (GAPDH). The standard
used for the standard dilution series is a cDNA sample of known quantity prepared
from RNA isolated from lung tissue.

* For each standard curve:
— Five points are used in the standard curve.

— Three replicates are used for each point. Replicates are identical reactions,
containing identical reaction components and volumes.

— The starting quantity is 200 ng and the serial factor is 1:10.

Complete the 1. Click the How many points do you need for each standard curve? field, then
Standards Screen enter 5.

2. Click the How many replicates do you need for each point? field, then enter 3.

3. Define the range of standard quantities for the c-myc assay:
a. Click the Enter Starting Quantity field, then enter 200.

b. From the Select Serial Factor dropdown menu, select 1:10.

4. Define the range of standard quantities for the GAPDH assay:
a. Click the Enter Starting Quantity field, then enter 200.

b. From the Select Serial Factor dropdown menu, select 1:10.

5. Review the Standard Curve Preview pane for each assay. The standard curves have
the following points: 200, 20, 2, 0.2, and 0.02.

6. Click Next >.

Notes
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2B. Set Up: Standards Standards Help )

a Instructions: EMter the number of points and replicates for all standard curves in the reaction plate. For sach standard curve, enter the starting quantity and select the serial factor

Set Up Standards = Required : View Plate Layout

* How many points do you need for each standard curve? 5 Arrange Plate hy: [Rows | Place Negative Controls in:

*H plicates d d e h it? 3 T T
5 ow many replicates do you need for each poinf | Esmwmwe\ls" | \,‘|5ng§51‘{1 |

For each standard curve, define the range of standard quantities by entering the starting quantity and serial factor 1 | 2 ‘ 3 | 4 ‘ 5 | 5 ‘ 7 | ) ‘

—

3a Dofinotos stondord sumes oo dhot oo sanas of standard quantities spans the expected range of guantities for the unknowns. Sample 1 Sample 1

Target Name l‘merstanmg@uam\w Select Serial Factor A D"' D“' D"' Dm‘ DSA Dm‘ mc— c—

@ c-myc “muu me .,",7 -

Sample 1 Sample 1 Sample 1 Sample 1 Sample 2 Sample 2 Sample 2 [Sample 2

Standard Curve Preview & Me.. @ea. @Mea. Mea. @Me.. [[Me. Mo |[@ea.

Standard Curve Preview for () GAPDH Sample 2 |Sample 2 D"' DD' D"' DD' D"' DD'
Mo~ GA.200 (200 200 |20 20 20

3b

o|Be- |Be. Be- |Be- Be- |He He- |He-
2 2 02 02

02 002 0.02

c|He |Hea. Hea |[Hen ESA Hea. Hea ZDEA

002 200 200 200 20 20

02 02 0.02 002 0.02

(B ZDGA. H ca.. A sa. EGA.. Hea. Hea.|Hea.

12 - Unknown D 30 - Standard D 6 - Negative Control 0 - Empty

If needed, use the scroll bar
to view GAPDH, then
perform steps 4a and 4b.

Design  When you design your own relative standard curve experiment:

Guidelines * Set up a standard curve for each target in the reaction plate. The targets are
previously defined on the Targets screen (“Set Up the Targets” on page 32).

* Enter the number of points for each standard curve in the reaction plate. Applied
Biosystems recommends at least five dilution points for each standard curve.

» Enter the number of identical reactions (replicates) for each point in the standard
curve. Applied Biosystems recommends three replicates for each point.

* Because the range of standard quantities affects the amplification efficiency
calculations, carefully consider the appropriate range of standard quantities for your
assay:

— For more accurate measurements of amplification efficiency, use a broad range of
standard quantities, spanning between 5 and 6 logs. If you specify a broad range
of quantities for the standards, you need to use a PCR product or a highly
concentrated template, such as a cDNA clone.

— If you have a limited amount of cDNA template and/or if the target is a low-copy
number transcript, or known to fall within a given range, a narrow range of
standard quantities may be necessary.

» The serial factor is used to calculate the quantities in all points of the standard curve.
If your starting quantity is the highest quantity, select a dilution factor such as 1:2,
1:3, and so on. If your starting quantity is the lowest quantity, select a concentration
factor such as 2X, 3X, and so on.

Notes
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For More For more information on:

Information * Completing the Standards screen, access the StepOne Software Help by clicking
@) or pressing F1.
+ Amplification efficiency, refer to the Amplification Efficiency of TagMan® Gene
Expression Assays Application Note.

Set Up the Samples

On the Samples screen, enter the number of samples, replicates, and negative controls to
include in the reaction plate, enter the sample names, then select the sample/target
reactions to set up.

About the In the relative standard curve example experiment:

Exqmple * Two samples are used: cDNA prepared from total RNA isolated from liver and
Experiment kidney tissues. The samples contain unknown quantities of the c-myc gene (target)
and GAPDH gene (endogenous control).

» Three replicates are used. The replicates are identical reactions, containing identical
reaction components and volumes.

» Three negative controls are used. The negative control reactions contain water
instead of sample and should not amplify.

Complete the 1. Click the How many samples do you want to test in the reaction plate? field, then
Samples Screen enter 2.

Note: The number of rows in the samples table updates with the number you
entered.
2. Click the How many replicates do you need? field, then enter 3.

3. Click the How many negative controls do you need for each target assay? field,
then enter 3.

4. Setup Sample 1:
a. Click the Enter Sample Name field, then enter Liver.
b. Leave the default in the Color field.

5. Set up Sample 2:
a. Click the Enter Sample Name field, then enter Kidney.
b. Leave the default in the Color field.

6. Select No Biological Replicates.

7. Select All Sample/Target Reactions to test all targets in all samples.

Notes
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8. In the Well Count pane, confirm that there are:
* 12 Unknown wells
* 30 Standard wells [E]
* 6 Negative control wells [
* 0 Empty wells

9. In the View Plate Layout tab:
a. From the Arrange Plate by dropdown menu, select Rows (default).

b. From the Place Negative Controls in dropdown menu, select Upper Left
(default).

10. Click Next >.

2C. Set Up: Samples Sanpis Hetp @)
u Instructions: Enter the number of samples to test in the reaction plate, enter the number of sampleftarget reaction replicates, enter the number of negative controls, enter sample names, associate the sample s with hiological replicate groups, then selectthe sampleftarget reactions to set up.
-regus N 9a
1 :HDWmanvmdnvnuwanttjtest\nmeveacﬁﬂ"p\ate’? 2 Arrange Plate by Rows. v Place Negative Controls in: |Upper Left [y 9
2 b s [ [
4 ‘:‘VE:'MSQWENW I . ) lla|eme  Mome  [Mome  [oaen  [Mowon  |[Dosenn -y -y
5 “deney T ”D“ . g
! oo me | n A o S S oo
o m e B S S B Bl Bag
Set Up Biological Replicate Groups |
6 ”}  No Biological Replicates \[ Specify Bislogical Replicate Groups ] . E; - ZDDDW”“ ZDDDEA“’“ ZDDDE””“ ZDDW‘“ ZDDEA“’“ ZDDEA“’“ ZD -
Which sample/target reactions do you want to set up?
7— 1 T I T TR | M
F IZ]EA?DH IZ]EA?DH DDZEAVDH DDZEAVDH DDZEAVBH E;Arnu EZEA?DH E;Arnu
8 ! 12 Uniiown H 30- standara 6 - Negatwe contol o ey
Design  When you design your own relative standard curve experiment:
Guidelines  Identify each sample using a unique name and color. You can enter up to 100
characters in the Sample Name field.
* Enter the number of replicates (identical reactions) to set up. Applied Biosystems
recommends three replicates for each sample reaction.
» Enter the number of negative control reactions to set up. Applied Biosystems
recommends three negative control reactions for each target assay.
» Set up the biological replicates groups:
— Select No Biological Replicates if you do not want to include biological replicate
groups in the experiment.
— Select Specify Biological Replicate Groups to include biological replicate
groups in the experiment. For more information on biological replicate groups,
see Chapter 10.
Notes
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* Select which targets to test in the samples:
— Select All Sample/Target Reactions to test all targets in all samples.

— Select Specify Sample/Target Reactions to specify the targets to test in each
sample.

Note: When you use the Design Wizard to set up a relative standard curve
experiment, you can set up only singleplex reactions (amplification and detection of
one target per well). If you want to set up a relative standard curve experiment with
multiplex reactions (amplification and detection of two or more targets per well),
design your experiment using Advanced Setup instead of the Design Wizard.

* If you are running the experiment on a StepOnePlus instrument and plan to edit the
Run Method (page 41) to set a different temperature for one or more of the VeriFlex
blocks, you need to:

a. Design your experiment using Advanced Setup instead of the Design Wizard.

b. In the Plate Setup screen, select the Assign Targets and Samples tab, select
the View Plate Layout tab, then select the Enable VeriFlex"" Block checkbox.

IMPORTANT! If you do not select the Enable VeriFlex" Block checkbox in
the Plate Setup screen, you will not be able to set a different temperature for
one or more of the VeriFlex blocks in the Run Method screen (page 41).

For More For more information on:

Information * Completing the Samples screen, access the StepOne Software Help by clicking
@) or pressing F1.
» Using Advanced Setup, see “Advanced Setup Workflow” on page 260.

Set Up the Relative Quantitation Settings

On the Relative Quantitation Settings screen, select the reference sample and the
endogenous control to perform relative quantitation.

About the In the relative standard curve example experiment:

Example » Kidney is used as the reference sample.

Experiment * GAPDH is used as the endogenous control.

Complete the 1. From the Which sample do you want to use as the reference sample? dropdown
Relative menu, select Kidney.

Quantitation .
Settings Screen 2. From the Which target do you want to use as the endogenous control? dropdown

menu, select GAPDH.

3. Click Next >.

Notes

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative 39
Standard Curve and Comparative C; Experiments



m Chapter 2 Design the Relative Standard Curve Experiment
Set Up the Relative Quantitation Settings

2D. Set Up: Relative Quantitation Settings Relative Quantitation Settings Help @

ﬂ Instructions: Selectthe reference sample and the endogenous contral to perform relative guantitation

—

Which sample do you want to use as the reference sample? |Kidney %

2 Which target do you wantto use as the endogencous control?  (GAPDH |+

Design  When you design your own relative standard curve experiment:

Guidelines » Select a reference sample from your previously created samples (“Set Up the
Samples” on page 37). Amplification results from the samples are compared to the
amplification results from the reference sample to determine relative expression.

+ Select an endogenous control from your previously created target assays (“Set Up
the Targets” on page 32). Amplification results from the endogenous control are
used to normalize the amplification results from the target for differences in the
amount of template added to each reaction.

For More For more information on:
Information » Completing the Relative Quantitation Settings screen, access the StepOne Software
Help by clicking @) or pressing F1.
» Reference samples (also known as calibrators) and endogenous controls, refer to
User Bulletin #2: Relative Quantitation of Gene Expression.

Notes
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Set Up the Run Method

On the Run Method screen, review the reaction volume and the thermal profile for the
default run method. If needed, you can edit the default run method or replace it with one
from the Run Method library.

About the In the relative standard curve example experiment, the default run method is used
Example without edits.
Experiment

Review the Run 1. Click either the Graphical View tab (default) or Tabular View tab.
Method Screen . ] )
2. Make sure the Reaction Volume Per Well field displays 20 uL.
3. Make sure the thermal profile displays the holding and cycling stages shown below.

4. Click Next >.

2E. Set Up: Run Method Run Method Help 0/.

n Instructions: Review the reaction volume and the thermal profile for the default run method. If needed, edit the default run method or select a run method from the library.

r

Graphical ViewI Tabular View ]

| W Reaction Volume Per Well 200 | uL
|

| H [ ado stage ¥ | acastep v | Detets ssiected | i[ conectpata v 1] apen Run wethoa | save Run etnod | EI

Holding Stage Cycling Stage &

Nurmber of Cycles: [40 3
[ Enable AutoDelta
Starting Cycle:

100 —| 95.0°C §5.0°C
00:20 100% 0001
3 TE —|

600°C
50 —| 00% 00:20

26 —|

a—|

Step 1 Step 1 Step 2 -
< >

Legend
Data Collection On Data Collection Off A AutoDelta On A AutoDelta OFF

Design  When you design your own relative standard curve experiment:

Guidelines * Enter a number from 10 to 30 for the reaction volume/well. The StepOne and
StepOnePlus systems support reaction volumes from 10 to 30 pL.

* Review the thermal profile:
— Make sure the thermal profile is appropriate for your reagents.
— If you are performing 1-step RT-PCR, include a reverse transcription step.

If your experiment requires a different thermal profile, edit the thermal profile or
replace the run method with one from the Run Method library. The Run Method
library is included in the StepOne software.

Notes
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» If you are running the experiment on a StepOnePlus instrument and you want to set
a different temperature for one or more of the VeriFlex blocks, you need to:

a. Design your experiment using Advanced Setup instead of the Design Wizard.

b. In the Plate Setup screen (page 39), select the Assign Targets and Samples
tab, select the View Plate Layout tab, then select the Enable VeriFlex™ Block
checkbox.

IMPORTANT! If you do not select the Enable VeriFlex" Block checkbox in
the Plate Setup screen, you will not be able to set a different temperature for
one or more of the VeriFlex blocks in the Run Method screen.

c. In the Run Method screen, select the Graphical View tab.

d. For each VeriFlex " block you want to change, click the temperature, then enter
the desired value.

Note: You can set a different temperature for one or more of the VeriFlex blocks, or
set each of the VeriFlex blocks to the same temperature. If neighboring VeriFlex
blocks are not set to the same temperature, the temperature difference must be
between 0.1 and 5.0 °C. The maximum temperature is 99.9 °C.

For More For more information on:

Information * The Run Method library or on completing the Run Method screen, access the
StepOne Software Help by clicking g) or pressing F1.

» Setting temperatures for the VeriFlex blocks, access the StepOne Software Help by
clicking g)or pressing FIL.
» Using Advanced Setup, see “Advanced Setup Workflow” on page 260.

Notes
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Review the Reaction Setup

On the Reaction Setup screen, select the assay type (if using TagMan reagents), then
review the calculated volumes for preparing the PCR reactions, standard dilution series,
and sample dilutions. If needed, you can edit the reaction volume, excess reaction
volume, component concentrations, standard concentration, and/or diluted sample
concentration.

IMPORTANT! Perform these steps for each target assay in the reaction plate.

About the In the relative standard curve example experiment:

Exa_lmple + Applied Biosystems TagMan® Gene Expression Assays are used.
Experiment The reaction volume per well is 20 pL.
» The excess reaction volume is 10%.
* The reaction components are:
TagMan® Fast Universal PCR Master Mix (2X)
c-myc Assay Mix (20X)
— GAPDH Assay Mix (20X)
Sample or standard
— Water

* The standard concentration in stock is 200 ng/uL.

* The diluted sample concentration is 5.0 ng/uL.
* The sample stock concentration is 100 ng/uL.

Complete the Complete the Reaction Mix Calculations Tab for the c-myc Assay

Reaction Setup

Screen 1. Select the Reaction Mix Calculations tab (default).

From the Select Target pane, select c-myc.
From the Assay Type dropdown menu, select Inventoried/Made to Order.
Make sure the Reaction Volume Per Well field displays 20 pL.

Make sure the Excess Reaction Volume field displays 10%.

o o k w0 Db

In the Reactions for c-myc pane:
a. Make sure the Master Mix Concentration field displays 2.0X.
b. Make sure the Assay Mix Concentration field displays 20.0X.

c. Review the components and calculated volumes for the PCR reactions:

Component Volume (pL) for 1 Reaction

Master Mix (2.0X) 10.0

Notes
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Component Volume (pL) for 1 Reaction
| Assay Mix (20.0X) 1.0
| Sample (10X) or Standard 2.0%
| H,O 7.0
Total Volume 20.0

I The sample or standard volume is limited to 10% of the total

reaction volume.

3 4 5

2F. Set Up: Reaction Setup

Reaction Setup Help g

. Faoreach target assay in the reaction plate, selectthe assay type (if using Tag
a Instructions: series, samples, and PCR reactions. fneeded, aditths reaction volume, exc|

\lan reagents), then review the calculated volumes for preparing the standard dilution
»ss reaction volume, component concent-ations, and/or stock concentrations. Click "Print

Reaction Setup” to print instructions ol how to prepare the PCR reactions.

1 Reaction Mix Calculations T Sarnple|Dilution Calculations ]

Select Tar ————
2 ’— Assay Type |Inventoried/Made to Order » Reaction Wolume Per Well 20 | yL  Excess Reaction Volume % \ Print Reaction Setup
('-rr'IV(
ERCLAN Reactions for c-myc A
6a
6b H Waster Mix Concentration: X AssayMix Concentration: | 20.0 | X
| ” Component Volume (uL) for 1 Reaction
Master Mix (2.0X)
6c
Hz0
Total Volume 1
Standard Dilution Series for c-myc
Standard Concentration in Stock: ‘ 100.0 | |ng v| peruL
Dilution Point Source Source Valume (UL) Diluent Volume (uL) Total Volume (JL) Standard Concentratio
1 (200 | | ‘ | | ‘ s

7. In the Standard Dilution Series for c-myc pane:
a. Click the Standard Concentration in Stock field, then enter 200.
b. In the units field, select ng per UL (default) from the dropdown menu.

c. Review the calculated volumes for preparing the standard dilution series:

Dilution Source Diluent Total Standard
Point Source Volume Volume Volume Concentration
(uL) (uL) (uL) (ng/pL)
1 (200) Stock 5.0 5.0 10.0 100.0
2 (20) Dilution 1 1.0 9.0 10.0 10.0
32 Dilution 2 1.0 9.0 10.0 1.0
4(0.2) Dilution 3 1.0 9.0 10.0 0.1
5(0.02) Dilution 4 1.0 9.0 10.0 0.01

Notes
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2F. Set Up: Reaction Setup Reaction Setup Helpp @

i Faor each target assay in the reaction plate, selectthe assay type (if using Taghian reagents), then review the calculated volumes for preparing the standard dilution
a Instructions: series, samples, and PCR reactions. Ifneeded, editthe reaction volume, excess reaction volume, component concentrations, and/or stock concentrations. Click "Print
Reaction Setup” to print instructions on how to prepare the PCR reactions.

Reaction Mix Calculations I Sarnple Dilution Calculations ]
Select Tar

GAPDH . ~
Total Volume 200

Standard Dilution Series for c-myc
7a

I
Standard Concentration in Stock: 200 | peruL

Assay Type |Inventoried/Made to Order Reaction Yaolume Per Well: 20 | yL Excess Reaction Volume 10| % \ ErlntReadlonSetupJ

7b

Dilution Point Source Source Volume (uL) Diluent Volume (pL) Total Volume (L) Standard Concentration (ng/pl)

1(200) Stock 5.0 5.0 10.0 100.0

2(20) Dilution 1 1.0 8.0 10.0 10.0

7C 3(2) Dilution 2 1.0 8.0 10.0 1.0

4(0.2) Dilution 3 1.0 8.0 10.0 01

5(0.02) Dilution 4 1.0 8.0 10.0 0.0

Complete the Reaction Mix Calculations Tab for the GAPDH Assay

—

Select the Reaction Mix Calculations tab (default).
. From the Select Target pane, select GAPDH.
. From the Assay Type dropdown menu, select Inventoried/Made to Order.

2

3

4. Make sure the Reaction Volume Per Well field displays 20 uL.
5. Make sure the Excess Reaction Volume field displays 10%.

6

In the Reactions for GAPDH pane:
a. Make sure the Master Mix Concentration field displays 2.0X.
b. Make sure the Assay Mix Concentration field displays 20.0X.

c. Review the components and calculated volumes for the PCR reactions:

Component Volume (pL) for 1 Reaction

Master Mix (2.0X) 10.0

Assay Mix (20.0X) 1.0

Sample (10X) or Standard 2.0%

H,O 7.0
Total Volume 20.0

I The sample or standard volume is limited to 10% of the total
reaction volume.

Notes

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative 45
Standard Curve and Comparative C; Experiments



Chapter 2 Design the Relative Standard Curve Experiment
Review the Reaction Setup

2F. Set Up: Reaction Setup

Reaction Setup Help Q_)‘,

} For each target assay in the reaction plate, select the assay type (ifusing TacMan reagents), then review the calculatec
a Instructions: series, samples, and PCR reactions. fneeded, editthe reaction volume, exc2ss reaction volume, component cancent
Reaction Setup” to print instructions o how to prepare the PCR reactions.

{"Reaction Mix Calculations T Sarnple|Dilution Calculations

volumnes for preparing the standard dilution
ations, andior stock concentrations. Click "Print

6a
6b

6¢c

Notes
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| H Master Mix Concentration 2.0 |X AssayMix Concentration

I'] Component Wolume (uL) for 1 Reaction

Master Mix (2.0)

10| %

Reactions for GAPDH &

| Print Reaction Setup

Hz0

Total Volume

Standard Dilution Series for GAPDH

Standard Goncentration in Stock: | 100.0 ‘ ‘ng v| per pL
Dilution Paint Source Source Volume (L) Diluent Volume (uL) Total Volume (L) Standard Concentratio...
1 o) \ | | \ | e
7. In the Standard Dilution Series for GAPDH pane:
a. Click the Standard Concentration in Stock field, then enter 200.
b. In the units field, select ng per UL (default) from the dropdown menu.
c. Review the calculated volumes for preparing the standard dilution series:
Dilution Source Diluent Total Standard
Point Source Volume Volume Volume Concentration
(uL) (uL) (uL) (ng/pL)
1 (200) Stock 5.0 5.0 10.0 100.0
2 (20) Dilution 1 1.0 9.0 10.0 10.0
32 Dilution 2 1.0 9.0 10.0 1.0
4(0.2) Dilution 3 1.0 9.0 10.0 0.1
5(0.02) Dilution 4 1.0 9.0 10.0 0.01
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2F. Set Up: Reaction Setup Reaction Setup Helpp @

i Faor each target assay in the reaction plate, selectthe assay type (if using Taghian reagents), then review the calculated volumes for preparing the standard dilution
a Instructions: series, samples, and PCR reactions. Ifneeded, editthe reaction volume, excess reaction volume, component concentrations, and/or stock concentrations. Click "Print
Reaction Setup” to print instructions on how to prepare the PCR reactions.

Reaction Mix Calculations I Sarnple Dilution Calculations ]

Salect Tar Assay Type __\nvemorlewmadeto Order % |  Reaction Yolume Perwell: -20 WL Excess Reaction Volume -10 % ‘m.‘
c-myc
— — =
Total Volume 20.0] U
7a
7b Standard Concentration in Stock: | 200 [T | perut
7”Dilu1iun Point Source Source Volume (pL) Diluent Volume (pL) Total Volume (L) Standard Concentration (ng/pl)
1200) Stock 5.0 5.0 10.0 100.0
2(20) Dilution 1 1.0 9.0 10.0 10.0
7C 32 Dilution 2 1.0 9.0 10.0 1.0
4{0.2) Dilution 3 1.0 9.0 10.0 01
5(0.02) Dilution 4 1.0 9.0 10.0 0.0
Complete the Sample Dilution Calculations Tab
1. Select the Sample Dilution Calculations tab.
2. Click the Diluted Sample Concentration (10X for Reaction Mix) field, then
enter 5.0.
3. From the unit dropdown menu, select ng/uL (default).
4. Review the calculated volumes for the sample dilutions:
Stock . Total Volume
Sample Name Concentration VO?::::I(e ) Vollz:lmu:rzt ) of Diluted
(ng/uL) H H Sample (uL)
Liver 100.0 1.0 19.0 20.0
Kidney 100.0 1.0 19.0 20.0
Notes
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2F_ Set Up: Reaction Setup > Reaction Mix Calculati

Reaction Setup Help n

i Foreach target assay in the reaction plate, selectthe assay type (if using TagMan reagents), then review the calculated volumes for preparing the standard dilution
a Instructions: series, samples, and PCR reactions. Ifneeded, editthe reaction volume, excess reaction volume, component concentrations, and/or stock concentrations. Click "Print
-1 Reaction Setun” to orintinstructions an how to prepare the PCR reactions.
2 [ Reaction Mix Calculations T Sample Dilution Calculations ]
3 Diluted Sample Concentration (10 for Reaction Mix): Nl v | Print Reaction Setup
| Sample Name Stock Concentration (ng/uL) Sample Volume (UL} Diluent Volume (JL) Total Volume of Diluted Sample ...
4 Liver [1o0.0 | 1.0 19.0 20,0
Kidney [1o0.0 | 1.0 19.0 20.0
Print Reaction Setup Instructions
Print detailed reaction setup instructions, then save the instructions for Chapter 3,
173 . . 2
Prepare the Relative Standard Curve Reactions.
. . .
1. Click Print Reaction Setup.
2F. Set Up: Reach Setup > Reach Mix Calculati Reaction Setup Help n
For each target assay in the reaction plate, select the assay type (if using TagMan reagents), then review the calculated volumes for preparing the standard dilution
a Instructions: series, samples, and PCR reactions. If needed, edit the reaction volume, excess reaction volume, component concentrations, and/or stock concentrations. Click "Print
Reaction Setup” to print instructions on how to prepare the PCR reactions
J Reaction Mix Calculations T Sample Dilution Calculations ]
H Diluted Sample Concentration (10= for Reaction Mix): naipL 1

—————— 1
| print Reaction Setup ”

2. In the dialog box, select:
* Detailed Reaction Setup Instructions
* Include Plate Layout

* Use sample color

3. Click Print to send the reaction setup instructions to your printer.

Print Reaction Setup Instructions &\

a Select the type of instructions to print

) Summary Reaction Setup Instructions
M (®) Detailed Reaction Setup Instructions
) Includs Flate Layout

Plate Layout Print Options

(& Use sample color

O Use task calor

1
‘ Preview | Prinit ‘ Cancel

Notes
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4. Click Next >.

Design  When you design your own relative standard curve experiment:

Guidelines » If you are using TagMan reagents, select the type of assay you are using:

— Select Inventoried/Made to Order if you are using Applied Biosystems
TagMan® Gene Expression Assays (Inventoried or Made to Order) or Applied
Biosystems Custom TagMan® Gene Expression Assays.

®

— Select Custom if you are designing your own assays with Primer Express
software.

* Enter a number from 10 to 30 for the reaction volume/well. The StepOne and
StepOnePlus systems support reaction volumes from 10 to 30 pL.

* Include excess reaction volume to account for the loss that occurs during pipetting.
Applied Biosystems recommends an excess reaction volume of at least 10%.

* Review the reaction mix concentrations for each target: If needed:
— For TagMan reagents, edit the master mix and assay mix concentrations.

— For SYBR Green reagents, edit the master mix, forward primer, and reverse
primer concentrations.

— For 1-step RT-PCR, edit the reverse transcriptase concentration.
* Review the reaction mix components for each target:

— Ifyou are running Fast PCR reactions, make sure you use Fast master mix in the
PCR reactions.

— Ifyou are running standard PCR reactions, make sure you use standard master
mix in the PCR reactions.

— For 1-step RT-PCR, make sure you include reverse transcriptase in the PCR
reactions and use a specific buffer.

* Review the standard dilution series calculations for each target. If needed, edit the
standard concentration in stock (including units).

Note: For the Standard Concentration in Stock units field, you can select ng or ug
from the dropdown menu or you can enter another unit in the field (for example,
copies, IU, [International Units], nmol, pg, and so on). The table updates according
to your entry.

* Review the sample dilution calculations for each sample. If needed, edit the diluted
sample concentration (including units) and stock concentration.

For More For more information on:
Information » Completing the Reaction Setup screen, access the StepOne Software Help by
clicking @) or pressing F1.

* Applied Biosystems assays, refer to the:
— TagMan® Gene Expression Assays Protocol

— Custom TagMan® Gene Expression Assays Protocol.

Notes
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Order Materials for the Experiment

About the
Example
Experiment

Complete the
Ordering
Materials Screen

Notes

On the Materials List screen, review the list of materials recommended to prepare the
PCR reaction plate. (Optional) Print the materials list, create a shopping list, then order
the recommended materials from the Applied Biosystems Store.

Note: To access the Applied Biosystems Store, you need to have an Internet connection.
Product availability and pricing may vary according to your region or country. Online
ordering through the Applied Biosystems Store is not available in all countries. Contact
your local Applied Biosystems representative for help.

Note: The StepOne software recommends the materials to order based on your
experiment design. It is assumed that you will design your experiment, order your
materials, then prepare (Chapter 3) and run (Chapter 4) the reaction plate when your
materials arrive.

In the relative standard curve example experiment, the recommended materials are:
+ MicroAmp® Fast Optical 48-Well Reaction Plate
+ MicroAmp® 48-Well Optical Adhesive Film
+ MicroAmp® 96-Well Support Base
+ TagMan® Fast Universal PCR Master Mix (2X), No AmpErase® UNG
» c-myc Assay Mix: Hs00153408_m1 (RefSeq NM_002467.3)
* GAPDH Assay Mix: Hs99999905_m1 (RefSeq NM_002046.2)

Note: The example experiment was created for a StepOne instrument. If you selected the
StepOnePlus instrument in the Experiment Properties screen (page 27), the 96-well
consumables (for example, the MicroAmp® Fast Optical 96-Well Reaction Plate) are
listed in place of the 48-well consumables.

1. Find the target assay on the Applied Biosystems Store:

Note: To access the Applied Biosystems Store, you need to have an Internet
connection.

a. Click the Enter Gene Name ficld, enter c-myc, then click Find Assay.

b. In the Find Assay Results dialog box, select the Hs00153408_m1 row, then
click Apply Assay Selection.
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%, Find Assay Results

21 Assays Found. Click the Assay ID to view the assay in the Applied Biosystems Store. Select an assay to detect and quantify the target sequence. c-myc

Avalability Assay ID Gene Symbal Gene Name RefSeq
- ~
e maan Usootsaang 1 MYC v-mye myslocytamatosis viral anc...  NM_002467.3
hCG16817 Gene hCG15917 Celera Annotation
e e myelocytomatosis viral ancogene .. NM_012603.2
rces59927 Gene rCG59927 Celera Annotation
Madeto Order  Dm01843708 m1  9m L DUSIHE
oo oo | ineiatam | myelocytomatosis oncogene NM_010849.4
mCG1625 Gene mCG1625 Celera Annotation
ErRaE MMO0487803 m1 e myelocytomatosis oneogens NM_010848.4
mCG1625 Gene mCG1625 Celera Annotation
I [ — v-mye myelocylomatosis viral onc...  NM_002467.3
hCG15917 Gene hCG15917 Celera Annotation
T ——c v-mye myelocytomatosis viral onc
hCG15917 Gene hCG15917 Celera Annotation
. v

| || | foft | Next> | | Last | | Apply Assay Selection | | Cancel |

c. Click the Enter Gene Name field, enter GAPDH, then click Find Assay.

d. In the Find Assay Results dialog box, select the Hs99999905_m1 row, then
click Apply Assay Selection.

%, Find Assay Results

21 Assays Found. Click the Assay ID to view the assay in the Applied Biosystems Store. Select an assay to detect and quantify the target sequence. GAPDH
Availability Assay ID Gene Symbol Gene Name RefSeq
mCG115100 Gene mCG115100 Celera Annota. ]
mCG115378 Gene mCG115873 Celera Annota.
mCG116755 Gene mCG116755 Celera Annota...
mCG1217 Gene mCG1217 Celera Annotation
mCG125818 Gene mCG125813 Celera Annota.
mCG134295 Gene mCG134295 Celera Annota...
mCG142398 Gene mCG142309 Celera Annota.
ERees e | glyceraldehyde-3-phosphate dehy.. NM_002046.3
hCG2005673 Gene hCG2005673 Celera Annot.
— N zem glyceraldehyde-3-phosphate dehy.. NM_002046.3
hCG2005673 Gene hCG2005673 Celera Annot.
Pre made 102786624 q1 GAPDH glyceraldehyde-3-phosphate dehy... NM_002046.3
hCG2005673 Gene hCG2005673 Celera Annot.
GAPDH glyceraldehyde-3-phosphate dehy... NM_002046.3 v
| || | 10f1 | Wext> | | Last | | Apply Assay Selection | | Cancel

2. From the Display dropdown menu, select All Items (default), then review the
recommended materials. If needed, use the scroll bar at right to see all items.

Note: For more information on a specific item, click the part number link. You will
be connected to the product information page on Applied Biosystems Store. To
access the Applied Biosystems Store, you need to have an Internet connection.

3. (Optional) Click Print Materials List to send the materials list to your printer.

4. (Optional) Create a shopping list:

a. Select the checkbox next to each of the following items:
+ MicroAmp® Fast Optical 48-Well Reaction Plate
+ MicroAmp® 48-Well Optical Adhesive Film
+ MicroAmp® 96-Well Support Base
+ TaqMan® Fast Universal PCR Master Mix (2X), No AmpErase® UNG
e Hs00153408_mI1 (c-myc Assay Mix)
. Hs99999905_m1 (GAPDH Assay Mix)

b. Click Add Selected Items to Shopping List.

Notes
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5. (Optional) Create a shopping basket on the Applied Biosystems Store:

Note: To access the Applied Biosystems Store, you need to have an Internet
connection. Product availability and pricing may vary according to your region or
country. Online ordering through the Applied Biosystems Store is not available in all
countries. Contact your local Applied Biosystems representative for help.

a. Check that the Experiment Shopping List contains the desired materials and
that the quantities are correct, then click Order Materials in List.

3A_ Order: Materials List (Optional) Materials List Help @

a Instructions: eView the list of materials recommended to prepare the PCR reaction plate. To create a shopping hasket on the Applied Biosystems Store, add items to the shopping
" list, enter a name forthe shopping hasket, click "Order Materials in List" then log in.

Find Assay

Enter Gene Name | GAPDH | | Find Assay

| Enter a gene name, then click "Find Assay" to search the Applied Biosysterns Store for 3 gene expression
ass
T

ay.

Experiment Materials List

N

4a

Notes
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1 Add Selected tems to Shopping List I Display : |AH ltems e | ‘ Prirt Materials List | 3
[ Check All Iltem Part Number Description
The MicroAmp™ Fast Optical 48-Well Reaction Plate, constructed ()
MicroAmp™ Fast Optical 48-Well Reaction Plate 4375816 from a single rigid piece of palypropylene ina 48-well format —
| Increased thermal contact for faster, more uniform heating
I n i 11 I film nsard t L th inteth v

Experiment Shopping List (2 items)

| Remove Selected tems from Shopping List J Shopping Basket Mame | Relative Standard Curve StepOne | | Order Materials in List J' 58
[ check Al Item Part Number Quantity
O MicroAmp™ Fast Optical 48-Well Reaction P 4375816 |1 |
O MicroAmp™ Cptical 48-Well Adhesive Film (. 4375323 |1 |

b. In the Order Materials - Log In dialog box, enter your user name and password
for the Applied Biosystems Store, then click Login and Submit.

Note: If you do not have an account with the Applied Biosystems Store, click
Register Now to create an account.

Order Materials - Log In E‘

Log inta the Applied Biosystems Stare to place the selected items in your shopping basket. If you do not
have a user name and password, click "Register Now” to ereate a new account.

oRrR
Store Log In Register

To log into the Applied Biosystams Store, enter your user Ifyou do not have

name and password then click"Log In and Submit" an Applied
— Biosystems
User Mame ‘ | account, click the
link below to
create a new
5b Password: | | account

‘ Log In and Submit Cancel J

Eeaister Mow

[[] Remember my user name and passward for future ordsrs
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c. When you are connected to the Applied Biosystems Store, follow the prompts
to complete your order.

6. Go to “Finish the Design Wizard” on page 54.

Design  When you design your own relative standard curve experiment:

Guidelines * Select all the materials you require for your experiment and add them to your
shopping list.

» To access the Applied Biosystems Store:
— Confirm that your computer has an Internet connection.
— Applied Biosystems recommends the following browsers and Adobe® Acrobat®
Reader versions to use the Applied Biosystems web site:

Microsoft® Adobe®
Desktop Operating System Internet Acrobat®
Explorer Reader
Windows® XP V6.X v4.0 or later
(Service Pack 2 or Service Pack 3)
Windows® Vista v7.x or later v4.0 or later

Note: Make sure that cookies and Java Script are turned on for the web site to
function correctly.

For More For more information on completing the Materials List screen, access the StepOne
Information  Software Help by clicking ) or pressing F1.

Notes
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Finish the Design Wizard

To finish the Design Wizard, review the plate layout, then select an exit option.

About the The StepOne software automatically selects locations for the wells in the reaction plate.

Example In the relative standard curve example experiment:
Experiment » The wells are arranged as shown below.
| ElShUW\HWE”S' | VwewLegend | | |
1 2 3 [ 4 [ 5 B [ 7 [ 8
A [ e-mye [ emye [ c-mye [2] aaron 1] aron [ sapoH m C_m::EI m C_ml;i:EI
R Liver Liver Live Liver Kidney Kidney Kidney Kidney
B | M e [T zaroH [0 zaroH [ zaroH M c-mye [ c-mye [ e-mye [T zaroH
o Heme EHeme EHemye Heme -mye: EHemye Heme mye:
2 2 2 0.2 0.2 0.2 0.02 0.02
E Dc-myc D GAPDH D GAPDH D GAPDH D GAPDH D GAPDH D GAPDH D GAPDH
0.02 200 200 200 20 20 20 2
r D GAPDH D GAPDH D GAPDH D GAPDH GAPDH D GAPDH D GAPDH D GAPDH
2 2 0.2 0.2 0.2 0.0; 0.02 0.02
Note: The example experiment was created for a StepOne instrument. If you
selected the StepOnePlus instrument in the Experiment Properties screen (page 27),
your reaction plate layout will differ from the layout shown above. The software
displays a 96-well reaction plate layout for the StepOnePlus instrument. For an
example of the 96-well reaction plate layout, see page 13.
» The experiment is saved as is and closed.
Note: For the example experiment, do not perform the run at this time.
Finish the 1. At the bottom of the StepOne software screen, click Finish Designing Experiment.

Design Wizard

2. In the Review Plate for Experiment window, review the plate layout. Make sure
there are:

* 12 Unknown wells [T

* 30 Standard wells [£]

* 6 Negative control wells [
* 0 Empty wells

Note: If the plate layout is incorrect, click Return to the Wizard and check your
entered values.

Notes

54 Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative

Standard Curve and Comparative C; Experiments



Chapter 2 Design the Relative Standard Curve Experiment m
Finish the Design Wizard

3. Click Save Experiment.

eview Plate Layout for Experiment "Relative Standard Curve Example™

a Review the plate layout, then select what you wantto do next

Create Ancther Experiment
3 | Save Experiment Start Run for This Experiment ‘ Edit Plate Layout ‘ Using the Design Wizard ‘ Return to the VWizard ‘
Save and close this Save this experiment, then Use Advanced Setup to edit Save and close this Continue designing this
experiment. startthe run. Make sure the the plate layout. experiment, then create experiment using the Design
reaction plate is loaded into another experiment using the Wizard
the instrument, Design Wizard.
| 07| showinwells ¥ | View Legend | ‘
1 \ 2 | g | 1 \ 5 | 8 | 7 \ 8 |

Liver Liver

A ([ e-mye [ e-mye [ e-mye [2] caPoH [ caroH [ caroH 1) [ el

Liver Liver Liver Liver Kidney Kidney Kidney Kidney

E M cme [0 zaroH [ zaroH [T zaroH [ c-mye [ e-mye M c-mye [0 zaroH

Kidney Kidney BHeme Hemye Hempe EH e-mye EHemye EH e-mye
20

5 C | [ saron [T sapon 200 200 200 20 20

o [Heme Heme Heme Heme Heme Heme Heme Heme
2 0.2

2 2 0z 02 0.02 0.0z

e E omye =] sapon [ sapoH [ caroH =] sapon [ sapoH [ caroH =] sapon
0.02 200 200 200 20 20 20 2

¢ |El caron [E zaroH & zaron [E] sapoH [E zaroH & zaron [E] sapoH [E zaroH
2 2 0.2 0.2 0.2

0.02 0.02 0.02

4. Inthe Save Experiment dialog box, click Save to accept the default file name and
location. The example experiment is saved and closed, and you are returned to the
Home screen.

Note: By default, the example experiment is saved to the <drive>:\Applied
Biosystems\<software name>\experiments folder.

Save Experiment Relative Standard Curve Example

Save in: |[EJ experiments "| ‘1]';3[‘9
__2_ IL2) examples
My Recent

Documents

&

[=}

esktop

S

My Documents

My Computer

@

! File name: | Relative Standard Curve Example.eds | save 4
My Network
Places Files of type: ‘Experlmem Document Single files (*.eds) V| | cancel J
Notes
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Finish the Design Wizard

Notes
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Design
Guidelines

When you design your own relative standard curve experiment:

* In the Review Plate for Experiment window, select the appropriate exit option:

Click

If you want to...

Save Experiment

Save and close the experiment without making any
further changes or starting the run.

Start Run for This Experiment

Edit Plate Layout

Create Another Experiment Using
the Design Wizard

Save the experiment and start the run. Make sure the
reaction plate is loaded in the instrument.

e Use advanced setup to edit the plate layout.

e (StepOnePlus instrument only) Set a different
temperature for one or more of the VeriFlex blocks
using Advanced Setup.

Save and close the current experiment, then create

another experiment using the Design Wizard.

Return to the Wizard

Return to the experiment to make changes using the
Design Wizard.

* By default, experiments are saved to the <drive>:\Applied Biosystems\<software
name>\experiments folder. To change the:

— Save location for a specific experiment, navigate to the desired location using the

Save Experiment dialog box.

— Default save location, select Tools » Preferences, then select the General tab
(default). In the Default Data Folder field, browse to the desired location.

Note: To change the default save location, you must be logged in to the software
with a user name, not as a Guest. For more information, see the “Design Guidelines”

for logging in on page 24.

For More For more information on using Advanced Setup, see “Advanced Setup Workflow” on

Information

page 260.
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Chapter 3

Prepare the Relative Standard
Curve Reactions

This chapter covers:

B Chapter OVeIVIEW . . . o vt e ettt e e e e e e 58
B Prepare the Template. . . ... ...ttt e 59
B Prepare the Sample Dilutions . .. ......... .. .. i 62
B Prepare the Standard Dilution Series . .. ............. ... 63
B Preparethe Reaction MiX . . ... ... . i e 66
B Preparethe ReactionPlate . ........... .. ... ... . ... .. ... .. ... .. .. .. ... 69

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne™ Real-Time PCR Software by pressing
F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Notes
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Chapter Overview

Chapter Overview

This chapter explains how to prepare the PCR reactions for the relative standard curve
example experiment and provides guidelines for how to prepare the PCR reactions for
your own relative standard curve experiment.

Example The workflow for preparing the PCR reactions for the example experiment provided with
Experiment this getting started guide is shown below.
Workflow

Relative Standard Curve Experiment
Start Experiment

h 4
Design the Experiment (Chapter 2)

v
Prepare the Reactions (Chapter 3)

Prepare the template.
Prepare the sample dilutions.
Prepare the standard dilution series.

Prepare the reaction mix for each target assay.

A A

Prepare the reaction plate.

v
Run the Experiment (Chapter 4)
v
Analyze the Experiment (Chapter 5)

v
End Experiment

Notes
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Prepare the Template

Prepare the Template

Prepare the template for the PCR reactions (both samples and standards) using the High-
Capacity cDNA Reverse Transcription Kit.

About the For the relative standard curve example experiment, the template for the PCR reactions is
Example cDNA reverse-transcribed from total RNA samples using the High-Capacity cDNA
Experiment Reverse Transcription Kit.

Required * One of the Ambion® starter packs listed below for RNA isolation:

Materials
. Catalog
Kit Contents Number
gRT-PCR Starter RNAJater® Tissue Collection: RNA Stabilization AM7020
Pack Solution
RNaseZap® Wipes AM9786
RT-PCR Grade Water (nuclease-free) AM9935
Silencer® Validated siRNA, Std Purity AM51331
Choice of RNA sample preparation products:
¢ RNAqueous®-4PCR Kit AM1914
Note: Recommended if you are isolating RNA from
cells or tissues that may be difficult to disrupt or have
high RNase activity.
¢ RiboPure™ Kit AM1924
Note: Recommended if you are:
e |solating RNA from all tissues, including those that
may be difficult to disrupt, are rich in lipids, or have
high RNase activity, or
¢ Labeling and amplifying RNA for use on
microarrays.
¢ TURBO DNA-free™ AM1907
Note: Recommended if you are using SYBR® Green
reagents. If you are using SYBR Green reagents, use
TURBO DNA-free with the RiboPure Kit.
PCR Starter Pack RT-PCR Grade Water (nuclease-free) AM9935
DNAZap™ AM9890
Choice of RNA sample preparation products, as listed See above
above under the gRT-PCR Starter Pack.
High Capacity RNAJater® Tissue Collection: RNA Stabilization AM7020
cDNA Kit Solution
RNaseZap® Wipes AM9786
Choice of RNA sample preparation products, as listed See above
above under the gRT-PCR Starter Pack.
miRNA Starter Pre-miR™ miRNA Starter Kit AM1540
Pack
Notes
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Prepare the Template

» For the samples, total RNA isolated from liver and kidney tissues
* For the standards, total RNA isolated from lung tissue

IMPORTANT! Be sure to prepare template for both your samples and your
standards.

* One of Applied Biosystems High-Capacity cDNA Reverse Transcription Kits:

Kit Part Number
High-Capacity cDNA Reverse Transcription Kit 4368814
(200 reactions)
High-Capacity cDNA Reverse Transcription Kit 4368813
(1000 reactions)
High-Capacity cDNA Reverse Transcription Kit 4374966

with RNase Inhibitor (200 reactions)

High-Capacity cDNA Reverse Transcription Kit 4374967
with RNase Inhibitor (1000 reactions)

Note: The High-Capacity cDNA Reverse Transcription Kit is used to perform the
example experiment. For a list of other kits you can use to perform your own
experiment, see “Preparation Guidelines” on page 61.

Note: The High-Capacity cDNA Reverse Transcription Kit was formerly called the
High-Capacity cDNA Archive Kit.

Prepare the Use the High-Capacity cDNA Reverse Transcription Kit to reverse-transcribe cDNA
Template from the total RNA samples. Follow the procedures in the Applied Biosystems High-
Capacity cDNA Reverse Transcription Kits Protocol to:

1. Prepare the RT master mix.

- (\I[e]\] CHEMICAL HAZARD. 10X RT Buffer may cause eye, skin,

and respiratory tract irritation. Read the MSDS, and follow the handling
instructions. Wear appropriate protective eyewear, clothing, and gloves.

2. Prepare the cDNA reactions.

3. Perform reverse transcription on a thermal cycler.

Notes
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Prepare the Template

Preparation When you prepare your own relative standard curve experiment, Applied Biosystems
Guidelines recommends:

» That you first extract DNA or RNA from the tissue or sample.
* The following templates:

— Complementary DNA (¢cDNA) — cDNA reverse-transcribed from total RNA
samples using one of the following kits:

Kit Part Number
High Capacity RNA-to-cDNA Kit (50 reactions) 4387406
High Capacity RNA-to-cDNA Master Mix 4390778
(200 reactions)
High-Capacity cDNA Reverse Transcription Kit 4368814
(200 reactions)
High-Capacity cDNA Reverse Transcription Kit 4374966

with RNase Inhibitor (200 reactions)

— RNA - Purified total RNA or mRNA extracted from tissue or sample.

— Genomic DNA (gDNA) — Purified gDNA already extracted from tissue or
sample.

For More For more information on:
Information * Preparing cDNA templates, refer to the protocol for the kit you select:
— High Capacity RNA-to-cDNA Kit Protocol
— High Capacity RNA-to-cDNA Master Mix Protocol
— High-Capacity cDNA Reverse Transcription Kits Protocol

Note: The Applied Biosystems High-Capacity cDNA Reverse Transcription Kits
Protocol is not shipped with the High-Capacity cDNA Reverse Transcription Kits.
You can download the protocol from:
http://docs.appliedbiosystems.com/search.taf.

* Preparing RNA or gDNA templates, refer to the protocol for the purification
reagents that you select. To locate Applied Biosystems purification reagents, visit:

http://www.appliedbiosystems.com/

Notes
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Prepare the Sample Dilutions

Prepare the Sample Dilutions

About the For the relative standard curve example experiment:
Exa_.mple » Sample dilutions are necessary because the sample volume is limited to 10% of the
Experiment total reaction volume in the StepOne software. The total reaction volume is
20 uL/reaction, so the sample volume is 2 \L/reaction.
» The stock concentration is 100 ng/uL. After diluting the sample according to the
Sample Dilutions Calculations table, the sample will have a concentration of
5.0 ng/uL. This is a 10X concentration when adding 2 uL to the final reaction mix
volume of 20 uL. You will have a 1X concentration in the final reaction.
* The volumes calculated in the software are:
Stock . Total Volume
. Sample Diluent .
Sample Name Concentration of Diluted
(ng/uL) Volume (pL) | Volume (uL) Sample (uL)
Liver 100.0 1.0 19.0 20.0
Kidney 100.0 1.0 19.0 20.0
Required + Water to dilute the sample
Materials * Microcentrifuge tubes
* Pipettors
* Pipette tips
» Sample stock
» Vortexer
* Centrifuge
Prepare the 1. Label a separate microcentrifuge tube for each diluted sample:
Sample Dilutions o Liver
* Kidney
2. Add the required volume of water (diluent) to each empty tube:
Tube Sample Name Diluent Volume
(L)
1 Liver 19.0
2 Kidney 19.0
Notes
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Perform sample dilutions before adding the samples to the final reaction mix. Dilute the

samples using the volumes that were calculated by the StepOne™ software (“Complete
the Sample Dilution Calculations Tab” on page 47).
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Prepare the Standard Dilution Series

3. Add the required volume of sample stock to each tube:

Sample Volume

Tube Sample Name

" P (L)
1 Liver 1.0
2 Kidney 1.0

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reaction plate.

Preparation When you prepare your own relative standard curve experiment:

Guidelines » Sample dilutions may be necessary because the sample volume is limited to 10% of
the total reaction volume in the StepOne software. You must perform the sample
dilutions before adding the samples to the final reaction mix.

+ For optimal performance of TagMan® Gene Expression Assays or Custom TagMan®
Gene Expression Assays, use 10 to 100 ng of cDNA template per
20-uL reaction. For Fast reagents, Applied Biosystems recommends 10 ng.

* Use TE buffer or water to dilute the sample.

For More For more information on Applied Biosystems assays, refer to the:
Information » TagMan® Gene Expression Assays Protocol
Custom TagMan® Gene Expression Assays Protocol.

Prepare the Standard Dilution Series

Prepare the standard dilution series using the volumes that were calculated by the
StepOne software (“Complete the Reaction Mix Calculations Tab for the c-myc Assay”
on page 43 and “Complete the Reaction Mix Calculations Tab for the GAPDH Assay” on
page 45):

About the For the relative standard curve example experiment:
Example » The standard concentration in stock is 200 ng/uL.

Experiment .
P * The volumes calculated in the software for the both the c-myc and GAPDH assays
are:
Dilution Source Diluent Total Standard
Point Source Volume Volume Volume Concentration
(uL) (uL) (uL) (ng/pL)
1 (200) Stock 5.0 5.0 10.0 100.0
2 (20) Dilution 1 1.0 9.0 10.0 10.0
3(2) Dilution 2 1.0 9.0 10.0 1.0
Notes
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Prepare the Standard Dilution Series

Dilution Source Diluent Total Standard
Point Source Volume Volume Volume Concentration
(bL) (uL) (uL) (ng/pL)
4(0.2) Dilution 3 1.0 9.0 10.0 0.1
5(0.02) Dilution 4 1.0 9.0 10.0 0.01

Required + Water to dilute the standards
Materials * Microcentrifuge tubes

* Pipettors

* Pipette tips

+ Standard stock

» Vortexer

* Centrifuge

Prepare the 1. Label a separate microcentrifuge tube for each standard:
Series for the

* c- Std. 2
c-myc Assay c-mye

e c-myc Std. 3
* c-myc Std. 4
e c-myc Std. 5

2. Add the required volume of water (diluent) to each empty tube:

Volume of
Tube Standard Name Diluent to
Add (pL)
1 c-myc Std. 1 5.0
2 c-myc Std. 2 9.0
3 c-myc Std. 3 9.0
4 c-myc Std. 4 9.0
5 c-myc Std. 5 9.0

3. Prepare dilution 1 in the c-myc Std. 1 tube:
a. Vortex the stock for 3 to 5 seconds, then centrifuge the tube briefly.
b. Using a new pipette tip, add 5.0 pL of stock to the c-myc Std. 1 tube.

c. Vortex Std. 1 for 3 to 5 seconds, then centrifuge the tube briefly.

4. Prepare dilution 2 in the c-myc Std. 2 tube:
a. Using a new pipette tip, add 1.0 pL of dilution 1 to the c-myc Std. 2 tube.
b. Vortex Std. 2 for 3 to 5 seconds, then centrifuge the tube briefly.

Notes

64 Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative
Standard Curve and Comparative C; Experiments



Chapter 3 Prepare the Relative Standard Curve Reactions m
Prepare the Standard Dilution Series

5. Prepare dilution 3 in the c-myc Std. 3 tube:
a. Using a new pipette tip, add 1.0 pL of dilution 2 to the c-myc Std. 3 tube.
b. Vortex Std. 3 for 3 to 5 seconds, then centrifuge the tube briefly.

6. Prepare dilution 4 in the c-myc Std. 4 tube:
a. Using a new pipette tip, add 1.0 uL of dilution 3 to the c-myc Std. 4 tube.
b. Vortex Std. 4 for 3 to 5 seconds, then centrifuge the tube briefly.

7. Prepare dilution 5 in the c-myc Std. 5 tube:

a. Using a new pipette tip, add 1.0 pL of dilution 4 to the c-myc Std. 5 tube.

b. Vortex Std. 5 for 3 to 5 seconds, then centrifuge the tube briefly.

8. Place the standards on ice until you prepare the reaction plate.

Prepare the 1. Label a separate microcentrifuge tube for each standard:
Standard Dilution « GAPDH Std. 1
Series for the
* GAPDH Std. 2
GAPDH Assay
* GAPDH Std. 3

* GAPDH Std. 4
* GAPDH Std. 5

2. Add the required volume of water (diluent) to each empty tube:

Volume of
Tube Standard Name Diluent to
Add (uL)

1 GAPDH Std. 1 5.0

GAPDH Std. 2 9.0

GAPDH Std. 3 9.0
GAPDH Std. 4 9.0

o b~ W N

GAPDH Std. 5 9.0

3. Prepare dilution 1 in the GAPDH Std. 1 tube:
a. Vortex the stock for 3 to 5 seconds, then centrifuge the tube briefly.
b. Using a new pipette tip, add 5.0 pL of stock to the GAPDH Std. 1 tube.
c. Vortex Std. 1 for 3 to 5 seconds, then centrifuge the tube briefly.

4. Prepare dilution 2 in the GAPDH Std. 2 tube:
a. Using a new pipette tip, add 1.0 uL. of dilution 1 to GAPDH Std. 2 tube.
b. Vortex Std. 2 for 3 to 5 seconds, then centrifuge the tube briefly.

Notes
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Prepare the Reaction Mix

5. Prepare dilution 3 in the GAPDH Std. 3 tube:
a. Using a new pipette tip, add 1.0 pL of dilution 2 to the GAPDH Std. 3 tube.
b. Vortex Std. 3 for 3 to 5 seconds, then centrifuge the tube briefly.

6. Prepare dilution 4 in the GAPDH Std. 4 tube:
a. Using a new pipette tip, add 1.0 uL of dilution 3 to the GAPDH Std. 4 tube.

b. Vortex Std. 4 for 3 to 5 seconds, then centrifuge the tube briefly.

7. Prepare dilution 5 in the GAPDH Std. 5 tube:
a. Using a new pipette tip, add 1.0 pL of dilution 4 to the GAPDH Std. 5 tube.
b. Vortex Std. 5 for 3 to 5 seconds, then centrifuge the tube briefly.

8. Place the standards on ice until you prepare the reaction plate.

Preparation When you prepare your own relative standard curve experiment:
Guidelines » Standards are critical for accurate analysis of run data.

* Any mistakes or inaccuracies in making the dilutions directly affect the quality of
results.

* The quality of pipettors and tips and the care used in measuring and mixing
dilutions affect accuracy.

e Use TE buffer or water to dilute the standards.

Prepare the Reaction Mix

Prepare the reaction mix using the components and volumes that were calculated by the
StepOne software (“Complete the Reaction Mix Calculations Tab for the c-myc Assay”
on page 43 and “Complete the Reaction Mix Calculations Tab for the GAPDH Assay” on
page 45).

Note: The software calculates the volumes for all components for the PCR reactions.
However, when you prepare the reaction mix in this section, include only the master mix,
assay mix, and water. Add the sample or standard when you prepare the reaction plate
(see “Prepare the Reaction Plate” on page 69).

About the For the relative standard curve example experiment:
Exa_.mple  The reaction mix components are:
Experiment - TaqMan® Fast Universal PCR Master Mix (2X)
— c-myc Assay Mix (20X)

— GAPDH Assay Mix (20X)
— Water
Notes
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Prepare the Reaction Mix

* The volumes calculated in the software for both target assays are:

Volume (pL) for

Component 1 Reaction
Master Mix (2.0X) 10.0
Assay Mix (20.0X) 1.0
H,O 7.0
Total Volume 18.0

Note: The sample or standard is not added at this time.

Required * Microcentrifuge tubes

Materials « Pipettors
* Pipette tips
* Reaction mix components (listed above)
* Centrifuge

Prepare the IMPORTANT! Prepare the reaction mix for each target assay separately.
Reaction Mix

1. Label an appropriately sized tube for each reaction mix:
* c-myc Reaction Mix
* GAPDH Reaction Mix

2. For the c-myc assay, add the required volumes of each component to the c-myc
Reaction Mix tube:

Volume (uL) for
Component Vo1IuFr:1e zg“tl:gr:or 24 Reactions
(Plus 10% Excess)
TagMan® Fast Universal PCR 10.0 264.0
Master Mix (2X)
c-myc Assay Mix (20X) 1.0 26.4
Water 7.0 184.8
Total Reaction Mix Volume 18.0 475.2
Notes
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Notes
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Prepare the Reaction Mix

3.

5.
6.

For the GAPDH assay, add the required volumes of each component to the GAPDH
Reaction Mix tube:

Volume (uL) for
Component Vo:uFr;Lt;‘(:pt:g:or 24 Reactions
(Plus 10% Excess)

TagMan® Fast Universal PCR 10.0 264.0
Master Mix (2X)

GAPDH Assay Mix (20X) 1.0 26.4
Water 7.0 184.8
Total Reaction Mix Volume 18.0 475.2

Mix the reaction mix in each tube by gently pipetting up and down, then cap each
tube.

Centrifuge the tubes briefly to remove air bubbles.

Place the reaction mixes on ice until you prepare the reaction plate.

Preparation When you prepare your own relative standard curve experiment:

Guidelines .

If your experiment includes more than one target assay, prepare the reaction mix for
each target assay separately.

Include excess volume in your calculations to provide excess volume for the loss
that occurs during reagent transfers. Applied Biosystems recommends an excess
volume of at least 10%.

Include all required components.
Prepare the reagents according to the manufacturer’s instructions.

Keep the assay mix protected from light, in the freezer, until you are ready to use it.
Excessive exposure to light may affect the fluorescent probes.

Prior to use:
— Mix the master mix thoroughly by swirling the bottle.
— Resuspend the assay mix by vortexing, then centrifuge the tube briefly.

— Thaw any frozen samples by placing them on ice. When thawed, resuspend the
samples by vortexing, then centrifuge the tubes briefly.

For More For more information on preparing the reaction mix, refer to the protocol appropriate for
Information the reagents you are using in the PCR reactions:

L]

TagMan® Gene Expression Assays Protocol

Custom TagMan® Gene Expression Assays Protocol
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Prepare the Reaction Plate

Prepare the Reaction Plate

Prepare the reactions for each replicate group, then transfer them to the reaction plate.
Use the plate layout displayed in the StepOne software.

About the For the relative standard curve example experiment:

E Exa_tmplei + A MicroAmp® Fast Optical 48-Well Reaction Plate is used.
Xperimen . .
P * The reaction volume is 20 pL/well.
* The reaction plate contains:
— 12 Unknown wells
— 30 Standard wells [£]
— 6 Negative control wells [
— 0 Empty wells
* The plate layout automatically generated by the StepOne software is used:
| [0 show in wells ¥ | B view Legend | | |
1 | 2 | 3 4 | 5 B | 7 8 |
o | eme eome ome [ carth [ carch [ caroh m;c mm:”
B Liver Liver Liver Liver Kidney Kidney Kidney Kidney
B c-myc m GAPDH GAPDH GAPDH m c-mye c-myc c-myc m GAPDH
Kidney Kidney c-myc &-myc c-mye c-myc &-myc c-mye
¢ GAPDH m GAPDH glj(m gljég % Q 9 E
b |Eeme Homwe Homw 5 [ ol Homw 5 [ Homwe
2 2 2 0.2 0.z 0.2 0.02 0.0z
£ |[Eemye [ caroH =] sapon [ sapoH [ caroH =] sapon [ sapoH [ caroH
0.02 200 200 200 20 20 20 2
¢ |[E saron [ caroH =] sapon [ sapoH [ caroH =] sapon [ sapoH [ caroH
2 2 0.2 0.2 0.z 0.02 0.02 0.0z
Note: The example experiment was created for a StepOne instrument. If you
selected the StepOnePlus instrument in the Experiment Properties screen (page 27),
your reaction plate layout will differ from the layout shown above. The software
displays a 96-well reaction plate layout for the StepOnePlus instrument. For an
example of the 96-well reaction plate layout, see page 13.
Required  Microcentrifuge tubes

Materials * Pipettors

* Pipette tips

* c-myc reaction mix (from page 67)

* GAPDH reaction mix (from page 67)
* Water

Notes
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Prepare the Reaction Plate

* c-myc standards (from page 64)

* GAPDH standards (from page 65)

+ Samples (from page 62)

+ MicroAmp® Fast Optical 48-Well Reaction Plate
+ MicroAmp® Optical 48-Well Adhesive Film

* Centrifuge

Prepare the 1.
Reaction Plate

For each target, prepare the negative control reactions:

a. To an appropriately sized tube, add the volumes of reaction mix and water
listed below.

Reaction Mix | Water Volume

Tube Reaction Mix Volume (uL) (uL)

1 c-myc reaction mix 59.4 6.6

2 GAPDH reaction 59.4 6.6
mix

b. Mix the reaction by gently pipetting up and down, then cap the tube.
c. Centrifuge the tube briefly to remove air bubbles.

d. Add 20 pL of the negative control reaction to the appropriate wells in the
reaction plate.

2. For each replicate group, prepare the standard reactions:

a. To appropriately sized tubes, add the volumes of reaction mix and standard
listed below.

Standard Reaction Reaction Standard
Tube N . MixVolume Standard Volume
Reaction Mix
(uL) (uL)
1 c-myc Std1 | c-myc 59.4 c-myc Std 1 6.6
reaction mix
2 c-myc Std2 | c-myc 59.4 c-myc Std 2 6.6
reaction mix
3 c-myc Std 3 | c-myc 59.4 c-myc Std 3 6.6
reaction mix
4 c-myc Std 4 | c-myc 59.4 c-myc Std 4 6.6
reaction mix
5 c-myc Std 5 | c-myc 59.4 c-myc Std 5 6.6
reaction mix
6 GAPDH GAPDH 59.4 GAPDH 6.6
Std 1 reaction mix Std 1
7 GAPDH GAPDH 59.4 GAPDH 6.6
Std 2 reaction mix Std 2
Notes
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Standard
Reaction

GAPDH

Std 3

GAPDH

Std 4

GAPDH

Std 5

Reaction
Mix

GAPDH

reaction mix

GAPDH

reaction mix

GAPDH

reaction mix

Reaction
MixVolume
(uL)

59.4

59.4

59.4

Prepare the Reaction Plate

Standard

GAPDH
Std 3

GAPDH
Std 4

GAPDH
Std 5

Standard
Volume
(uL)

6.6

6.6

6.6

b. Mix the reactions by gently pipetting up and down, then cap the tubes.

c. Centrifuge the tubes briefly to remove air bubbles.

d. Add 20 pL of the standard reaction to the appropriate wells in the reaction

plate.

3. For each replicate group, prepare the reactions for the unknowns:

a. To appropriately sized tubes, add the volumes of reaction mix and sample listed

below.
. Reaction Sample
Tube Unkno_wn Reac_tlon MixVolume Sample Volume
Reaction Mix
(uL) (uL)
1 c-myc Liver | c-myc 59.4 Liver 6.6
reaction mix
2 c-myc c-myc 59.4 Kidney 6.6
Kidney reaction mix
3 GAPDH GAPDH 59.4 Liver 6.6
Liver reaction mix
4 GAPDH GAPDH 59.4 Kidney 6.6
Kidney reaction mix

b. Mix the reactions by gently pipetting up and down, then cap the tubes.

c. Centrifuge the tubes briefly to remove air bubbles.

d. Add 20 pL of the unknown (sample) reaction to the appropriate wells in the
reaction plate.

4. Seal the reaction plate with optical adhesive film.

5. Centrifuge the reaction plate briefly to remove air bubbles.

Notes
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Prepare the Reaction Plate

6. Confirm that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the reaction plate again at a higher speed and for a longer period of time.

IMPORTANT! Do not allow the bottom of the reaction plate to become dirty. Fluids
and other contaminants that adhere to the bottom of the reaction plate can
contaminate the sample block(s) and cause an abnormally high background signal.

Correct Incorrect

GR1303

Liquid is at the ¢ Not centrifuged with enough force, or
bottom of the well. | o Not centrifuged for enough time

7. Until you are ready to perform the run, place the reaction plate on ice in the dark.

Preparation When you prepare your own relative standard curve experiment:
Guidelines * Make sure you use the appropriate consumables.

» Make sure the arrangement of the PCR reactions matches the plate layout displayed
in the StepOne software. You can either:

— Accept the plate layout automatically generated by the software.
or
— Use Advanced Setup to change the plate layout in the software.

» Ifyou use optical adhesive film to seal your reaction plates, seal each reaction plate
as follows:

Example

Action
StepOne™ System StepOnePlus™ System

1. Place the reaction plate onto the center of the 96-well base. Be sure the reaction plate is flush with the top surface of the

96-well base.

2. Load the reaction plate as desired.

3. Remove a single optical adhesive film (film) from the box.
e For the StepOne system reaction plate, bend both end-tabs

upward. Hold the film backing side up. . 1

e For the StepOnePlus system reaction plate, fold back one of
the end-tabs. Hold the film backing side up.

Notes
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Prepare the Reaction Plate

Example
Action
StepOne™ System StepOnePlus™ System

4. In one swift movement, peel back the white protective backing
from the center sealing surface. Do not touch the center
sealing surface.

IMPORTANT! Improper peeling of the optical adhesive film may
result in haziness, but will not affect results. Haziness will
disappear when the film comes into contact with the heated cover
in the instrument.

5. Holding the film by the end-tabs, lower the film onto the
reaction plate (adhesive side facing the reaction plate). Be sure
the film is completely covering all wells of the reaction plate.

6. While applying firm pressure, move the applicator slowly
across the film, horizontally and vertically, to ensure good
contact between the film and the entire surface of the reaction
plate.

7. While using the applicator to hold the edge of the film in place,
grasp one end of the end-tab and pull up and away sharply.
Repeat for the other end-tab.

8. To ensure a tight, evaporation-free seal:
a. Repeat step 6.
b. While applying firm pressure, run the edge of the applicator along all four sides of the outside border of the film.

Note: Optical adhesive films do not adhere on contact. The films require the application of pressure to ensure a tight,
evaporation-free seal.

9. Inspect the reaction plate to be sure all wells are sealed. You should see an imprint of all wells on the surface of the film.

For More For more information on:
Information * Preparing the reaction plate, refer to the protocol appropriate for the reagents you
are using in the PCR reactions:

— TagMan® Gene Expression Assays Protocol
— Custom TagMan® Gene Expression Assays Protocol
* Consumables, see “Supported Consumables” on page 4.

» Using Advanced Setup to change the plate layout, see “Advanced Setup Workflow”
on page 260.

Notes
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Prepare the Reaction Plate

Notes
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Chapter 4

n Run the Relative Standard Curve
Experiment

This chapter covers:

B Chapter OVeIVIEW . . . o vt e ettt e e e e e e 76
B Prepare forthe Run. .. ... ... ... ... . . 77
B (Optional) Enable the Notification Settings . . . ........... ... ... ... 79
B Startthe Run. . ....... ... 82
B Monitorthe Run . ... ... ... . 86
B Unload the Instrument and Transferthe Data. . ........................... 93

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne™ Real-Time PCR Software by pressing
F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Notes
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Chapter Overview

Chapter Overview

This chapter explains how to perform a run on the Applied Biosystems StepOne™ and
StepOnePlus™ Real-Time PCR Systems.

Example The workflow for running the example experiment provided with this getting started
Experiment guide is shown below.

Workflow
Start Experiment

h 4
Design the Experiment (Chapter 2)

v
Prepare the Experiment (Chapter 3)

h 4
Run the Experiment (Chapter 4)

Prepare for the run.
(Optional) Enable the notification settings.
Start the run.

Monitor the run.

o > 0 b=

Unload the instrument and transfer the data.

v
Analyze the Experiment (Chapter 5)

h 4
End Experiment

Notes
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Prepare for the Run

Prepare for the Run

Prepare for the run by opening the example experiment file you created in Chapter 2,
then loading the sealed reaction plate into the StepOne™™ or StepOnePlus™ instrument.

Open the 1. Double-click g (StepOne software) or select Start » All Programs » Applied
Example Biosystems » StepOne Software » <software name>

Experiment where <software name> is the current version of the StepOne software.

2. In the Login dialog box, select EXAMPLEUSER from the User Name dropdown
menu, then click OK.

Note: EXAMPLEUSER is the user name you created when designing the relative
standard curve experiment (page 23).
3. From the Home screen, click Open.

4. In the Open dialog box, navigate to the experiments folder (default):

<drive>:\Applied Biosystems\<software name>\experiments

5. Double-click Relative Standard Curve Example to open the example experiment
file you created in Chapter 2.

File Edit Instrument Analysis Tools Help I

2 [ | NEW CARETITIETL = =3 Open H 4‘ JJ Send Experiment to Instrument L_Yi. Download Experiment from Instrument. &m Y
Analyze
@ e Experiment
4 om0 experimeants v [ IEEE
—| L) examples
5 " il Relative Standard Curve Example.eds

My Recent
Documents

My Computer

My Network

File name Relative Standard Curve Example 2ds

Places Files oftype: Al SDS Files (edm; eds; edt)

Notes
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Prepare for the Run

Load the ACAUTION PHYSICAL INJURY HAZARD. During instrument operation, the

Reaction Plate temperature of the sample block(s) can exceed 100 °C. If the instrument has been used
Into the recently, keep your hands away until the sample block(s) reach room temperature.
Instrument

# IMPORTANT! Wear powder-free gloves when you handle the reaction plate.

1. Open the instrument drawer.

StepOne instrument StepOnePlus
sample block instrument VeriFlex™
Sample Blocks

2. Place the reactions in the sample block(s):

» If using a reaction plate: Place the reaction plate in the sample block(s) with
well A1 at the back-left corner.

» If using reaction tube strips: Place the tray containing the tube strips in the
sample block(s).

» Ifusing reaction tubes: Place the tray containing the tubes in the sample
block(s).

Notes
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(Optional) Enable the Notification Settings

IMPORTANT! For optimal performance with partial loads:

StepOnePlus instruments — Load at least 16 tubes and arrange them in:

* Adjacent columns of 8 tubes, using rows A through H. For example, fill wells
in column 1 (rows A through H) and column 2 (rows A through H).

or

* Adjacent rows of 8 tubes, using columns 3 through 10. For example, fill wells
in row A (columns 3 through 10) and row B (columns 3 through 10).

StepOne instruments — Load at least 4 tubes in the sample block.

3. Close the instrument drawer carefully.

éCAUTION

(Optional) Enable the Notification Settings

Enable the notification settings so that the StepOne software alerts you by e-mail when
the StepOne or StepOnePlus instrument begins and completes the run, or if an error
occurs during the run. You can also set up the software to attach a completed run file to
the Run Completed e-mail notification. Enabling the notifications settings feature is
optional and does not affect the performance of the StepOne™ and StepOnePlus™
systems or the duration of the run.

IMPORTANT! The notification settings feature is available only if the computer that you
are using is running the StepOne or StepOnePlus instrument and is connected to an
Ethernet network.

Note: The notification system is also available to computers that are monitoring a
StepOne or StepOnePlus instrument remotely. For more information, see “Remote
Monitor” on page 90.

About the In the example experiment:

Exgmple * The StepOne software is set up to send notifications to three users (scientist,
Experiment supervisor, and technician at mycompany.com) when the StepOne or StepOnePlus
system ends the run and if it encounters any errors during operation.

e The example SMTP server (www.mycompany.com) is set up for Secure Sockets
Layer (SSL) encryption and requires authentication for use.

Notes

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative 79
Standard Curve and Comparative C; Experiments



n Chapter 4 Run the Relative Standard Curve Experiment
(Optional) Enable the Notification Settings

Set Up the 1. In the StepOne software, click @ Run in the navigation pane.
Notification

Settings Click 5 Notification Settings.

Select Yes for Enable Notifications.

P 0D

Select the events that generate notifications:
a. Select Instrument Error.

b. Select Run Completed.

5. In the Enter e-mail addresses for notifications field, enter:
scientist@mycompany.com, supervisor@mycompany.com,
technician@mycompany.com.

6. Inthe Outgoing Mail Server (SMTP) field, enter smtp.mycompany.com.

7. Select No next to “Attach completed runs to message.”

Note: This option applies only to e-mail notifications that are generated when the
instrument completes a run (that is, Run Completed is selected in step 4).

8. Set the authentication settings:
a. Select Yes for Server requires authentication.
b. In the User Name field, enter Example User.

c. In the Password field, enter password.

Notification Settings

Enable Notifications: @) Yes () Mo
[ Selectthe events to gensrate natifcations: [ Instrument Error
4 1 [[] Run Started
L [#] Run Gompleted
Enter e-mail addresses for notifications: com, com, com
Separate e-mall aceresses with commas.
For example: jane_ com com
6 Outgoing Mail Server (SMTF): | smtp.mycormpany.com
‘| For example: smip.mycompany.com
7 Attach completed uns to message? () Yes (@) Mo
8a H Server requires an enciypted connection? (O Yes () No
Semver requires authentication? Af‘YES C‘ND
8b (Server. UserName: |Exarnple User
80 (Server Authentication) Password. |wessssss
Testthe cutrent parameters,
When you press the "Test Comfiguration” BUHN, | e contiunction
sarmple stattrun, error, and run complete
events will be sent Using the cutrent paramaters.
Notes
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(Optional) Enable the Notification Settings

Run Guidelines When you set up the StepOne or StepOnePlus system for automatic notification:

* Your system must be set up for network use. Refer to the Applied Biosystems
StepOne™ and StepOnePlus™ Real-Time PCR Systems Installation, Networking,
and Maintenance Guide.

* Select the events for which you want to receive e-mail notifications:

— Instrument Error — When selected, recipients are e-mailed all errors
encountered by the instrument during each run.

— Run Started — When selected, recipients are e-mailed every time the instrument
starts a run.

— Run Completed — When selected, recipients are e-mailed every time the
instrument completes a run.

¢ Obtain e-mail addresses to receive notifications.

IMPORTANT! Separate addresses with a comma (,).

» Contact your systems administrator or information technology department if you
need:

E-mail addresses for users who will receive notifications

— A network address for a simple mail transfer protocol (SMTP) server on the LAN

A user name and password for the server, if required for access

The Secure Sockets Layer (SSL) setting of the server (on or off)

* Click Test Configuration to test your notification settings. If the notification
settings are set up correctly, sample e-mails are sent to the addresses you entered.

Notes
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Start the Run

Start the Run

Start the run according to the layout of your StepOne or StepOnePlus system:

Layout Description See...
Colocated The yellow cable connects the computer to the “Colocated Startup”
instrument below
Standalone e The computer and the instrument are not “Standalone Startup”
connected, or on page 83
e The computer and the instrument are
connected to the same network.

Colocated Perform this procedure if your computer is directly connected to your StepOne or
Startup  StepOnePlus instrument by the yellow cable.

1. In the StepOne software, click % Run in the navigation pane.

2. Click START RUN .

1 YR Instrument Status: @& Connected

Run Status:  Not Started Enable Notifications

Notes
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Start the Run

Standalone Perform these procedures if your computer and StepOne or StepOnePlus instrument are
Startup not directly connected by the yellow cable. Start with:

* “Send the Experiment to the Instrument Over the Network™ on page 83 if your
computer and instrument are connected to the same network.

or

* “Transfer the Experiment to the Instrument Using a USB Drive” on page 83 if your
computer and instrument are not connected to the same network.

Send the Experiment to the Instrument Over the Network

1. In the StepOne software, click %] Send Experiment to Instrument.

2. In the Send Experiment to Instrument dialog box:
a. Click Browse, navigate to the example experiment file, then click Open.
b. Select the instrument to receive the experiment file.
Note: If your instrument is not listed, set up the instrument for monitoring as

explained in the Applied Biosystems StepOne™ and StepOnePlus™ Real-Time
PCR Systems Installation, Networking, and Maintenance Guide.

c. Click Send Experiment to send the experiment to the your instrument over the

network.
Send Experiment to Instrument g|
a Selectan experimentto send, selectthe instrument to receive the experiment, then click
"Send Experiment” OJ
2a —1 1 select Experiment | Browse
2b 1 2 Selectinstrument. % Local Instrument (Default) v

20 : Send Experiment | Cancel

3. When prompted, click OK to close the confirmation.

4. Go to “Start the Instrument Run Using the Touchscreen” on page 84.

Transfer the Experiment to the Instrument Using a USB Drive
1. Connect the USB drive to one of the USB ports on the computer.
2. 1In the StepOne software, select | Save » Save As.

3. In the Save dialog box, navigate to the USB drive, then click Save.

Notes
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Start the Run

4. Remove the USB drive from your computer, then connect it to the USB port of your
StepOne or StepOnePlus instrument.

5. Go to “Start the Instrument Run Using the Touchscreen” below.
Start the Instrument Run Using the Touchscreen
1. Touch the StepOne or StepOnePlus instrument touchscreen to awaken it.

Note: If the touchscreen is not at the Main Menu screen, touch @

Wait for the USB sign to appear on the touchscreen.
In the Main Menu screen, touch Browse/New Experiments.

In the Browse screen, touch {fZ) Folders.

a » 0O DN

In the Choose an Experiment Folder screen:
* Touch USB if you transferred the experiment on a USB drive.
* Touch Default if you sent the experiment over a network connection.
6. Before starting the run, save the example experiment to your instrument:
a. In the Browse screen, touch the example experiment name, then touch Copy.

b. In the Save Experiment screen, navigate to a destination folder, then click
Save & Exit.

7. In the Browse screen, touch the example experiment name, then touch
[ Start Run.

Notes
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Start the Run

( ﬁ) Browse Last Accessed Experiments (1)
4
Experiment I Folder I Last Used * D'

R o ple Experiment

Transfer

Page
111

6a —

LX)

r (elwlzlels] -

Start Run Mew View/Edit Copy Delete

Touch an experiment to select it, then touch
any of the buttons to perform an action.
Touch a column title to sort the table.

8. In the Run Parameters screen:

a. Touch the Reaction Volume field, use the keypad to enter the reaction volume
for the example experiment, then touch Done.

b. Touch Start Run Now.

(‘ ﬁ) Experiment Parameters

8a Reaction Volume: |20 uL

Cover Temperature: |105.0 o0

Experiment Name: IExampIeiExperiment

8b St:;lr:):un |
Touch each field then use the keyboard
to edit the contents. When you are finished, ?'
touch Start Run.
Notes
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Monitor the Run

Monitor the Run

Monitor the run according to the layout of your StepOne or StepOnePlus system:

Layout Description See...
Colocated The yellow cable connects the computer to the “Colocated Monitoring”
instrument. below
Standalone The computer and the instrument are “Remote Monitor” on
(Networked) connected to the same network. page 90
Standalone The computer and the instrument are not “Standalone Monitoring”
(Basic) connected. on page 92

Colocated If your computer is directly connected to your StepOne or StepOnePlus instrument by the

Monitoring yellow cable, you can view the progress of the run in realtime as described below. During
the run, periodically view all three plots available from the StepOne software for
potential problems.

# To... Action

A | Stop the run 1. In the StepOne software, click STOP RUN.

2. In the Stop Run dialog, click one of the following:
— Stop Immediately to stop the run immediately.

— Stop after Current Cycle/Hold to stop the run after the
current cycle or hold.

— Cancel to continue the run.

B | View amplification data | Select w Amplification Plot.

in realtime See “About the Amplification Plot Screen” on page 87.

C | View temperature data Select @ Temperature Plot.

for the run in realtime See “About the Temperature Plot Screen” on page 88.

D | View progress of the Select |: Run Method.
run in the Run Method See “About the Run Method Screen” on page 89.
screen

E | Enable/disable the Select or deselect Enable Notifications.

Notification Settings See “(Optional) Enable the Notification Settings” on page 79.

Notes
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Monitor the Run

} STOP RUN Estimated Time Remaining:56 min 22 sec Instrument Status: Oa(:?ul'nlech}:d
Amplification Plot Run Status mn [ Enable Notifications E
Temperature Plot
\& L Temperature Plot Current Temperatures
i~ .
RunMethod a & = = M cover
.Samp\e
Notification Settings Temperature Plot Block
110
100
a0
a0
70
H
£ 80
i
g
E &0
5
=
40
30
20
0 Temperature Plot
e 7 T - R TR T R v v <M | T
Time
Fixed view []

About the Ampilification Plot Screen

The Amplification Plot screen allows you to view sample amplification as your
instrument collects fluorescence data during a run. If a method is set up to collect real-
time data, the Amplification Plot screen displays the data for the wells selected in the
View Plate Layout tab. The plot contrasts normalized dye fluorescence (ARn) and cycle
number. The figure below shows the Amplification Plot screen as it appears during the
example experiment.

To view data in the Amplification Plot screen, select the wells that you want to view in
the View Plate Layout tab.

>
P P amRE!
Amplification Plot | [3 showinwells ¥

Selectwelis with: |- Select tem - v || |

B E

View Legend

v,

55

1 2 3 4 il B 7 8
50

45
4.0
35

Liver Liver

Al em.... [dem... [dem. . [1] car.. [i] sap... [ sar Mo A@en

Liver Liver Liver Liver Kidney  Kidney  Kidney  Kidney

c-m GAP. GAP GAP. c-m. c-m c-m GAP.
idney §_ianey Y em. Y em.. | Hem. {Hen. |Hen. Hen.
20

[ sar_ [ car_ 200 200 200 20 20

o|Hen- | Hem. | Hen. [Hen. Hen. Hen. [Hen. | Hen.

2 2 0.2 0.2 0.02 0.02

R T T g |[Eem.. [Heer.. [Hosr. Hosr.. [Heer.. [Hosr. Hosr. [Heer..
20 20 20 2

Cycle 0.02 200 200 200
’— Legend ‘

AN o I c o I c:F

30
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m

25
20

o]

15
1.0
05

0.0

-n

E oar... [ ear... [ osr.. [ crr...|[E ear... [E ear... [ oar... [E esp...
2 2 0.2 0.2 0.2

0.02 0.02 0.02

The Amplification Plot screen is useful for identifying and examining abnormal
amplification. Abnormal amplification can include the following:

* Increased fluorescence in negative control wells.

Notes
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Monitor the Run
» Absence of detectable fluorescence at an expected cycle (determined from previous
similar experiments run using the same reagents under the same conditions).
If you notice abnormal amplification or a complete absence of signal, troubleshoot the
error as explained in the StepOne Software Help (click @ or press F1).
About the Temperature Plot Screen
During a run, the Temperature Plot screen displays the temperatures of the sample
block(s), the heated cover, and samples (calculated) in realtime. The figure below shows
the Temperature Plot screen as it appears during the example experiment.
To... Action

A | Add/remove temperature plots Select Cover or Sample Block to
toggle the presence of the
associated data in the plot.

B | Change the time displayed by plot From the View dropdown menu,
select the amount of time to display
in the plot.

C | Display a fixed time window during the instrument | Select Fixed View.

run
If the entire plot does not fit in the screen, the
screen is not updated as the run progresses. For
example, if you select 10 minutes from the View
dropdown menu, the plot will show data for 10
minutes. If the run lasts more than 10 minutes:
e The plot updates as the run progresses with
Fixed View deselected.
¢ The plot does not update as the run progresses
with Fixed View selected.
B =2 Cover
@ L .Sample ] A
Temperature Plot Black

'.:I.s .“rn.

Temperature

M
|

o Temperature Plot

o
00:00:00 00:04:10 00:08:20 00:12:30 00:16:40 00:20:50 00:25:.00 00:26:10 00:33:20 00:37:30 00:41:40 00:45:50 00:50:00 00:54:10 00:58:20
Time

View 1 Hour vH—B
Fixed View [] C

The Temperature Plot screen can be useful for identifying hardware failures. When
monitoring the Temperature Plot screen, observe the Sample and Block plots for
abnormal behavior.

Notes
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Monitor the Run

* In general, the Sample and Block plots should mirror each other approximately. A
significant deviation of the plots may indicate a problem.

» The Cover plot should maintain the constant temperature specified in the method. A
departure from the constant temperature may indicate a problem.

If you notice an abnormal temperature plot, troubleshoot the error as explained in the
StepOne Software Help (click @ or press F1).

Note: The Sample temperature displayed in the Current Temperatures group is an
estimated value.

About the Run Method Screen

The Run Method screen displays the run method selected for the run in progress. The
software updates the Run Status field throughout the run. The figure below shows the
Run Method screen as it appears in the example experiment.

To... Action

A | Change the number of cycles In the Adjust # of Cycles field, enter the number of
cycles to apply to the Cycling Stage.

B | Add a melt curve stage to the Select Add Melt Curve Stage to End.
end of the run

C | Add a Hold stage to the end of Select Add Holding Stage to End.

the run
D | Apply your changes Click Send to Instrument.
Holding Stage Cycling Stage I:li g
e c
Starting Cycle: [T | D

100 —|

75 —|

50 —|

25 —|

Step 1 Step 1 Step 2
<
end

Leg
Data Caollection On Data Collection Off & AutoDelta On A& AutoDelta Off ‘

If an alert appears, click the error for more information and troubleshoot the problem as
explained in the StepOne Software Help (click @ or press F1).

Notes
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Monitor the Run

Remote Monitor If your StepOne or StepOnePlus instrument is connected to a network, you can use the
Remote Monitor in the StepOne software to view the progress of the run in realtime from
any computer on the network.

IMPORTANT! Networked computers cannot control the StepOne or StepOnePlus
instrument, only monitor it.

To monitor your instrument remotely:

1. In the StepOne software, select Instrument » Remote Monitor.

2. In the navigation pane, select your instrument.

If the navigation pane does not list your instrument:
a. Click Add Instrument.

b. Enter a name for the instrument profile within the Remote Monitor.

Note: Enter any name that helps you identify the instrument. The profile name
you enter will be displayed in the Remote Monitor and in the instrument
dropdown menus when you send experiments, download experiments, or
monitor instruments.

c. In the Instrument Name, Host Name, or IP Address field:
 If you know the host name, enter the host name.

* If you do not know the host name, enter the instrument name or IP
address.

Note: The instrument name and IP address are displayed on the instrument
touchscreen. Go to Settings Menu » Admin Menu » Set Instrument Name or
Set IP Address. Contact your systems administrator or information technology
department for the host name.

d. Click Save & Exit.

Add Instrument

a Enter a name for this instrument profile within the Remote Monitor. Then, enter the instrument name, host name, or IP address to connect to the instrument. | Required
Ifyour network administrator provided you with a host name, enter the host name. Ifyou do not have a host name, enter the instrument name or IP address.  — a9 &

2b T " Profile Name
2c

*Instrument Name, Host Name, or IP Address

Save & Exit | \ Save & Add Another ‘ | Cancel

2d

Note: For more information on configuring the StepOne or StepOnePlus instrument
for network use or for the Remote Monitor feature, refer to the Applied Biosystems
StepOne™ and StepOnePlus™ Real-Time PCR Systems Installation, Networking,
and Maintenance Guide.

Notes
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Monitor the Run

3. Click | % | Start monitoring the instrument for your instrument. It may take
several minutes for the instrument to send the information to your computer.

1 \
File Edit Instrument Analysis Tools Help
[E2] Mew Experiment = =] Open.. =] B Close I"_—I Send Experiment to Instrument. L_|r Download Experiment from Instrument... 489 Y
Manage Instruments <«
9 & an instrument, then click "Monitor' to monitor the INEl %/ Local Simulator (Defaul) v -
% Local Instrument v [ Runstatus [ | ProfileName:  Local Simulator [[] Enable Run Natifications
Estimated Time Remaining: 75 min 5 sec Status: Connected ‘m
g ) ification Settings
2 # (Default) Local Simulator A Experiment Name: dieciipey  AlnEibiock ——
Experiment Type: Serial Number:
3 ' L5 ‘AJ |LJ ‘l”i‘ Temperature Plot
Temperature Plot Current Temperatures
110 W cover 25.0°C
- W sample 50.0°C
Block 50.0°C
80
80
o 70
5
® 60
T
g s
o
LT}
30
20
10
View Chart
0 [
00:00:00 00:01:40 00:03:20 00:05:00 00:06:40 00:08:20 00:10; Wiew 10 Minutes v |
Time Fixed View []
4. View data as described below.
# To... Action

A | View amplification data | Click Amplification Plot.

in realtime See “About the Amplification Plot Screen” on page 87.

B | View temperature data Click Temperature Plot.

for the run in realtime See “About the Temperature Plot Screen” on page 88.

C | View progress of the Click Run Method.

run in the Run Method See “About the Run Method Screen” on page 89.
screen
D | Enable/disable the Select or deselect Enable Notifications.

Notification Settings See “(Optional) Enable the Notification Settings” on page 79.

Notes
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Monitor the Run

File Edit Instrument Analysis Tools Help

[E] New Experiment ~ [55 Open.. [

_1 Close ’IJ_‘| Send Experiment to Instrument... ’—T’L Download Experiment from Instrument... .@

Manage Instruments «

Add Instrument...

ment, then click "Monitor” to monitor the instrument.  KE SETEIRIRITE T (REEITTES -

[ Run status:
Estimated Time Remaining: 75 min 5 sec
Experiment Mame
Experiment Type:

'Qf Local Instrument

& (Default) Local Simulator

Profile Name:  Local Simulatar
Status:

Block Type:
Serial Number:

[]Enable Run Motifications

48-Well Block G Netficaton Settings |

‘LJ |£J ‘LJ |2‘ ‘hl Temperature Plot
| |
| |
7\ =~
‘\,A/ (B/ \C//

Current Temperatures

................................................ W cover 250°C
W sample 50.0°C
Block 50.0°C

Standalone If you started the run from your StepOne or StepOnePlus instrument, you can view the
Monitoring progress of the run from the touchscreen. The Run Method screen displays the method
for the experiment and highlights the thermal profile steps as the instrument performs
them.
# To... Action
A | Add a melt curve stage | Touch i{|-A. Add Melt Curve, then touch OK.
to the run
B | Display the time Touch Display Experiment Time, then touch X to return
remaining in the run to the Run Method screen.
C | Stoptherun Touch [ STOP, then touch:
e Stop to stop the run after the instrument completes the
current cycle or hold.
¢ Abort to stop the run immediately.
e X to continue the run with no changes.
D | View experiment Touch View Experiment Information, then touch X to
information return to the Run Method screen.
E | View the Error Log Touch the status bar to display the error log.
Elle View Help
\ 50.0 °C 01:15:02
Experiment: Example Experiment
Stage 2
X 40
a
| 95.0° 95.0°
D | = B
A el B ) =) c

Feld Melt Curve ‘View Expeniment  Display Expenment
Information Time

C oo

Notes
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Unload the Instrument and Transfer the Data

Unload the Instrument and Transfer the Data

When your StepOne or StepOnePlus instrument displays the Main Menu screen, unload
the reaction plate from the instrument and transfer the experiment data to the computer
for analysis.

Unload the ACAUTION PHYSICAL INJURY HAZARD. During instrument operation, the

Reaction Plate temperature of the sample block(s) can exceed 100 °C. Keep your hands away until the
sample block(s) reach room temperature.

Note: When the StepOne or StepOnePlus instrument completes a run, the system saves
the details of the run to the run history, which remains present in the system until the
instrument completes another run.

1. When the Run Report screen appears in the StepOne or StepOnePlus instrument
touchscreen, touch (#).

2. Open the instrument drawer.
3. Remove the reaction plate from the sample block(s).

4. Carefully close the instrument drawer.

A CAUTION

Select a Data Transfer the experiment to your computer for analysis according to the layout of your
Transfer Method  StepOne or StepOnePlus system:

Layout Description See...
Colocated The yellow cable connects the computer and “Colocated Data Transfer”
the instrument. below
Standalone The computer and the instrument are “Remote Data Transfer” on
(Networked) connected to the same network. page 94
Standalone The computer and the instrument are not “Standalone
(Basic) connected. Data Transfer” on page 95
Notes
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Colocated
Data Transfer

Remote
Data Transfer

If your computer is directly connected to your StepOne or StepOnePlus instrument by the
yellow cable, no action is necessary. The StepOne software automatically transfers the
experiment data from the instrument to the computer after the run.

Note: In a colocated layout, you can start the run from the computer or from the
instrument touchscreen. However, the StepOne software only transfers the experiment
data automatically when a run is started from the computer (see “Colocated Startup” on
page 82).

If your computer and StepOne or StepOnePlus instrument are connected to the same
Ethernet network, download the experiment from the instrument over the network:

1. In the StepOne software, click &, Download Experiment from Instrument to
open the Download Experiment from Instrument dialog box.
2. From the Select Instrument dropdown menu, select your instrument.
3. From the Experiment dropdown menu, select the example experiment file.
4. In the Download File To field:
a. Click Browse.
b. Navigate to:
<drive>:\Applied Biosystems\<software name>\experiments\
where:
<drive> is the computer hard drive on which the StepOne software is installed.
The default installation drive for the software is the D drive.
<software name> is the current version of the StepOne software.
c. Click Select.
5. Click Download Experiment to download the example experiment file from your
instrument to your computer over the network.
Download Experiment from Instrument
n Selectthe instrument with the experiment, select a location on this computer for the experiment, @}
then click "Download Experiment”
2 + 1. Select Instrument QLocal Instrument {Default) » | Experiment 3
4 I - 2 Download File To; | CMpplied Biosystems\StepOne Software v2.0lexperiments | Browse...
5 ! | Cancel ‘
6. When prompted, click OK to close the confirmation.
Download Complete
(o | 6
Notes
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Standalone If your computer is not connected to your StepOne or StepOnePlus instrument, use the
Data Transfer USB drive to transfer the experiment from the instrument to the computer:

1. Ifnot already connected to the instrument, connect a USB drive to the USB port.

I

2. Touch the StepOne or StepOnePlus instrument touchscreen to awaken it.

Note: If the touchscreen is not at the Main Menu screen, touch @

3. Wait for the USB sign to appear on the touchscreen.

4. Inthe Main Menu, touch Collect Results to save the data to the USB drive.
Note: If your instrument cannot find the USB drive, remove the USB drive, then try

again. If the instrument still does not recognize the USB drive, try another USB
drive.

5. When prompted that the data has been transferred successfully, touch OK.
i‘;;)\?riem]el\;i:' l Settings Menul Tools Menu l Ig:sltzl‘é: l

& Information
RiaseP Wi RESTISLY

Experiment results reacy:
You may remave your USE storage

Shorteu Shorteut
5 oK I 8
@ 2006-11-18 | 2:15 PM '*
<

6. Remove the USB drive from your instrument, then connect it to one of the USB
ports on your computer.

7. In the computer desktop, use the Windows explorer open the USB drive.

Notes
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8. Copy the example experiment file to:
<drive>:\Applied Biosystems\<software name>\experiments\

where:

» <drive> is the computer hard drive on which the StepOne software is installed.
The default installation drive for the software is the D drive.

» <software name> is the current version of the StepOne software.

Notes
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E Analyze the Relative Standard
Curve Experiment

This chapter covers:

B Chapter OVeIVIEW . . . o vt e ettt e e e e e e 98
B Section5.1 Review Results........... .. .. ... ... .. . i .. 99
B Section 5.2 Troubleshoot (If Needed). . ........... ... ... ... ... ..... 121

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne™ Real-Time PCR Software by pressing
F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Notes

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative 97

Standard Curve and Comparative C; Experiments



ﬂ Chapter 5 Analyze the Relative Standard Curve Experiment
Chapter Overview

Chapter Overview

The StepOne"™ software analyzes the data using the relative standard curve quantitation
method. Section 1 of this chapter explains how to review the analyzed data using several
of the analysis screens and how to publish the data. If you receive questionable results,
Section 2 of this chapter explains how to perform some troubleshooting steps.

Note: The relative standard curve example experiment includes four flagged wells. The
flags reflect common problems that you may encounter when performing your own
experiments; procedures are provided for viewing the flags and omitting one of the wells.

Example The workflow for analyzing the example experiment provided with this getting started
Experiment guide is shown below.
Workflow

Relative Standard Curve Experiment
Start Experiment

v

Design the Experiment (Chapter 2)
v

Prepare the Reactions (Chapter 3)

v
Run the Experiment (Chapter 4)

v
Analyze the Experiment (Chapter 5)

Section 1, Review Results:

. Analyze.

. View the standard curve.

View the ampilification plot.

View the gene expression plot/results table.

. Publish the data.

Section 2, Troubleshoot (If Needed):

1. View the analysis settings; adjust the baseline/threshold.

OISR,

. View the quality summary.
Omit wells.

View the multicomponent plot.

o s N

View the raw data plot.

h 4
End Experiment

Notes
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Section 5.1 Review Results

This section covers:

B Analyze the Experiment . .. ........ ... i, 100
B Viewthe Standard Curve .. ........... ... . . 106
B View the Amplification Plot. . ...... ... ... ... ... ... .. ... .. .. . ... 109
B View the Gene Expression Plotand Well Table ... ....................... 116
B PublishtheData ........ .. ... . . . . . . . 119
Notes
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Analyze the Experiment

Analyze the Experiment

Notes

100

About the
Example
Experiment

Analyze the
Example
Experiment

The StepOne software analyzes the experiment and displays results in the analysis
screens (for example, the Amplification Plot screen, QC Summary screen, and so on).

For the relative standard curve example experiment, use the data file that installs with the
StepOne software. The data file was created with the same design parameters provided in
Chapter 2, then run and analyzed on a StepOne™ instrument.

You can find the data file for the example experiment on your computer:

<drive>:\Applied Biosystems\<software name>\experiments\examples\
Relative Standard Curve Example.eds

where:

—

<drive> is the computer hard drive on which the StepOne software is installed. The
default installation drive for the software is the D drive.

<software name> is the current version of the StepOne software.

. Double-click g- (StepOne software) or select Start » All Programs » Applied

Biosystems » StepOne Software » <software name>

where <software name> is the current version of the StepOne software.

In the Login dialog box, select EXAMPLEUSER from the User Name dropdown
menu, then click OK.

Note: EXAMPLEUSER is the user name you created when you designed the
relative standard curve experiment (page 23).

From the Home screen, click Open.

In the Open dialog box, navigate to the examples folder:
<drive>:\Applied Biosystems\<software name>\experiments\examples

Double-click Relative Standard Curve Example to open the example experiment
data file.

Note: The examples folder contains several data files; be sure to select Relative
Standard Curve Example. For information on the other data files, see “Data Files
in the Examples Folder” on page 18.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative

Standard Curve and Comparative C; Experiments



Chapter 5 Analyze the Relative Standard Curve Experiment ﬂ
Analyze the Experiment

File Edit Instrument Analysis Tools Help

.. H j “‘S._—l Send Experiment to Instrument... Fr Download Experiment from Instrument... . &0 B

Analyze

ze Experiment

4 B Lookin: j;.»"-' examples | 6 [ =

£3 aRhiell Comparative CT Example.eds Fresence Absence Example.eds
L.g |2 96-well Genatyping Example.eds Relative Standard Curve Example.eds — === SRR 5
ggci';c:% |23 98-Well Multiplex Exammple.gds ) RMase P Experiment.eds
R — 96-\hell Presence Absence Example.eds Standard Curve Example.eds
aB-Wwiell Relative Standard Curve Example.eds SYBR Example.eds
96-iell RMaseP Experiment eds
Desitap Of-tiell Standard Curve Example eds
—— aB-Well SYBR Example.eds
Cormparative CT Example.ads
Comparative CT Study Bio Replicates Example.edm
Comparative CT Study Example.edm
|3 Genotyping Example.eds
:L)"E | Multiplex Example.eds

My Computer |
— [

My Documents | |

;_3 File name
My MNetwork *
Places Files oftype: a1 SDS Files (adm; eds; edt

* Home

6. Click Analyze. The software analyzes the data using the default analysis settings.

File Edit Instrument Analysis Tools Help

[] New Experiment ~ [ Open.. = Ssave - =) Close JI_‘| Send Experiment to Instrument... Fr Download Experiment from Instrument... &8 Export.. ~ 5 PrintReport...

Experiment Menu4« | Expe... Relative Standard Curve Exal T... Relative Standard Cur Reag... TaqMan® Reagen @
I Setup Amplification Plot <H View Plate Layout | View wel Table |
I ... | i ctort Wt it Camrart s 8 |

7. See “Software Elements” below and “Navigation Tips” on page 104 for information
on navigating within the analysis screens.

Guidelines When you analyze your own relative standard curve experiment:

* Immediately after a run, the StepOne software automatically analyzes the data using
the default analysis settings, then displays the Amplification Plot screen on your
computer.

» To reanalyze the data, select all the wells in the plate layout, then click Analyze.

Software The StepOne software elements for the analysis screens are illustrated below.

Elements . . )
1. Menu bar — Displays the menus available in the software:
* File
« Edit
e Instrument
* Analysis
* Tools
Notes
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* Help

2. Toolbar — Displays the tools available in the software:
* New Experiment
* Open
* Save
* Close
* Send Experiment to Instrument
* Download Experiment from Instrument
* Export
* Print Report

3. Experiment header - Displays the experiment name, experiment type, and reagents
for the open experiment.

4. Experiment Menu pane — Provides links to the following software screens:
* Setup screens
* Run screens
* Analysis screens:
* Amplification Plot
+ Standard Curve
* Gene Expression
* Multicomponent Plot
* Raw Data Plot
* QC Summary
* Multiple Plots View

5. Plot pane — Displays the selected analysis screen for the open experiment.
6. View tabs — Displays the plate layout or Well Table for the open experiment

7. Experiment tab(s) — Displays a tab for each open experiment.

Notes
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1 File Edit Instrument Analysis Tools Help
2 [E] New Experiment ~ (55 Open.. [d Save - £ Close ’IJ_‘| Send Experiment to Instument.. 0, Download Experimentfam Instument.. | 8 Export. ~ £ PrintReport.
. @
Amplification Plot <[ View Plate Layout | View Wel Table |
Plot Settings > Select Wells With: |- Select tem - v | |
Plot Type:[aRn vs Cycle v Graph Type:[Linear | Plot Color: well v ‘
| Elsvmwmwp.\ls v View Legend | ‘ |
» P & =
L 1 2 3 4 i B T 8
Amplifi Plot " n
L/ L 3 Amplification Plot
[ e-mye [ e-mye [ e-mye | [ sapor [ caPot [ Gapot g ?;'m’“ g 3“'"“’“
Standard Curve :Z A | T Undef CT: Undef CT: Undef CT: Undei CT: Undet CT: Undet cr 7. 1 Cr 27 1
4 45
5 [ c-mye [ car... [ car.. [ ear.. [ cmye [Ic-mye [[c-mye [1] car
GBIIBEXD[BSSI(\II 42 B 793 L4918 925 948 475 - 481 . 485 41931
28 CT.28... ) CT:24.66 Ct. 24.65 CT. 24.61/ CT: 28.... / CT:28... / CT. 28.. / CT: 24.64
. Multicomponent Plot & a4
28 M car.. [ err.. [Hemye Hem. Hempe Eemye Home B omye
20 ¢ |9.08 8.88 200 - 200 . 200 420 420 420 ]
. Raw Data Plot 16 CT:24.68 C1:24.71 C1:23.. / CT:23.3 / CT: 23... /CT: 26..../ CT: 26.. /.CT: 26....
10
05 1 Homye Heome Eemye Eome Eeme 1 1
QC Summary = o |EHemye 2 12 {02 {02 {02 Hem. Hempe
2 +CT:29../CT29.. /CT33../Cr33../CT33../ po2 S 002
e ) IR EEEEEEEEEEEEEEEERE
LIRS A Cyele 1 E ear.. [ ear.. [ car.. [ ear.. [ ear.. [ car.. [ ear
Legend El: w200 200 200 20 20 20 2
{ A B - c - D - E - F | 0.02 +CTm:20.03 CT:20 CT:19.98/.CT: 23.59/.CT: 23.56/\CT: 23.56/.CT: 26.95
Options [ ear.. [ ear.. [ car.. [ ear.. [ ear.. [ car.. [ ear.. [ car
Fl2 2 02 02 02 002 002 002
Target: |All "‘ Threshold: i i C1:26.95 C1:26.95 C1:30.41 C1:30.36 C1:30.38 CT:33.71 C1:33.83 CT:33.78
Shi Threshold — [ | Baseline Start: Well B T: ta B line End: Well [l
B.% [Tl | JIEEREE i 5T s M Wells 12 Unknown [5] 30 Standard [] 6 Negative Control 0 Empty
& | Analysis Summary:  Total Wells in Plate: 4t Wells SetUp:48  Wells Omitted Manually: 0 Wells Flagged: 4 Wells Omitted by Analysis:0  Samples Used: 2 Targets Used: 2
7 ﬂ ‘-‘-:-‘“-:( [i] Relative Stan..ve Example.eds x)
Notes
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Analyze the Experiment

Navigation Tips How to Select Wells

To display specific wells in the analysis screens, select the wells in the View Plate Layout
tab as follows:

1.

To select wells of a specific type, use the Select Wells With dropdown menus: Select
Sample, Target, or Task, then select the sample, target, or task name.

To select a single well, click the well in the plate layout.

To select multiple wells, click and drag over the desired wells, press CTRL+click,
or press Shift+click in the plate layout.

4. To select all 48 wells, click the upper left corner of the plate layout.
View Plate Layout | View Well Table | \ — 1
i T
Select Wells With: |Sample v || selectitem -
| [ show in Wells ¥ | ] View Legend Liver | |
Kidney
4 ! i 2 3 4 5 5 7 5
D c-myc D c-myc D c-mye D GAPDH D GAPDH D GAPDH ;'mw o
A CT: Undetermined CT: Undetermined C1. Undetermined CT: Undetermined CT: Undetermined C1. Undetermined
CT. 2789 Cr.27.96
c-myc GAPDH GAPDH GAPDH c-myc c-myc c-myc GAPDH
N EE ERE 9.25 9,48 475 481 485 9.3t
CT. 28,02 CT: 24.66 CT 2465 CT: 24 61 Cr:26.74 CT 2873 CT. 28,71 CT: 24.64
GAPDH GAPDH Bl e-mye E c-mye [ e-mye Bl e-mye E c-mye [ e-mye
cla0s 8.88 200 200 200 20 20 0
CT. 24,68 CT: 24.71 CT 23.35 CcT.233 CT:23.35 CT. 26.64 CT. 26.71 CT:26.85
1 = emye EHeme SE = emye EHeme 1 1
o [l 2 2 02 0.2 02 ! )
|2jc " Cr.20.95 Cr 2995 CT 3316 Cr33.63 Cr 3359 lﬂ; " lﬂ; .
1 D GAPDH E GAPDH D GAPDH D GAPDH E GAPDH D GAPDH D GAPDH
EE cmye 200 200 200 0 20 20 2
0.02 CT:20.03 cT 20 CT19.98 CT:23.59 CT 2356 CT. 2356 CT: 26,95
=] caroH [E] earon ST [E] zaron [E] earon ST [E] zaron [E] earon
F 2 2 0.2 02 0.2 0.02 0.02 0.02
CT. 26,95 CT:26.95 CT. 3041 CT. 30,36 CT:30.38 CT. 3371 CT.33.83 CT:33.78
wells: [l 12 Unknown [£] 30 Standard [1] 6 MNegative Control 0 Emply
Notes
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How To Display Multiple Plots

Use the Multiple Plots view to display up to four plots simultaneously. To navigate within
the Multiple Plots view:

1. From the Experiment Menu pane, select Analysis » |£%| Multiple Plots View.

To display four plots, click 75 Show plots in a 2 X 2 matrix.

To display two plots in columns, click [|[| Show plots in two columns.

2.
3. To display two plots in rows, click = Show plots in two rows.
4.
5.

To display a specific plot, select the plot from the dropdown menu above each plot

display.
5 2 83
T N B
=1 —
I
[mpiification Piot - ARnvs Cycle v [ampiification Piot - Rnvs Cycle |
AP ey I= £ P &g =

Amplification Plot

Amplification Plot

]

Cycla

- cllcilclN: -

[ Legend

Banurre

Cycla

EA s llc o : -

{ Legend

[mplification Piot - Crvs Well Number |

AP iy B =
Amplification Plot

aaaaaaa
- =T A
s0 “e e
-- -—v= -
-----
&

- cllcilclN: -

[ Legend

|Gene Expression Plot

]

15
=]
g 10

a5

RQ vs Target

i &

s

Target

Notes
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View the Standard Curve

About the
Example
Experiment

View the
Standard Curve

Notes

The Standard Curve screen displays the standard curve for samples designated as
standards. The StepOne software calculates the quantity of an unknown target from the
standard curve.

In the relative standard curve example experiment, you review the Standard Curve screen
for the following values:

L]

Slope/amplification efficiency
R? value (correlation coefficient)

C; values

. From the Experiment Menu pane, select Analysis » Standard Curve.

Note: If no data are displayed, click Analyze.

Display all 48 wells in the Standard Curve screen by clicking the upper left corner of
the plate layout in the View Plate Layout tab.
From the Target dropdown menu, select All (default).

From the Plot Color dropdown menu, select Default.

Click = Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

View the values displayed below the standard curve. In the example experiment, the
values for each target fall within the acceptable ranges:

Amplification

2
Target Slope R“ Value Efficiency (Eff%)
GAPDH -3.435 1 95.477
c-myc -3.233 0.995 103.841

Check that all samples are within the standard curve. In the example experiment, all
samples (blue dots) are within the standard curve (red dots).

106 Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative

Standard Curve and Comparative C; Experiments



Chapter 5 Analyze the Relative Standard Curve Experiment ﬂ
View the Standard Curve

3 4
(e I
Plot i ‘ ‘
Target Al | PiatCalor [Defautt | |
B g = S
Standard Curve
325 7
o001 0.0z a1 0z 1 Eng (Qiual:ht;) 10 20 50 100 200 100C
6 Target; GAPDH Slope; -3.435 Ynter; 27.97 ﬂz: 1 Effte: 95477
Target; c-myc Slope; -3.233 Y.nter; 30.931 ﬂz: 0.995 EM: 103.841
Legend
{. standard [l Unknown Bl Unknown (Flagged)
8. Check the C; values:
a. Click the View Well Table tab.
b. From the Group By dropdown menu, select Replicate.
c. Look at the values in the C; column. In the example experiment, the C; values
fall within the expected range (>8 and <35).
Note: The C; values for wells D7, D8, and E1 are >35 due to a low amount of
target. The wells do not need to be removed from the analysis.
Notes
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8a
Wiew Plate Layout | View Well Table ]
8b SelectWells With: - Select tem - v
| Show in Table ¥ | Group By ¥ | Expand Al Gollapse All
: 8c
# | Well Omit Flag Sample Na Target Name | Task Dyes cr Ct Mean CtsD Quantity MNormaliz. MNormaliz.
= GAPTH - NTC ~
1 Ad O GAPDH NTC FAM-WFQ-MGB Undetermi
2 A5 O GAPDH NTC FAM-WFQ-MGB Undetermi
3 A8 O GAPDH NTC FAM-WFQ-MGB Undetermi
= GAPTH - STANCARD - 0.02
4 F6 O GAPDH STANDARD  FAM-MFQ-MGE 33705063 3377124 0.064 0.02
5 F7 O GAPDH STANDARD  FAM-MFQ-MGE 33.83324 3377124 0.064 0.02
8 Fe O GAPDH STANDARD ~ FAM-MFQ-MGE 33775414 3377124 0.064 0.02
= GAPTH - STANCARD - 0.2
7 F3 O GAPDH STANDARD  FAM-MFQ-MGE 30400830 30.385414 0.023 0.2
8 Fé O GAPDH STANDARD  FAM-MFQ-MGE 30.363256 30.385414 0.023 0.2
] F5 O GAPDH STANDARD  FAM-MFQ-MGE 30.383087 30.385414 0.023 0.2
= GAPTH - STANCARD - 2.0
10 E8 O GAPDH STANDARD  FAM-MFQ-MGE 26948175 26.950138 0.004 2
1 F1 O GAPDH STANDARD  FAM-MFQ-MGE 26947723 26.950138 0.004 2
12 F2 O GAPDH STANDARD  FAM-MFQ-MGE 26954515 26.950138 0.004 2
= GAPTH - STANCARD - 20.0
13 ES O GAPDH STANDARD  FAM-MFQ-MGE 23587563 23567474 0.017 20
14 EB O GAPDH STANDARD  FAM-MFQ-MGE 23557608 23567474 0.017 20
15 ET O GAPDH STANDARD ~ FAM-MFQ-MGE 23557253 23567474 0.017 20
= GAPTH - STANCART - 200.0
16 E2 O GAPDH STANDARD  FAM-WFQ-MGE 20028923 20.003408 0.025 200 a
o = = coeooo  cococc ecncen coon oo e ——— g -
< >

Analysis When you analyze your own relative standard curve experiment, look for:

Guidelines * Slope/amplification efficiency values — The amplification efficiency is calculated
using the slope of the regression line in the standard curve. A slope close to —3.3
indicates optimal, 100% PCR amplification efficiency. Factors that affect
amplification efficiency:

— Range of standard quantities — For more accurate and precise efficiency
measurements, use a broad range of standard quantities, 5 to 6 logs
(10° to 10° fold).

— Number of standard replicates — For more accurate efficiency measurements,
include replicates to decrease the effects of pipetting inaccuracies.

— PCR inhibitors — PCR inhibitors in the reaction can reduce amplification
efficiency.

» R? values (correlation coefficient) — The R? value is a measure of the closeness of
fit between the regression line and the individual C; data points of the standard
reactions. A value of 1.00 indicates a perfect fit between the regression line and the
data points. An R? value >0.99 is desirable.

* C; values — The threshold cycle (C;) is the PCR cycle number at which the
fluorescence level meets the threshold. A C; value >8 and <35 is desirable. A C;
value <8 indicates that there is too much template in the reaction. A Cy value >35
indicates a low amount of target in the reaction; for C values >35, expect a higher
standard deviation.

If your experiment does not meet the guidelines above, troubleshoot as follows:
* Omit wells (see “Omit Wells from the Analysis” on page 126).
Or

* Rerun the experiment.

Notes
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View the Amplification Plot

For More For more information on:

Information * The Standard Curve screen, access the StepOne Software Help by clicking @) or

pressing F1.

+ Amplification efficiency, refer to the Amplification Efficiency of TagMan® Gene
Expression Assays Application Note.

View the Amplification Plot

The Amplification Plot screen displays amplification of all samples in the selected wells.
There are three plots available:

* ARn vs Cycle — ARn is the magnitude of normalized fluorescence signal generated
by the reporter at each cycle during the PCR amplification. This plot displays ARn
as a function of cycle number. You can use this plot to identify and examine
irregular amplification and to view threshold and baseline values for the run.

* Rn vs Cycle — Rn is the fluorescence signal from the reporter dye normalized to the
fluorescence signal from the passive reference. This plot displays Rn as a function
of cycle number. You can use this plot to identify and examine irregular
amplification.

* Cpvs Well — C; is the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot. This plot displays Cy as a function of well
position. You can use this plot to locate outlying amplification (outliers).

Each plot can be viewed as the following graph types: linear or log10.

About the In the relative standard curve example experiment, you review each target in the
Example Amplification Plot screen for:

Experiment e Correct baseline and threshold values

e Qutliers

View the 1. From the Experiment Menu pane, select Analysis » Amplification Plot.
Amplification Plot
Note: If no data are displayed, click Analyze.

2. Display the GAPDH wells in the Amplification Plot screen:
a. Click the View Plate Layout tab.
b. From the Select Wells With dropdown menus, select Target, then GAPDH.

Notes
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View the Amplification Plot

2a

Notes

110

View Plate LayoutT View well Table ] 2b
SelectWells With: |Target V| |GAF‘DH ~
| @ showinwells ¥ | [ view Lagend ‘ |
1 2 3 4 5 6 7 8 [
[ emye [ o-mye [ e-mye [L] caPDH [ sapoH [ saPoH E;-mw E o
A | C1 Undetermined CT1: Undetermined Ct: Undetermined C1. Undetermined CT1: Undetermined CT: Undetermined y )
CT.27.89 CT 27.96
M emye GAPDH GAPDH [ caroH o-mye o-mye M emye GAPDH
B|7.93 519 625 9.48 475 481 485 9.3
CT1:28.02 CT. 24 66 Cr: 24,865 C1 2481 Cr 2874 Cr 2873 Cr 2871 CT 24 64
[ saroH GAPDH E o-mye EHemye E c-mye E e-mye EHemye E c-mye
c |9.06 8.88 200 200 200 20 20 20
C1: 24 88 Cr2471 Cr1:23.35 C1: 233 CT 2335 Cr: 26.64 C1 2671 CT 26.85
1 EH e-mye Hemye Hemye EH e-mye Hemye 1 1
o|Heme 2 2 0.2 02 0.2 [ . e
5 CT-29.95 CT:29.95 CT 3316 CT 3363 CT:33.59 002 002
1 =] caroH [E] earon ST [E] zaron [E] earon ST [E] zaron
E Ec.mw 200 200 200 20 20 20 2
0.02 CT: 2003 Cr:20 CT.19.98 CT. 2358 Cr:23.56 CT. 23.56 CT.26.95
[ caroH | sapon [ sapoH [ caroH | sapon [ sapoH [ caroH | sapon
2 2 0.2 0.2 0.2 0.02 0.02 0.02
CT1: 26.95 CT 26.95 Cr30.41 CT1:30.36 CT 3038 Cr3371 CT1:33.83 CT 3378
wells: [ 12 Unknown [5] 30 Standard [ 6 Negative Control 0 Empty

3. Inthe Amplification Plot screen:

a. From the Plot Type dropdown menu, select ARn vs Cycle (default).
b. From the Plot Color dropdown menu, select Well (default).
c. Click *= Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes
to Hide the plot legend.

4. View the baseline values:

a. From the Graph Type dropdown menu, select Linear.

b. Select the Baseline checkbox to show the start cycle and end cycle.

c. Verify that the baseline is set correctly: The end cycle should be set a few

cycles before the cycle number where significant fluorescent signal is detected.
In the example experiment, the baseline is set correctly.
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View the Amplification Plot

3a 4a 3b

Plot
| |
Plot Type:|ARN vs Cycle v—| Graph Type:|Linear v | Plot Color:well A
PR B = 3c

Amplification Plot

5.5
5.0
4.5
4.0
3.5
3.0
2.5
2.0
1.5
1.0
0.5

ARn

0.0 —r

’— Legend

AN o I c o I c:F
Options

Show: [] Threshold — I_T_l

Well B Target <« Baseline End: Well ‘M Target 4.

4b
5. View the threshold values:
a. From the Graph Type dropdown menu, select Log.
b. From the Target dropdown menu, select GAPDH.
c. Select the Threshold checkbox to show the threshold.
d. Verify that the threshold is set correctly. In the example experiment, the
threshold is in the exponential phase.
5a
T
Plot il ‘
PlotType:‘Aans Cycle v| GraphType:|Lng \"| PIotCoIor ‘
£ p By =
Amplification Plot
1 L.461128
g 0.001 /§§ % :YK//\
: o 2 4 & 8 10 12 14 16 18 ZOCyDIEZZ 24 28 28 50 52 34 38 38 40 a2
Legend
{ A slcilcEl:r
"Options
5b Target Threshu\d [#] Auto l:l
Show. @Threshnld— Baseline Start: Well B Target <. Baseline End: Well "M Target 4~
50— t—
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View the Amplification Plot

6. Locate any outliers:
a. From the Plot Type dropdown menu, select Cy vs Well.

b. Look for outliers from the amplification plot. In the example experiment, there
are no outliers for GAPDH.

6a

Plot i
Plot Type:|C1vs Well + | Graph Type Plot Color: \wWell A ‘

P paREE

Amplification Plot

40.0 *ae
a7.5
35.0
az.5
30.0 v
27.5 -
25.0 -w
22.5
20.0 -+ a
17.5
15.0
12.5
10.0
75
5.0
25
0o

2 a & B 10 1z 14 16 18 20 22 24 26 28 30 3z a4 36 38 40 42 44 46 48
Well Number

AlleNcilcIN:INr

’— Legend

7. Repeat steps 2 through 6 for the c-myc wells. In the example experiment, there is
one outlier for c-myc (well D1). You will omit this well in the troubleshooting
section (“Omit Wells from the Analysis” on page 126).

Analysis When you analyze your own relative standard curve experiment, look for:

Guidelines « Outliers

* A typical amplification plot — The StepOne software automatically calculates
baseline and threshold values based on the assumption that the data exhibit a #ypical
amplification plot. A typical amplification plot has four distinct sections:

a. Plateau phase
b. Linear phase
c. Exponential (geometric phase)

d. Baseline

Notes
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View the Amplification Plot

0210658
Threshold

0.1

ARnNn

0.01

0.001

- .l-: ':; Zi "'IFH T ry.lllu
/Y A hid i A I~

02r_Ea1012|1¢1ﬁ1ﬁm”kﬂﬂ“1‘9t““m0d

Cycle

0.0001

IMPORTANT! Experimental error (such as contamination or pipetting errors) can
produce atypical amplification curves that can result in incorrect baseline and
threshold value calculations by the StepOne software. Therefore, Applied
Biosystems recommends that you examine the Amplification Plot screen and review
the assigned baseline and threshold values for each well after analysis completes.

* Correct baseline and threshold values — See the threshold examples on page 114 and
the baseline examples on page 115.

Notes

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative 113

Standard Curve and Comparative C; Experiments



E Chapter 5 Analyze the Relative Standard Curve Experiment

View the Amplification Plot

Threshold Set Correctly

The threshold is set in the exponential phase of the
amplification curve.

Threshold settings above or below the optimum
increase the standard deviation of the replicate
groups.

Task Dyas (54 T Mean (58-I Quantey Quantey Quantey Commi
NTC FAMENFG-.. Uniseteami_

NTC FAMENFO-. Unidetedmi..

NTC FAM-HFG-.. Undsisimi..

UNFMOWN FAMKNFO-.. 2896287 28923796 0074 248431 2551476 1262

UNFMOWH  FAN-HFGO:. .
URFMOWN  FAM-NFG-..

20838787
20.04972

20.923706
20.923708

0.074  2887.084
0074 24TI084

2551478 1282
2551478 182

Threshold Set Too Low

The threshold is set below the exponential phase of
the amplification curve. The standard deviation is
significantly higher than that for a plot where the
threshold is set correctly. Drag the threshold bar up
into the exponential phase of the curve.

Task Dyes cr CrMean  CTS0 Quarlly  Ouartly.. Ouanidy
HTC FAM-HFC-. Undstedni.

HTC FAM-NFQ-... Undstsimi..

NTC FAM-HFG-.. 38453182

UNKMNOWH FAM-NFO-.. 2285404 22761744 0252 2314852 2472483 400435
UNKMNOWN FAM-NFG-. 22478873 22781744 0282 2827732 2472483 400,435
URENOWH  FAMNFG-.. 22054218 22781744 0252 2AT4MIE  24T2483 400435

Threshold Set Too High

The threshold is set above the exponential phase of
the amplification curve. The standard deviation is
significantly higher than that for a plot where the
threshold is set correctly. Drag the threshold bar
down into the exponential phase of the curve.

Task Dyas cr Cr Mean CreD Quamtsy Quuamtsy Quaamtsy Commag
NTC FAM-NFG-.. Undatermi_

HTC FAN-NFQ- Unistedmi..

TG FAM-HFO-.. Undslsimi.,

UNKNOWH FAM-NFO-. 37681107 3749507 0202 25T1A77 2880429 353775
UNKNOWH  FAM-NFG-. 3727571 3748407 0202 3260833 2880429 353778
URENOWH  FAM-NFG-.. 37.524385 3748507 0202 2824187 28RBS I[ATIS

0.242796.

0.1

ARn

o1

ARn

L.754743

"_."
| ."'I.l ;
A ."f;.: :
s ) / .l
1 AN
K [ A
L AAL Tl A A
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View the Amplification Plot

Baseline Set Correctly

The amplification curve begins after the maximum ’
baseline. i/

Baseline Set Too Low

The amplification curve begins too far to the right 7
of the maximum baseline. Increase the End Cycle . 77 /)
value. i, Y

Baseline Set Too High

The amplification curve begins before the Y,
maximum baseline. Decrease the End Cycle value. 7

If your experiment does not meet the guidelines above, troubleshoot as follows:
* Omit wells (see “Omit Wells from the Analysis” on page 126).
Or

* Manually adjust the baseline and/or threshold (see “View the Analysis Settings” on
page 122).

For More For more information on the Amplification Plot screen, access the StepOne Software
Information  Help by clicking @) or pressing F1.

Notes
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View the Gene Expression Plot and Well Table

View the Gene Expression Plot and Well Table

The Gene Expression Plot screen displays the results of relative quantitation calculations
in the gene expression profile. There are two plots available:

* RQ vs Target — Groups the relative quantitation (RQ) values by target. Each sample
is plotted for each target. You can view the plot as the following graph types: linear,
log10, Ln, log2.

RQ vs Target

2781
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* RQ vs Sample — Groups the relative quantitation (RQ) values by sample. Each
target is plotted for each sample. You can view the plot as the following graph types:
linear, log10, Ln, log2.

R vs Sample

=
2w |
Tact
188}
1
(T
ras
ez}
o
oo |
o L

Fa o iy -

kgl RO
L]

B

8

r Legera
M cosnio I srars W s

The Well Table displays data for each well in the reaction plate, including:
* The sample name, target name, task, and dyes
* The calculated threshold cycle (C;), normalized fluorescence (Rn), and quantity

values
* Flags
Notes
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View the Gene Expression Plot and Well Table

About the In the relative standard curve example experiment, you review:
Example .

A Each target in the Gene Expression Plot screen for the expression level (or fold
Experiment

change) of the target sample relative to the reference sample.
» The Well Table to evaluate the precision of the replicate groups.

View the Gene 1. From the Experiment Menu pane, select Analysis » Gene Expression.
Expression Plot
and Well Table Note: If no data are displayed, click Analyze.

2. In the Gene Expression Plot screen:
a. From the Plot Type dropdown menu, select RQ vs Sample.
b. From the Graph Type dropdown menu, select Log10.

c. From the Orientation dropdown menu, select Vertical Bars.

3. Click = Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

In the example experiment, the expression level of c-myc in liver is displayed
relative to its expression level in the reference sample (kidney). Since the reference
sample is compared to itself, the relative expression level is 1. When the result is
displayed in the Log10 graph type, the expression level of the reference sample
appears as 0 in the graph (log10 of 1 = 0).

2a 2b 2c

Plot Type: |RQ vs Sample | Graph Type: [Log10 ~ Orientation: [Vertical Bars &
ah e E 3c
RQ vs Sample

0.250

0.225

0.200

0175

g 0.150

2 o128

- 0.100

0.075

0.050

0.025

0.000

\f‘é *_gs‘@
Sample
4. View the Well Table:
Notes
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View the Gene Expression Plot and Well Table

a. From the Experiment Menu pane, select Analysis » Amplification Plot,
then select the View Well Table tab.

b. From the Group By dropdown menu, select Replicate.

c. Look at the C; SD column to evaluate the precision of the replicate groups. In
the example experiment, there is one outlier (well D1). You will omit this well
in the troubleshooting section (“Omit Wells from the Analysis” on page 126).

4a

View Plate Layout | View Well Table ]

4b Select Wells With: - Select ftem-
| Show in Table ¥ | Group By v—| Expand Al Gollapse All
' I 4c
# | Well Omit Flag Sample Ma. Target Mame = Task Dyes Cr CT Mean CT5D Quantity Normaliz. Normaliz.
o At i iy e AT L s e
32 A2 ] c-myc NTC FAM-MNFQ-MGE LUndetermi
33 A3 O c-myc NTC FAM-MNFQ-MGE Undetermi
= c-myc - STANCARL - 0.02
34 o7 O 1 c-mye STANDARD FAM-NFQ-MGE 35704887 36.135754 0.532 0.02
35 D8 ] 1 c-myc STANDARD FAM-MNFQ-MGB 36.7307 36.135754 0.532 0.02
36 E1 O 1 c-myc STANDARD FAM-NFQ-MGB 3597167 36.135754 0.532 0.02
= c-myc - STANCARL - 0.2
37 D4 O c-mye STANDARD FAM-NFQ-MGBE 33.16362 33.450904 0.257 0.2
38 D5 ] c-myc STANDARD FAM-MNFQ-MGE 33.629368 33.450904 0.257 0.2
39 D6 O c-myc STANDARD FAM-NFQ-MGE 33.586723 33.450904 0.257 0.2
= c-myc - STANCARL - 2.0
4C —— o1 O 1 c-mye STANDARD FAM-NFQ-MGE 30.474045 30.127508 03 2
41 D2 ] c-myc STANDARD FAM-NFQ-MGBE 29.954172 30.127508 03 2
42 D3 O c-myc STANDARD FAM-NFQ-MGE 29.854302 30.127508 03 2
= c-mye - STANCARLD - 20.0
43 Cce O c-mye STANDARD FAM-NFQ-MGE 26.639078 26.732008 0.108 20
44 c7 ] c-myc STANDARD FAM-MNFQ-MGB 26.705336 26.732008 0.108 20
45 c8 O c-myc STANDARD FAM-NFQ-MGE 26.851606 26.732008 0.108 20
= c-mye - STANCARL - 200.0
46 Cc3 O c-mye STANDARD FAM-NFQ-MGBE 23.350729 23.333328 0.026 200
a7 Cca ] c-myc STANDARD FAM-MNFQ-MGE 23.304045 23.333328 0.026 200
48 Ccs O c-myc STANDARD FAM-NFQ-MGB 23.345207 23.333328 0.026 200 v
< ¥

Note: To show/hide columns in the Well Table, select/deselect the column name from the
Show in Table dropdown menu.

Analysis When you analyze your own relative standard curve experiment, look for:

Guidelines  Differences in gene expression (as a fold change) relative to the reference sample.

+ Standard deviation in the replicate groups (C SD values). If needed, omit outliers
(“Omit Wells from the Analysis” on page 126).

For More For more information on the Gene Expression Plot screen or Well Table, access the
Information  StepOne Software Help by clicking g) or pressing F1.

Notes
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Publish the Data

Publish the Data

You can publish the experiment data in several ways:
» Save the plot as an image file
* Print the plot
* Print the plate layout
* Create slides
* Print a report
* Export data

For information on performing these procedures, access the StepOne Software Help by
clicking @) or pressing F1.

Notes
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Notes
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Section 5.2 Troubleshoot (If Needed)

This section covers:

B View the Analysis Settings . .. ...ttt 122
B View the QC SUMMATIY. . . ..ottt ettt e e e e e e e e 124
B Omit Wells from the Analysis. . ........ ... ..., 126
B View the Multicomponent Plot. .. ........ ... ... .. ... ... ... .. ... 128
M Viewthe Raw DataPlot ... ........ ... .. .. .. . . . . . . . . . . .. 130
Notes
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View the Analysis Settings

View the Analysis Settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle
(Cy), flags, relative quantitation, and advanced options. If the default analysis settings in
the StepOne software are not suitable for your experiment, you can change the settings in
the Analysis Settings dialog box, then reanalyze your experiment.

About the In the relative standard curve example experiment, the default analysis settings are used
Example without changes.
Experiment

View the Analysis 1. From the Experiment Menu pane, select Analysis.

Settings
2. Click Analysis Settings to open the Analysis Settings dialog box.
3. In the example experiment, the default analysis settings are used for each tab:
* C; Settings
* Flag Settings
» Relative Quantitation Settings
* Advanced Settings
£ Analysis Settings for Relative Standard Curve Example
\__QI___ﬁggjn_g_ﬁ__| Flag Settings I Relative Quantitation Settings I Advanced Settings l
a Review the default settings for analysis of targets in this experiment. To editthe default settings, click "Edit Default Settings.” To use different settings
for atarget, selectthe target from the table, deselectthe "Use Default Settings” checkhox, then change the settings that are displayed.
Default C1 Settings
Default CT settings are used to calculate the CT for targets without custom settings. To edit the default settings, click "Edit Default Settings "
Threshold: AUTO Baseline Start Cycle: AUTO Baseline End Cycle: AUTO ‘ Edit Default Settings
Select a Target Cr1 Settings for c-myc
Target Threshaold Baseline Start Baseline End 7 Settings to Use: Use Default Settings
c-myc AUTO lAUTO AUTO e
GAPDH AUTO IAUTO AUTO I:l
==] [E:]
~
Revert to Original Analysis Seftings ‘ Apply Analysis Seftings | Cancel
Notes
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View the Analysis Settings

Analysis Unless you have already determined the optimal settings for your experiment, use the
Guidelines default analysis settings in the StepOne software. If the default settings are not suitable
for your experiment, you can change the:

* C; Settings — Use this tab to manually set the threshold and baseline. When
manually setting the threshold and baseline, Applied Biosystems recommends the

following:
Setting Recommendation
Threshold Enter a value for the threshold so that the threshold is:
¢ Above the background.
¢ Below the plateau and linear regions of the amplification curve.
e Within the exponential phase of the amplification curve.
Baseline Select the Start Cycle and End Cycle values so that the baseline

ends before significant fluorescent signal is detected.

* Flag Settings — Use this tab to:
— Adjust the sensitivity so that more wells or fewer wells are flagged.
— Change the flags that are applied by the StepOne software.

* Relative Quantitation Settings — Use this tab to:
— Change the reference sample and/or endogenous control.

— Select the algorithm to use to determine RQ Min/Max values (confidence level or
standard deviations).

* Advanced Settings — Use this tab to change baseline settings well by well.

For More For more information on the analysis settings, access the StepOne Software Help by
Information pressing F1 when the Analysis Settings dialog box is open.

Notes
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View the QC Summary

The QC Summary screen displays a list of the StepOne software flags, and includes the
flag frequency and location for the open experiment.

About the In the relative standard curve example experiment, you review the QC Summary screen
Example for any flags triggered by the experiment data:

Experiment * Wells D7, D8, and E1 produced data that triggered the HIGHSD flag.
* Well D1 produced data that triggered the OUTLIERRG flag.

View the QC 1. From the Experiment Menu pane, select Analysis » | o| QC Summary.

Summary
Note: If no data are displayed, click Analyze.

2. Review the Flags Summary. In the example experiment, there are 4 flagged wells.

3. In the Flag Details table, look in the Frequency and Wells columns to determine
which flags appear in the experiment. In the example experiment:

* The HIGHSD flag appears 3 times, in wells D7, D8, and E1.
* The OUTLIERRG flag appears 1 time, in well D1.

Note: A 0 displayed in the Frequency column indicates that the flag does not appear
in the experiment.

4. For each flag that appears in the experiment, click the flag row to display detailed
information about the flag. In the example experiment:

a. The HIGHSD flag (wells D7, D8, and E1) indicates high standard deviation in
the replicate group. This is expected for C values >35 due to a low amount of
target. The wells do not need to be removed from the analysis.

b. The OUTLIERRG flag (well D1) indicates an outlier in replicate group.
Proceed to “Omit Wells from the Analysis” on page 126 to remove well D1.

Notes
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View the QC Summary

Qc summary

Flag v
Total Wells: 48 | Processed Wells. 48 | Targets Used 2
Wells Set Lip 48 | Flagged Wells 4 Samples Used 2 ‘
‘ 2
\
Flag: Mame Frequency Wells
AMPNC Amplification in negative control 0 ~
BADROX Bad passive reference signal 0
OFFSCALE Fluorescence is offscale 0
HIGHSD High standard deviation in replicate group 3 D7, D8, E1
NOAMP Mo amplification 0
NOISE Moise higher than others in plate 0
SPIKE Noise spikes 0
MNOSIGNAL Mo signal in well 0
4 OUTLIERRG Qutlier in replicate group 1 D1
EXPFAIL Exponential algorithm failed 0 )

Flag: OUTLIERRG—Cutlier in replicate group
Flag Detail: The CT deviates significantly from C1 values in the associated

replicate group
Flagged Wells: D1

View OUTLIERRG Troubleshoating Information

Possible Flags

experiment data.

For relative standard curve experiments, the flags listed below may be triggered by the

If a flag does not appear in the experiment, its frequency is 0. If the frequency is >0, the
flag appears somewhere in the experiment; the well position is listed in the Wells column.

Flag Description
AMPNC ' Amplification in negative control
BADROX ' Bad passive reference signal
BLFAIL ' Baseline algorithm failed
CTFAIL C; algorithm failed
EXPFAIL Exponential algorithm failed
HIGHSD High standard deviation in replicate group
MTP ' Multiple Tm peaks
Note: This flag is only displayed if the experiment
includes a melt curve.
NOAMP " No amplification
NOISE " Noise higher than others in plate
NOSIGNAL ' No signal in well
OFFSCALE Fluorescence is offscale
OUTLIERRG Outlier in replicate group
SPIKE Noise spikes
THOLDFAIL ' Thresholding algorithm failed
Notes
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Omit Wells from the Analysis

Analysis When you analyze your own relative standard curve experiment:

Guidelines . (lick each flag in the Flag Details table with a frequency >0 to display detailed
information about the flag. If needed, click the troubleshooting link to view
information on correcting the flag.

* You can change the flag settings:
— Adjust the sensitivity so that more wells or fewer wells are flagged.
— Change the flags that are applied by the StepOne software.

For More For more information on the QC Summary screen or on flag settings, access the StepOne
Information  Software Help by clicking ) or pressing F1.

Omit Wells from the Analysis

Experimental error may cause some wells to be amplified insufficiently or not at all.
These wells typically produce C; values that differ significantly from the average for the
associated replicate wells. If included in the calculations, these outliers can result in
erroneous measurements; to ensure precision, omit the outliers from the analysis.

About the In the relative standard curve example experiment, you use the Well Table to remove well
Example DI from the analysis. Well D1 is flagged with the OUTLIERRG flag (see “View the QC
Experiment Summary” on page 124).

Omit Wells 1. From the Experiment Menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. In the Amplification Plot screen, select Cy vs Well from the Plot Type dropdown
menu.

3. Select the View Well Table tab.

4. Inthe Well Table:
a. From the Group By dropdown menu, select Replicate.

b. Look for any outliers in the replicate group (be sure they are flagged). In the
example experiment, well D1 is an outlier.

c. Select the Omit checkbox next to well D1.

Notes
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Omit Wells from the Analysis

Notes

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative

Amplification Plot <| WView Plate Layout | View Well Table
Plot Seti > SelectWells with: - Selectitem - v | |
PIotTvpe:|c-rvsWe|| v| Grapthpe| ‘ Plotcmor:‘wgu vl i | = = 4a
| [ show nTasie v | eroupsy v | | 5 Expana an | B colapse an |
!
PP B
# | well omit | Flag Sample Na TargetMame = Task
Amplification Plot o n = e e
32 A2 ™ | c-myc NTC
00 reVmeh 33 A3 ™ | c-myc NTC
s . = c-myc - STANDART - 0.02
350 i L4 e 34 o7 [ F t-mye STANDAR
225 Well D1 nt 35 e [ 4 c-mye STANDAR
300 D 1] T4 36 E1 a 1 c-myc STANDAR
275 on % e = c-myc - STANDARD - 0.2
250 am py 37 D4 I~ | c-myc STANDAR
25 e u 38 s [ c-myc STANDAR
© 200 med 39 D6 a c-myc STANDAR
175 S comyc - STANDART . 20 4c
150 40 D1 ] 1 c-myc STAMDAR
125 41 D2 O c-mye STAMDAR
100 42 D3 O c-mye STAMDAR
75 = c-mye - STANDARD - 20.0
50 43 C6 O c-mye STAMDAR
25 44 cy O c-mye STAMDAR
oo 45 cs O c-mye STAMDAR
B EEEEEE R R R R E E R E E R
el Number = c-mye - STANDARD - 200.0
46 2 O c-mye STANDAR
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analysis.
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Guidelines

Analysis When you analyze your own relative standard curve experiment, carefully view the

replicate groups for outliers. If needed, remove outliers manually using the Well Table.

Follow the “Omit Wells” procedure above to remove the outliers in your experiment.
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For More For more information on omitting wells from the analysis, access the StepOne Software
Information  Help by clicking g) or pressing F1. Within the Help, search for the omit well topics:

1. Click the Search tab.
2. Enter omit well.

3. Click List Topics.

4

. Double-click the topics you want to review.

View the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye
in a selected well over the duration of the PCR run.

About the In the relative standard curve example experiment, you review the Multicomponent Plot
Example screen for:
Experiment « ROX"™ dye (passive reference)
« FAM™ dye (reporter)
» Spikes, dips, and/or sudden changes

+ Amplification in the negative control wells

View the 1. From the Experiment Menu pane, select Analysis » || &
Multicomponent
Plot Note: If no data are displayed, click Analyze.

Multicomponent Plot.

2. Display the unknown and standard wells one at a time in the Multicomponent Plot
screen:

a. Click the View Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen.

Note: Ifyou select multiple wells, the Multicomponent Plot screen displays the
data for all selected wells simultaneously.

3. From the Plot Color dropdown menu, select Dye.

4. Click = Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

Notes
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View the Multicomponent Plot

5. Check the FAM dye signal. In the example experiment, the FAM dye signal
increases throughout the PCR process, which indicates normal amplification.

6. Check the ROX dye signal. In the example experiment, the ROX dye signal remains
constant throughout the PCR process, which indicates typical data.

3 4 2a
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7. Select the negative control wells one at time and check for amplification. In the
example experiment, there is no amplification in the negative control wells.
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Analysis
Guidelines

For More
Information

When you analyze your own relative standard curve experiment, look for:

» Passive reference — The passive reference dye fluorescence level should remain
relatively constant throughout the PCR process.

» Reporter dye — The reporter dye fluorescence level should display a flat region
corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds.

* Any irregularities in the signal — There should not be any spikes, dips, and/or sudden
changes in the fluorescent signal.

* Negative control wells — There should not be any amplification in the negative
control wells.

For more information on the Multicomponent Plot screen, access the StepOne Software
Help by clicking @) or pressing F1.

View the Raw Data Plot

About the
Example
Experiment

View the Raw
Data Plot

Notes

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for each
optical filter for the selected wells during each cycle of the real-time PCR.

In the relative standard curve example experiment, you review the Raw Data Plot screen
for a stable increase in signal (no abrupt changes or dips) from the appropriate filter.

1. From the Experiment Menu pane, select Analysis » Raw Data Plot.

Note: If no data are displayed, click Analyze.

2. Display all 48 wells in the Raw Data Plot screen by clicking the upper left corner of
the plate layout in the View Plate Layout tab.

3. Click = Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

Note: The legend displays the color code for each row of the reaction plate. In the
example shown below, Row A is red, Row B is yellow/green, Row C is green, and so
on.

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 40. In the example
experiment, there is a stable increase in signal from filter 1, which corresponds to
the FAM™ dye filter.
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Raw Data Plot
Bz = 3

Raw Data Plot

750001

70,000

65,000 -_.
g 60,000 +=
=5

g 55,000 =

50,000 +—

45,000

40,000

1 2 3
Filter

{ Legend ‘

A s el - r

Options
Show Cycle 40 - ; ‘ 4
1 10 20 0 40

The filters are:

StepOne system StepOnePlus system
Filter Dye Filter Dye
1 FAM™ dye 1 AW dye
| SYBR® Green dye | | SYBR® Green dye
2 JOE™ dye 2 JOE™ dye
VIC® dye VIC® dye
3 ROX™ dye 3 TAMRA™ dye
| | " NED™ dye

4 | ROX™dye

Analysis When you analyze your own relative standard curve experiment, look for the following in
Guidelines each filter:

* Characteristic signal growth
* No abrupt changes or dips

For More For more information on the Raw Data Plot screen, access the StepOne Software Help by
Information clicking g) or pressing F1.

Notes
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Notes
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m Design the Comparative C; Experiment

This chapter covers:

B Chapter OVeIVIEW . . . oottt e e e e e et et 134
B Createa New Experiment. . ........ ..., 135
B Define the Experiment Properties .. .......... .. .. ... .. .. .. . ... 139
B Define the Methods and Materials . .. ............. .. ... ... oo, 141
B SetUpthe Targets. ... ..ottt e e e e e 144
B SetUpthe Samples. . ... 146
B Set Up the Relative Quantitation Settings . .............. ... ... ..., 149
B SetUpthe RunMethod ........ ... ... . .. . ... 150
B Review the Reaction Setup. ... 152
B Order Materials for the Experiment .. ............. ... ... ... ......... 157
B Finishthe Design Wizard . . ........... ... . . . . i 161

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne™ Real-Time PCR Software by pressing
F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Notes
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Chapter Overview

This chapter explains how to use the Design Wizard in the StepOne"™ software to set up
the comparative C (AAC) example experiment. The Design Wizard walks you through
Applied Biosystems recommended best practices as you enter design parameters for the
example experiment.

Example The workflow for designing the example experiment provided with this getting started
Experiment guide is shown below.
Workflow
Note: Design the example experiment using the Design Wizard in the StepOne software.
When you design your own experiments, you can select alternate workflows (see “Using
This Guide With Your Own Experiments” on page 11).

Comparative C; (AAC;) Experiment
Start Experiment

v
Design the Experiment (Chapter 6)

. Create a new experiment.
. Define the experiment properties.
. Define the methods and materials.
. Set up the targets.
. Set up the sampiles.
. Set up the relative quantitation.
. Set up the run method.
. Review the reaction setup.
Order materials for the experiment.

1
2
3
4
5
6
7
8
9.
10.Finish the Design Wizard.

v
Prepare the Reactions (Chapter 7)

v
Run the Experiment (Chapter 8)

v
Analyze the Experiment (Chapter 9)

v
End Experiment

Notes
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Create a New Experiment

Create a new experiment using the Design Wizard in the StepOne software.

Log Intothe 1. Double-click € (StepOne software) or select Start » All Programs » Applied
Software and Biosystems » StepOne Software » <software name>

Crea_te an where <software name> is the current version of the StepOne software.
Experiment

2. In the Login dialog box, create a user name:

a. In the User Name field, enter EXAMPLEUSER. You cannot enter spaces in
the User Name field.

b. Click OK.

Loginas Guest [l Delets User(s)

3. From the Home screen, click (Design Wizard) to open the Design Wizard.

IF\lE Edit Instrument Analysis Tools Help I

[E] New Experiment - =] Open.. [ [ TJ_“ Send Experiment to Instrument... L_'r Download Experiment from Instrument.. &30 8

Notes
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4. See “Software Elements” on page 137 for information on navigating within the
Design Wizard.

Design  When you design your own experiment, you can do one of the following in the Login
Guidelines dialog box:

* Log in as a new user — In the User Name field, enter a user name, then click OK.

Note: You cannot use the following characters in the User Name field: space,
forward slash (/), backslash (\), greater than sign (>), less than sign (<), asterisk (*),
question mark (?), quotation mark ("), vertical line (]), colon (:), or semicolon (;).

* Log in as an existing user — From the User Name dropdown menu, select an existing
user, then click OK.

* Log in anonymously — Click Log in as Guest.

Applied Biosystems recommends that you log in with a user name. If you log in with a
user name, you can set preferences in the software. The next time you log in to the

software with the same user name, the software uses the preferences you set as the
defaults.

IMPORTANT! If you log in to the software as a Guest, you cannot set preferences.

You can set preferences as follows:

* Save as the default checkboxes — Select the Save as the default checkboxes as
needed. The Save as the default checkboxes appear on the Home screen, on the
Export Data dialog box, and on several Analysis screens.

* Preferences dialog box — Select Tools » Preferences to open the Preferences dialog
box. In the Defaults and/or Startup tabs, change the preferences as desired.

» Preferences

a Enter a default sample volume for your experiments, select your default folders, and
selectthe type of instrument for the sofware to use by default

Sample Reaction val: |20 HL

Data Falder: S\pplied BiosysternsiStepOne Software v2 1lexperiments \

Import Folder: S\pplied BiosysternsiStepOne Software v2 1lexperiments \

Export Folder: \Applied BiosystemsiStepOne Software v2.1lexperiments

Instrument Type

ok || cancal

For More For more information, access the StepOne Software Help by clicking @ or pressing F1.
Information

Notes
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Software The StepOne software elements for the Design Wizard are illustrated below.

Elements _ _ )
1. Menu bar — Displays the menus available in the software:

* File

« Edit

* Instrument
* Analysis
* Tools

* Help

2. Toolbar — Displays the tools available in the software:
* New Experiment
* Open
* Close
» Send Experiment to Instrument

* Download Experiment from Instrument

3. Experiment header — Displays the experiment name, experiment type, and reagents
for the open experiment.

4. Navigation pane — Provides links to all screens in the Design Wizard:
* Experiment Properties
* Methods & Materials
» Targets
» Relative Quantitation Settings

* Samples

e Run Method
» Reaction Setup
* Materials List

Note: The Design Wizard initially displays the Quantitation - Standard Curve
experiment type. The available Design Wizard screens may change when you select
a different experiment type. For example, the Relative Quantitation Settings screen
is not displayed until you select the relative standard curve or comparative C;
(AACy) experiment type.

5. Experiment tab(s) — Displays a tab for each open experiment.

Notes

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative 137
Standard Curve and Comparative C; Experiments



m Chapter 6 Design the Comparative C; Experiment

Create a New Experiment

IFi\e Edit Instrument Analysis

Tools  Help

experiment...

1. Define

* Experiment
Properties

2. SetUp

3. Order ( Optional)

5 1 v o] Untitled <

Notes

138

[] New Experiment ~ 5 Open.. [

=] Close ‘;5_“ Send Experiment to Instrument... ’% Download Experimentfrom Instrument... | £

Reagents: Ta

1A. Define: Experiment Properties Experiment Properties Help @)

a Instructions: Enter an experiment name, selectthe instrumenttype, then selectthe type of experiment to design.

How do you want to identify this experiment? = Required

* Experiment Name: Untitled

Barcode (Optional): ‘

|
|
User Name (Optional): ‘ |

Comments (Optional); ‘

<[>

Which instrument are you using to run the experiment?

[ StepCnePlus™ Instrument (96 Wells) ] { + StepCne™ Instrument (48 Wells) ]

Setup, run, and analyze an experiment using a 3-color, 48-well system

What type of experiment do you want to design?

[ « Quantitation ] [ Genotyping ] [ Presence / Absence ]

Desian a gene quantitation experiment to determine the amount of target nucleic acid sequence in a sample.

- + Finish Designing Experiment
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Define the Experiment Properties

On the Experiment Properties screen, enter identifying information for the experiment,
select the instrument type, then select the type of experiment to design.

About the In the comparative C; (AAC) example experiment:
Exa_tmple » The experiment is identified as an example.
Experiment . . . .

* The instrument selected to run the experiment is the StepOne instrument.
+ A MicroAmp® Fast Optical 48-Well Reaction Plate is used.

* The experiment type is quantitation.

Complete the 1. Click the Experiment Name field, then enter Comparative CT Example.

Experiment
Properties Screen Note: The experiment header updates with the experiment name you entered.

2. Leave the Barcode field empty.

Note: The MicroAmp Fast Optical 48-Well Reaction Plate does not have a barcode.

3. Click the User Name field, then enter Example User.

4. Click the Comments field, then enter Comparative CT Getting Started Guide
Example.

5. Select StepOne™™ Instrument (48 Wells).

Note: The example experiment was created for a StepOne instrument. You can
create the example experiment for a StepOnePlus instrument; however, your
reaction plate layout will differ from the layout shown in this guide. The software
displays a 48-well reaction plate layout for the StepOne instrument and a 96-well
reaction plate layout for the StepOnePlus instrument. To create the example
experiment for a StepOnePlus instrument, select StepOnePlus™ Instrument
(96 Wells).

6. Select Quantitation for the experiment type.

7. Click Next >.

Notes

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative 139
Standard Curve and Comparative C; Experiments



n Chapter 6 Design the Comparative C; Experiment

Define the Experiment Properties

1A. Define: Experiment Properties Experimert Properties Help ﬂ_‘,
ﬂ Instructions: Enter an experiment name, selectthe instrument type, then selectthe type of experiment to design.
How do you want to identify this experiment? = Required
1 * Experiment Name: | Comparative CT Exampl |
2 Barcode (Optional): | |
3 User Name (Optional): | Example User |
4 [lplg ClieR (el hENVM C omparative CT Getting Started Guide Example ’*|
:
[ StepCnePlus™ Instrument (96 Wells) } | + StepOne™ Instrument (48 Wells) ‘
Setup, run, and analyze an experiment using a 3-color, 48-well system.
What type of experiment do you want to design?
6 i + Quantitation ‘ [ Genotyping } [ Fresence / Absence }
Design a gene quantitation experiment to determine the amount of target nucleic acid sequence in a sample
Design  When you design your own comparative C experiment:
Guidelines * Enter an experiment name:
— The experiment name is used as the default file name.
— Enter a name that is descriptive and easy to remember. You can enter up to
100 characters in the Experiment Name field.
Note: You cannot use the following characters in the Experiment Name field:
forward slash (/), backslash (\), greater than sign (>), less than sign (<), asterisk
(*), question mark (?), quotation mark ("), vertical line (]), colon (%),
semicolon (), and sign (&), percent sign (%), dollar sign ($), at sign (@),
circumflex (%), left parenthesis ( (), right parenthesis () ), or exclamation
point (!).
IMPORTANT! If you run the instrument in standalone mode from the
instrument touchscreen, you cannot enter more than 32 characters in the
Experiment Name field and you cannot include spaces in the name.
+ (Optional) If you use a MicroAmp® Fast Optical 96-Well Reaction Plate, enter a
barcode to identify the barcode on the PCR reaction plate. You can enter up to 100
characters in the Barcode field.
Note: The MicroAmp Fast Optical 48-Well Reaction Plate does not have a barcode.
* (Optional) Enter a user name to identify the owner of the experiment. You can enter
up to 100 characters in the User Name field.
* (Optional) Enter comments to describe the experiment. You can enter up to 1000
characters in the Comments field.
Notes
140 Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative

Standard Curve and Comparative C; Experiments



Chapter 6 Design the Comparative C; Experiment m
Define the Methods and Materials

* Select the instrument you are using to run the experiment:
— StepOne™ Instrument (48 Wells)
— StepOnePlus’” Instrument (96 Wells)

Note: You can use StepOne Software v2.1 or later to design experiments for both
the StepOne and StepOnePlus instruments. The instrument you select in the
Experiment Properties screen affects the reaction plate layout and materials list.

Note: To set the default instrument type, select Tools » Preferences, then select the
General tab (default). From the Default Instrument Type dropdown menu, select the
appropriate instrument. To change the default instrument type, you must be logged
into the software with a user name, not as a Guest. For more information, see the
“Design Guidelines” for logging in on page 136.

* Select Quantitation as the experiment type.

For More For more information on:

Information » Completing the Experiment Properties screen, access the StepOne Software Help by
clicking @) or pressing F1.
* Consumables, see “Supported Consumables” on page 4.

* Quantitation experiments, refer to the Real-Time PCR Systems Reagent Guide.

Define the Methods and Materials

On the Methods & Materials screen, select the quantitation method, reagents, ramp
speed, and PCR template to use for the experiment.

About the In the comparative C; example experiment:

E Exa_tmplet * The comparative C quantitation method is used.
Xperimen + TagMan® reagents are used.

* The Fast ramp speed is used in the instrument run.

* cDNA (prepared from total RNA isolated from liver, kidney, and brain tissues) is the
template type. Before using cDNA template, you must first perform reverse
transcription to convert the RNA to cDNA (see “Prepare the Template” on
page 167).

Complete the 1. Select Comparative Cy (AACy) as the quantitation method.
Methods &
Materials Screen 2. Select TagMan® Reagents for the reagents.

3. Select Fast (~ 40 minutes to complete a run) for the ramp speed.
4. Select cDNA (complementary DNA) for the template type.
5. Click Next >,

Notes
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1B. Define: Methods & Materials Methods & Materials Help 0/.

n Instructions: Selectthe quantitation method, reagents, ramp speed, and type of template for the real-time PCR reactions

Which quantitation method are you using?

[ Standard Curve } [ Relative Standard Curve ] ‘ « Comparative ‘CT (AACT) |

Notes

142

With the comparative CT (AACT) method, you use a reference sample and an endogenous control to determine the relative guantity oftargst sequence in a sample.

Which reagents do you want to use to detect the target sequence?

i + TagMan® Reagants ‘ [ SYBRE Green Reagants ]

These real-time PCR reactions contain two primers and a TagMan® probe. The primers are designed to amplify the target sequence. The TagMan probe is designed to hybridize to
the target sequence and generate fluorescence signal when the target sequence is amplified

Which ramp speed do you want to include in the instrument run?

[ Standard (~ 2 hours to complete a run) } |( Fast (~ 40 mmules‘m complete a run)|
J

H For optimal results using the Fastramp speed, Applied Biosystems recommends using Fast reagents for your reaktime PCR reactions.

What type of template do you want to use in the real-time PCR reactions?

ou are adding cDNA to the real-time PCR reactions. You have already perfarmed reverse transcription to convert the RNA to eDNA.

}VI + cONA (complementary DNA) | [ RMNA ] [ gDMA (genaomic DNA)

Design  When you design your own comparative C experiment:
Guidelines * Select Comparative C; (AACy) as the quantitation method. The comparative Cy

(AAC;) method is used to determine the relative target quantity in samples. When
setting up your reaction plate, the comparative C; method requires targets, samples,
a reference sample, and an endogenous control.

Note: Before you use the comparative C; method, Applied Biosystems
recommends that you determine that the PCR efficiencies for the target assay and
the endogenous control assay are approximately equal. Applied Biosystems
TagMan® Gene Expression Assays and Custom TagMan® Gene Expression Assays
have equivalent amplification efficiencies of 100% (£10%).

» Select the reagents you want to use:

— Select TagqMan® Reagents if you want to use TagMan reagents to detect
amplification and quantify the amount of target in the samples. TagMan reagents
consist of two primers and a TagMan® probe. The primers are designed to
amplify the target. The TagMan probe is designed to hybridize to the target and
generate fluorescence when the target is amplified.

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA™ dye
as a reporter or quencher with the StepOne™™ system. TAMRA dye may be used as a
reporter or quencher with the StepOnePlus™ system.

— Select SYBR® Green Reagents if you want to use SYBR Green reagents to
detect amplification and quantify the amount of target in the samples. SYBR
Green reagents consist of two primers and SYBR Green dye. The primers are
designed to amplify the target. The SYBR Green dye generates fluorescence
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when it binds to double-stranded DNA. SYBR Green dye is often part of the
SYBR Green master mix that is added to the reaction. If you use SYBR Green
dye, select the Include Melt Curve checkbox to perform melt curve analysis of
the amplified target.

Note: You can use other fluorescence-based reagents on the StepOne and
StepOnePlus systems, but you must design your experiment using Advanced Setup
instead of the Design Wizard.

» Select the appropriate ramp speed for the instrument run:

— Select Fast (~ 40 minutes to complete a run) if you use fast reagents for the
PCR reactions.

— Select Standard (~ 2 hours to complete a run) if you use standard reagents for
the PCR reactions.

* Select the appropriate PCR template:

— Select cDNA (complementary DNA) if you are performing 2-step RT-PCR, and
you have already performed reverse transcription to convert the RNA to cDNA.
You are adding complementary DNA to the PCR reactions.

— Select RNA if you are performing 1-step RT-PCR. You are adding total RNA or
mRNA to the PCR reactions.

Note: To use the Fast ramp speed with RNA templates, you must design your
experiment using Advanced Setup instead of the Design Wizard.

— Select gDNA (genomic DNA) if you have already extracted the gDNA from
tissue or sample. You are adding purified genomic DNA to the PCR reactions.

For More For more information on:
Information » Completing the Methods & Materials screen, access the StepOne Software Help by
clicking ) or pressing F1.
* Determining PCR efficiencies, access the StepOne Software Help by clicking g) or
pressing F1. Within the Help, search as follows:
a. Click the Search tab.
b. Enter PCR efficiency.
c. Click List Topics.

d. Double-click Determine Amplification Efficiency.
» Using Advanced Setup, see “Advanced Setup Workflow” on page 260.

» Using the relative standard curve quantitation method, see Chapters 2 to 5 of this
guide.

» Using the standard curve quantitation method, refer to the Applied Biosystems
StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
Standard Curve Experiments.

» TagMan and SYBR Green reagents, refer to the Real-Time PCR Systems Reagent
Guide.

Notes
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* PCR, including singleplex vs. multiplex PCR and 1-step vs. 2-step RT PCR, refer to
the Real-Time PCR Systems Reagent Guide.

Set Up the Targets

On the Targets screen, enter the number of targets you want to quantify in the PCR
reaction plate, then set up the assay for each target.

About the In the comparative C; example experiment:
Example .

A Two targets are quantified in the reaction plate.
Experiment

» The Target 1 assay is set up for the target you are studying. For the example
experiment, this is TP53 (a transcription factor that regulates other genes).

» The Target 2 assay is set up for the endogenous control. For the example experiment
this is human glyceraldehyde-3-phosphate (GAPDH). GAPDH serves as the
endogenous control because its expression levels tend to be relatively stable.

Complete the 1. Click the How many targets do you want to quantify in the reaction plate? field,
Targets Screen then enter 2.

Note: The number of rows in the target assays table updates with the number you
entered.

2. Set up the Target 1 assay:
a. Click the Enter Target Name cell, then enter TP53.
b. From the Reporter dropdown menu, select FAM (default).
c. From the Quencher dropdown menu, select NFQ-MGB (default).
d. Leave the default in the Color field.
3. Set up the Target 2 assay:
a. Click the Enter Target Name cell, then enter GAPDH.
b. From the Reporter dropdown menu, select FAM (default).
c. From the Quencher dropdown menu, select NFQ-MGB (default).
d. Leave the default in the Color field.

4. Click Next >.
Note: For all targets, leave the (Optional) Enter Gene Name field blank. You can search

for the gene/assay ID when you order your materials (see “Order Materials for the
Experiment” on page 157).

Notes

144 Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative
Standard Curve and Comparative C; Experiments



Chapter 6 Design the Comparative C; Experiment n
Set Up the Targets

2A Set Up: Targets Targets Help 9_)

ﬂ Instructions: Enter the number oftargets to quantify in the reaction plate, then setup the assay for each target.

Set Up Targets = Required

* How many targets do you want to guantify in the reaction plate? 2

For each target assay in the reaction plate, enter a target nams, selectthe reporter and quencher to use to dstsct the target, and select a taraet color, (Optional) Enter a gene name,
find Applied Biosystams gene expression assays, then select an assay to fill in the Assay D,

* Enter Target Name Reporter Quencher Color Assay D (Optionaly Enter Gene Mame and Click "Find"

2 GTF53 | [Fam « [NFQ-mGE - v | Finat |

3 (X | |Fam  [NFO-MGE v v | Finat |

Design  When you design your own comparative C experiment:

Guidelines  Identify each target assay with a unique name and color. You can enter up to 100
characters in the Target Name field.

* Select an endogenous control for each sample. The endogenous control is a target
that is present in all samples under investigation. It should be expressed equally in
all sample types, regardless of treatment or tissue origin (examples of endogenous
controls are B-actin, GAPDH, and 18S ribosomal RNA [18S rRNA]). The
endogenous control is used to normalize the PCR results; the endogenous control
corrects for variable sample mass, nucleic acid extraction efficiency, reverse
transcription efficiency, and pipette calibration errors. Note that:

— Each sample type (for example, each tissue in a study comparing multiple tissues)
requires an endogenous control.

— If samples are spread across multiple plates, each plate must have an endogenous
control. Additionally, every plate must include an endogenous control for every
sample type on the plate.

» Select the reporter dye used in the target assay. In the Methods & Materials screen
on page 141, if you selected:

— TagMan® Reagents, select the dye attached to the 5" end of the TagMan probe.
— SYBR® Green Reagents, select SYBR.

* Select the quencher used in the target assay. In the Methods & Materials screen on
page 141, if you selected:

— TaqMan® Reagents, select the quencher attached to the 3’ end of the TagMan
probe.

Notes
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— SYBR® Green Reagents, select None.

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA dye as
a reporter or quencher with the StepOne system. TAMRA dye may be used as a
reporter or quencher with the StepOnePlus system.

For More For more information on:

Information

L]

Completing the Targets screen, access the StepOne Software Help by clicking g) or
pressing F1.

Selecting an endogenous control, see the Application Note Using TagMan®
Endogenous Control Assays to Select an Endogenous Control for Experimental
Studies.

Set Up the Samples

About the
Example
Experiment

Complete the
Samples Screen

Notes

On the Samples screen, enter the number of samples, replicates, and negative controls to
include in the reaction plate, enter the sample names, then select the sample/target
reactions to set up.

In the comparative C; example experiment:

L]

—

Three samples are used: cDNA prepared from total RNA isolated from liver, kidney,
and brain tissues. The samples contain unknown quantities of TP53 (target) and
GAPDH (endogenous control).

Three replicates are used. The replicates are identical reactions, containing identical
reaction components and volumes.

Six negative controls are used. The negative control reactions contain water instead
of sample and should not amplify. The software automatically includes three
negative controls for each target assay.

. Click the How many samples do you want to test in the reaction plate? field, then

enter 3.

Note: The number of rows in the samples table updates with the number you
entered.

Click the How many replicates do you need? field, then enter 3.

Click the How many negative controls do you need for each target assay? field,
then enter 3.

Set up Sample 1:
a. Click the Enter Sample Name field, then enter Liver.
b. Leave the default in the Color field.
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5. Set up Sample 2:
a. Click the Enter Sample Name field, then enter Kidney.
b. Leave the default in the Color field.

6. Set up Sample 3:
a. Click the Enter Sample Name field, then enter Brain.
b. Leave the default in the Color field.
7. Select No Biological Replicates.
8. Select All Sample/Target Reactions to test all targets in all samples.

9. In the Well Count pane, confirm there are:
e 18 Unknown wells
* 6 Negative control wells [
* 24 Empty wells

10. In the View Plate Layout tab, from the Arrange Plate by dropdown menu, select
Rows (default).

11. Click Next >.

2B. Set Up: Samples Samples Help @)

T structions: Erter e nurerof samples (0 st 1 reacton pat,aer 1 bt of sampletargl15a6kon epltes, oer sarle nare, assoclte 1s Al Wi bioogial eplicate groups, e selecthe sarplaRarge eactons 1o setup,

—— |10

* How many samples do you want to test in the reaction plate? 3 Armange Plate by: [Rows v,

* How many tepliales doyouneed? | 3] |E|Sh R v
owinwelis v | [ view Legen

+How many neaative controls do you need for each target assay? 3
T 7 1 s 1 &+ [ s [ = 7 0

For each sample in e reaction plate, enter a sample name and select a sample color.

| * Enter samnle Name Color |
|| Erer SampleName
(lover | <)

@qmv ] )

Lver e
N AEE Mresa e Moswon  [Doaron  [Hoaron - -

OO WN—

eram ] ) ‘

i i o i s dney dne e
8@ s oaron caroi oaroH P53 Tesa P83 oaroH

ey ey s s s B sain s
C|Mowon  Mowon  Mrwss M M Mowvon  Mowon [ oron

o
Set Up Biological Replicate Groups |

7 T\l Mo Biological Replicates ) Specity Biolagical Replicate Groups )
E

Which sampleftarget reactions do you want to set up?
88— Tl Al Sample/Target Reactions I Specity Sample/Target Raactions )
.
9 [ M - v RTT— pop—

Notes
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Notes

148

Set Up the Samples

Guidelines

When you design your own comparative C; experiment:

* Identify each sample with a unique name and color. You can enter up to 100

characters in the Sample Name field.

Enter the number of replicates (identical reactions) to set up. Applied Biosystems

recommends three replicates for each sample reaction.

The software automatically includes three negative controls for each target assay.

Set up the biological replicates groups:

— Select No Biological Replicates if you do not want to include biological replicate
groups in the experiment.

— Select Specify Biological Replicate Groups to include biological replicate
groups in the experiment. For more information on biological replicate groups,
see Chapter 10.

Select which targets to test in the samples:

— Select All Sample/Target Reactions to test all targets in all samples.

— Select Specify Sample/Target Reactions to specify the targets to test in each
sample.

Note: When you use the Design Wizard to set up a comparative C experiment, you
can set up only singleplex reactions (amplification and detection of one target per
well). If you want to set up a comparative C; experiment with multiplex reactions
(amplification and detection of two or more targets per well), design your
experiment using Advanced Setup instead of the Design Wizard.

If you are running the experiment on a StepOnePlus instrument and plan to edit the
Run Method (page 150) to set a different temperature for one or more of the
VeriFlex blocks, you need to:

a. Design your experiment using Advanced Setup instead of the Design Wizard.

b. In the Plate Setup screen, select the Assign Targets and Samples tab, select
the View Plate Layout tab, then select the Enable VeriFlex"" Block checkbox.

IMPORTANT! If you do not select the Enable VeriFlex™ Block checkbox in the
Plate Setup screen, you will not be able to set a different temperature for one or
more of the VeriFlex blocks in the Run Method screen (page 150).

For More For more information on:

Information » Completing the Samples screen, access the StepOne Software Help by clicking

@) or pressing F1.

» Using Advanced Setup, see “Advanced Setup Workflow” on page 260.
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Set Up the Relative Quantitation Settings

On the Relative Quantitation Settings screen, select the reference sample and the
endogenous control to perform relative quantitation.

About the In the comparative C; example experiment:

Example * Brain is used as the reference sample.

Experiment * GAPDH is used as the endogenous control.

Complete the 1. From the Which sample do you want to use as the reference sample? dropdown
Relative menu, select Brain.
Quantitation

Settings Screen 2. From the Which target do you want to use as the endogenous control? dropdown

menu, select GAPDH.

3. Click Next >.

2C. Set Up: Relative Quantitation Settings Relative Quantitation Settings Help 0/,

a Instructions: Select the reference sample and the endogenous control to perform relative quantitation.

1 | i Which sample do you want1o use as the reference sample?  Brain v

2 Which target do you wantto use as the endogenous control? |GAPDH (%

Design  When you design your own comparative C experiment:

Guidelines » Select a reference sample from your previously created samples (“Set Up the
Samples” on page 146). Amplification results from the samples are compared to the
amplification results from the reference sample to determine relative expression.

* Select an endogenous control from your previously created target assays (“Set Up
the Targets” on page 144). Amplification results from the endogenous control are
used to normalize the amplification results from the target for differences in the
amount of template added to each reaction.

Notes
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For More For more information on:

Information * Completing the Relative Quantitation Settings screen, access the StepOne Software

Help by clicking g or pressing F1.
» Reference samples (also known as calibrators) and endogenous controls, see User
Bulletin #2: Relative Quantitation of Gene Expression.

Set Up the Run Method

On the Run Method screen, review the reaction volume and the thermal profile for the
default run method. If needed, you can edit the default run method or replace it with one
from the Run Method library.

About the In the comparative C; example experiment, the default run method is used without edits.

Example
Experiment
Review the Run 1. Click either the Graphical View tab (default) or Tabular View tab.
Method Screen _ . .
2. Make sure the Reaction Volume Per Well field displays 20 pL.
3. Make sure the thermal profile displays the holding and cycling stages shown below.
4. Click Next >,
2D. Set Up: Run Method Run Method Help @
a Instructions: Review the reaction volume and the thermal profile for the default run method. If needed, editthe default run method or select a run method from the library.
1 Graphical View T Tabular View }
2 Reaction Volume PerWell | 20.0 | UL
[ ada stage v | dostep v | petete selected | 1] collectpata v 1] open Run methoo | save Run ethoa | El
Holding Stage Cycling Stage e
Mumber of Cycles: 40 %
[1Enable AutoDelta
Starting Cycle
100 —| 95.0°C 95.0°C
3 00:20 100% 00:01
75 —|
i 60.0°C
5o | 00% 00:20
-
.
Step 1 Step 1 Step 2 ~
< >
Legend
Data Caollection On Data Collection Off & AutoDelta On A& AutoDelta Off

Design  When you design your own comparative C experiment:

Guidelines » Enter a number from 10 to 30 for the reaction volume/well. The StepOne and
StepOnePlus systems support reaction volumes from 10 to 30 pL.
Notes
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* Review the thermal profile:
— Make sure the thermal profile is appropriate for your reagents.
— If you are performing 1-step RT-PCR, include a reverse transcription step.

If your experiment requires a different thermal profile, edit the thermal profile or
replace the run method with one from the Run Method library. The Run Method
library is included in the StepOne software.

» If you are running the experiment on a StepOnePlus instrument and you want to set
a different temperature for one or more of the VeriFlex blocks, you need to:
a. Design your experiment using Advanced Setup instead of the Design Wizard.

b. In the Plate Setup screen (page 148), select the Assign Targets and Samples
tab, select the View Plate Layout tab, then select the Enable VeriFlex"™ Block
checkbox.

IMPORTANT! If you do not select the Enable VeriFlex" Block checkbox in
the Plate Setup screen, you will not be able to set a different temperature for
one or more of the VeriFlex blocks in the Run Method screen.

c. In the Run Method screen, select the Graphical View tab.

d. For each VeriFlex " block you want to change, click the temperature, then enter
the desired value.

Note: You can set a different temperature for one or more of the VeriFlex blocks, or
set each of the VeriFlex blocks to the same temperature. If neighboring VeriFlex
blocks are not set to the same temperature, the temperature difference must be
between 0.1 and 5.0 °C. The maximum temperature is 99.9 °C.

For More For more information on:

Information * The Run Method library or on completing the Run Method screen, access the
StepOne Software Help by clicking @) or pressing F1.

» Setting temperatures for the VeriFlex blocks, access the StepOne Software Help by
clicking @ or pressing FI.

» Using Advanced Setup, see “Advanced Setup Workflow” on page 260.

Notes
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Review the Reaction Setup

Complete the

On the Reaction Setup screen, select the assay type (if using TagMan reagents), then
review the calculated volumes for preparing the PCR reactions and sample dilutions. If
needed, you can edit the reaction volume, excess reaction volume, component
concentrations, and/or diluted sample concentration.

IMPORTANT! Perform these steps for each target assay in the reaction plate.

About the In the comparative C; example experiment:

Example .
Experiment

L]

L]

Reaction Setup

Notes

1562

Screen 1.

2
3
4.
5
6

Applied Biosystems TagMan® Gene Expression Assays are used.

The reaction volume per well is 20 uL.

The excess reaction volume is 10%.

The reaction components are:
TagMan® Fast Universal PCR Master Mix (2X)

TP53 Assay Mix (20X)
GAPDH Assay Mix (20X)
Sample

Water

The diluted sample concentration is 5.0 ng/uL.

The sample stock concentration is 100 ng/uL.

Complete the Reaction Mix Calculations Tab for the TP53 Assay

Select the Reaction Mix Calculations tab (default).

. From the Select Target pane, select TP53.

. From the Assay Type dropdown menu, select Inventoried/Made to Order.

Make sure the Reaction Volume Per Well field displays 20 pL.

. In the Reactions for TP53 pane:

. Make sure the Excess Reaction Volume field displays 10%.

a. Make sure the Master Mix Concentration field displays 2.0X.

b. Make sure the Assay Mix Concentration field displays 20.0X.

c. Review the components and calculated volumes for the PCR reactions:

Component

Volume (pL) for 1 Reaction

Master Mix (2.0X)
Assay Mix (20.0X)

10.0
1.0
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Component Volume (pL) for 1 Reaction

Sample (10X) 2.0%
H,O 7.0
Total Volume 20.0

I The sample volume is limited to 10% of the total reaction volume.

3 4 5

2E_ Set Up: Reaction Setup Reaction Setup Help @

i Faoreach target assay in the reaction pate, selectthe assay type (if using Taglian reagents), then review the calculatec| volumes for preparing the samples and PCR
a Instructions: reactions. Ifneeded, edit the reaction vplume, excess reaction volume, compgnent concentrations, and/ar stock concel|trations. Click"Print Reaction Setup” to print
instructions on how to prepare the PCH? reactions

1 ’fr Reaction Mix Calculations T Sample Dilution Calculations ]

Select Tar =i
’i Assay Type |Inventoried/Made to Order Reaction Yaolume Per Well: 20 | yL Excess Reaction Volume 10| % \ Print Reaction Setup
TP53

BRIl Reactions for TP53
6a

|
6b

Master Mix Concentration 2.0 | X Assay Mix Concentration ‘20 0|x

Compaonent Wolume (uL) for 1 Reaction

Master Mix (2.0x) 10.0

6¢c

Hz0 7.0

Total Volume 20.0

Complete the Reaction Mix Calculations Tab for the GAPDH Assay
1. Select the Reaction Mix Calculations tab (default).
From the Select Target pane, select GAPDH.
From the Assay Type dropdown menu, select Inventoried/Made to Order.

2

3

4. Make sure the Reaction Volume Per Well field displays 20 pL.
5. Make sure the Excess Reaction Volume field displays 10%.

6

In the Reactions for GAPDH pane:
a. Make sure the Master Mix Concentration field displays 2.0X.
b. Make sure the Assay Mix Concentration field displays 20.0X.

Notes
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6a

c. Review the components and calculated volumes for the PCR reactions:

Component Volume (pL) for 1 Reaction
Master Mix (2.0X) 10.0
| Assay Mix (20.0X) 1.0
| Sample (10X) 2.0%
| H,O 7.0
Total Volume 20.0

I The sample volume is limited to 10% of the total reaction volume.

3

4

5

2E. Set Up: Reaction Setup

Reaction Setup Help @

7 For each target assay in the reaction p
a Instructions: reactions. If needed, edit the reaction v

instructions on how to prepare the PCH? reactions

ate, selectthe assay type (if using Taa
alume, excess reaction volume, compc

TP&3

{“Reaction Mix Calculations T Sarnple
Select Tar

Dilution Calculations ]

dan reagents), then review the calculatec
nent concentrations, andior stock coneer

volumes for preparing the samples and PCR
trations. Click"Print Reaction Setup” to print

Assay Type |Inventoried/Made to Order | Reaction Volume Per Well:

Reactions for GAPDH

6b

6¢c

Notes

154

” Master Mix Concentration

| ” Compaonent

Master Mix (2.0x)

Hz0

20| uL  Excess Reaction Volume

2.0 | X Assay Mix Concentration ‘200 X

Wolume (uL) for 1 Reaction

10.0

10| %

‘ Print Reaction Setup

Total Volume

Complete the Sample Dilution Calculations Tab

1. Select the Sample Dilution Calculations tab.

2. Click the Diluted Sample Concentration (10X for Reaction Mix) field, then

enter 5.0.

3. From the unit dropdown menu, select ng/uL (default).

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative
Standard Curve and Comparative C; Experiments




Chapter 6 Design the Comparative C; Experiment n
Review the Reaction Setup

4. Review the calculated volumes for the sample dilutions:

Sample Name Conc?;ﬁ(t:rztion Vo?:r:r\‘epl(ﬁL) Vollzlilmuzrzth) T‘:)tfa IID‘i,I?JItl:Se
(ng/uL) Sample (uL)
Liver | 100.0 | 1.0 | 19.0 20.0
Kidney 100.0 1.0 19.0 20.0
Brain 100.0 1.0 19.0 20.0

2E. Set Up: Reaction Setup > Reaction Mix Calculati

Reaction Setup Help n
a Far each target assay in the reaction plate, selectthe assay type (ifusing TagMan reagents), then review the calculated volumes for preparing the samples and PCR
Instructions:

reactions. If needed, editthe reaction volume, excess reaction volume, component concentrations, and/or stock concentrations. Click "Print Reaction Setup” to print

1 instructions on how to brenare the PCR reactions

2 [ Reaction Mix Calculations T Sample Dilution Calculations ]

3 Diluted Sample Concentration (10= for Reaction Mix): 5.0 | ngiL % | Print Reaction Setup ]

Sample Name Stock Concentration (naful) Sample Volume (uL) Diluent Volume (uL) Total Volume of Diluted Sample ...

[Liver ||100.0 \‘ 1 0| 19.0| 200

4 Kidney ||100.0 \‘ 1 o| 19.0| 20.0)

Brain ||100.0 \‘ 1 o| 19.0| 20.0)

Print Reaction Setup Instructions

Print detailed reaction setup instructions, then save the instructions for Chapter 7,
“Prepare the Comparative CT Reactions.”

1. Click Print Reaction Setup.

2E. Set Up: Reaction Setup > Reaction Mix Calculati

Reaction Setup Help n

i Faoreach target assay in the reaction plate, selectthe assay type (if using Taghian reagents), then review the calculated volumes for preparing the samples and PCR
a Instructions: reactions. Ifneeded, edit the reaction volume, excess reaction volume, component concentrations, and/ar stock concentrations. Click"Print Reaction Setup” to print
instructions on how to prepare the PCR reactions

J Reaction Mix Calculations T Sample Dilution Calculations ]

H Diluted Sample Concentration (10x= for Reaction Mixl:

5.0 | |ngmL Print Reaction Setup \ H | 1

2. In the dialog box, select:

* Detailed Reaction Setup Instructions
* Include Plate Layout
* Use sample color

3. Click Print to send the reaction setup instructions to your printer.
Notes
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Print Reaction Setup Instructions E
q Selectthe type of instructions to print

(& summary Reaction Setup Instructions
(® Detailed Reaction Setup Instructions
2 [inglude Plate Layout

Plate Layout Print Options

| (%) Use sample color

() Use task colar

Preview | |_Pr;‘ | Cancel

4. Click Next >.

Design  When you design your own comparative C experiment:
Guidelines » If you are using TagMan reagents, select the type of assay you are using:

— Select Inventoried/Made to Order if you are using Applied Biosystems
TagMan® Gene Expression Assays (Inventoried or Made to Order), or Applied

Biosystems Custom TagMan® Gene Expression Assays.

— Select Custom if you are designing your own assays with Primer Express®

software.

* Enter a number from 10 to 30 for the reaction volume/well. The StepOne and
StepOnePlus systems support reaction volumes from 10 to 30 pL.

* Include excess reaction volume to account for the loss that occurs during pipetting.
Applied Biosystems recommends an excess reaction volume of at least 10%.

* Review the reaction mix concentrations for each target: If needed:
— For TagMan reagents, edit the master mix and assay mix concentrations.

— For SYBR Green reagents, edit the master mix, forward primer, and reverse
primer concentrations.

— For 1-step RT-PCR, edit the reverse transcriptase concentration.
* Review the reaction mix components for each target:

— Ifyou are running Fast PCR reactions, make sure you use Fast master mix in the
PCR reactions.

— If you are running standard PCR reactions, make sure you use standard master
mix in the PCR reactions.

— For 1-step RT-PCR, make sure you include reverse transcriptase in the PCR
reactions and use a specific buffer.

* Review the sample dilution calculations for each sample. If needed, edit the diluted
sample concentration (including units) and stock concentration.

For More For more information on:

Information » Completing the Reaction Setup screen, access the StepOne Software Help by
clicking ) or pressing F1.
* Applied Biosystems assays, refer to the:
— TagMan® Gene Expression Assays Protocol

Notes
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— Custom TagMan® Gene Expression Assays Protocol.

Order Materials for the Experiment

On the Materials List screen, review the list of materials recommended to prepare the
PCR reaction plate. (Optional) Print the materials list, create a shopping list, then order
the recommended materials from the Applied Biosystems Store.

Note: To access the Applied Biosystems Store, you need to have an Internet connection.
Product availability and pricing may vary according to your region or country. Online
ordering through the Applied Biosystems Store is not available in all countries. Contact
your local Applied Biosystems representative for help.

Note: The StepOne software recommends the materials to order based on your
experiment design. It is assumed that you will design your experiment, order your
materials, then prepare (Chapter 7) and run (Chapter 8) the reaction plate when your
materials arrive.

About the In the comparative C; example experiment, the recommended materials are:
Exa_lmple » MicroAmp® Fast Optical 48-Well Reaction Plate
Experiment . ® : -
* MicroAmp®™ 48-Well Optical Adhesive Film
+ MicroAmp® 96-Well Support Base
+ TaqMan® Fast Universal PCR Master Mix (2X), No AmpErase® UNG
o TP53 Assay Mix: Hs00153340_m1 (RefSeq NM_000546.2)

* GAPDH Assay Mix: Human GAPD (GAPDH) Endogenous Control kit
(PN 4333764T)

Note: The example experiment was created for a StepOne instrument. If you selected the
StepOnePlus instrument in the Experiment Properties screen (page 139), the 96-well
consumables (for example, the MicroAmp® Fast Optical 96-Well Reaction Plate) are
listed in place of the 48-well consumables.

Complete the 1. Find the target assay on the Applied Biosystems Store:

Ordering
Materials Screen Note: To access the Applied Biosystems Store, you need to have an Internet
connection.
a. Click the Enter Gene Name field, enter TP53, then click Find Assay.
b. In the Find Assay Results dialog box, select the Hs00153340_m1 row, then
click Apply Assay Selection.
Notes
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) Find Assay Results &3
67 Assays Found. Click the Assay ID to view the assay in the Applied Biosystems Store. Select an assay to detect and quantify the target sequence. TP53
Availability Assay ID Gene Symbal Gene Name RefSeq
neGs LU G LG0T LRI AT a
e e e tumor protein p53 (Li-Fraumeni sy.. NM_000546.2
hCG42016 Gene hCG42016 Celera Annotation
|Made 10 Order He01034252 g1 TPS3 tumar protein ps3 (Li-Fraumeni sy... NM_000546.2
hCG42016 Gene hCG42016 Celera Annotation
e e | SoT iG] |72 tumor protein p53 (Li-Fraumeni sy.. NM_000546.2
hCG42016 Gene hCG42016 Celera Annotation
et i E tumor protein p53 (Li-Fraumeni sy.. NM_000546.2
e U heeénis Gene hCG42016 Celera Annotation
|Made 1o Oraer RN01467558 g1 Tp53 tumar protein p53 MNM_030989.1
| rCG34831 Gene rCG34931 Celera Annotation
[ —— {umor protein p53 NM_030389.1
| rcc34831 Gene rCG34931 Celera Annotation
| || 103 | Mext> | | Last | | Apply Assay Selection | | Cancel

c. Click the Enter Gene Name field, enter GAPDH, then click Find Assay.

d. In the Find Assay Results dialog box, select a GAPDH assay row, then click
Apply Assay Selection.

) Find Assay Results &3
21 Assays Found. Click the Assay ID to view the assay in the Applied Biosystems Store. Select an assay to detect and quantify the target sequence. GAPDH
Availability Assay ID Gene Symbal Gene Name RefSeq
mCG115100 Gene mCG115100 Celera Annota. ]
mCG115378 Gene mCG115873 Celera Annota.
mCG116755 Gene mCG116755 Celera Annota...
mCG1217 Gene mCG1217 Celera Annotation
mCG125818 Gene mCG125813 Celera Annota.
mCG134295 Gene mCG134295 Celera Annota...
mCG142398 Gene mCG142309 Celera Annota.
B e | glyceraldehyde-3-phosphate dehy.. NM_002046.3
i hCG2005673 Gene hCG2005673 Celera Annot.
(D N zem glyceraldehyde-3-phosphate dehy.. NM_002046.3
hCG2005673 Gene hCG2005673 Celera Annot.
Pre made 102786624 q1 GAPDH glyceraldehyde-3-phosphate dehy... NM_002046.3
| hCG2005673 Gene hCG2005673 Celera Annot.
GAPDH glyceraldehyde-3-phosphate dehy... NM_002046.3 ~
| || 10f1 | Mext> | | Last | | Apply Assay Selection | | Cancel

Note: The Human GAPD (GAPDH) Endogenous Control kit (PN 4333764T) was
used in the example experiment. However, it is not available through the StepOne
software Find Assay feature and must be ordered separately. You can order the kit
separately or you can select one of the Applied Biosystems GAPDH assays listed in
the Find Assay Results dialog box (as illustrated in the example above).

2. From the Display dropdown menu, select All Items (default), then review the
recommended materials. If needed, use the scroll bar at right to see all items.

Note: For more information on a specific item, click the part number link. You will
be connected to the product information page on Applied Biosystems Store. To
access the Applied Biosystems Store, you need to have an Internet connection.

3. (Optional) Click Print Materials List to send the materials list to your printer.

4. (Optional) Create a shopping list:

a. Select the checkbox next to each of the following items:
+ MicroAmp® Fast Optical 48-Well Reaction Plate
+ MicroAmp® 48-Well Optical Adhesive Film

Notes
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Order Materials for the Experiment

+ MicroAmp® 96-Well Support Base

+ TagMan® Fast Universal PCR Master Mix (2X), No AmpErase® UNG

* Hs00153340_m1 (TP53 Assay Mix)

* GAPDH Assay Mix: Human GAPD (GAPDH) Endogenous Control kit
(PN 4333764T)

b. Click Add Selected Items to Shopping List.

5. (Optional) Create a shopping basket on the Applied Biosystems Store:

Note: To access the Applied Biosystems Store, you need to have an Internet
connection. Product availability and pricing may vary according to your region or
country. Online ordering through the Applied Biosystems Store is not available in all
countries. Contact your local Applied Biosystems representative for help.

a. Check that the Experiment Shopping List contains the desired materials and
that the quantities are correct, then click Order Materials in List.

3A. Order: Materials List (Optional) Materials List Help ﬂ_‘,

n Instructions: 2VIEw the list of materials recommended to prepare the PCR reaction plate. To create a shopping basket on the Applizd Biosystems Stare, add items to the shopping
" list, enter a name for the shopping basket, click"Order Materials in List" then log in.

Find Assay

Enter Gene Name | GAPDH ‘ | Find Assay | Enter a gene name, then click "Find Assay' to search the Applied Biosystemns Store for a gene expression
assay.
1a,1c —

Experiment Materials List

w N

! rovaeanien |
4b | Add Selected tems to Shopping List | Display |A|I ftems v| | Print Materials List |

[ check Al Itam Part Number Description

An optically-clear adhesive film used to sealthe samples into the ~
wells of a microplate. This will reduce the possibility of

cross-contamination hetween sample wells and help ensure
consistent Real-Time PCR data v

Experiment Shopping List (2 items)

| Remove Selected ftems from Shopping List | Shopping Basket Name | Comparative CT Exampl StepOne ‘ | order Materials in List i 58

4a | MicroAmp™ Optical 48-Well Adhesive Film (100 4375323

[ check Al Item Fart Number Quantity

O MicroAmp™ Fast Optical 48-Well Reaction P.. 4375816 h |

O MicroAmpT™ Optical 48-Well Adhesive Film ( 4375323 h |

b. In the Order Materials - Log In dialog box, enter your user name and password
for the Applied Biosystems Store, then click Login and Submit.

Note: If you do not have an account with the Applied Biosystems Store, click
Register Now to create an account.

Notes
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Order Materials - Log In E\
Log into the Applied Biosystems Store to place the selected items in your shopping basket. If you do not
have a user name and password, click "Register Mow" to create a new account.

OR ( ]
Store Log In Register
To log into the Applied Biosystems Store, enter your user Ifyou do not have
name and password then click"Log In and Submit" an Applied
Biosystems
User Mame: account, click the
link below to
create a new
b Fassword account.
‘ Log In and Submit Cancel
Register Now
[[] Remember my user name and password for fulure orders

c. When you are connected to the Applied Biosystems Store, follow the prompts
to complete your order.

6. Go to “Finish the Design Wizard” on page 161.

Design  When you design your own comparative C experiment:

Guidelines Select all the materials you require for your experiment and add them to your

shopping list.
* To access the Applied Biosystems Store:
— Confirm that your computer has an Internet connection.

— Applied Biosystems recommends the following browsers and Adobe® Acrobat®
Reader versions to use the Applied Biosystems web site:

Microsoft® Adobe®
Desktop Operating System Internet Acrobat®
Explorer Reader
Windows® XP V6.X v4.0 or later
(Service Pack 2 or Service Pack 3)
Windows® Vista v7.x or later v4.0 or later

Note: Make sure that cookies and Java Script are turned on for the web site to
function correctly.

For More For more information on completing the Materials List screen, access the StepOne
Information  Software Help by clicking ) or pressing F1.

Notes
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Finish the Design Wizard

Finish the Design Wizard

To finish the Design Wizard, review the plate layout, then select an exit option.

About the The StepOne software automatically selects locations for the wells in the reaction plate.
Example In the comparative C; example experiment:
Experiment » The wells are arranged as shown below.

| [3 | show inwells ¥ | [BE view Legend | |

1 | 2 \ : | 4 | § | 8 \ 7 | 8 |

Liver Liver

[ trsa [ rsa [ tesa [ caroH [ caroH [2] caPoH @ s @ s

=

Kidney Kidney Kidney Kidney

Liver Liver Liver Liver
[ tesa [T zaroH [0 zaroH [ zaroH [ tesa [ tesa [ resa [ zaroH

[

Kidney Kidney

Brain Brain Brain Brain Brain Brain
¢ m GAPDH m GAPDH m TP53 m TPS3 m TPS3 m GAPDH m GAPDH m GAPDH

Note: The example experiment was created for a StepOne instrument. If you
selected the StepOnePlus instrument in the Experiment Properties screen

(page 139), your reaction plate layout will differ from the layout shown above. The
software displays a 96-well reaction plate layout for the StepOnePlus instrument.
For an example of the 96-well reaction plate layout, see page 14.

» The experiment is saved as is and closed.

Note: For the example experiment, do not perform the run at this time.

Finish the 1. At the bottom of the StepOne software screen, click Finish Designing Experiment.
Design Wizard

2. In the Review Plate for Experiment window, review the plate layout. Make sure
there are:
e 18 Unknown wells [T]
* 6 Negative control wells [
* 24 Empty wells

Note: If the plate layout is incorrect, click Return to the Wizard and check your
entered values.

3. Click Save Experiment.

Notes
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Finish the Design Wizard

& Review Plate Layout for Experiment "Comparative CT Exampl™

a Review the plate layout, then select what you wantto do next

3 | Save Experiment Start Run for This Experiment ‘ Edclit Plate Layout ‘ C[f:::g?;g;:;::z;l:::‘ ‘ Return to the Wizard ‘
Save and close this Save this experiment, then  Use Advanced Setup to edit Save and close this Continue designing this
experiment. start the run. Make sure the the plate layout. experiment, then create  experiment using the Dasign
reaction plate is loaded into another experiment using the Wizard
the instrument Design Wizard.
| 07| showinwells v | View Legend | ‘
1 \ 2 | 3 | 1 \ 5 | 8 | 7 \ 8 |
| [ tesa [l tesa [E] resa 1] aron [ caroH [ caroH m TF&:W' Tpsgiw
Liver Liver Liver Liver Kidney Kidney Kidney Kidney
B m TPS3 m GAPDH m GAPDH m GAPDH m TP53 m TP53 m TPS3 m GAPDH
Kidney Kidney Brain Brain Brain Brain Brain Brain
2 © GAPDH GAPDH TPs3 [ Tpsa P53 GAPDH [ caroH GAPDH
D
E
F
4. Inthe Save Experiment dialog box, click Save to accept the default file name and
location. The example experiment is saved and closed, and you are returned to the
Home screen.
Note: By default, the example experiment is saved to the <drive>:\Applied
Biosystems\<software name>\experiments folder.
+ Save Experiment Comparative CT Example
Save n: |@ exparimeants V| @JIE[@
@ =) examples
My Recent
Documents
Desktop
My D‘ocument:
My C.umpmer
g File name [Comparative CT Example | | Save J 4
My Network
Places Files oftype:  |Experiment Docurnent Single files (*.eds) V| | cancel J
Notes
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Finish the Design Wizard

Design  When you design your own comparative C experiment:

Guidelines * In the Review Plate for Experiment window, select the appropriate exit option:
Click If you want to...
Save Experiment Save and close the experiment without making any

further changes or starting the run.

Start Run for This Experiment Save the experiment and start the run. Make sure the
reaction plate is loaded in the instrument.

Edit Plate Layout e Use advanced setup to edit the plate layout.

e (StepOnePlus instrument only) Set a different
temperature for one or more of the VeriFlex blocks
using Advanced Setup.

Create Another Experiment Using Save and close the current experiment, then create

the Design Wizard another experiment using the Design Wizard.
Return to the Wizard Return to the experiment to make changes using the
Design Wizard.

* By default, experiments are saved to the <drive>:\Applied Biosystems\<software
name>\experiments folder. To change the:

— Save location for a specific experiment, navigate to the desired location using the
Save Experiment dialog box.

— Default save location, select Tools » Preferences, then select the General tab
(default). In the Default Data Folder field, browse to the desired location.

Note: To change the default save location, you must be logged in to the software

with a user name, not as a Guest. For more information, see the “Design Guidelines”
for logging in on page 136.

For More For more information on using Advanced Setup, see “Advanced Setup Workflow” on
Information  page 260.

Notes
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Notes
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n Prepare the Comparative C; Reactions

This chapter covers:

B Chapter OVeIVIEW . . . oottt e e e e e et et 166
B Prepare the Template. . ... ... ... 167
B Prepare the Sample Dilutions . .. ....... ... ... ... .. . . 170
B Prepare the Reaction MiX . .......... .. i 171
B Preparethe ReactionPlate . ........... .. ... ... ... ... ... ... .. ... . ... 174

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne™ Real-Time PCR Software by pressing
F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Notes
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Chapter Overview

This chapter explains how to prepare the PCR reactions for the comparative C (AACy)
example experiment and provides guidelines for how to prepare the PCR reactions for
your own comparative C experiment.

Example The workflow for preparing the PCR reactions for the example experiment provided with
Experiment this getting started guide is shown below.

Workflow
Comparative C; (AACt) Experiment

Start Experiment

v
Design the Experiment (Chapter 6)

v
Prepare the Reactions (Chapter 7)

Prepare the template.
Prepare the sample dilutions.

Prepare the reaction mix for each target assay.

A=

Prepare the reaction plate.

v
Run the Experiment (Chapter 8)
v
Analyze the Experiment (Chapter 9)

End Experiment

Notes
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Prepare the Template

Prepare the template for the PCR reactions using the High-Capacity cDNA Reverse
Transcription Kit.

About the For the comparative C; example experiment, the template for the PCR reactions is cDNA
Example reverse-transcribed from total RNA samples using the High-Capacity cDNA Reverse
Experiment Transcription Kit.

Required * One of the Ambion® starter packs listed below for RNA isolation:

Materials
. Catalog
Kit Contents Number
gRT-PCR Starter RNAJater® Tissue Collection: RNA Stabilization AM7020
Pack Solution
RNaseZap® Wipes AM9786
RT-PCR Grade Water (nuclease-free) AM9935
Silencer® Validated siRNA, Std Purity AM51331
Choice of RNA sample preparation products:
¢ RNAqueous®-4PCR Kit AM1914
Note: Recommended if you are isolating RNA from
cells or tissues that may be difficult to disrupt or have
high RNase activity.
¢ RiboPure™ Kit AM1924
Note: Recommended if you are:
e |solating RNA from all tissues, including those that
may be difficult to disrupt, are rich in lipids, or have
high RNase activity, or
¢ Labeling and amplifying RNA for use on
microarrays.
¢ TURBO DNA-free™ AM1907
Note: Recommended if you are using SYBR® Green
reagents. If you are using SYBR Green reagents, use
TURBO DNA-free with the RiboPure Kit.
PCR Starter Pack RT-PCR Grade Water (nuclease-free) AM9935
DNAZap™ AM9890
Choice of RNA sample preparation products, as listed See above
above under the gRT-PCR Starter Pack.
High Capacity RNAJater® Tissue Collection: RNA Stabilization AM7020
cDNA Kit Solution
RNaseZap® Wipes AM9786
Choice of RNA sample preparation products, as listed See above
above under the gRT-PCR Starter Pack.
miRNA Starter Pre-miR™ miRNA Starter Kit AM1540
Pack
Notes
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» Total RNA isolated from liver, kidney, and brain tissues
* One of Applied Biosystems High-Capacity cDNA Reverse Transcription Kits:

Kit Part Number
High-Capacity cDNA Reverse Transcription Kit 4368814
(200 reactions)
High-Capacity cDNA Reverse Transcription Kit 4368813
(1000 reactions)
High-Capacity cDNA Reverse Transcription Kit 4374966

with RNase Inhibitor (200 reactions)

High-Capacity cDNA Reverse Transcription Kit 4374967
with RNase Inhibitor (1000 reactions)

Note: The High-Capacity cDNA Reverse Transcription Kit is used to perform the
example experiment. For a list of other kits you can use to perform your own
experiment, see “Preparation Guidelines” on page 169.

Note: The High-Capacity cDNA Reverse Transcription Kit was formerly called the
High-Capacity cDNA Archive Kit.

Prepare the Use the High-Capacity cDNA Reverse Transcription Kit to reverse-transcribe cDNA
Template from the total RNA samples. Follow the procedures in the Applied Biosystems High-
Capacity cDNA Reverse Transcription Kits Protocol to:

1. Prepare the RT master mix.

. (o\1[e]] CHEMICAL HAZARD. 10X RT Buffer may cause eye, skin,

and respiratory tract irritation. Read the MSDS, and follow the handling
instructions. Wear appropriate protective eyewear, clothing, and gloves.

2. Prepare the cDNA reactions.

3. Perform reverse transcription on a thermal cycler.

Notes
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Preparation When you prepare your own comparative C; (AACy) experiment, Applied Biosystems
Guidelines recommends:

» That you first extract DNA or RNA from the tissue or sample.
* The following templates:

— Complementary DNA (¢cDNA) — cDNA reverse-transcribed from total RNA
samples using one of the following kits:

Kit Part Number
High Capacity RNA-to-cDNA Kit (50 reactions) 4387406
High Capacity RNA-to-cDNA Master Mix 4390778
(200 reactions)
High-Capacity cDNA Reverse Transcription Kit 4368814
(200 reactions)
High-Capacity cDNA Reverse Transcription Kit 4374966

with RNase Inhibitor (200 reactions)

— RNA - Purified total RNA or mRNA extracted from tissue or sample.

— Genomic DNA (gDNA) — Purified gDNA already extracted from tissue or
sample.

For More For more information on:
Information * Preparing cDNA templates, refer to the protocol for the kit you select:
— High Capacity RNA-to-cDNA Kit Protocol
— High Capacity RNA-to-cDNA Master Mix Protocol
— High-Capacity cDNA Reverse Transcription Kits Protocol

Note: The Applied Biosystems High-Capacity cDNA Reverse Transcription Kits
Protocol is not shipped with the High-Capacity cDNA Reverse Transcription Kits.
You can download the protocol from:
http://docs.appliedbiosystems.com/search.taf.

* Preparing RNA or gDNA templates, refer to the protocol for the purification
reagents that you select. To locate Applied Biosystems purification reagents, visit:

http://www.appliedbiosystems.com/

Notes
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Prepare the Sample Dilutions

Perform sample dilutions before adding the samples to the final reaction mix. Dilute the
samples using the volumes that were calculated by the StepOne™ software (“Complete
the Sample Dilution Calculations Tab” on page 154).

About the For the comparative C; example experiment:

Exa_.mple » Sample dilutions are necessary because the sample volume is limited to 10% of the
Experiment total reaction volume in the StepOne software. The total reaction volume is
20 uL/reaction, so the sample volume is 2 \L/reaction.
» The stock concentration is 100 ng/uL. After diluting the sample according to the
Sample Dilutions Calculations table, the sample will have a concentration of
5.0 ng/uL. This is a 10X concentration when adding 2 uL to the final reaction mix
volume of 20 uL. You will have a 1X concentration in the final reaction.

¢ The volumes calculated in the software are:

Stock . Total Volume
. Sample Diluent .
Sample Name Concentration of Diluted
(ng/uL) Volume (pL) | Volume (uL) Sample (uL)
Liver 100.0 1.0 19.0 20.0
Kidney 100.0 1.0 19.0 20.0
Brain 100.0 1.0 19.0 20.0
Required +  Water to dilute the sample
Materials * Microcentrifuge tubes
* Pipettors
* Pipette tips
» Sample stock
* Vortexer
* Centrifuge
Prepare the 1. Label a separate microcentrifuge tube for each diluted sample:
Sample Dilutions e Liver
* Kidney
* Brain
2. Add the required volume of water (diluent) to each empty tube:
Tube Sample Name Diluent Volume
(L)
1 Liver 19.0
2 Kidney 19.0
Notes
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Diluent Volume
(uL)

3 Brain 19.0

Tube Sample Name

3. Add the required volume of sample stock to each tube:

Sample Volume

Tube Sample Name L)
1 | Liver | 1.0
2 Kidney 1.0
3 Brain 1.0

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reaction plate.

Preparation When you prepare your own comparative C experiment:

Guidelines » Sample dilutions may be necessary because the sample volume is limited to 10% of
the total reaction volume in the StepOne software. You must perform the sample
dilutions before adding the samples to the final reaction mix.

+ For optimal performance of TagMan® Gene Expression Assays or Custom TagMan®
Gene Expression Assays, use 10 to 100 ng of cDNA template per
20-uL reaction. For Fast reagents, Applied Biosystems recommends 10 ng.

* Use TE buffer or water to dilute the sample.

For More For more information on Applied Biosystems assays, refer to the:
Information » TagMan® Gene Expression Assays Protocol

s Custom TagMan® Gene Expression Assays Protocol.

Prepare the Reaction Mix

Prepare the reaction mix using the components and volumes that were calculated by the
StepOne software (“Complete the Reaction Mix Calculations Tab for the TP53 Assay”
on page 152 and “Complete the Reaction Mix Calculations Tab for the GAPDH Assay”
on page 153).

Note: The software calculates the volumes for all components for the PCR reactions.
However, when you prepare the reaction mix in this section, include only the master mix,
assay mix, and water. Add the sample when you prepare the reaction plate (see “Prepare
the Reaction Plate” on page 174).

Notes
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About the For the comparative C; example experiment:

Exa_.mple * The reaction mix components are:
Experiment — TagMan® Fast Universal PCR Master Mix (2X)
— TP53 Assay Mix (20X)
— GAPDH Assay Mix (20X)
— Water

* The volumes calculated in the software for both target assays are:

Component Volume (pL) for

1 Reaction
Master Mix (2.0X) 10.0
Assay Mix (20.0X) | 1.0
H,O | 7.0
Total Volume | 18.0

Note: The sample is not added at this time.

Required * Microcentrifuge tubes

Materials « Pipettors
* Pipette tips
» Reaction mix components (listed above)
* Centrifuge

Prepare the IMPORTANT! Prepare the reaction mix for each target assay separately.
Reaction Mix

1. Label an appropriately sized tube for each reaction mix:
* TPS53 Reaction Mix
* GAPDH Reaction Mix

2. For the TP53 assay, add the required volumes of each component to the TP53
Reaction Mix tube:

Volume (pL) for

Volume (uL) for 12 Reactions

Component

1 Reaction (Plus 10% Excess)
TagMan® Fast Universal PCR 10.0 132.0
Master Mix (2X)
TP53 Assay Mix (20X) 1.0 13.2
Water 7.0 92.4
Total Reaction Mix Volume 18.0 237.6
Notes
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3. For the GAPDH assay, add the required volumes of each component to the GAPDH
Reaction Mix tube:

Volume (uL) for Volume (pL) for

Component 1 Reaction (PI:: ? gl’a}oclt-:i::esss)
TagMan® Fast Universal PCR 10.0 132.0
Master Mix (2X)
GAPDH Assay Mix (20X) | 1.0 | 13.2
Water 7.0 92.4
Total Reaction Mix Volume 18.0 237.6

4. Mix the reaction mix in each tube by gently pipetting up and down, then cap each
tube.

5. Centrifuge the tubes briefly to remove air bubbles.

6. Place the reaction mixes on ice until you prepare the reaction plate.

Preparation When you prepare your own comparative C experiment:

Guidelines » If your experiment includes more than one target assay, prepare the reaction mix for
each target assay separately.

* Include excess volume in your calculations to provide excess volume for the loss
that occurs during reagent transfers. Applied Biosystems recommends an excess
volume of at least 10%.

* Include all required components.
* Prepare the reagents according to the manufacturer’s instructions.

» Keep the assay mix protected from light, in the freezer, until you are ready to use it.
Excessive exposure to light may affect the fluorescent probes.

¢ Prior to use:

— Mix the master mix thoroughly by swirling the bottle.
— Resuspend the assay mix by vortexing, then centrifuge the tube briefly.

— Thaw any frozen samples by placing them on ice. When thawed, resuspend the
samples by vortexing, then centrifuge the tubes briefly.

For More For more information on preparing the reaction mix, refer to the protocol appropriate for
Information the reagents you are using in the PCR reactions:

s TagMan® Gene Expression Assays Protocol

 Custom TagMan® Gene Expression Assays Protocol

Notes
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Prepare the Reaction Plate

Prepare the reactions for each replicate group, then transfer them to the reaction plate.
Use the plate layout displayed in the StepOne software.

About the For the comparative C example experiment:

Example + A MicroAmp® Fast Optical 48-Well Reaction Plate is used.
Experiment The reaction volume is 20 pL/well.
* The reaction plate contains:

— 18 Unknown wells [

— 6 Negative control wells [1]

— 24 Empty wells
* The plate layout automatically generated by the StepOne software is used:

| [3 | show inwells ¥ | [BE view Legend | |

1 | 2 \ : | 4 | § | 8 \ 7 | 8 |

Liver Liver

[ trsa [ rsa [ tesa [ caroH [ caroH [2] caPoH @ s @ s

=

Kidney Kidney Kidney Kidney

Liver Liver Liver Liver
[ tesa [T zaroH [0 zaroH [ zaroH [ tesa [ tesa [ resa [ zaroH

[

Kidney Kidney

Brain Brain Brain Brain Brain Brain
¢ m GAPDH m GAPDH m TP53 m TPS3 m TPS3 m GAPDH m GAPDH m GAPDH

Note: The example experiment was created for a StepOne instrument. If you
selected the StepOnePlus instrument in the Experiment Properties screen

(page 139), your reaction plate layout will differ from the layout shown above. The
software displays a 96-well reaction plate layout for the StepOnePlus instrument.
For an example of the 96-well reaction plate layout, see page 14.

Required * Microcentrifuge tubes
Materials « Pipettors
* Pipette tips
* TP53 reaction mix (from page 172)
* GAPDH reaction mix (from page 172)
* Water
» Samples (from page 170)

Notes
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» MicroAmp® Fast Optical 48-Well Reaction Plate
+ MicroAmp® Optical 48-Well Adhesive Film
* Centrifuge

Prepare the 1. For each target, prepare the negative control reactions:

Reaction Plate a. To an appropriately sized tube, add the volumes of reaction mix and water

listed below.

Reaction Mix | Water Volume

Tube Reaction Mix Volume (uL) (uL)

1 TP53 reaction mix 594 6.6

2 GAPDH reaction 59.4 6.6
mix

b. Mix the reaction by gently pipetting up and down, then cap the tube.
c. Centrifuge the tube briefly to remove air bubbles.

d. Add 20 pL of the negative control reaction to the appropriate wells in the
reaction plate.

2. For each replicate group, prepare the reactions for the unknowns:

a. To appropriately sized tubes, add the volumes of reaction mix and sample listed

below.
. Reaction Sample
Tube Unkno_wn Reaqtlon MixVolume Sample Volume
Reaction Mix
(uL) (uL)
1 TP53 Liver TP53 59.4 Liver 6.6
reaction mix
2 TP53 TP53 59.4 Kidney 6.6
Kidney reaction mix
3 TP53 Brain TP53 59.4 Brain 6.6
reaction mix
4 GAPDH GAPDH 59.4 Liver 6.6
Liver reaction mix
5 GAPDH GAPDH 59.4 Kidney 6.6
Kidney reaction mix
6 GAPDH GAPDH 59.4 Brain 6.6
Brain reaction mix

b. Mix the reactions by gently pipetting up and down, then cap the tubes.
c. Centrifuge the tubes briefly to remove air bubbles.

d. Add 20 pL of the unknown (sample) reaction to the appropriate wells in the
plate.

Notes
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Prepare the Reaction Plate

3. Seal the reaction plate with optical adhesive film.
4. Centrifuge the reaction plate briefly to remove air bubbles.

5. Confirm that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the reaction plate again at a higher speed and for a longer period of time.

IMPORTANT! Do not allow the bottom of the reaction plate to become dirty. Fluids
and other contaminants that adhere to the bottom of the reaction plate can
contaminate the sample block(s) and cause an abnormally high background signal.

Correct Incorrect
3
Liquid is at the ¢ Not centrifuged with enough force, or
bottom of the well. o Not centrifuged for enough time

6. Until you are ready to perform the run, place the reaction plate on ice in the dark.

Preparation When you prepare your own comparative C experiment:
Guidelines * Make sure you use the appropriate consumables.

» Make sure the arrangement of the PCR reactions matches the plate layout displayed
in the StepOne software. You can either:

— Accept the plate layout automatically generated by the software.
or
— Use Advanced Setup to change the plate layout in the software.

» Ifyou use optical adhesive film to seal your reaction plates, seal each reaction plate
as follows:

Example
Action
StepOne™ System StepOnePlus™ System

1. Place the reaction plate onto the center of the 96-well base. Be sure the reaction plate is flush with the top surface of the
96-well base.

2. Load the reaction plate as desired.

3. Remove a single optical adhesive film (film) from the box. PN

* For the StepOne system reaction plate, bend both end-tabs
upward. Hold the film backing side up.

* For the StepOnePlus system reaction plate, fold back one of
the end-tabs. Hold the film backing side up.

Notes
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Example
Action
StepOne™ System StepOnePlus™ System

4. In one swift movement, peel back the white protective backing
from the center sealing surface. Do not touch the center
sealing surface.

IMPORTANT! Improper peeling of the optical adhesive film may
result in haziness, but will not affect results. Haziness will
disappear when the film comes into contact with the heated cover
in the instrument.

5. Holding the film by the end-tabs, lower the film onto the
reaction plate (adhesive side facing the reaction plate). Be sure
the film is completely covering all wells of the reaction plate.

6. While applying firm pressure, move the applicator slowly
across the film, horizontally and vertically, to ensure good
contact between the film and the entire surface of the reaction
plate.

7. While using the applicator to hold the edge of the film in place,
grasp one end of the end-tab and pull up and away sharply.
Repeat for the other end-tab.

8. To ensure a tight, evaporation-free seal:
a. Repeat step 6.
b. While applying firm pressure, run the edge of the applicator along all four sides of the outside border of the film.

Note: Optical adhesive films do not adhere on contact. The films require the application of pressure to ensure a tight,
evaporation-free seal.

9. Inspect the reaction plate to be sure all wells are sealed. You should see an imprint of all wells on the surface of the film.

For More For more information on:
Information * Preparing the reaction plate, refer to the protocol appropriate for the reagents you
are using in the PCR reactions:

— TagMan® Gene Expression Assays Protocol
— Custom TagMan® Gene Expression Assays Protocol
* Consumables, see “Supported Consumables” on page 4.

» Using Advanced Setup to change the plate layout, see “Advanced Setup Workflow”
on page 260.

Notes

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative 177
Standard Curve and Comparative C; Experiments



ﬂ Chapter 7 Prepare the Comparative C; Reactions
Prepare the Reaction Plate

Notes
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m Run the Comparative C; Experiment

This chapter covers:

B Chapter OVeIVIEW . . . oottt e e e e e et et 180
B Prepare forthe Run. .. ... ... ... .. . . . . . 181
182

B Runthe Experiment .. ....... ... . i,

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne™ Real-Time PCR Software by pressing
F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Notes
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Chapter Overview

This chapter explains how to perform a run on the Applied Biosystems StepOne™ and
StepOnePlus™ Real-Time PCR Systems.

Example The workflow for running the example experiment provided with this getting started
Experiment guide is shown below.

Workflow
Start Experiment

v
Design the Experiment (Chapter 6)

v
Prepare the Experiment (Chapter 7)

v
Run the Experiment (Chapter 8)

Prepare for the run.
(Optional) Enable the notification settings.
Start the run.

Monitor the run.

o > 0 b=

Unload the instrument and transfer the data.

v
Analyze the Experiment (Chapter 9)

h 4
End Experiment

Notes
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Prepare for the Run

Prepare for the Run

Prepare for the run by opening the example experiment file you created in Chapter 6,
then loading the sealed reaction plate into the StepOne™™ or StepOnePlus™ instrument.

Open the 1. Double-click g (StepOne software) or select Start » All Programs » Applied
Example Biosystems » StepOne Software » <software name>

Experiment where <software name> is the current version of the StepOne software.

2. In the Login dialog box, select EXAMPLEUSER from the User Name dropdown
menu, then click OK.

Note: EXAMPLEUSER is the user name you created when designing the
comparative C; experiment (page 135).
3. From the Home screen, click Open.

4. In the Open dialog box, navigate to the experiments folder (default):

<drive>:\Applied Biosystems\<software name>\experiments

5. Double-click Comparative CT Example to open the example experiment file you
created in Chapter 6.

File Edit Instrument Analysis Tools Help I

3 TEa vew EapenmEnt v L7 Open. [ [ JJ Send Experimentto Instrument.. %, Download Experiment from Instrument... 48 a

Analyze

ﬁ‘ e Experiment

4 om0 experimeants v [ IEEE

| |2 examples

5 " il Comparative CT Example.eds
My Recent

Documenits

My Computer
My Network
Places Files oftype: Al SDS Files (edm; eds; edt)

File name Comparative CT Example.eds

Notes
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Run the Experiment

Perform the following procedures in Chapter 4 for the comparative C experiment:
* “Load the Reaction Plate Into the Instrument” on page 78
* “(Optional) Enable the Notification Settings” on page 79
e “Start the Run” on page 82
* “Monitor the Run” on page 86
* “Unload the Instrument and Transfer the Data” on page 93

Be sure to select the Comparative CT Example.eds file rather than the Relative
Standard Curve Example.eds file.

Notes
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m Analyze the Comparative C; Experiment

This chapter covers:

B Chapter OVeIVIEW . . . oottt e e e e e et et 184
B Section9.1 Review Results......... ... .. .. ... . . ... 185
B Section 9.2 Troubleshoot (If Needed). . ........... ... ... ... ... ..... 203

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne™ Real-Time PCR Software by pressing
F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Notes
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Chapter Overview

The StepOne™ software analyzes the data using the comparative C; (AACt) quantitation
method. Section 1 of this chapter explains how to review the analyzed data using several
of the analysis screens and how to publish the data. If you receive questionable results,
Section 2 of this chapter explains how to perform some troubleshooting steps.

Example The workflow for analyzing the example experiment provided with this getting started
Experiment guide is shown below.

Workflow
Comparative C; (AAC;) Experiment

Start Experiment
v
Design the Experiment (Chapter 6)
v
Prepare the Reactions (Chapter 7)

h 4
Run the Experiment (Chapter 8)

v
Analyze the Experiment (Chapter 9)

Section 1, Review Results:

1. Analyze.

2. View the gene expression plot/results table.

3. View the ampilification plot.

4. Publish the data.

Section 2, Troubleshoot (If Needed):

1. View the analysis settings; adjust the baseline/threshold.
. View the quality summary.

Omit wells.

View the multicomponent plot.

NSNS

View the raw data plot.

h 4
End Experiment

Notes
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Section 9.1 Review Results

Section 9.1 Review Results

This section covers:

B Analyze the Experiment . . ........ ... ... 186
B View the Gene Expression Plotand Well Table . . ........................ 192
B View the Amplification Plot. . ...... ... ... ... ... ... .. ... .. .. . ... 195
B PublishtheData ......... ... . . . . . . . . 202
Notes
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Analyze the Experiment

Notes

186

About the
Example
Experiment

Analyze the
Example
Experiment

The StepOne software analyzes the experiment and displays results in the analysis
screens (for example, the Amplification Plot screen, QC Summary screen, and so on).

For the comparative C example experiment, use the data file that installs with the
StepOne software. The data file was created with the same design parameters provided in
Chapter 6, then run and analyzed on a StepOne™ instrument.

You can find the data file for the example experiment on your computer:

<drive>:\Applied Biosystems\<software name>\experiments\examples\
Comparative CT Example.eds

where:

—

<drive> is the computer hard drive on which the StepOne software is installed. The
default installation drive for the software is the D drive.

<software name> is the current version of the StepOne software.

. Double-click g- (StepOne software) or select Start » All Programs » Applied

Biosystems » StepOne Software » <software name>

where <software name> is the current version of the StepOne software.

In the Login dialog box, select EXAMPLEUSER from the User Name dropdown
menu, then click OK.

Note: EXAMPLEUSER is the user name you created when you designed the
comparative C; experiment (page 135).
From the Home screen, click Open.

In the Open dialog box, navigate to the examples folder:

<drive>:\Applied Biosystems\<software name>\experiments\examples

Double-click Comparative CT Example to open the example experiment data file.

Note: The examples folder contains several data files; be sure to select
Comparative CT Example. For information on the other data files, see “Data Files
in the Examples Folder” on page 18.
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Analyze the Experiment

IFHP. Edit Instrument Analysis Tools Help

3 | = MewDpsdmert— B open.. Wl [} “‘S._—l Send Experimentto Instrument... Fr Download Experiment from Instrument... | &5 B
= », =
D ANa
Design Wiz Ope ze Experiment
4 —— Lookin: [ examples v BDEE
: ki

[N

Presence Absence Example eds
Relative Standard Cune Example.eds

96-\hell Comparative CT Example.eds

G

My D it
e Comparative CT Study Example.edm

Genotyping Example.eds
Multiplex Example.eds

|2 96-well Genatyping Example.eds s
ggci';c:% _‘ 96-Well Multiplex Example.eds 2 RMNase P Experiment.eds

———— |} 9B-Well Presence Absence Example.eds 3 Standard Curve Example.eds

{‘B |22 96-well Relative Standard Curve Example.eds 3 SYBRExample.eds

- '_‘ 96-iell RMaseP Experiment eds

Desktop |23 96-Well Standard Curve Example eds

— | |2 96-Well SYBR Example.eds
5 Y 2 Comparative CT Example.eds
J |22 Comparative GT Study Bio Replicates Example.edm

a

My Computer | |
— [ % »

":g File name [ ] | open ‘

hly hetwork = E _—

Places | Files oftype: Al SDS Files (adm; eds; ey w| [ cencel |

* Home

6. Click Analyze. The software analyzes the data using the default analysis settings.

File Edit Instrument Analysis Tools Help
] New Experiment = 5 open.. [d Save - £ Close | {57 Send Experimentto Instrument.. B¢} Download Experiment from Instrument.. | 48 Export.. = £} Print Report |

\
Experiment Menu <« | Experi.. Comparative CT Examf Ty... Comparative CT (AACT Reage... TagMan® Reagent& @J
& s (S e ot o |
77— N e > Gt it Wit | Salnnt o oo |
7. See “Software Elements” on page 188 and “Navigation Tips” on page 190 for
information on navigating within the analysis screens.

Guidelines When you analyze your own comparative C; experiment:

* Immediately after a run, the StepOne software automatically analyzes the data using
the default analysis settings, then displays the Amplification Plot screen on your
computer.

» To reanalyze the data, select all the wells in the plate layout, then click Analyze.

Notes
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Analyze the Experiment

Software The StepOne software elements for the analysis screens are illustrated below.

Elements _ _ )
1. Menu bar — Displays the menus available in the software:

* File

« Edit

* Instrument
* Analysis
* Tools

* Help

2. Toolbar — Displays the tools available in the software:
* New Experiment
* Open
* Save
* Close
* Send Experiment to Instrument
* Download Experiment from Instrument
* Export
* Print Report

3. Experiment header - Displays the experiment name, experiment type, and reagents
for the open experiment.

4. Experiment Menu pane — Provides links to the following software screens:
* Setup screens
* Run screens
* Analysis screens:
* Amplification Plot
* Gene Expression
*  Multicomponent Plot
* Raw Data Plot
* QC Summary
e Multiple Plots View

5. Plot pane — Displays the selected analysis screen for the open experiment.
6. View tabs — Displays the plate layout or Well Table for the open experiment

7. Experiment tab(s) — Displays a tab for each open experiment.

Notes
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Analyze the Experiment

File Edit Instrument Analysis Tools

Help

Gene Expression
Multicomponent Plot

Raw Data Plot

QC Summary

¥ Multiple Plots View

Plot Settings

Plot Type: GraphTYpE:leear V\ lecmur:|wm|
AP By
Amplification Plot

vl‘

g
8 7
7 i
8
I
T 5
|
a
3
2
1 /
0
IR EEEEEREEEEEEEEEEER)
Cycle
Legend
[-A e I c o =

Options

Show: [] Threshold — [[] Baseline Start: Well B0 Target - Baseline End: Well 'l

[&] MewExperiment - (5 Open.. |l Save - E5 Close ’ﬂ Send Experiment to Instrument. L_ri Download Experiment from Instrument..  &# Export. - Print Report..

Analysis Settings @;

>

SelectWells With: |- Setect tem - v || |

| El Show in Wells ¥

iew Legend ‘

1 2 3 4 5 6 7 8

[ ess [ tesz | [ sz [ sapor [ sarot [1] carot [I] trsa P53

A | CT. Undet CT: Undei CT: Undei CT: Undef CT: Undei CT: Undet CT: 30 Cr: 30

P53 GAP

5 GAP GAP P53 P53 P53 GAP
Ct 30

Ct: 2468 CT: 24 67/ CT: 24.68) CT: 30 Ct 30 Ct 30 Cr 2488

GAP Gap.. [ tpsz | [0 trss [0 trs3 GAP
Ct: 2483/ CT: 24 95/ CT: 30 Ct 30 Ct 30

GAP GAP

Crm:2351/C1: 2339/ C1: 23.39

3]

Wells: [ 18 Unknown [] 6 Negative Contral 24 Empty

Analysis Summary:  Total Wells in Plate: 4if  Wells Set Up: 24

Wells Omitted Manually: 0

Wells Flagged:0  Wells Omitted by Analysis:0  Samples Used:3  Targets Used: 2

- |[[] comparative CT Example.eds x)
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Navigation Tips How to Select Wells

To display specific wells in the analysis screens, select the wells in the View Plate Layout
tab as follows:

1. To select wells of a specific type, use the Select Wells With dropdown menus: Select
Sample, Target, or Task, then select the sample, target, or task name.

2. To select a single well, click the well in the plate layout.

3. To select multiple wells, click and drag over the desired wells, press CTRL+click,
or press Shift+click in the plate layout.

4. To select all 48 wells, click the upper left corner of the plate layout.

View Plate LayoutT View well Table ] I T 1
|
SelectWells With: [Sample ~ |- Selectltem - w
[0 showinwells v | View Legend Liver ‘ |
kidney
Brain
4 1 2 3 : 5 B 7 B
P53 [ resa [ psa [1] sapoH [ caroH [ earoH P53 P53
A |CT Undstermined | CT. Undetermined | CT: Undetermined | CT Undetermined | CT: Undetermined | CT: Undetermined | CT. 30.72 CT: 30,69
TPS3 GAPDH GAPDH GAPDH P53 TPs3 TPS3 GAPDH
B lcr 3066 CT 24 68 Cr: 24 867 C1: 24 88 CT 30.67 Cr:30.68 CT1:30.75 CT 2488
GAPDH GAPDH TP53 TPS3 TP53 GAPDH GAPDH GAPDH
Clcr 2483 CT. 2495 Cr:30.86 CT.30.95 CT 3093 Cr 2351 CT1.23.39 CT 2339
D
E
F
Wells 18 Unknown [] 6 Negative Control 24 Empty
Notes
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Analyze the Experiment

How To Display Multiple Plots

Use the Multiple Plots view to display up to four plots simultaneously. To navigate within
the Multiple Plots view:

1. From the Experiment Menu pane, select Analysis » |£%| Multiple Plots View.

To display four plots, click 75 Show plots in a 2 X 2 matrix.

2.

3. To display two plots in rows, click = Show plots in two rows.

4. To display two plots in columns, click ||| Show plots in two columns.
5.

To display a specific plot, select the plot from the dropdown menu above each plot

display.
5 2 3
(T I I N
EE S 4
—
[mpiication Pot - ARn vs Cycle | Ampification Plot - Rn vs Cycle v
£ P K E £ P AW
Amplification Plot Amplification Plot
5 :a.u ‘ - /‘ = _';‘ /-
= © @ m a3 s 1m  m :;;‘C‘C;L 32 2m am @1 Az ae  aa am e “ = + w @m 1@ 13 1a m m c:i;c':- P E
Legend Legend
{ A slc o EN: lF ‘ [ A sl c o El: - ‘
[Mutticomponent piot | Raw Data Plot v
iy 2 = iy 2 =
. Multicomponent Plot Raw Data Plot
Legend - ' .
AldcllciloIN:F Legend
{ [ A sl c o El: -
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View the Gene Expression Plot and Well Table

The Gene Expression Plot screen displays the results of relative quantitation calculations
in the gene expression profile. There are two plots available:

* RQ vs Target — Groups the relative quantitation (RQ) values by target. Each sample
is plotted for each target. You can view the plot as the following graph types: linear,
log10, Ln, log2.

RQ vs Target

2781

250 1
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125 |
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Targat
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Legend ‘

{ Grain [ iver [l Lung  iidnay

* RQ vs Sample — Groups the relative quantitation (RQ) values by sample. Each
target is plotted for each sample.You can view the plot as the following graph types:
linear, log10, Ln, log2.

R vs Sample
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The Well Table displays data for each well in the reaction plate, including:
* The sample name, target name, task, and dyes
* The calculated threshold cycle (C;), normalized fluorescence (Rn), and quantity

values
* Flags
Notes
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About the In the comparative C; example experiment, you review:
Example .

) Each target in the Gene Expression Plot screen for the expression level (or fold
Experiment

change) of the target sample relative to the reference sample.
» The Well Table to evaluate the precision of the replicate groups.

View the Gene 1. From the Experiment Menu pane, select Analysis » Gene Expression.
Expression Plot
and Well Table Note: If no data are displayed, click Analyze.

2. In the Gene Expression Plot screen:
a. From the Plot Type dropdown menu, select RQ vs Sample.
b. From the Graph Type dropdown menu, select Log10.

c. From the Orientation dropdown menu, select Vertical Bars.

3. Click = Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

In the example experiment, the expression level of TP53 in liver and kidney is
displayed relative to its expression level in the reference sample (brain). Since the
reference sample is compared to itself, the relative expression level is 1. When the
result is displayed in the Log10 graph type, the expression level of the reference
sample appears as 0 in the graph (logl10 of 1 =0).

2a 2b 2c

F‘DtTYpE RQvs Sample hd GraphTy’pe LUg‘\U | Orientation: Vertical Bars A
a8 R~ E 3c
RQ vs Sample

0.55
0.50
0.45
0.40
0.35

(=)

X 0.30

E’ 0.25
0.20
015
010
0.05
0.00

& e @es“q
Sample
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4. View the Well Table:

then select the View Well Table tab.

the example experiment, there are no outliers.

[ View Piate Layout | View Well Table |
4b Select Wells With

b. From the Group By dropdown menu, select Replicate.

- Selectltem - +

| Show in Table ¥ | Group By ¥ |

‘ BY sxpand i | BS callapse al |

a. From the Experiment Menu pane, select Analysis » Amplification Plot,

c. Look at the C; SD column to evaluate the precision of the replicate groups. In

4c

# | well Omit Flag Sample TargetM.. | Task Dyes Ccr CTMean CTsD ACT ACTMean | ACTSE
=l Brain - GAPDH - 23.386133
1 cy [ ] Brain GAPDH UNKNOWN FAM-NFGQ-... 23386133 23427872 0.067
=l Brain - GAPDH - 23.392385
2 ce Brain GAPDH UNKNOWN FAM-NFGQ-... 23392385 23427872 0.067
= Brain - GAPDH - 23.505098
3 Ct6 [ ] Brain GAPDH UNKNOWN FAM-MFGQ-... 23505096 23427872 0.067
=l Brain - TP53 - 30.856344
4 c3 [ ] Brain TP53 UNKNOWN FAM-NFGQ-... 30856344 30912079 0.049 7.484 0.l
=l Brain - TP53 - 30.93019
= Cs [ ] Brain TP53 UNKNOWHN  FAM-NFGQ-... 3093019 30.912079 0.049 7.484 0.l
=l Brain - TP53 - 30.949701
(] cd [ ] Brain TP53 UNKNOWN  FAM-MFGQ-... 30949701 30912079 0.049 7.484 0.l
=l GAPLCH - Undetenmined
T Ad " | GAPDH NTC FAM-MFQ-... Undetermi...
a AS " | GAPDH NTC FAM-MFQ-... Undetermi...
= AB [ ] GAPDH NTC FAM-MFQ-... Undetermi...
=l Kidney - GAPDH - 24 832582
10 c1 [ ] Kidney GAPDH UNKNOWN FAM-MFGQ-... 24832582 24.888632 0.059
=l Kidney - GAPDH - 24 883427
11 B8 [ ] Kidney GAPDH UNKNOWN FAM-MNFG-... 24883427 24.888632 0.059
=l Kidney - GAPDH - 24 949886
12 c2 [ ] Kidney GAPDH UNKNOWN FAM-MFGQ-... 24949886 24 888632 0.059
P -
Note: To show/hide columns in the Well Table, select/deselect the column name from the
Show in Table dropdown menu.
Analysis  When you analyze your own comparative C; experiment, look for:
Guidelines » Differences in gene expression (as a fold change) relative to the reference sample.
+ Standard deviation in the replicate groups (C SD values). If needed, omit outliers
(see “Omit Wells from the Analysis” on page 208).
For More For more information on the Gene Expression Plot screen or Well Table, access the

Information

Notes

StepOne Software Help by clicking @) or pressing F1.
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View the Amplification Plot

View the Amplification Plot

The Amplification Plot screen displays amplification of all samples in the selected wells.
There are three plots available:

* ARn vs Cycle — ARn is the magnitude of normalized fluorescence signal generated
by the reporter at each cycle during the PCR amplification. This plot displays ARn
as a function of cycle number. You can use this plot to identify and examine
irregular amplification and to view threshold and baseline values for the run.

* Rn vs Cycle — Rn is the fluorescence signal from the reporter dye normalized to the
fluorescence signal from the passive reference. This plot displays Rn as a function
of cycle number. You can use this plot to identify and examine irregular
amplification.

* Cpvs Well — C; is the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot. This plot displays C; as a function of well
position. You can use this plot to locate outlying amplification (outliers).

Each plot can be viewed as the following graph types: linear or log10.
About the In the comparative C; example experiment, you review each target in the Amplification

Example Plot screen for:

Experiment * Correct baseline and threshold values

¢ Qutliers

View the 1. From the Experiment Menu pane, select Analysis » Amplification Plot.
Amplification Plot
Note: If no data are displayed, click Analyze.

2. Display the GAPDH wells in the Amplification Plot screen:
a. Click the View Plate Layout tab.
b. From the Select Wells With dropdown menus, select Target, then GAPDH.

Notes
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2a View Plate Layout | View Well Table | 2b
SelectWells With: [Target d | |GAPDH v
| ElshuwinWeHsv | ViewLegend | |
1 2 3 4 5 [} 7 8
TP53 D TP53 D TPS3 GAPDH D GAPDH D GAPDH TP53 TP53
A | CTUndetermined | CT: Undetermined  CT: Undetermined  |CT Undetermined | CT: Undetermined | CT. Uneletermined | CT: 30.72 CT: 30,69
P53 GAPDH GAPDH GAPDH P53 P53 P53 GAPDH
B | cT 3066 Cr:24.68 CT. 24.67 CT. 2468 Cr: 30,67 CT. 30.68 CT 3075 Cr:24.88
GAPDH GAPDH TPS3 P53 TPs3 GAPDH GAPDH GAPDH
Clcr 2483 Cr:24.895 CT1: 30.86 CT 3095 Cr:30.83 C1: 2351 CT 2338 Cr:23.39
o]
E
F
Wells: [ 18 Unknown [Z] 6 Megative Control 24 Emply

3. Inthe Amplification Plot screen:
a. From the Plot Type dropdown menu, select ARn vs Cycle (default).
b. From the Plot Color dropdown menu, select Well (default).
c. Click *= Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes
to Hide the plot legend.

4. View the baseline values:
a. From the Graph Type dropdown menu, select Linear.
b. Select the Baseline checkbox to show the start cycle and end cycle.

c. Verify that the baseline is set correctly: The end cycle should be set a few
cycles before the cycle number where significant fluorescent signal is detected.
In the example experiment, the baseline is set correctly.

Notes
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View the Amplification Plot

3a 4a 3b

Plot
| |
Plot Type: ARnvs Cycle | Graph Type:|Linear % | Plot Color|Well e
Y 3¢

Amplification Plot

ARn
o - N we @ a N ow B

Cycle

’— Legend

Al ciloIN: -
Options

Show. DThreshnld— Baseline Start: Well B Target <. Baseline End: Well "M Target 4~
]

4b
5. View the threshold values:
a. From the Graph Type dropdown menu, select Log.
b. From the Target dropdown menu, select GAPDH.
c. Select the Threshold checkbox to show the threshold.
d. Verify that the threshold is set correctly. In the example experiment, the
threshold is in the exponential phase.
5a
T
Plot il ‘
PlotType:‘AF!nvs Cycle v| GraphType:|Lng \"| PIotCoIor ‘
P pAaRRE
Amplification Plot
B e e SO OO R OSSO — e :
% 0.001 B /m E"‘f-
: o 2 4 & 8 10 12 14 16 18 ZOCyDIEZZ 24 28 28 50 52 34 38 38 40 a2
Legend
{ A slcilcEl:r
“Options )
5b Target mThreshu\d [#] Auto l:l
Show: @Z‘I’hreshn‘lﬁ— Baseline Start: Well B Target <. Baseline End: Well "M Target 4~
50— t—
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6. Locate any outliers:
a. From the Plot Type dropdown menu, select Cy vs Well.

b. Look for outliers from the amplification plot. In the example experiment, there
are no outliers for GAPDH.

6a

Plot i
Plot Type:|CTvs Well | Graph Type Plot Color: \wWell A ‘

P p el =

Amplification Plot

400 - - -
37.5
35.0
3z.5
30.0
27.5
25.0 - -
228
20.0
17.5
15.0
12.5
10.0

7.8

5.0

2.5

0.0 o

2 4 & & 10 1z 14 18 18 20 22 24
Well Number

AlleNcilcIN:INr

’— Legend

7. Repeat steps 2 through 6 for the TP53 wells. In the example experiment, there are no
outliers for TP53.

Analysis  When you analyze your own comparative C; experiment, look for:

Guidelines o Outliers

* A typical amplification plot — The StepOne software automatically calculates
baseline and threshold values based on the assumption that the data exhibit a #ypical
amplification plot. A typical amplification plot has four distinct sections:

a. Plateau phase
b. Linear phase
c. Exponential (geometric phase)

d. Baseline

Notes

198 Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative
Standard Curve and Comparative C; Experiments



Chapter 9 Analyze the Comparative C; Experiment m
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0210658
Threshold

0.1

ARnNn

0.01

0.001

- .l-: ':; Zi "'IFH T ry.lllu
/Y A hid i A I~

02r_Ea1012|1¢1ﬁ1ﬁm”kﬂﬂ“1‘9t““m0d

Cycle

0.0001

IMPORTANT! Experimental error (such as contamination or pipetting errors) can
produce atypical amplification curves that can result in incorrect baseline and
threshold value calculations by the StepOne software. Therefore, Applied
Biosystems recommends that you examine the Amplification Plot screen and review
the assigned baseline and threshold values for each well after analysis completes.

* Correct baseline and threshold values — See the threshold examples on page 200 and
the baseline examples on page 201.

Notes
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View the Amplification Plot

Threshold Set Correctly

The threshold is set in the exponential phase of the
amplification curve.

Threshold settings above or below the optimum
increase the standard deviation of the replicate
groups.

Task Dyas (54 T Mean (58-I Quantey Quantey Quantey Commi
NTC FAMENFG-.. Uniseteami_

NTC FAMENFO-. Unidetedmi..

NTC FAM-HFG-.. Undsisimi..

UNFMOWN FAMKNFO-.. 2896287 28923796 0074 248431 2551476 1262
UNHEMOWH  FAMENFG... 28 838787 28423708 0074 2887054 2EE1ATE 1282
URFMOWN FAM-NFG-. 2008572 20023708 0.074 2473084 255147 182

Threshold Set Too Low

The threshold is set below the exponential phase of
the amplification curve. The standard deviation is
significantly higher than that for a plot where the
threshold is set correctly. Drag the threshold bar up
into the exponential phase of the curve.

Task Dyes cr CrMean  CTS0 Quarlly  Ouartly.. Ouanidy
HTC FAM-HFC-. Undstedni.

HTC FAM-NFQ-... Undstsimi..

NTC FAM-HFG-.. 38453182

UNKMNOWH FAM-NFO-.. 2285404 22761744 0252 2314852 2472483 400435
UNKMNOWN FAM-NFG-. 22478873 22781744 0282 2827732 2472483 400,435
URENOWH  FAMNFG-.. 22054218 22781744 0252 2AT4MIE  24T2483 400435

Threshold Set Too High

The threshold is set above the exponential phase of
the amplification curve. The standard deviation is
significantly higher than that for a plot where the
threshold is set correctly. Drag the threshold bar
down into the exponential phase of the curve.

0.242796.

L.754743

Task Dyas cr CT Mean CTE0 Quansy Quansy Quantsy Commg
NTC FAM-NFQ-_. UndSsteimi_.
NTC FAM-NFO-_. Undetedmi_.
HNTC FAM-HFQ-.. Undsdemi..
UNKNOWN FAM-NFQ-. 37.681107 3749507 0.202 2571477 2880428 383775
UNKNOWH FAM-NFG-.. 37.278T1 Ir.assor 0202 3260623 2288425 383778
UNKMNOWN FAM-NFG-.. 37.524305 3740507 0202 :E24187 ZEBBAS IBATTS
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Baseline Set Correctly

The amplification curve begins after the maximum ’
baseline. i/

Baseline Set Too Low

The amplification curve begins too far to the right 7
of the maximum baseline. Increase the End Cycle . 77 /)
value. i, Y

Baseline Set Too High

The amplification curve begins before the Y,
maximum baseline. Decrease the End Cycle value. 7

If your experiment does not meet the guidelines above, troubleshoot as follows:
* Omit wells (see “Omit Wells from the Analysis” on page 208).
or

* Manually adjust the baseline and/or threshold (see “View the Analysis Settings” on
page 204).

For More For more information on the Amplification Plot screen, access the StepOne Software
Information  Help by clicking @) or pressing F1.

Notes
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Publish the Data

You can publish the experiment data in several ways:
» Save the plot as an image file
* Print the plot
* Print the plate layout
* Create slides
* Print a report
* Export data

For information on performing these procedures, access the StepOne Software Help by
clicking @) or pressing F1.

Notes
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Section 9.2 Troubleshoot (If Needed)

This section covers:

B View the Analysis Settings . .. ...ttt 204
B View the QC SUMMATIY. . . ..ottt ettt e e e e e e e e 206
B Omit Wells from the Analysis. . ........ ... ..., 208
B View the Multicomponent Plot. .. ........ ... ... .. ... ... ... .. ... 209
M Viewthe Raw DataPlot ... ........ ... .. .. .. . . . . . . . . . . .. 212
Notes
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View the Analysis Settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle
(Cy), flags, relative quantitation, and advanced options. If the default analysis settings in
the StepOne software are not suitable for your experiment, you can change the settings in
the Analysis Settings dialog box, then reanalyze your experiment.

About the In the comparative C; example experiment, the default analysis settings are used without
Example changes.
Experiment

View the Analysis 1. From the Experiment Menu pane, select Analysis.

Settings
2. Click Analysis Settings to open the Analysis Settings dialog box.
3. In the example experiment, the default analysis settings are used for each tab:
* C; Settings
* Flag Settings
» Relative Quantitation Settings
* Advanced Settings
£ Analysis Settings for Comparative CT Example
\__QI___ﬁggjn_g_ﬁ__| Flag Settings I Relative Quantitation Settings I Advanced Settings l
a Review the default settings for analysis of targets in this experiment. To editthe default settings, click "Edit Default Settings.” To use different settings
for atarget, selectthe target from the table, deselectthe "Use Default Settings” checkhox, then change the settings that are displayed.
Default C1 Settings
Default CT settings are used to calculate the CT for targets without custom settings. To edit the default settings, click "Edit Default Settings "
Threshold: AUTO Baseline Start Cycle: AUTO Baseline End Cycle: AUTO ‘ Edit Default Settings
Select a Target C1 Settings for TP53
Target Threshaold Baseline Start Baseline End 7 Settings to Use: Use Default Settings
TP53 AUTO AUTO AUTO e
GAPDH AUTO IAUTO AUTO l:l
==] [E:]
~
Revert to Original Analysis Seftings ‘ Apply Analysis Seftings | Cancel
Notes
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Analysis Unless you have already determined the optimal settings for your experiment, use the
Guidelines default analysis settings in the StepOne software. If the default settings are not suitable
for your experiment, you can change the:

* C; Settings — Use this tab to manually set the threshold and baseline. When
manually setting the threshold and baseline, Applied Biosystems recommends the

following:
Setting Recommendation
Threshold Enter a value for the threshold so that the threshold is:
¢ Above the background.
¢ Below the plateau and linear regions of the amplification curve.
e Within the exponential phase of the amplification curve.
Baseline Select the Start Cycle and End Cycle values so that the baseline

ends before significant fluorescent signal is detected.

* Flag Settings — Use this tab to:
— Adjust the sensitivity so that more wells or fewer wells are flagged.
— Change the flags that are applied by the StepOne software.

* Relative Quantitation Settings — Use this tab to:
— Change the reference sample and/or endogenous control.

— Correct the amplification efficiency. You can enter a percentage value between
1% and 150%. When you set an assay to have a value that differs from 100%
efficiency, the software uses the relative standard curve algorithm.

— (For multiplex reactions) Specify the AC; value at which to reject replicates
(outlier rejection).

— Select the algorithm to use to determine RQ Min/Max values (confidence level or
standard deviations).

* Advanced Settings — Use this tab to change baseline settings well by well.

For More For more information on the analysis settings, access the StepOne Software Help by
Information pressing F1 when the Analysis Settings dialog box is open.

Notes
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View the QC Summary

Notes

206

The QC Summary screen displays a list of the StepOne software flags, and includes the
flag frequency and location for the open experiment.

About the In the comparative C example experiment, you review the QC Summary screen for any
Example flags triggered by the experiment data. In the example experiment, no flags have been
Experiment triggered.

View the QC 1. From the Experiment Menu pane, select Analysis »
Summary
Note: If no data are displayed, click Analyze.

2. Review the Flags Summary. In the example experiment, there are 0 flagged wells.

3. In the Flag Details table, look in the Frequency and Wells columns to determine
which flags appear in the experiment. In the example experiment, the Frequency
column displays O for all flags.

Note: A 0 displayed in the Frequency column indicates that the flag does not appear
in the experiment.

4. (Optional) Click each flag row to display detailed information about the flag.

QC Ssummary

Flag v

Total Wells: 48 | Processed Wells: 24 | Targets Used 2
Wells Set Up: 24 | Flagged Wells: 0 Samples Used: 3 ‘

[
Flag Details
Flag Name Frequency Wells

AMPNC Amplification in negative contral 0 ~
BADROX Bad passive reference signal 0

OFFSCALE Fluorescence is offscale 0

HIGHSD High standard deviation in replicate group 0

NOAMP Mo amplification 0

MOISE Moise higher than others in plate 0

SPIKE MNoise spikes 0

NOSIGMAL Mo signal in well 0

OUTLIERRG Outlier in replicate group 0

EXPFAIL Exponential algarithm failed 0 B

Flag: AMPNC—Amplification in negative cantrol

Flag Detail: A sequence amplified in a negative contral
reaction.

Flag Criteria: CT<35.0
Flagged Wells: None
View AMPNC Troubleshooting Infarmation
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Possible Flags For comparative C experiments, the flags listed below may be triggered by the
experiment data.

If a flag does not appear in the experiment, its frequency is 0. If the frequency is >0, the
flag appears somewhere in the experiment; the well position is listed in the Wells column.

Flag Description
AMPNC Amplification in negative control
BADROX Bad passive reference signal
BLFAIL Baseline algorithm failed
CTFAIL ' Cy algorithm failed
EXPFAIL ' Exponential algorithm failed
HIGHSD ' High standard deviation in replicate group
MTP Multiple Tm peaks

Note: This flag is only displayed if the experiment
includes a melt curve.

NOAMP No amplification

NOISE Noise higher than others in plate
NOSIGNAL No signal in well

OFFSCALE " Fluorescence is offscale
OUTLIERRG " Outlier in replicate group

SPIKE " Noise spikes

THOLDFAIL Thresholding algorithm failed

Analysis When you analyze your own comparative C experiment:

Guidelines * Click each flag in the Flag Details table with a frequency >0 to display detailed
information about the flag. If needed, click the troubleshooting link to view
information on correcting the flag.

* You can change the flag settings:
— Adjust the sensitivity so that more wells or fewer wells are flagged.
— Change the flags that are applied by the StepOne software.

For More For more information on the QC Summary screen or on flag settings, access the StepOne
Information  Software Help by clicking ) or pressing F1.

Notes
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Omit Wells from the Analysis

Experimental error may cause some wells to be amplified insufficiently or not at all.
These wells typically produce C values that differ significantly from the average for the
associated replicate wells. If included in the calculations, these outliers can result in
erroneous measurements; to ensure precision, omit the outliers from the analysis.

About the In the comparative C; example experiment, there are no outliers; no wells need to be
Example removed from analysis.
Experiment

Omit Wells 1. From the Experiment Menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. In the Amplification Plot screen, select Cy vs Well from the Plot Type dropdown
menu.

3. Select the View Well Table tab.

4. In the Well Table:
a. From the Group By dropdown menu, select Replicate.

b. Look for any outliers in the replicate group (be sure they are flagged). In the
example experiment, there are no outliers.

3
View Plate Layout | View Well Table W
4a | SelectWells With: | Selectitem - v
‘ |
[ snowinTapie v | eroupay v | | 5 Expand an | 5 collapse Al |
‘
# | wel omit Flag Sample .. | TargetN.. | Task Dyes cr CiMean | CTSD | acr ACTMean | ACTSE
= Brain - GAPDH - 23.386133 ~
1 cr m| Brain GAPDH  UNKNOWN FAM-NFQ-.. 23386133 23427872 0.067
= Brain - GAPCH - 23.392385
2 cs m| Brain GAPDH  UNKNOWN FAM-NFQ-.. 23382385 23427872 0.067
= Brain - GAPCH - 23.505096
3 ce m| Brain GAPDH  UNKNOWN FAM-NFQ-.. 23505096 23427872 0.067
= Brain - TPS3 - 30856344
1 c3 m| Brain TPs3 UNKNOWN FAM-NFQ-.. 30856344 30812079 0.048 7.484 0l
= Bran - TPS3 - 5093019
5  cs m| Brain TPs3 UNKNOWN FAM-NFQ-.. 3093018 30812079 0.048 7.484 0l
= Brain - TP53 - 30949701
6 c4 m| Brain TPs3 UNKNOWN FAM-NFG-.. 30948701 30812079 0.048 7.484 0l
= GAPLCH - Undetetmined
7 M =] GAPDH  NTC FAM-NFG-.. Uindetermi
8 A =] GAPDH  NTC FAM-NFG-.. Uindetermi
CRT) =] GAPDH  NTC FAM-NFG-.. Uindetermi
= Kidney - GAPTH - 24832582
0 e Il Kidney ~ GAPDH  UNKNOWN FAM-NFQ-. 24832582 24888632 0.059
= Kidney - GAPTH - 24883427
- Il Kidney ~ GAPDH  UNKNOWN FAM-NFQ-. 24883427 24888632 0.059
= Kidney - GAPTH - 24949886
17 c2 Il Kidney ~ GAPDH  UNKNOWN FAM-NFQ-. 24943886 24888632 0.059 .
FE—E—rey .
Notes
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Analysis When you analyze your own comparative C experiment, carefully view the replicate
Guidelines groups for outliers. If needed, remove outliers manually using the Well Table:

1. From the Experiment Menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. In the Amplification Plot screen, select Cy vs Well from the Plot Type dropdown
menu.

3. Select the View Well Table tab.

4. Inthe Well Table:
a. From the Group By dropdown menu, select Replicate.
b. Look for any outliers in the replicate group (be sure they are flagged).

c. Select the Omit checkbox next to the outlying well(s).

5. Click Analyze to reanalyze the experiment data with the outlying well(s) removed
from the analysis.

For More For more information on omitting wells from the analysis, access the StepOne Software
Information  Help by clicking @) or pressing F1. Within the Help, search for the omit well topics:

1. Click the Search tab.
2. Enter omit well.

3. Click List Topics.

4

. Double-click the topics you want to review.

View the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye
in a selected well over the duration of the PCR run.

About the In the comparative C; example experiment, you review the Multicomponent Plot screen
Example for:

Experiment « ROX"™ dye (passive reference)
+ FAM™ dye (reporter)
» Spikes, dips, and/or sudden changes
+ Amplification in the negative control wells
Notes
Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative 209

Standard Curve and Comparative C; Experiments



m Chapter 9 Analyze the Comparative C; Experiment
View the Multicomponent Plot

View the
Multicomponent
Plot

1. From the Experiment Menu pane, select Analysis »

Multicomponent Plot.

Note: If no data are displayed, click Analyze.

2. Display the unknown wells one at a time in the Multicomponent Plot screen:

a. Click the View Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent

Plot screen.

Note: Ifyou select multiple wells, the Multicomponent Plot screen displays the
data for all selected wells simultaneously.

3. From the Plot Color dropdown menu, select Dye.

4. Click = Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to

Hide the plot legend.

5. Check the FAM dye signal. In the example experiment, the FAM dye signal
increases throughout the PCR process, which indicates normal amplification.

6. Check the ROX dye signal. In the example experiment, the ROX dye signal remains
constant throughout the PCR process, which indicates typical data.

3 4

2a

>

Plot i
Plot Color |Dye

v

300,000
275,000
250,000
225,000
200,000
175,000

150,000

Fluorescence

125,000
100,000

75 000

a i K=

Multicomponent Plot

50,000

Notes
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25,000

]

T

6 & 10 12 14 16 18 N W M X M N W M % B 4 &
Cycle

Legend

| Y [

w | - Selectltem- w

SelectWells With: Target

| [0 | show inwells ¥ | [ viewL=gend

|

1+ [ 2 [ 3 [ 4 [ s [ & [ 7 | 8

[tesa [tesz [ tesa | [ aaror [0 sarotr [0 sapot [ esa [ Tps3

Cr1: Undel| C1: Undel CT: Undel| CT: Unded| C1. Unde! CT:Undel| C1: 30.... | CT. 30....

I trsz | sae... [ cap.. [ car.. [ rsz [ rsa
Cr:30.... |Cr: 24,68 CT: 24,67 |Cm: 2468 C1 30 Gl |

m GAP m GAP m TP53 mTPss m TP53 m GAP

Cr:24.83(C1: 2485 Cm:30.... '|C1:30.... "(CT 30.... |G 23.51

>

[ sz |[O sar...

Cr:30...'|CT. 2488

m

m GAP m GAP

Cr:23.39|C1 23.39

o

wells: [I] 18 Unknown [1] 6 Negative Control 24 Empty

2b
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7. Select the negative control wells one at time and check for amplification. In the
example experiment, there is no amplification in the negative control wells.

Multicomponent Plot <| View Plate Layout I View Well Table }
Plot Setti > SelectWells with: [Target v || seizetitem- v
| El Show inWells ¥ | [ View Legend |
s
1 [z ] 3 4 s [ 6 | 7 [ 8
Multicomponent Plot
300000 [ trsz |[Lltrsz [l tesz ([ sarct|[L] caror [1] carot [ tesz ([ trs2
A | CT Undel €T Undel Gt Undel|Cr: Undel| CT: Undel CT Undei Gr:30. . CT:30..°
275,000
250,000 | |
TP53 GAP m GAP. GAP TP53 m TPS3 TP53 GAP
225,000 B|Cman.. " Cr 2468 CT 2467 CT 2468 CT:30... CT30.. Cm30. ' CT.24.88
200,000 [ |
» .
2 175000 i @ cer... [[oar. [ sz [@1rsa [Mess @ car... [ car.. | [0 car
% 150,000 G |CT.24.83CT:24.95 CT; 30...  CT:30... " CT:30.... | CT; 23.51 CT. 23.39| CT: 23.39
5
2 125000 |
100,000
D
75,000
50,000 |
7 25.000H E
a 0 2 4 & B 10 12 14 16 18 20 X2 24 6B 28 N L M ¥ M 40 £ {1
Cycle
Legend F
B rox I Fav ||
wells: [I] 18 Unknown [l 6 Megative Control 24 Empty

Analysis When you analyze your own comparative C experiment, look for:

Guidelines » Passive reference — The passive reference dye fluorescence level should remain

relatively constant throughout the PCR process.

* Reporter dye — The reporter dye fluorescence level should display a flat region
corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds.

* Any irregularities in the signal — There should not be any spikes, dips, and/or sudden
changes in the fluorescent signal.

» Negative control wells — There should not be any amplification in the negative
control wells.

For More For more information on the Multicomponent Plot screen, access the StepOne Software
Information  Help by clicking @) or pressing F1.

Notes
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View the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for each
optical filter for the selected wells during each cycle of the real-time PCR.

About the In the comparative C example experiment, you review the Raw Data Plot screen for a
Example stable increase in signal (no abrupt changes or dips) from the appropriate filter.
Experiment

View the Raw 1. From the Experiment Menu pane, select Analysis » Raw Data Plot.
Data Plot
Note: If no data are displayed, click Analyze.

2. Display all 48 wells in the Raw Data Plot screen by clicking the upper left corner of
the plate layout in the View Plate Layout tab.

3. Click = Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

Note: The legend displays the color code for each row of the reaction plate. In the
example shown below, Row A is red, Row B is yellow/green, Row C is green, and so
on.

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 40. In the example
experiment, there is a stable increase in signal from filter 1, which corresponds to
the FAM™ dye filter.

Notes
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Raw Data Plot
3

8=

Raw Data Plot

325,000
300,000
275.000
260,000 f=
225,000
&
£ 200,000
=3
175.000

150,000

125,000

100.000

75,000

50,000

Filter

{ Legend ‘

A s el - r

Options
Show Cycle 40 - U 4
1 10 20 0 40

The filters are:

StepOne system StepOnePlus system
Filter Dye Filter Dye
1 FAM™ dye 1 AW dye
| SYBR® Green dye | | SYBR® Green dye
2 JOE™ dye 2 JOE™ dye
VIC® dye VIC® dye
3 ROX™ dye 3 TAMRA™ dye
| | " NED™ dye

4 | ROX™dye

Analysis When you analyze your own comparative C experiment, look for the following in each
Guidelines filter:

* Characteristic signal growth
* No abrupt changes or dips

For More For more information on the Raw Data Plot screen, access the StepOne Software Help by
Information clicking g) or pressing F1.

Notes

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative 213
Standard Curve and Comparative C; Experiments



m Chapter 9 Analyze the Comparative C; Experiment
View the Raw Data Plot

Notes
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B Analyzethe Study....... ... ... . . 229
B View the Analysis Settings . ... 235
B View the Amplification Plot. . ....... ... ... ... .. ... .. .. .. .. ... .. 237
B View the Gene ExpressionPlot. . ............. ... ... ... .......... 240
B View the Replicate Results Data and the Well Results Data .............. 243
B View the Multicomponent Plot. .. ............. ... ... ... ... ........ 248
B View the QC SUMmMAry. . .. ..ottt e e e 250
B Compare Analysis Settings. .. ...ttt 252
B (If Needed) Omit Wells from the Analysis. ............ ... ... ... ..... 250
B Publishthe Data ....... ... . ... 257

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne™" Real-Time PCR Software by pressing
F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Notes
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Chapter Overview

The StepOne™ software can combine the analysis of experiments that use the
comparative C; (AACy) quantitation method into a comparative C; study. This chapter
explains how to design and analyze multiple experiments as a study.

About Studies i
In a comparative C; study, you can... You cannot...
e Specify the endogenous control(s) and e Create, add, or modify samples.
reference sample for the study. e Create, add, or modify targets.
. tSet irldividual efficiency values for each e Change assay tasks.
arget.
. Note: You can perform these operations in
* Select the control type when applicable. individual comparative C; experiments.
e Set baseline and threshold values and
confidence levels, or set the number of
standard deviations for Comparative C
Min/Max.
e Omit wells individually or together through
their association with replicate groups
(technical or biological).
Note: For more information about methods of calculating relative quantitation, refer to
the Real-Time PCR Systems Reagent Guide.
Notes
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Example Study The workflow for analyzing the example studies provided with this getting started guide
Workflow is shown below.

Comparative C; (AAC;) Experiment
Start Experiment

v
Design the Experiment (Chapter 6)

h 4
Prepare the Reactions (Chapter 7)

v
Run the Experiment (Chapter 8)

v
Analyze the Experiment (Chapter 9)

v
Design and Analyze a Study (Chapter 10)

1. Design a study:
a. Create a study.
b. Define study properties.
c. Define replicates.

2. Analyze a study:
. View the analysis settings.
. View the amplification plot.
. View the gene expression plot.
. View the replicate results data and well results data.
. View the multicomponent plot.
View the quality summary.
. Compare the analysis settings.
. (If needed) Omit wells from the analysis.

3. Publish the data.

SQ ™~ 0 o O T o

v
End Experiment
Notes
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Design a Study

This section explains how to use the StepOne software to set up a comparative C
example study. It also describes Applied Biosystems recommended best practices as you
design the study.

Create a New Study
To create a new study in the StepOne software:

1. Double-click g (StepOne software) or select Start » All Programs » Applied
Biosystems » StepOne Software » <software name>
where <software name> is the current version of the StepOne software.

2. In the Login dialog box, select EXAMPLEUSER from the User Name dropdown
menu, then click OK.

Note: EXAMPLEUSER is the user name you created when you designed the
comparative C; experiment (page 135).

Loginas Guest [l Delets User(s)

3. From the Home screen, click | 47| (Create Study).

Note: If you do not see the Create Study icon, click the arrow beneath the Analyze
Experiment icon to expand the Analyze menu.

Notes
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File Edit hstrument Analysis Tools Help

open.. M 5 37 send Experimentto Instument... B¢, Download Experinent frem Instrament. | 4 a

Analyze

Analyze Experiment

4. See “Software Elements” on page 220 for information on navigating within a study.

Design  When you design your own study, you can do one of the following in the Login dialog
Guidelines  box:

* Log in as a new user — In the User Name field, enter a user name, then click OK.

Note: You cannot use the following characters in the User Name field: space,
forward slash (/), backslash (\), greater than sign (>), less than sign (<), asterisk (*),
question mark (?), quotation mark ("), vertical line (|), colon (:), or semicolon (;).

* Log in as an existing user — From the User Name dropdown menu, select an existing
user, then click OK.

* Log in anonymously — Click Log in as Guest.

Applied Biosystems recommends that you log in with a user name. If you log in with a
user name, you can set preferences in the software. The next time you log in to the
software with the same user name, the software uses the preferences you set as the
defaults.

IMPORTANT! If you log in to the software as a Guest, you cannot set preferences.

You can set preferences as follows:

» Save as the default checkboxes — Select the Save as the default checkboxes as
needed. The Save as the default checkboxes appear on the Home screen, on the
Export Data dialog box, and on several Analysis screens.

Notes
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* Preferences dialog box — Select Tools » Preferences to open the Preferences dialog
box. In the Defaults and/or Startup tabs, change the preferences as desired.

» Preferences

a Enter a default sample volume for your experiments, select your default folders, and
selectthe type of instrument for the sofware to use by default

Sample Reaction vol.: |20 HL

Data Folder: \Applied BiosystemsiStepOne Software v2.1lexperiments ‘ ‘

Import Folder: S\pplied BiosysternsiStepOne Software v2 1lexperiments \

Export Folder: \Applied BiosystemsiStepOne Software v2.1lexperiments ‘ ‘

Instrument Type

ok || cancal

Software The StepOne software elements for the study are illustrated below.

Elements . . )
1. Menu bar — Displays the menus available in the software:

* File

» Edit

e Instrument
* Analysis
* Tools

* Help

2. Toolbar — Displays the tools available in the software:
* New Experiment
* Open
* Save
* Close
» Send Experiment to Instrument

* Download Experiment from Instrument

3. Study header — Displays the study name, the number of experiments in the study,
and the date/time that the study was last modified.

4. Study Menu pane — Provides links to the following Setup screens:
» Study Properties
» Define Replicates

5. Study/experiment tab(s) — Displays a tab for each open study or experiment.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative
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% ] NewExgariment -+ (5 open. el Save - £ close ] Sena Experments Insiumerr.. ) Down oa Exserment fom nstrumert.. | )

Study Properties

* Sty Nare: Unitea

(Comments (opticnai: |

Analysis: Lninown

[User Narre (Optional: [EXAMPLEUSER

Last Mocifed.

Number of Experiments:

Set Up Experiments (0)

[ s Erparmerics) | | | i rter
Enter a filter query, then click"Apply Filtar"
IF [Bxperment Name v = =l

Experiment Name

Number o Targets | Numbr f Sampl... | Opsrator Run Date

1| ety Fier | | )

Select
an
expeiiment

to
preview

Notes
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Define Study Properties

In the Study Properties screen, enter identifying information for the study, then add
experiments to the study.

About the In the example study, the:
Example Study + Study is identified as an example.

* Experiment that you add to the study is the same example experiment that you
analyzed in Chapter 9 of this guide.

Complete the 1. Inthe Study Menu pane, select Setup » Study Properties.

Study Properties . _ _
Screen 2. In the Study Properties pane, click the Study Name field, then enter Comparative

Ct Study Example.

3. Click the Comments ficld, then enter Example Comparative Ct Study for the
Relative Standard Curve/Comparative Ct Getting Started Guide.

4. In the Set Up Experiments pane, click Add Experiment(s).

5. In the Open dialog box, open the Comparative CT Example.eds file at:

<drive>:\Applied Biosystems\<software name>\experiments\examples

6. In the Set Up Experiments table, select the Comparative CT Example experiment.
The StepOne software displays the details of the experiment in the Properties pane.

2 Study Name: | Comparative Ct Study Example Analysis: RQ
3 omments (Optional): [Example Comparative Ct Study for the Relative Standard CurvelComparative Ct Getting Started Guide
User Name (Optional): | EXAMPLEUSER
Last Modified: Number of Experiments: 1
4 { ) ( | FiteFter
Enter a filter query, then click "Apply Filter"
IF |ExperimentName v = v | ol Fiter | | |
Experiment it Name Number of Targets ~ Number of Sampl. Operator Run Date 7 6
6 -l omparative CT Example.eds 12 3 Exarnple User 11/20/2006 17:36:20 PST
v
® Negative Control Well
@ Standard Well
@ Unknown well
@ Erpty Well
Notes
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Design  When you design your own comparative Cy study:

Guidelines * Enter a study name that is descriptive and easy to remember. You can enter up to

100 characters in the Study Name field. The study name is used as the default file
name.

Note: You cannot use the following characters in the Study Name field: forward
slash (/), backslash (\), greater than sign (>), less than sign (<), asterisk (*), question
mark (?), quotation mark ("), vertical line (]), colon (:), semicolon (;), and sign (&),
percent sign (%), dollar sign ($), at sign (@), circumflex ("), left parenthesis ( (),
right parenthesis () ), or exclamation point (!).

* (Optional) Enter comments to describe the study. You can enter up to
1000 characters in the Comments field.

» Use the default user name, or enter a new user name, to identify the owner of the
study. You can enter up to 100 characters in the User Name field.

Note: The User Name field is automatically populated with the name you selected
at log in.

* You can add an unlimited number of comparative C; experiments (reaction plates)
to the study. To add experiments to a study, note the following:

— Each experiment in the study must:

* Have one or more common endogenous control(s). The endogenous
control(s) must be present on each reaction plate within the study.

* Have identical thermal cycling parameters (the same number of steps,
cycles, sample volume, and emulation mode). The StepOne software
cannot combine in the same study experiments that use Fast and standard
thermal cycling conditions.

* Have been run and analyzed on the same type of instrument (that is, you
cannot add experiments from a StepOne instrument and experiments from
a StepOnePlus instrument to the same study).

* Have the same passive reference.

— As the default, the StepOne software assigns the endogenous control and
reference sample for a study based on the analysis settings of the first experiment
that you added to the study.

— If experiments that contain biological replicate groups are added to a study, the
StepOne software automatically merges the matching biological groups.

— The StepOne software automatically analyzes a study after you add more than
one experiment to it. Consequently, to ensure that the software uses the correct
settings, Applied Biosystems recommends that you review the analysis settings of
your study after adding multiple experiments.

* When adding experiments to the study, Ctrl+click multiple experiments in the Open
dialog box to add them to the study.

* Select an experiment that has been added to the study to view its properties in the
Properties pane.

Notes
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* Filter the experiments added to the study to simplify the list for easier review. See
“How to Filter the Experiments Added to the Study” below.

How to Filter the Experiments Added to the Study

To narrow your search for an experiment, define and apply a filter:
1. In the left-most dropdown menu, select an experiment attribute to query.
2. 1In the center dropdown menu, select an operator for the query.

3. In the right-most field, enter the condition to look for, then click Apply Filter.

Note: After you apply a filter, click Hide Filter/Show Filter to hide or show the filter
tool, or click Remove Filter to remove the filter.

For More For more information on:

Information » Completing the Study Properties screen — Open the StepOne Software Help by
clicking @) or pressing F1.
* Quantitation experiments — Refer to the Real-Time PCR Systems Reagent Guide.

Notes
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Define Replicates

In the Define Replicates screen, create biological replicate groups and use them to
associate samples for the analysis. Biological replicates allow you to assess the
representative nature of your results as they relate to the population being studied.
Including biological replicates can give insight into any natural variation that is in the
population.

About the The comparative C; example study does not contain biological replicate groups. You will
Example Study create and apply the biological group “LiverGroup” as an exercise.

Define Replicates.

Complete the 1. Inthe Study Menu pane, select Setup »

Define Replicates ] L . .
Screen 2. Click Add Biological Group to open the Add Biological Replicate Group dialog

box.
3. Define the biological replicate group:
a. Click the Biological Group Name field, then enter LiverGroup.

Note: In the example study, the LiverGroup biological group is not used for the
analysis.

b. In the Color field, leave the default.

c. Click the Comments field, then enter Example Biological Replicate Group
for the Example Comparative Ct Study.

4. Add technical replicates:

a. From the Select Plate dropdown menu, select Comparative CT
Experiment.eds.

b. In the plate layout, select well B5, then click >> to add the technical replicate
wells that are associated with the selected well to the biological group.

c. Click OK.

5. Select the LiverGroup group that you just added to the study. The StepOne
software displays the details of the biological group in the Properties pane.

Notes
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@ instructions: Add biologicalreplicate groups o the sty as needed

Set Up Biological Replicate Groups 3
2 { | [ cm I ]

Biological Group Name Calor #ofRepicates | Comments Properties
5 IverGroup | 11 | Exarple Biological Replicate Group for the Example Camp,

Biological Group Name: LiverGroup

calor [

Comments.

#of Replicates: 1

Sample Target
Kidney P53

» Add Biological Replicate Group

3b @ mstructions: Eneranarefor e iologzalrelivate roup, e add eshical © dcal replcae
Define Biological Replicate Group
3a |} sovsis capriane i | [Ty
3c Comments Optonay: | Bologial Replica Greunfo the Example Comaaratie CtStusy ‘
Add technical replicates to the new biolagical replicate group:
For sach axperimsntin the study, celectthe plat, ther selet the wells of e plats that ortain sarr ples associatec wit the 16w tolog calreplizate croup.
A5 youselecttechnical licates, e software automaticaly a3ds tre associate teplicate wells 0 the bologieal replicate group.
48— couvrae Eorpuatscroroness Teshcl Rt Grous A oDl et Gro
= #of Rep iates ir Group: 1
sarmple Taget
' I 2 I 3 I + 5 s I ; I s Kidney sz
Lier Lier
O Dwe Mrwes [ oaron [ earon [ weon E. E.
4b Luer Liver Liver Liser <idney Kidrey, Kidney Fidney
ElI+= v v v e e e B
Kitney Kidnay Bain Bnin Bnin Bnin Brin Brin =
¢ | snvon [0 saron s (LS mes [ eeon Mowesn [ oweon
D
. Use on Piate(sit
*Comparatise CTExample £ds
3
wlls: [E118 unknown [E] 0 Sandard [ 6 Negative Contrel 24 Erply
((Sove and et Ao G | [ 2K ) [[Coneel

\
4c

6. Click Analyze, then close the study:
a. Select File » Close.

b. At the prompt, click Yes.

Unsaved Changes

ﬁ This study has changes. Would you like to save the changes before closing?

| Yes || No ||Cancell

Notes
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c. In the Save Study as dialog box, click Save to accept the default file name and
location. The example study is saved and closed, and you are returned to the
Home screen.

Note: By default, the example study is saved to the <drive>:\Applied
Biosystems\<software name>\experiments folder.

* Save Study as E\

Save in ||;= experiments "l ‘I‘J‘E‘E‘E

(= examples

&

My Recert
Documents

o

Desktop

s

My Documents

&

My Compuiter

File name

| [ s 6¢c
My Network

Places Files oftyne:  |Study files (* edm) v| [ cancal

Design  When you design your own comparative Cy study:

Guidelines » Enter a biological replicate group name that is descriptive and easy to remember.
You can enter up to 100 characters in the Biological Group Name field. You cannot
use the following characters in the Biological Group Name field: /\><*?"|:;

* (Optional) Enter comments to describe the biological replicate group. You can enter
up to 1000 characters in the Comments field.

* You can add an unlimited number of technical replicates to a biological group.

IMPORTANT! A sample cannot belong to more than one biological group.

— Click-drag over the desired wells, or CTRL+click or Shift+click in the plate
layout to select multiple wells.

— Click the upper-left corner of the plate layout to select all wells.

* You can change the name of a biological replicate group, change its color
identification and description, and add or remove technical replicates. See “Edit a
Biological Replicate Group” on page 228.

* You can remove an existing biological replicate group. See “Remove Biological
Replicate Groups” on page 228.

IMPORTANT! After you remove a biological replicate group from a study, you
cannot restore it.

Notes
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Design a Study

Edit a Biological Replicate Group

1.
2.

Open the study of interest.

In the Study Menu pane, select Setup » Define Replicates.

Click Edit Biological Group to open the Edit Biological Replicate Group dialog
box.

Edit the group information:
a. From the Biological Group Name dropdown menu, select the group to edit.
b. To change the group name, click Edit, enter a new name, then click OK.

c. To change the color, select a color from the dropdown menu.

o

. (Optional) Enter comments.
From the Select Plate dropdown menu, select the experiment of interest.

Add samples to the biological group:

a. In the Plate Layout, select the well(s) of the plate that contain samples to add to
the biological group.

b. Click >> to add the samples that are associated with the selected wells to the
biological group.

Remove samples from the biological group:

a. In the Technical Replicate Groups Added to Biological Replicate Group pane,
select a sample. You can select only one sample at a time.

b. Click << to remove the sample from the biological group.
Repeat steps 5 through 7 for the other experiments in the study.

Click OK to save the changes and return to the study; click Cancel to exit the dialog
box without saving the changes.

Remove Biological Replicate Groups

1.
2.

Open the study of interest.

In the Study Menu pane, select Setup » Define Replicates.

In the Define Replicates screen, select the group to remove, then click Delete
Biological Group.

Click Yes to remove the group from the study; click No to keep the group in the
study.
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Analyze the Study

This section explains how to use the StepOne software to analyze the comparative C;
example study. It also describes Applied Biosystems recommended best practices as you
perform the analysis.

Note: The Comparative CT Study Example.edm file does not demonstrate the use of
biological replicate groups. However, an additional example study that uses biological
replicate groups is provided with the StepOne software. You can find this study file on
your computer at: <drive>:\Applied Biosystems\<software name>\experiments\
examples\Comparative CT Study Bio Replicates Example.edm.

About the For the comparative C; example study, use the data file that is installed with the StepOne
Example Study software. The data file was created with the same design parameters that are provided in
“Design a Study” on page 218.
You can find the data file for the example study on your computer at:

<drive>:\Applied Biosystems\<software name>\experiments\examples\
Comparative CT Study Example.edm

where:

<drive> is the computer hard drive on which the StepOne software is installed. The
default installation drive for the software is the D drive.

<software name> is the current version of the StepOne software.

Open the IMPORTANT! If you use the same computer to collect run data and to analyze data,
Example Study Applied Biosystems recommends that you do not analyze studies during a run.

1. Double-click g- (StepOne software) or select Start » All Programs » Applied
Biosystems » StepOne Software » <software name>

where <software name> is the current version of the StepOne software.

2. In the Login dialog box, select EXAMPLEUSER from the User Name dropdown
menu, then click OK.

Note: EXAMPLEUSER is the user name you created when you designed the
comparative C; experiment (page 135).
3. In the Home screen, click Open.

4. In the Open dialog box, navigate to the examples folder at:

<drive>:\Applied Biosystems\<software name>\experiments\examples

Notes
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5. Double-click Comparative CT Study Example.edm to open the example study
data file.

Note: The examples folder contains several data files; be sure to select
Comparative CT Study Example.edm.

4 Laok in: ‘|','=' examples "‘ PEEE
A £ % 88-Well Comparative CT Example eds % Presence Ahsence Example.eds
‘_'\3 3 98-nell Genotyping Example.eds 2 Relative Standard Curve Example eds
"D";’D'f:n'::r';"s 3 96-well Multiplex Example.eds 3 Rhase P Experiment.eds
——————— |1 96-\ell Presence Absence Example eds % Standard Curve Example eds
mt‘ 3 98-nell Relative Standard Curve Example.eds 3 SYBR Example.eds
3 96-nell RMaseP Experiment.eds
Desktop 3 9B-well Standard Curve Example.eds
3 96-#fell SYBR Example.eds
3 Comparative CT Example.eds
3 Comparative CT Study Bio Replicates Example.edm
5 My Documents | o Gormparative GT Study Example.sdm
- 3 Genotyping Example.eds
:“[Jg 3 Multiplex Example eds
My Computer
| Ed
. File name: | | | open ]
My Metwork _
Places Files of type:  [a)l DS Files fadm; eds; et v| [ caneal |

6. See “Software Elements” below and “Navigation Tips” on page 232 for information
on navigating within a study.

Software The StepOne software elements for the study are illustrated below.

Elements ) . )
Menu bar — Displays the menus available in the software:

* File

* Edit

e Instrument
* Analysis
* Tools

* Help

2. Toolbar — Displays the tools available in the software:
* New Experiment
* Open
* Save
* Close
* Send Experiment to Instrument
* Download Experiment from Instrument
* Export
* Print Report

Notes
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3. Study header — Displays the study name, the number of experiments in the study,
and the date/time that the study was last modified.

4. Study Menu pane — Provides links to the following Analysis screens:
* Gene Expression
* Amplification Plot
*  Multicomponent Plot
* Multiple Plots View
* QC Summary
* Compare Settings

5. Plot pane — Displays the selected analysis screen for the open study.

6. Replicate Results Data pane — For the open study, displays results data for the
technical replicate groups (Technical Replicates tab) and, if present, the biological
replicate groups (Biological Replicates tab).

7. Study/experiment tab(s) — Displays a tab for each open study or experiment.

File Edit Instrument Analysis Tools Help

[i2] New Experiment ~ (5 | close 3 send Experimentto Instrumerr... ¢} Down oad Exaeriment from nstument.. | & Exort.. < £} rint Report

wnN—

Fiter Data: Enter aiter query, then clickApply Fiter T enter multple fier queries, click"Atvanced Filter!

| somer || )

F [Boogical oo v = o[

Plot Seftings [Technical Replicates | Biological Replicates |
Plot Tyne: [RG vs Sarple v Graph Type: Linear ] orizntation: Vertical Bars v (R ) e ()
v n Table v | Biocrou | [ Enda Contrls v | [ Ref Sampiz
# | omit Sample | Terget | CTMean | ACTMean | ACTSE | aACT RG
4 i o 18 Ta7eau 3
[ seve current setiings s the defautt 2 bladder  ACTNZ 2367114 7.927168¢ 008696952 00
N 3 bladder  ATP1A2 20879446 813547¢ 0.0BL0566T 00
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5 bladder  CD38 2054782 7003019 00473453 00
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575 8 bladder  GABRD LIRSS 1623048 0.06T4EI84 00
P compare setiings s50 ] bladder  HPRT! A 6320472 007227252 0o
525 10 blagder  PLA2G2A  17.470462 17354836 011555808 00
0 11 blagder  POLR2A 25522417 0778445 013227484 00
12 bladder  SFPQ 20635714 4891741 016286142 00
75 13 bladder  SHH 26542048 10738975 D.ADTET41T 00
50 14 bladder  UBD 175615 18175279 0.05721478 00
25 15 blader  vOAM1 20326762 658478 2342761 00
00 18 bladder T2 20273084 13529081 0.0501408. 00
s 17 brain 188 15.075831
18 || b AcN2 22000889 6.925058¢ 0.05¢10841 10021101 2
as0 19 [ bran ATP1A2 20 66 5 13 2620032 5,y
25 [ e e i Rasesa a
< >
g
B ~
0 Well Results Data
25
20 | ShowinTabe v || Goup Resus By ¥ ( I |
175
150 # | sample | Taget | Experiment| wel omi Flag or acr
125
100
75
50
2 ] I
N i, I Il I A i 1
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Navigation Tips How to Filter the Data Displayed in the Analysis Screens

To reduce the data displayed in the analysis screens, use the filter function at the top of
the analysis screen to define and apply a filter:

1. In the left-most drop-down list, select an attribute to query.

2. In the center drop-down list, select an operator for the query.

3. In the right-most field, enter the condition to look for, then click Apply Filter.
Note: After applying a filter, click Hide Filter/Show Filter to hide or show the filter
tool, or click Remove Filter to remove the filter.

How to Display Multiple Plots

Use the Multiple Plots View screen to display up to four plots simultaneously. To
navigate within the Multiple Plots View screen:

1. From the Study Menu pane, select Analysis » [££] Multiple Plots View.

2. To display two plots in rows, click = Show plots in two rows.

3. To display two plots in columns, click [|[| Show plots in two columns.
4. To display four plots, click 55 Show plots in a 2 X 2 matrix.

To display a specific plot, select the plot from the dropdown menu above each plot
display.

Multiple Plots
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How to Use the Experiment Data and Well Results Data Panes

The Experiment Data and Well Results Data panes appear in the Amplification Plot,

Multicomponent Plot, and Multiple Plots View screens.

» To display or hide columns in the Experiment Data pane: From the Show In Table
dropdown menu, select or deselect one or more options: Experiments, # of Targets,

# of Samples, Run Date.
Experiment Data
i Experi IE‘E‘JIELEZIED\UmriE(D Shnwmlhet’a‘ahle\“‘
11,2008 Ovary.eds
# of Targets 11,2008 Colon.eds
12,2008 Hearteds
# of Samples 012, 2008 Stomach.eds
12,2008 Spleeneds
Run Date 012, 2008 Bladder eds
T TH TAug 12,2008 Testes.eds
8 16 1Aug 12,2008 Lung.eds
2] 16 1Aug 12,2008 Brain.eds
10 16 1Aug 12,2008 Livereds
" 16 1Aug 12,2008 Placenta.eds

» To display a subset of the study data in the plots: Select one or more rows in the
Experiment Data pane or the Well Results Data pane, then select Hide unselected
data from plot to display data only from the selected rows.

The Experiments Data pane lists each reaction plate (experiment) that is added to a study.
The data that are displayed in the Well Results Data pane depend on which tab you select
in the Experiment Data pane:

Tab Description lllustration
View Well | When you select one or more experiments in the
Table tab Experiment Data pane, the well table displays the ey

wells that make up the selected experiment(s). # Egeinent FoTan | fordamp. | FunDoto
e s 1 Aug 11, 2008 5
2Colon eds 16 1Aug 11,2008
3Heart eds 16 1Aug 12,2008
4 Stomach.eds 16 1Aug 12,2008
§5pleen.eds 18 1Aug 12,2008
7Testes eds 16 1Aug 12,2008
8Llung.eds 16 1Aug 12,2008
§Brain.eds 16 1Aug 12,2008
10Livereds 16 1Aug 12,2008
View Well Table | View Plate Layout |
| “show nTebke v | [ Grous ResutsBy T [ exparsan | [ cotepse a1 |
#  Sample Target Experiment  Well Omit Flag cT ACT
28 colon PLA2G2A  Coloneds BT | 19505127 A
30 colon FLAZGZA  Coloneds CF O 18843723
31 colon POLR2A  gooness D2 0 25611128
32 colon POLR2A Coloneds E2 : 26.216286
33 colon POLR2A Coloneds  F2 : 26.362299
3 colon SFPQ Coloneds D7 O 21981417
35 colon SFPQ Coloneds  E7 O 21531075
36 colon SFPQ Coloneds  F7 O 21640082
ar colon SHH Coloneds A8 O 275411
38 colon sHH Colonsds B8 0 27483029
38 colon SHH Coloneds 8 0 27732286
40 colon UBC Coloneds A2 L 18.907955
2 colon UBC Coloneds B2 O 19.95652
42 colon UBG Coloneds €2 O 18.807451
43 colon VAWM Coloneds D8 : 23018288
44 colon WCAMT Coloneds  E8 : 22643612
45 coon VCAMI  colness FB 0 22675842
156 colon WNT2 Coloneds A4 O 30676216
47 colon wnT2 Colones B4 0 30620773
18 colon WNT2 Coloneds €4 O 903964
heart
ovary b
< >
Notes
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Tab

View Plate
Layout
tab

Notes
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Description

When you select one experiment in the
Experiment Data pane, the plate layout displays
the plate layout for the selected experiment.

Note: If you select more than one experiment in
the Experiment Data pane, only the plate layout
for the first experiment is displayed in the View
Plate Layout tab.

Using the Plate Layout tab:

1. To select wells of a specific type, use the
Select Wells With dropdown menus: Select
Sample, Target, or Task, then select the
sample, target, or task name.

2. To select a single well, click the well in the
plate layout.

3. To select multiple wells, click and drag over
the desired wells, press CTRL+click, or press
Shift+click in the plate layout.

4. To select all wells, click the upper left corner
of the plate layout.

lllustration

Experiment Data

(Srowntae v

#  Experiment
1Ovary.eds

#0ofTarg.. | #ofSamp.. RunDate
1 Aug 11,2008
1 Aug 11,2008
1Aug 12,2008
1 Aug 12,2008
1 Aug 12,2008
1 Aug 12, 2008
1 Aug 12, 2008
1 Aug 12,2008
1 Aug 12,2008
1 Aug 12, 2008
1 Aug 12, 2008

2Colon sts 18
3Hearteds 18
4Stomach.eds 18
§5pleen eds 18
gBladdereds 18
7Testes eds 18
8lung.eds 18
gBrain.eds 18
10Livereds 18
11Placenta eds 18

Well Results Data
ViewWell Table | View Plate Layout]
Select Wells With:
B view Legena

| [0 showinwens ¥
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View the Analysis Settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle
(Cy), flags, and relative quantitation. If the default analysis settings in the StepOne
software are not suitable for your study, you can change the settings in the Analysis
Settings dialog box, then reanalyze your study.

About the In the comparative C example study, the default analysis settings are used without
Example Study changes.

View the Analysis 1. From the Study Menu pane, select Analysis.

Settings

2. Click Analysis Settings to open the Analysis Settings dialog box.

3. Select the Relative Quantitation Settings tab, then view the default reference
sample and endogenous control. In the example study, the default reference sample
is bladder and the default endogenous control is 18S.

4. Select the Cy Settings tab, then the Flag Settings tab. In the example study, the
default analysis settings are used in each tab.

5. Click Analyze.

% Analysis Settings for Comparative CT Study Example

Cr Settings I Flag Settings | Relative Quantitation Settings | h
Analysis Type
Selectthe type of analysis to perform.
(@ singleplex
Reference Sample(s)
Selectreference samples for the biological andiortechnical replicate groups of this study,
Biologieal Replicate Group Reference Sample: | v | Tectical Replcate Group Reference Sample:  aoder v/
Endogenous Control(s)
Selectthe targetto use as the endogen ous contral for this experiment,
Endogenous Control fws ¥
Efficiency
Target Effciency (%)
188 1000 P
Enter percentage values between 1 and 150% ACTN2 100.0
ATP1A2 1000
Clorft 100.0 v
Outlier Rejection
Selectto reject replicates with ACT values less than o equal to the value entered helow. These analysis setiings apply onlyto muliplex reactions.
]
RQ MinMax Calculations
Select an algorithm to determine RQ Min and Max values {error bars).
@ confteneleel 550 v %
() Standard Deviations:
Revertto Defaut Anslyss Setings | | Anslyze | | Cancel |
Notes
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Analysis Unless you have already determined the optimal settings for your study, use the default
Guidelines analysis settings in the StepOne software. If the default settings are not suitable for your
study, you can change the:

* C; Settings — Use this tab to manually set the threshold and baseline. When
manually setting the threshold and baseline, Applied Biosystems recommends the

following:
Setting Recommendation
Threshold Enter a value for the threshold so that the threshold is:
¢ Above the background.
¢ Below the plateau and linear regions of the amplification curve.
e Within the exponential phase of the amplification curve.
Baseline Select the Start Cycle and End Cycle values so that the baseline

ends before significant fluorescent signal is detected.

* Flag Settings — Use this tab to:
— Adjust the sensitivity so that more wells or fewer wells are flagged.
— Change the flags that are applied by the StepOne software.

* Relative Quantitation Settings — Use this tab to:

— Change the reference sample and/or endogenous control. As the default, the
StepOne software assigns the endogenous control and reference sample for a
study based on the analysis settings of the first experiment added to it.

— Correct the amplification efficiency. You can enter a percentage value between
1% and 150%. When you set an assay to have a value that differs from 100%
efficiency, the software uses the relative standard curve algorithm.

— (For multiplex reactions) Specify the AC; value at which to reject replicates
(outlier rejection).

— Select the algorithm to use to determine RQ Min/Max values (confidence level or
standard deviations).

For More For more information on the analysis settings, access the StepOne Software Help by
Information pressing F1 when the Analysis Settings dialog box is open.

Notes
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View the Amplification Plot

The Amplification Plot screen displays post-run amplification of the samples of each
experiment that is added to a study. Three plots are available:

* ARn vs Cycle — ARn is the magnitude of normalized fluorescence signal generated
by the reporter at each cycle during the PCR amplification. This plot displays ARn
as a function of cycle number. You can use this plot to identify and examine
irregular amplification and to view threshold and baseline values for the run.

* Rn vs Cycle — Rn is the fluorescence signal from the reporter dye normalized to the
fluorescence signal from the passive reference. This plot displays Rn as a function
of cycle number. You can use this plot to identify and examine irregular
amplification.

* Cpvs Well — C; is the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot. This plot displays C; as a function of well
position. You can use this plot to locate outlying amplification (outliers).

Each plot can be viewed as the following graph types: linear or log10.

About the In the comparative C; example study, you review each target in the Amplification Plot
Example Study screen for correct baseline and threshold values.

View the 1. From the Study Menu pane, select Analysis » Amplification Plot.
Amplification Plot
Note: If no data are displayed, click Analyze.

2. In the Experiment Data pane, select all of the experiments (click and drag to select
all rows in the table).

3. In the Amplification Plot pane, set the parameters for the plot:
a. From the Plot Type dropdown menu, select ARn vs Cycle.
b. From the Plot Color dropdown menu, select Well.

c. Click = Show a legend for the plot.

Note: This is a toggle button. When the legend is displayed, the button changes
to Hide the plot legend.

d. From the Target dropdown menu, select 18S to highlight all 18S wells in the
study.

4. View the baseline values:
a. From the Graph Type dropdown menu, select Linear.

b. Select the Show Baseline checkbox to show the start cycle and end cycle.

Notes
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3d

Analyze the Study

3a

c. Verify that the baseline is set correctly: The end cycle should be set a few
cycles before the cycle number where significant fluorescence is detected. In
the example study, the baseline is set correctly.

4a 3b

Plot Settings

|
Prot Type [sRnve Cyele | Orapn Type [Lnear v FiotCoror el %]

[] save current settings as the default

i)

P P a g & = 3c

Amplification

El ks

& [ "0 2 T s oy Zo 22 En En) Za E) E) a1 B a8 a0 a2

’if! E ENC WD ENE BF

| Options

4b

Notes
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showe: [] Thresnola — [7] BASEIHG Starl well B Targst s Baseline End: well ‘B Targst 4

528 Wells Selected

Hide unselected data from plot

5. View the threshold values:

a. From the Graph Type dropdown menu, select Log.

b. Deselect the Show Baseline checkbox, then select the Show Threshold
checkbox to show the threshold.

c. Verify that the threshold is set correctly. In the example study, the threshold is
in the exponential phase.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative
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Plot Settings "\
Plot Type:[aRn vs Cycle v | Granh TypeLog | Piot Color:well ~|
[] save current settings as the default
2P & o Z =
Amplification
SO03ZR
o0.01 ="
=
5 o.o01 /)?\ N
[
0.0001 \
0.00001
0000001
00000001

Cyele

LIS B lc Mo He HF

| Options "\

Torgetiss  wlhreshot: [ Auto [0 smnni |
show: [V]ihreshoid — ] Baseline Start: Well M Target 4 Baseline End: Well M Target 4
5b—
528 Wells Selected Hide unselected data from plot
6. Repeat steps 3 through 5 for the remaining targets.
Analysis  When you analyze your own comparative C; study, look for:
Guidelines * A typical amplification plot — See the amplification plot example on pages 198 to
199.
* Correct baseline and threshold values — See the threshold examples on page 200 and
the baseline examples on page 201.
If your study does not meet the guidelines above, you can:
* Manually adjust the baseline and/or threshold. See “View the Analysis Settings” on
page 235.
* Omit individual wells from the analysis. See “(If Needed) Omit Wells from the
Analysis” on page 257.
Note: For tips on navigating within the analysis screens, see “Navigation Tips” on
page 232.
For More For more information on the Amplification Plot screen, access the StepOne Software
Information  Help by clicking @) or pressing F1.
Notes
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View the Gene Expression Plot

View the Gene
Expression Plot

Notes
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About the
Example Study

The Gene Expression Plot screen displays the results of the relative quantitation
calculations in the gene expression profile. Three plots are available:

* RQ vs Target — Groups the relative quantitation (RQ) values by target. Each sample

is plotted for each target. You can view the plot as the following graph types: linear,
log10, Ln, log?2.

RQ vs Sample (displayed only when the Technical Replicates tab is selected in the
Replicate Results Data pane) — Groups the relative quantitation (RQ) values by
sample. Each target is plotted for each sample. You can view the plot as the
following graph types: linear, log10, Ln, log2.

RQ vs BioGroup — (displayed only when the Biological Replicates tab is selected in
the Replicate Results Data pane) — Groups the relative quantitation (RQ) values by
biological replicate group. Each target is plotted for each sample. You can view the
plot as the following graph types: linear, log10, Ln, log2.

Note: The Comparative CT Example Study.edm does not contain biological
replicate groups.

In the comparative C; example study, you review each target in the Gene Expression Plot
screen for the expression level (or fold change) of the target sample relative to the
reference sample.

1. From the Study Menu pane, select Analysis » Gene Expression.

2. In the Gene Expression Plot pane, set the parameters for the plot:

. In the Plot Type dropdown menu, select RQ vs Sample.

a
b. In the Graph Type dropdown menu, select Log10.

o

In the Orientation dropdown menu, select Vertical Bars.

d. Click = Show a legend for the plot.

Note: This is a toggle button. When the legend is displayed, the button changes
to Hide the plot legend.

In the example study, the expression levels of multiple targets in samples are displayed
relative to the expression levels of the same targets in the reference sample (universal).
Because the reference sample is compared to itself, the relative expression level is 1.
When the result is displayed in the Log10 graph type, the expression level of the
reference sample appears as 0 in the graph (log10 of 1 =0).
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2a 2b 2c
Gene Expression

Piot Settings "\ ‘
Plot Type: R vs Sample ~ | Graph Type: [Log10 |+ | Orientation: [Vertical Bars  ~ |

[[] save current settings as the default

a b =p— 2d
RQ vs Sample
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;GAE!F\D | RES W 2Tz atP1a2 [l HPRTT [l ctonet [l sHH Il POLR2A ~
[ Eiy weant [l DT M cEnPa sFra Elcoss [l usc Il PLa2G2A {
H 0 Replicates Selected [] Hide unselectad data from plat
3. Select multiple endogenous controls:
a. In the Replicate Results Data pane, select the Technical Replicates tab.
b. From the Endo Controls dropdown menu, select HPRT1 and UBC, then
deselect 18S.
Note: You can also select the endogenous controls in the Analysis Settings dialog
box. See “View the Analysis Settings” on page 235.
Technical Replicates Biclogical Replicate:
| Show In Table ¥ || Add BioGroup || Endo Controls ¥ || Ret sar
#  omit Sample T: 18S
1 hladder 18!
3 dadier Al ACTN2
7 oedier 1| | ATP1A2
: S o | Clorfol
‘ deaier i | CDS8
¥ teaer r| | CENPA
12 aeaowr | | DCT
i omie Uy | GABRD
£ e R HeRTL
e[| oan s |PLA2G2A
%o e & POLR2A
< SFPQ
e SHH
ik
| Show in Table ¥ || Group Results B VCAM1
# Sample Target E WNTZ
Notes
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4. Click Analyze. In the example study, all samples for the endogenous controls
HPRT1 and UBC have an no values (with the exception of the C; Mean value), and
the RQ values for the remaining samples change. For example, in the example study,
the RQ value for the ACTN2/brain sample changes from ~2 (with 18S as the
endogenous control) to ~3 with the new endogenous controls.

Replicate Results Data

Technical Replicates ] Biological Replicates ]
[ Show in Tenle ¥ | |_addBiocroup | [ Endo controls ¥ | | ret sampie ¥ |
# | omit sample Taraet T Mean ACT Mean | ACT SE ancT Ra RG Min RQ Max
a bladder HPRT1 2212642 p
10 bladder FLAZGZA 17.479464 -2.3644072 0.12662643 oo 1.0 08139087 132286376
11 bladder POLRZA 26522417 56784563 0.14115642 oo 1.0 07934538 12603128
12 bladder SFPQ 20636714 07917531 01701538 oo 1.0 0.75E6282 1.3216584
13 hladder SHH 26.542946  6.698985  0.1183256 oo 1.0 0.82370776  1.2140229
14 bladder uBC 17.5818502
15 hladder VCART 24328758 4.4847975  2.3432791 oo 1.0 0.0214783.. 46.558548
16 bladder WNTZ 20273064  0.420104 0.07020295 oo 1.0 08911622  1.1221302
17 |l brain 185 16.076882 -4.702716 0.0843743 -0.6027297 1.5185871 1.8224628 1.7488104
18 1 brain ACTNZ 22000883 2.202336 0.08175110 -1.6048415 30416234 26801925 54777453
19 [l brain ATP1AZ 20,6860 09077649 011497223 -3.127781  ©.740593 7.2393746 10658117
20 1 brain C orfE1 21.793047  1.0645003 0.0747244 -0.550247  754.4318 BET.4B643 8527281
21 || brain CD&s 26.762297  5.983748 0.077202E7 21798198 0.22070332 0.19447067 0.26047457
22 1 brain CENPA 36.383656 16.605108 0.3982607 357094475 0.0836525. 0.0435439. 016068302
2z || brain DCT 28120453 B.341905 014786239 -4.2195393  18.68108  14.621307 23.7405
24 1 brain GABRD 23.563555  3.785008 0.08046048  -5.345485 32526785 265.07632 371.12582
25 brain HPRT1 20.502407
26 L brain PLA2GZA 33207176 13.428628 01273401 15793125 1.7611466.. 1.4283838 . 2 1698968
27 || brain FOLRZA 25187264 54187164 01402310  -0.25874 1.1877628 0.0514134  1.606641
28 | brain SFPQ 21.521765 1.7432169 015953657 095146376 051710755 039312535 06716483
29 |l brain _SHH 28.360203  8.571654 D.101B5765 1.8728691 0.27306777 0.23115765 0.3226764
30 hrain uBc 19.054688
31 L] brain VCART 26.286074 65075254 015759581 2022728 0.2460924 01800719  0.318624 e
a7 |l birain AT 298 35424 A ANSAA? 0 11AA29A N 17AAARA 0 AR47927 N 7309562 10710012
[ Show in Table ¥ | [ Groun Resuts By ¥ | [ Expand an | [ Collopse a1 |
+ | sample Target Experiment | well omit Flag cr £CT £CT Mean | ACT SE 2nGT R@ R@ Min
= HFRT1 ~
1 blad... HPRTT Bladder.eds D1 |l d 22 238853
2 blad... HPRT1 Bladgdereds E1 |l 2207128
3 blad... HPRT1 Bladdereds F1 L] 22.088472
4 brain  HPRT1 Braineds D1 |l 2063047
5 brain HPRT1 Brain.eds E1 1 2041884
& brain  HPRT1 Braineds F1 [ 20487912
= UBC
7 blad... UBC Bladdereds A2 |l 17.62726
[} blad... UBC Eladdereds B2 L] 17.55119
a blad... UBC Bladdereds C2 || 17.60808
10 brain  UBG Braineds A2 L] 18121252 ~
< >

Analysis When you analyze your own comparative C study, look for:
Guidelines » Differences in gene expression (as a fold change) relative to the reference sample.
+ Standard deviation in the replicate groups (C SD values).

If needed, you can omit outliers. See “Omit Replicates from the Analysis” on page 247.

Note: To display a subset of the study data in the Gene Expression Plot pane, select one
or more rows in the Technical Replicates tab or the Biological Replicates tab, then select
Hide unselected data from plot to display data only from the selected rows. For more
tips on navigating within the analysis screens, see “Navigation Tips” on page 232.

For More For more information on:

Information » The Gene Expression Plot screen, access the StepOne Software Help by clicking
@) or pressing F1.
» Calculating Relative Quantitation Values — Refer to the User Bulletin #2: Relative
Quantitation of Gene Expression.

Notes
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View the Replicate Results Data and the Well Results Data

The Replicate Results Data pane lists each reaction plate (experiment) that is added to a
study. The results of the study are arranged by technical or biological replicate

association.

The data that are displayed in the Well Results Data pane depend on which tab you select
in the Replicate Results Data pane:

Technical Replicates Tab

Biological Replicates Tab

This tab arranges the results of the relative quantitation
analysis by technical replicate group. The StepOne software
displays the results for each sample/target combination as a
row in the table.

You can view the members of a technical replicate group by
selecting the appropriate row in the table. When a row is
selected, the Well Results Data pane displays the wells that
make up the selected technical replicate group.

Replicate Results Data

Technical Replicates | Eiclogical Replicates }

| Show inTases v | [ acaBiGroup || Endo controls v | | Ret sampie v |

# | omit Sample | Target CrMean | aCTMean | AcTSE ‘
1 brain 1 188 14,4768 —_—
2 brain 1 ACTNZ 238482 .3724 0.0364
3 brain 1 ATPIAZ 209829 6.4871 00145
1 brain 1 Clorfe1 225043 8.0285 0.0249
5 brain 1 HPRT1 205028 5.028 0.0217
6 brain 1 POLRZa 259438 11.488 00118
7 brain 1 uBc 192791 48033 0.0118
8 brain 1 WNT2 [} 205801 151138 00128
] brain 2 183 153754

10 || brainz ACTNZ 247807 9.4053 00151

1 []  brainz ATP1AZ 18654 6.49 0.0323

12 || brain 2 C1orfB1 23 4763 2101 0.0154

43 [] oramz  HPRT1 21572 Bases 00387

14 [] brainz POLRZa 269647 11.5893 0.0148

15 (| brain 2 uec 205695 51942 0.0165

16 [] oramz w2 30473 150877 0.055

17 calen 1 188 147839

18 [ ]  colent ACTNZ 173274 125436 0.0233

18 []  colen ATP1AZ 265105 11.7266 0.0258

20 (] colon 1 Clore1 348725 20.0887 0.2564

21 []  colent HPRT1 13467 6.5628 0.0323

22 [ | colont POLR2a 252383 104545 ootz ¥

< >

Well Results Data

| Show In Table ¥ || Group Resuts By ¥ ( I J

# | sample Taraet

Experiment wvell omit Flag cr

1 brani 188 EQBrain Al O 14

2 brain1 188 RoBram A2 0 14

3 bran1 188 ROQBrain A3 O 14
< >

Notes
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This tab arranges the results of the relative quantitation
analysis by biological replicate group. The StepOne
software displays the results for each biological group as a
row in the table (each row displays a biological sample with
its target).

You can view the members of a biological replicate group by
selecting the appropriate row from the table. When a row is
selected:

¢ The Biological Replicate Details table displays the
technical replicate groups that make up the selected
biological replicate group.

e The Well Results Data pane displays the individual
members of the technical replicate groups that make up
the selected biological replicate group.

Replicate Results Data

Technical Replicates | Biological Replicates 1

[ Show in Tate v | [ Ad BiaGrows || Endo Cartros v || Ref Biocraup 7 |

# | omit Binlogica.. | Target #Replica..| CTMean | ACTMean | .

7 Brain UBc 2 199243 4.9987 e

8 Brain VT2 1 300313 151086

] Calon 188 2 152463

10 || coion ACTNZ 2 278524 126081

1 (| Golon ATP1AZ z 271038 11.8576

12 [H) colon C1ore1 % 2 19.7899

43 [  coon HPRT1 2 21.845 6.5388

14 [ coen POLR23 2 257506 105044
< >

Biological Replicate Details | it BioGroup | | Delete BioGroup |

# | omit Sample | Target CTMean | aCTMean | ACTSE ach
1 brain 1 UBC 19.2791 4.8033 0.0119
2 L brain 2 uec 205695 51942 0.01865
< >

[ snow nTabie v || Group Resuts By ( I J

# Sample Target Experiment Wyl Omit Flag cr
1 braint  UBC RQBrEn AT O i
2 brani  UBC RQBrain A8 O 19
3 wraini  UBC ROBrain A9 O 19)
4 brani  UBC RQBrain  CF O 0
5§ brain2  UBC RoBran  C8 O 20
6 branZ UBC RQBrain G O 20
< >
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Column
Descriptions

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative

The table below provides definitions for the column headings that appear in the tables in
the Technical Replicates and Biological Replicates tabs.

Column Description

AC; The calculated AC; value for the replicate group associated with the test
sample.

Note: The AC; value is calculated only for multiplex experiments and is
calculated at the well level (that is, the individual technical replicate level) by
subtracting the target C; value from the endogenous control C; value.

ACt Mean The arithmetic average of the technical replicate C; values for the sample
replicate group.

Note: The AC; Mean value is calculated at the reaction plate level and
represents the mean difference between the target C; values and the
endogenous control C; values for all the technical replicates for that sample
that are present on the plate.

AC; SE The sample standard deviation of the sample replicate group level C; values.
Note: The AC; SE value is calculated differently for multiplex and singleplex
experiments. For multiplex experiments, the calculation is at the well level. For
singleplex experiments, the calculation combines the plate-level C; value
variation between the target and the endogenous control.

AACt The calculated AAC; value for the replicate group associated with the
reference sample.

# Replicates | The number of biological replicate groups in the study.

Biological The name of the biological replicate group.

Group

Cy Threshold cycle; the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot.

Ct Mean The arithmetic average of the technical replicate C; values.

Experiment The name of the experiment file (for example, heart.eds).

Flag The number of QC flags that the well generated as listed in the A symbol.

Omit Indicates the omission status of the members of the associated technical or

(Replicate biological replicate group(s):

Results Data
pane)

Omit (Well
Results Data
pane)

e A check mark (v) indicates that all replicates have been removed from the
analysis.

e A hyphen (-) indicates that one or more replicates have been removed from
the analysis.

Indicates the omission status of the well. A check mark (v) indicates that the
well has been removed from the analysis.

RQ

The calculated relative level of gene expression for the replicate group that is
associated with the test sample.

RQ Max

The maximum relative level of gene expression in the test samples calculated
using the confidence level set in the Analysis Settings dialog box.

Note: The maximum includes the variability associated with the endogenous
control and targets in only the test samples.

Standard Curve and Comparative C; Experiments
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Column Description
RQ Min The minimum relative level of gene expression in the test samples calculated
using the confidence level set in the Analysis Settings dialog box.

Note: The minimum includes the variability associated with the endogenous
control and targets in only the test samples.

Sample The sample associated with the data displayed in the row.
Target The target assay associated with the data displayed in the row.
Well The location of the well in the reaction plate.

About the In the comparative C example study, you review the Replicate Results Data pane and the
Example Study Well Results Data pane to evaluate the precision of the replicate groups and view related
RQ information.

View the Results 1. From the Study Menu pane, select Analysis » Gene Expression.

Data
2. Click < at the top left of the Replicate Results Data pane.
3. View the technical replicates:

a. Click the Technical Replicates tab. The table displays the results by technical
replicate group.

b. In the Technical Replicates table, select the following groups:

* Bladder/ACTN2 (row 2)
* Bladder/ATP1A2 (row 3)
* Brain/ACTN2 (row 18)
* Brain/ATP1A2 (row 19)
The Well Results Data pane displays all wells that make up the selected groups.
4. View the values in the Well Results Data pane:

a. From the Group Results By dropdown menu, select Target.

b. View the C; AC; Mean, and AC SE values to evaluate the precision of the
replicate groups. In the example study, the low AC; SE values indicate these
replicates have good precision.

Note: See page 244 for a description of each column in the tables. To show or hide
columns in a table, select or deselect the column name from the Show In Table dropdown
menu.

Notes
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3a

Replicate Results Data

Technical‘RepIicateS ] Biological Replicates ]

| Show inTable ¥ || acaBiocroup || Enco cortrois v || Ref sampe ¥ |

#* | omit Sample Target CTMean | &CTMean | ACTSE 2401 RGl RQ Min RQ Max
1 Bladder 185 16743976  -4.099986 0.0804617 00 1.0 087644686 11409707 F
2 bladder ACTNZ 23671139 38271775 0.08314542 [ili} 1.0 087269986 1.1460005
3 Bladder ATP1AZ 23679446 4035486 008081851 oo 1.0 0876934 11418382
4 hladder Clorat 31367708 11513747 0.0800487 0.0 1.0 08770402 11401988
5 bladder cDss 23.64769 0.8039284 0.08833724 0o 1.0 0894038 11185206
5 hladder CENPA 32.86962  13.026B6 0.0807326 0.0 1.0 08760577 11414772
7 bladder DCT 32405506 12561644 011878676 0.0 1.0 082308537 12149408
8 bladder GABRD 31074453 121304892 0.08355925 00 1.0 08720082  1.1467781
3 kladder HPRT1 2212642

Sb 10 bladder PLA2G2A 17479464 -2.3644872 012562643 0.0 1.0 08129087 12286375

11 bladder POLR2A 26622417 5B7B4663 014116642 00 1.0 07934538 1.2603128

12 bladder SFPQ 20635714 07917531 01701536 0.0 1.0 07566252 1.3216584

13 bladder SHH 26642946 6649966 01163266 00 1.0 082370776 1.2140229

14 bladder UBC 17.561502

15 bladder VAR 24 378756 44847875 23432791 00 1.0 0.0214783..  46.558548

18 bladder WNT2 20273064 6429104 0.07030295 0.0 10 D0.8011622 11221302

17 | brain 185 16076832 -4702716 0.0843743 -06027287 16186871 13224628 17438104

18 = brain ACTNZ 22.000883 2.222336 0.08176119 -1.6048415 3.0416234 26601926 5.4777453

19 ] brain ATP1AZ 20686302 08077649 011497223 -3127731 8740693 7.2393746 10663117

20 [} brain C1orE1 21.733047 18545003 D.0747244 -9.559247 754.4318 B67.46643 852.7281

21 || hrain cpsa 26762297 5083748 007720287 21798188 022070332 019447067 025047457

22 [ brain CENPA 36.363666 16605108 0.3962607 03.5794475 0.0936525.. 0.0436499.. 018068302

23 || brain DCT 28120453  8.341905 014786230 -42196383  18.63108 14621307 237408 e

74 I hrain GARRD 25 AARARG G 7RANNA NNAN4AA4E R 346485 306 PA7AA  2RANFA32 371 12682

Well Results Data

[ Snow in Tabie ¥ | (" Expan a1l | [ cotapse A |
# | Sample None el omit Flag cr act ACTMean | &CTSE ancT Ra R@ Min R@ Max Flags

da

= ACTNZ ~
1 blaa Sample | 2677037 38271776 008014542 00 10 087259955 1.1460005
2 blad Target | 2362218 2.8271775 0.08314542 00 1.0 0.87250985 1.1460005
3 biag | 23620863 38271775 0.08314542 00 1.0 0.87250986 1.1460005
4 brain Plate O 22068619 2.222336 0.08175119 -1.6048415 3.0416234 26601925 B8.4777453
5 brain | O 21.983532 2222335 0.08175118 -1.6048415 3.0416234 26601925 3.4777453
B brain Replicates =] 21.0503 2222336 0.08176110 16048416 3.0416234 26601925 34777453
= ATP1a2
7 blad... ATP1AZ Bladder eds D3 Ll 23.970669 4.085486 0.08081851 0.0 1.0 08759943 11416382
8 blad... ATP1AZ Bladder.eds E8 [} 23.822793 4.026486 0.08081851 0.0 1.0 08750343 11416382
a blag... ATP1AZ Eladder ads F3 | 23.833039 4.036486 0.08081861 0.0 10 08750343 11416382
10 brain ATP1AZ Braineds D3 O 20.862645 0.9077649 011487223 -3.127731 8740593 7.2398746 10.558117
I brain ATP1AZ  Droneds  E3 Ol 20503576 05077545 011487223 3127731 8740883 72393745 10.563117 =
13 hrain ATP1AD Eirained:s  F3 1 20 ROPRAL 00077540 011487993 3197731 A 740605 7 230874A 106ARI11F

Analysis When you analyze your own comparative C study:

Guidelines + Select the Technical Replicates tab or the Biological Replicates tab to organize and
view the sample data according to the associated technical replicate group or biological
replicate group.

» View all wells for a technical or biological replicate group by selecting the
appropriate row in the table. When a row is selected, the Well Results Data pane
displays the wells that make up the group. Ctrl+click to select multiple rows.

* Change the endogenous control by clicking Endo Control, then selecting a new target.
* Change the reference sample by clicking Ref Sample, then selecting a new sample.
* Add biological replicate groups by clicking Add BioGroup.

* Omit biological or technical replicates from the analysis. See “Omit Replicates from
the Analysis” on page 247.

Note: The Comparative CT Study Example.edm file does not demonstrate the use of
biological replicate groups. However, an additional example study that uses biological
replicate groups is provided with the StepOne software. You can find this study file on
your computer at: <drive>:\Applied Biosystems\<software name>\experiments\
examples\Comparative CT Study Bio Replicates Example.edm.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative
Standard Curve and Comparative C; Experiments
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Omit Replicates from the Analysis

To omit a technical or biological replicate from the analysis:
1. From the Study Menu pane, select Analysis » Gene Expression.

2. Select the Technical Replicates or Biological Replicates tab according to the type
of replicate that you want to omit.

3. In the replicate table, scroll to the biological or technical replicate of interest, then
select the corresponding checkbox in the Omit column.

4. Click Analyze when you finish omitting wells.

IMPORTANT! You cannot omit all technical replicates that belong to a reference sample
or a reference biological group, or that serve as the endogenous control for a study.

Note: You can also omit the biological replicates in the Biological Replicate Details table
at the bottom of the Biological Replicates tab.

For More For more information on:

Information » The Gene Expression Plot screen, access the StepOne Software Help by clicking
@) or pressing F1.
» Calculating Relative Quantitation Values — Refer to the User Bulletin #2: Relative
Quantitation of Gene Expression.

Notes

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative 247
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View the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye
over the duration of the PCR run in a selected well of any experiment that is added to the
study.

About the Inthe comparative C example study, you review the Multicomponent Plot screen for:
Example Study « ROX™ dye (passive reference)
+ FAM™ dye (reporter)
» Spikes, dips, and/or sudden changes
+ Amplification in the negative control wells

#

View the 1. From the Study Menu pane, select Analysis » | % | Multicomponent Plot.

Multicomponent . .
Plot 2. Inthe Experiment Data pane, select the Ovary.eds experiment.

3. Display the unknown wells one at a time in the Multicomponent Plot pane:
a. Click the View Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot pane.

Note: If you select multiple wells, the Multicomponent Plot pane displays the
data for all selected wells simultaneously.

4. In the Multicomponent Plot pane, set the parameters for the plot:
a. From the Plot Color dropdown menu, select Dye.

b. Click = Show a legend for the plot.

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

5. Check the FAM dye signal. In the example study, the FAM dye signal increases
throughout the PCR process, which indicates normal amplification.

6. Check the ROX dye signal. In the example study, the ROX dye signal remains
constant throughout the PCR process, which indicates typical data.

7. Repeat steps 2 through 6 for the remaining experiments in the study.

Notes

248 Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative
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“Plot Seftings "\
PioESEtingy | ("ShownTable ¥
Plot Color |Dye v
# | Experiment #ofTarg.. | #ofSamp.. RunDale
[ save curent setings as the default 1 Ovary.£0s 16 1.Aug 11, 2008 2
2Colon.eds 16 1 Aug 11,2008
a g = 3Hearteds 16 1.Aug 12,2008
45tomach.eds 16 1 Aug 12,2008
Multicomponent 55pleen eds 16 1 Aug 12, 2008
gBladder.eds 16 1 Aug 12,2008
260,000 7Testes.eds 18 1 Aug 12,2008
250,000 BLung.ds 16 1Aug 12, 2008
240000 9Brain e 16 1 Aug 12,2008
10Livereds 16 1 Aug 12, 2008
230,000 A1 Placenta eds 16 1/ Aug 12, 2008
220,000
210,000 =
200600 Well Results Data
120 000
180,000 ViewWell Table | View Plate Layout 1 3a
170,000
& 150,000 X —
£ oo i |[|snnwmwmv ] view Legens i
£ 130,000
3 120000 1 2 | s [ 4« [ s | & ]| Il
110,000 o o o o o o o
100000 LR RO -
a0.000 I
socm0 = 2 2 2 3B 3 = 3b
5 SRR -
60,000 L
50,000 o o o o o o o
6 w0000 g8 NS R NS R e -
30000 [
20000 o o o o o o o
1000 g 3% b 3% B % -
o T 4 & & w2 4w w2 2 2 @ w0 @ w4 w @ 1 O
Cyele a a o o a a
g 3% 3B 3F B % .
’iFAM H Rox [
2% 3% b R 3 W .
1 Wells Selected [V Hide unselected data from plot

Analysis When you analyze your own comparative C study, look for:

Guidelines » Passive reference — The passive reference dye fluorescence level should remain

relatively constant throughout the PCR process.

» Reporter dye — The reporter dye fluorescence level should display a flat region
corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds.

* Any irregularities in the fluorescence — There should not be any spikes, dips, and/or
sudden changes in the fluorescence.

* Negative control wells — There should not be any amplification in the negative
control wells.

If your study does not meet the guidelines above, you can omit individual wells from the
analysis. See “(If Needed) Omit Wells from the Analysis” on page 257.

Note: For tips on navigating within the analysis screens, see “Navigation Tips” on
page 232.

For More For more information on the Multicomponent Plot screen, access the StepOne Software
Information  Help by clicking g) or pressing F1.

Notes
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View the QC Summary

The QC Summary screen displays a list of the StepOne software flags, and it includes the
flag frequency and location for any experiment that is added to a study.

About the In the comparative C example study, you review the QC Summary screen for any flags
Example Study generated by the study data. In the example study, several wells produced data that
generated flags.

View the QC 1. From the Study Menu pane, select Analysis » QC Summary.
Summary
Note: If no data are displayed, click Analyze.
2. Inthe Flags Summary table, look in the Frequency column to determine which flags
appear in the study. In the example study:

* The NOAMP flag appears 8 times.

* The EXPFAIL flag appears 28 times.

» The HIGHSD flag appears 15 times.

* The OUTLIERRG flag appears 9 times.

Note: A 0 displayed in the Frequency column indicates that the flag does not appear
in the study.

3. For each flag that appears in the study, click the flag row to display details about the
flag in the Flag Details table. In the example study, the:

* NOAMP flag indicates that the sample did not amplify (low- or non-expressing
targets).

+ EXPFAIL flag indicates that the automatic C algorithm failed, and the
software cannot identify the exponential region of the amplification plot.

» HIGHSD flag indicates high standard deviation in the replicate group. This is
expected for C values >35 due to a low amount of target. The wells do not
need to be removed from the analysis.

* OUTLIERRG flag indicates an outlier in the replicate group.

4. Consider removing the NOAMP, EXPFAIL, and/or OUTLIERRG wells from the
analysis. See “(If Needed) Omit Wells from the Analysis” on page 257.
Notes
250 Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative
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Flag Summary

Flag Name Frequency
1= Expetiment Flags - 3 of 11 Found .

SPIKE Noise spikes 0

BADROX Bad passive reference signal 0

HOAME o i 8

CTFAIL Cralgorithm failed 0

BLFAIL Baseline algorthm failed 0

EXPFAIL Exponential algorithm failed bl

HIGHSD High standard deviation in replicate group 15

NOSIGNAL Mo signal inwell 0

NOISE Noise higher than athers in plate 0

OFFSCALE Fluorescence is ofscale 0

AMPNC Amplification in negative control 0 2

= Renlicate Flags - 1 of2 Found
av

Flag Details
-~

Flag Criteria; AMplication algorinim resutt < 0.1

‘yiew NOAMP Troubleshooting

Infarmation
[ "ShowinTette ¥ | roup Resuts 8y v I
#  Sample | Tamet Experiment el Omit Flag cr act ACTMean | ACTSE | 8ACT RQ RQMin | RaMax | Flags
1 colon  ClorBl  Coloneds D4 O 2 Undetermi 20,5347 138775 00001 NOAME, EX.
2 colon  ClomBl  Coloneds F¢ O ) Undetermi 205347 138778 00001 NOAMP, EX.
3 heat  CloMBl  Heaeds D4 O 2 Undeterm.. NOAMP, EX.
4 heat  SHH Hearteds  C8 O 2 Undetermi 208855 06248 76211 00051 00013 0.0202NOAMP, EX
& ovay ClofBl  Ovaeds E4 O 2 Undatermi 182788 04902 126183 00002 00001 0.0005 NOAMP, EXC
6 spleen  SHH Spleeneds A3 O 2 Undetermi NOAME, EX.
7 spleen  SHH Spleeneds BB | A Undetermi NOAMP, X
8 spleen  SHH Spleeneds C8 O 2 Undeterri NOAMP, EX.

Possible Flags For comparative C; studies, the flags listed below may be generated by the study data.

If a flag does not appear in the study, its frequency is 0. If the frequency is >0, the flag
appears somewhere in the study, and the associated well position is listed in the
Wells column.

Flag Description

AMPNC ' Amplification in negative control

BADROX Bad passive reference signal
BLFAIL ' Baseline algorithm failed
CTFAIL Cy algorithm failed

EXPFAIL ' Exponential algorithm failed
HIGHSD High standard deviation in replicate group
NOAMP ' No amplification

NOISE Noise higher than others in plate
NOSIGNAL ' No signal in well

OFFSCALE Fluorescence is offscale
OUTLIERRG ' Outlier in replicate group

SPIKE Noise spikes

THOLDFAIL ' Thresholding algorithm failed

Notes
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Analysis When you analyze your own comparative C study:

Guidelines * In the Flag Summary table, click each flag that has a frequency >0 to display details
about the flag in the Flag Details table. If needed, click the troubleshooting link in
the Flag Details table to view information on correcting the flag.

Note: In the Flag Details table, the numbers on each flag symbol indicate the
number of flags generated for that well. For example, 2 indicates that two flags
have been generated for that well.

* You can change the flag settings:
— Adjust the sensitivity so that more wells or fewer wells are flagged.
— Change the flags that are applied by the StepOne software.

* You can omit individual wells from the analysis. See “(If Needed) Omit Wells from
the Analysis” on page 257.

For More For more information on the QC Summary screen, access the StepOne Software Help by
Information  clicking @) or pressing F1.

Compare Analysis Settings

Use the Compare Settings screen to perform a side-by-side comparison of analysis
settings for a comparative C study. You can change one or more of the analysis settings,
then compare the new results with the previous results. For example, you can compare
the effects of:

» Using multiple endogenous controls versus a single endogenous control.

* Changing the amplification efficiency of a specific target versus keeping it at 100%.

About the In the comparative C; example study, you change the endogenous control to UBC, then
Example Study compare results.

Complete the 1. From the Study Menu pane, select Analysis » Compare Settings. When the
Compare Compare Settings screen is initially displayed (that is, before you make any
Settings Screen changes):

* In the Settings Comparison pane, the white column is titled “Current Analysis
Settings,” the green column is titled “Comparison Analysis Settings,” and the
Use Comparison Analysis Settings button is under the green column.

* In the Results Comparison pane, values in the white columns and values in the
green columns are the same.

» The Gene Expression Comparison plot is the same plot that is displayed in the
Gene Expression screen (Analysis » Gene Expression).

2. In the Settings Comparison pane, click Edit in the green column to open the
Comparison Analysis Settings dialog box.
Notes
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2

: I
Gene Expression Comparison Seftings Currenit Analysis Setings Comparison Analysis Settings
= Target Settings (Threshold, Baseline Star, Baseline End) A
AUTO, AUTO, AUTO AUTO, AUTO, AUTO -
575 188 AUTO, AUTO, AUTO AUTO, AUTG, AUTO
HPRT AUTO, AUTO, AUTO AUTO, AUTO, AUTO
o0 Clorfs1 AUTO, AUTO, AUTO AUTO, AUTO, AUTO E
ﬁ SFPQ AUTO, AUTO, AUTO AUTO, AUTO, AUTO
2 PLAZGIA AUTO, AUTO, AUTO AUTO, AUTO, AUTO
0 GABRD AUTO, AUTO, AUTO AUTO, AUTO, AUTO
ATP1A2 AUTO, AUTO, AUTO AUTO, AUTO, AUTO
5 [V AUTO, AUTO, AUTO AUTO, AUTO, AUTO
ACTNZ AUTO, AUTO, AUTO AUTO, AUTO, AUTO
50 D58 AUTO, AUTO, AUTO AUTO, AUTO, AUTO 3
ner LIT0 AT 81170 LITn ALY 81170
4 [ use comparison Anlysis setings |
™ av
a7
350 Enter a filter query, then click "Apply Filter*
% IF [sample vz [ | [ aowy Fiter | | |
G 300 -
4 | ShowIn Table ¥ | | Hide Comparison Fiter
27
* Sample | Target | CiMeand | CrMean? | ACTMea.. | ACTMea.. | ACTSE1 | ACTSE2 | AACT1 | Gtz | Rad Ra2 R Min 1
250 1 bladder 185 15744 AET44 A
2 bladder  ACTNZ BT 23671 7417 7927 0087 0.067 0 0 1 1 0879
25 E biadder  ATP1AZ 3878 23879 8135 8135 0064 0.084 [ 0 1 1 0884
4 bladder  Clorb1 3388 31388 15614 15614 0083 0.063 0 0 1 1 0986
00 5 biadder  CD5B 3648 13548 7904 7904 0047 0.047 0 0 1 1 0913
o bladder  CENPA 3287 3287 17428 17428 0084 0.054 0 0 1 1 0884
s i bladder  DCT 32406 32406 16862 1BER2 0108 0.108 0 0 1 1 0812
o biadder  GABRD ae74 31974 16.23 1623 0067 0.067 0 0 1 1 0878
150 o bladder  HPRTI 21% 2212 6.382 6362 0072 0.072 0 o 1 1 067
pe 10 bladder  PLAZG2A 17478 17479 1736 1735 0118 0.116 0 0 1 1 0801
11 bladder  POLR2A 25502 28522 4778 4778 0132 0.132 0 0 1 1 0775
0 ‘ 12 bladder  SFPQ 6% 2063 4892 4802 0183 0163 0 0 1 1 0731
13 bladder  SHH 053 16543 10799 10799 0108 0.108 0 0 1 1 0813
75 | 14 bladder  UBC 17562 17.562 1818 1818 0057 0.057 [ 0 1 1 0896
| 15 bladder  VCAM 239 24329 8585 8585 2343 2343 0 0 1 1 0011
50 16 bladder  WNTZ 8273 19273 13529 13519 005 005 0 0 1 1 0908
[ 17 brain 185 15076 15076
% | 18 brain ACTN? 2 2200 6.026 6925 0084 0.054 1.002 1.002 2003 2003 1805
| 19 bain ATP1AZ 0686 20686 551 561 0087 0.087 2525 2525 5756 5756 4773
0 20 borain Clorst 1733 M3 6.657 6.657 0043 0.043 8957 8957 4968 4968 45756
S oL E eSS K 21 brain ook 6761 16762 10686 10688 0047 0.047 2783 2783 0145 0.145 0133
& A 22 farain CENPA 384 awa 21308 21308 0304 0.334 4182 4182 0055 0.055 0026
® & & 23 brain et 2842 2812 13045 13045 0138 013 3617 3E17 12260 12260 9.47
2 brain GABRD 3564 23554 8.488 8488 0051 0.052 7743 773 Nade 14191 193738 Y
Sample < | »

Notes

a. Select the Relative Quantitation Settings tab.

3. In the Comparison Analysis Settings dialog box, change the endogenous control:

b. In the Endogenous Control(s) pane, select UBC from the Endogenous Control

dropdown menu.

c. Click Analyze to analyze the data and close the dialog box.

Comparison Analysis Settings \

Cr Seftings | Flag Settings | Relative Quantitation Settings |

Analysis Type
Selectthe type of analysis to perform.
® Singpiex

Reference Sample(s)
Select reference samples for the biological andor technical replicate oroups ofhis study.
Biological Replicate Group Reference Sample:

Endogenous Control(s)
Selectthe targetto uss as the endogenous control for this experiment

Encogenous Contol [0S %]
Enciency
e o
000 3
rteparentan vaes etwaen 1 an 150% ACTNZ 1000 4
ATP1A2 100.0 i
Chor: 1000 3

Outiier Refection

RQ MinMax Calculations
Select an algorithm to determine RQ Min and Max values (error bars).
@ concerceLower 350 9] %

O standara evitons:

Selectto reject replicates with ACT values less than or equal to the value entsred below. These analysis setings apply only to multiplex reactions.

[btadger

Technical Replicate Group Reference Sample:

[ Revertto Detaut anaiysis Setings | [ anaiyze | | cance

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative
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4. In the Settings Comparison pane, click Use Comparison Analysis Settings under

the green column, then compare the results:
* In the Settings Comparison pane, the white column is titled “Comparison

Analysis Settings,” the green column is titled “Current Analysis Settings,” and
the Use Comparison Analysis Settings button is under the white column.

In the Results Comparison pane, values in the white columns are based on the
default analysis settings, and values in the green columns are based on the
modified analysis settings. In the example experiment, changing the
endogenous control to UBC affects the RQ values. To view the RQ values,
scroll to the left. If desired, you can click and drag the RQ column headings so
that they appear first in the table.

The Gene Expression Comparison plot displays the default analysis settings
(the values from the white columns).

Note: The Gene Expression Comparison plot has limited functions. For
example, you cannot change to log scale and you cannot view by target.

Note: The default analysis settings are the settings automatically made by the
software when the study is initially analyzed.

i 3
Gene Expression Comparison Setlings Gomparison Analysis Setings | Edt... | Cument Analysis Settings | Edt.
= Target Setings (Threshold, Baseline Star, Baseline End) ~
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o5 SFPQ AUTO, AUTO, AUTO AUTO, AUTO, AUTO
2 PLAZG2A AUTO, AUTO, AUTO AUTO, AUTO, AUTO
0 GABRD AUTO, AUTO, AUTO AUTO, AUTO, AUTO
ATP1AZ AUTO, AUTO, AUTO AUTO, AUTO, AUTO
r [V AUTO, AUTO, AUTO AUTO, AUTO, AUTO
ACTNZ AUTO, AUTO, AUTO AUTO, AUTO, AUTO
50 CD38 AUTO, AUTO, AUTO AUTO, AUTO, AUTO 3
nor ALTA a1 TR ALTo
5
00 =
a7
0 Enter a filler query, then click"Apply Fiter”
-  [gample 9] = v iy P | | )
G 300 ) e
4 | [ show i Tabie v | [ rise comparson Fter |
B # Sample | Taget | CTMeani | CrMeanl ACTMea.. ACTMea. |ACTSE1 | ACTSEZ | ACT1 | #acT2 | RO1 RQZ RQMin 1
250 1 bladder 185 15744 15744 1818 0.057 0 1
2 bladder  ACTNZ 23671 23871 7927 611 0087 0.061 0 0 1 1 0879
25 3 bladder  ATP1AZ 23879 22879 8135 6318 0.084 0.058 0 0 1 1 0884
4 biadder  Clorb1 31358 31358 15614 13798 0083 0.057 0 0 1 1 0886
200 5 bladder  CD58 23648 23548 7404 6086 0047 0.03 0 o 1 1 0413
o bladder  CENPA 3287 3287 1708 15308 0064 0.058 0 0 1 1 0884
1 i bladder  DCT 32406 32406 16662 14844 0108 0.104 [ 0 1 1 0812
o bladder  GABRD EDEIZT) 1) 1823 14413 0087 0.061 0 0 1 1 0878
150 B biadder  HPRTI 213 12126 6.382 4565 0072 0.067 0 0 1 1 087
15 | 10 bladder  PLA262A 17473 17479 1735 0082 0116 0112 0 0 1 1 0801
11 bladder  POLR2A %572 28522 9778 7961 0132 0.120 0 0 1 1 0776
10 ‘ 12 bladder  5FRQ 063 2063 4832 3074 0163 016 0 0 1 1 0731
13 bladder  SHH 563 26543 10730 8981 0408 0104 0 o 1 1 0613
7 14 bladder  UBC 17861 17562 1818 0057 0 1 0896
| 15 bladder  VGAMT 138 24329 8585 6.767 2343 2343 0 0 1 1 0011
50 16 bladder  WNT2 20273 20273 1350 11712 005 0.042 0 0 1 1 0908
f 17 brain 185 15076 15076 -3979 0.054 2161 4473
2% | 18 farain ACTNZ 200 2200 6925 2946 0054 005 -lo0z 3183 2008 816 1805
Il ] | 19 brain ATP1A2 0686 20586 551 1632 0087 0095 2625 4686 5755 28747 4773
0 20 brain Clorst 01 18 6.657 2678 0043 0037 8857 1118 4988 2272315 45756
$ S ¢ ¢ H e &5 K 21 brain cpsg 26762 25762 10686 6708 0.047 0.042 2783 0621 0145 065 0133
F & egFdesd 22 brain CENPA 36.384 36384 21308 17.329 0394 0383 4182 201 0.085 0.246 0.026
& © &8 F e
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Notes

5. From the Study Menu pane, select Analysis » Gene Expression to view the

gene expression plot using the modified analysis settings.

Note: In the Gene Expression screen you can view the modified data in log scale,
by target, and so on. See “View the Gene Expression Plot” on page 240.
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Analyze the Study

6. (Optional) View the data in the other analysis screens. All other analysis screens for
the study display the data using the modified analysis settings.

7. Close the study. You can do one of the following:
» Save your changes before closing the study.

* Close the study without saving your changes. If you do not save your changes,
the software reverts to the default analysis settings the next time you open the
study.

Analysis When you analyze your own comparative C; study:

Guidelines » Edit the comparison analysis settings as desired. For information on editing the
settings, see “View the Analysis Settings” on page 235.

+ After making your first round of changes to the analysis settings, you can continue
making changes using one of the following methods:

— (Recommended) Revert to the saved analysis settings, then make new changes.
To do this: In the Settings Comparison pane, click Use Comparative Analysis
Settings (now under the white column) to revert to the saved analysis settings,
then repeat steps 2 through 6 above. This method ensures that you do not lose the
saved analysis settings.

Note: If you have made changes, but have not saved them, the software reverts
to the default analysis settings when you click Use Comparative Analysis
Settings. The default analysis settings are the settings automatically made by
the software when the study is initially analyzed.

— Continually compare new settings with previous settings. To do this: In the
Settings Comparison pane, alternate clicking Edit in the white and green
columns, then repeat steps 3 through 6 above. This method does not allow you to
return to your saved settings; subsequent comparisons are made with the previous
analysis settings, building upon any changes that you have already made.

* You can revert to the default analysis settings. See “Revert to the Default Analysis
Settings” below.

Revert to the Default Analysis Settings

IMPORTANT! The default analysis settings are defined by the software. If you make
changes to the analysis settings and save the study, the saved changes are lost when you
revert to the default analysis settings.

1. In the Settings Comparison pane, click Edit next to the settings you want to revert to
the default: Current Analysis Settings or Comparison Analysis Settings.

Notes
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2. In the Analysis Settings dialog box:
a. Click Revert to Default Analysis Settings.
b. At the prompt, click Yes.

A You have selected to revert to Default Analysis Settings. Are you sure you want to continue?

[ Yes || Mo |

c. Click Analyze to analyze the data and close the dialog box.

This dialog box is titled Comparison Analysis
Settings or Current Analysis Settings, depending on
the Edit button you clicked in step 1.

» Comparison Analysis Settings

[C1 Seftings | Flag Setfings | Relafive Quantitation Seftings |

n Review the default settings for analysis of targets in this experiment. To edit the default settings, click"Edit Default Settings.” To use different settings for a target, select the target from the table, deselect"Use Devauﬁemngs‘“ then change the
cetings thatare leyet
Default 1 Settings
Default O sstings are used o calculatsth O o targes wihout custom setings. To i the dafaulsetings, clck"Edt Default Seings

Threshold: AUTO Baseline Start Cycle: AUTO  Baseline End Cycle: AUTO | Ecit Defaut Settings

Select a Target Cr Settings for 185
Target Thestold Baseline Start Baseline End G iings 15 Use: B Uss et Ssings

188 lauTo lauTo lauTo

ACTNZ lauTo lauTo lauTo R

ATP1A2 lauTo lauTo lauTo e

Clor lauTo lauTo lauTo =2 @
cDss lauTo lauTo lauTo

CENPA lauTo lauTo lauTo

et lauTo lauTo lauTo

GABRD lauTo lauTo lauTo

HPRT lauTo lauTo lauTo

PLA262A lauTo lauTo lauTo

POLR2A lauTo lauTo lauTo

sFPa lauTo lauTo lauTo

SHH lauTo lauTo lauTo

use lauTo lauTo lauTo

veamt lauTo lauTo lauTo

WNT2 lauTo lauTo lauTo

3. In the Settings Comparison pane, click Use Comparison Analysis Settings. In the
Results Comparison pane, values for the settings you selected to edit in step 1
(“Current Analysis Settings” or “Comparison Analysis Settings”) are generated
according to the default analysis settings.

For More For more information on the Compare Settings screen, access the StepOne Software Help
Information by clicking g) or pressing F1.

Notes
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(If Needed) Omit Wells from the Analysis

You can use the Well Table to omit individual wells from the analysis. To omit a well:

1. From the Study Menu pane, select one of the following analysis screens:
* Analysis » Amplification Plot
* Analysis » Multicomponent Plot
« Analysis » [£Z] Multiple Plots View

2. In the Experiment Data pane, select the experiment that contains the well to omit.

3. In the Well Results Data pane, click the View Well Table tab, then select the
checkbox in the Omit column for the well to omit.

IMPORTANT! You cannot omit all technical replicates that belong to a reference sample
or a reference biological group, or that serve as the endogenous control.

For More For more information on the QC Summary screen or on flag settings, access the StepOne
Information  Software Help by clicking ) or pressing F1.

Publish the Data

You can publish the study data in the same way that you publish experiment data. See
“Publish the Data” on page 202 for more information.

Notes
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Appendix A

“ Alternate Experiment Workflows

This appendix covers:

B Advanced Setup Workflow . .. ... ... ... . . . 260
B QuickStart Workflow . ... ... . 261
B Template Workflow. . . ... .. . . 263
B Export/Import Workflow ......... .. ... . ... . . 265

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne™" Real-Time PCR Software by pressing
F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Notes
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Advanced Setup Workflow

When you create an experiment using Advanced Setup in the StepOne”™" software, you
can set up the experiment according to your own design.

1. Double-click g- (StepOne software) or select Start » All Programs » Applied
Biosystems » StepOne Software » <software name>

where <software name> is the current version of the StepOne software.

2. Log in with a user name or as a Guest.

3. From the Home screen, click Advanced Setup.

Note: If you do not see the Advanced Setup icon, click the arrow beneath the
Design Wizard icon to expand the Set Up menu.

4. Complete the setup screens to set up a new experiment:

a. Click Experiment Properties (default), enter the experiment name, then
select the experiment properties.

b. Click Plate Setup:
Experiment Type Action
Genotyping Define the SNP assays, then assign them to wells in the

reaction plate.

All other experiments Define the targets, then assign them to wells in the
reaction plate.

c. Click Run Method, review the reaction volume and thermal profile, then
edit as needed.

d. Click Reaction Setup, review the components and calculated volumes for
the PCR reactions, then edit as needed.

e. (Optional) Click D Materials List, review the list of materials, then order
the materials you need to prepare the reaction plate.

5. Prepare the PCR reactions:

Experiment Type Action

Relative standard curve Prepare the template.

. Prepare the sample dilutions.
Prepare the standard dilution series.
Prepare the reaction mix.

Prepare the reaction plate.

Standard curve

® oo o

Notes
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Experiment Type Action

Comparative Ct . Prepare the template.

a

Genotyping b. Prepare the samplle dl|l:ItI0nS.
c. Prepare the reaction mix.

Presence/absence d. Prepare the reaction plate.

6. Run the experiment:

a. Load the reaction plate into the instrument.

b. Start the run

c. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.
7. Analyze the data:

Open the experiment in the StepOne software.

a.
b. From the Experiment Menu, click Analysis.

o

If the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

QuickStart Workflow

When you create an experiment using QuickStart, you can run the reactions on the
instrument with no reaction plate setup information.

1. Prepare the PCR reactions:

Experiment Type Action

Relative standard curve . Prepare the template.
. Prepare the sample dilutions.

a
b
c. Prepare the standard dilution series.
d
e

Standard curve

. Prepare the reaction mix.
. Prepare the reaction plate.

Comparative Cy a. Prepare the template.
Genotyping b. Prepare the samp.le dI|L'JtI0nS.
c. Prepare the reaction mix.
Presence/absence d. Prepare the reaction plate.
Notes
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2. QuickStart the experiment:

a. Double-click g- (StepOne software) or select
Start » All Programs » Applied Biosystems » StepOne Software »
<software name>

where <software name> is the current version of the StepOne software.
b. Log in with a user name or as a Guest.
c. From the Home screen, click [:Q QuickStart.

d. Select the Experiment Properties tab (default), enter the experiment name,
then select the experiment properties.

e. Select the Run Method tab, review the reaction volume and thermal profile,
then edit as needed.

3. Run the experiment:
a. Load the reaction plate into the instrument.
b. Start the run
c. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.

4. In the StepOne software, complete the plate setup:

Experiment Type Action

Genotyping a. Select and complete the Define SNP Assays and
Samples tab.

b. Select and complete the Assign SNP Assays and
Samples tab.

All other experiments a. Select and complete the Define Targets and
Samples tab.

b. Select and complete the Assign Targets and
Samples tab.

5. Analyze the data:
a. Open the experiment in the StepOne software.
b. From the Experiment Menu, click Analysis.

If the data are not analyzed, click Analyze.

o

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

Notes
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Template Workflow

You can use a template to create a new experiment. Templates are useful when you want
to create many experiments with the same setup information.

Createa 1. Double-click g (StepOne software) or select Start » All Programs » Applied
Template Biosystems » StepOne Software » <software name>

where <software name> is the current version of the StepOne software.
2. Log in with a user name or as a Guest.

3. Open an existing experiment, or create a new experiment.

Note: You can create a new experiment using the Design Wizard (see Chapter 2 and
Chapter 6) or Advanced Setup (see page 260).

4. Seclect File » Save As Template.
5. Enter a file name, select a location for the template, then click Save.

6. Click & Close.

Create an 1. From the Home screen, click Template.

Experiment with a
Template Note: If you do not see the Template icon, click the arrow beneath the Design

Wizard icon to expand the Set Up menu.

2. Locate and select the template you created in step d, then click Open. A new
experiment is created using the setup information from the template:

* Experiment properties
* Plate setup

* Run method

* Reaction setup

3. (Optional) If you want to modify the experiment, use Advanced Setup (see
page 260).

4. Click [d Save, enter a file name, then click Save to save the experiment.

Notes
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5. Prepare the PCR reactions:

Experiment Type Action

Relative standard curve | a. Prepare the template.

Standard curve b. Prepare the sample dI|L.ltIO-nS. .
c. Prepare the standard dilution series.

d. Prepare the reaction mix.

e

. Prepare the reaction plate.

Comparative Cy . Prepare the template.

a
. b. Prepare the sample dilutions.
Genotyping P p I u I
c. Prepare the reaction mix.
Presence/absence d. Prepare the reaction plate.

6. Run the experiment:

a. Load the reaction plate into the instrument.

b. Start the run

c. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.
7. Analyze the data:

Open the experiment in the StepOne software.

a.
b. From the Experiment Menu, click Analysis.

o

If the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).
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Export/Import Workflow

Use the Export/Import workflow to set up a new experiment using setup data exported
from another experiment. Only reaction plate setup data are exported and imported.

Note: Setup data that are exported from experiments in StepOne Software v1.0 or v2.0
can be imported into experiments in StepOne Software v2.1. However, setup data that are
exported from experiments in StepOne Software v2.1 cannot be imported into
experiments in StepOne Software v1.0 or v2.0.

Export Setup 1. Double-click g (StepOne software) or select Start » All Programs » Applied
Data Biosystems » StepOne Software » <software name>

where <software name> is the current version of the StepOne software.
2. Log in with a user name or as a Guest.

3. Open an existing experiment, or create a new experiment.

Note: You can create a new experiment using the Design Wizard (see Chapter 2 and
Chapter 6) or Advanced Setup (see page 260).
4. Select File » Export.

5. Select the Export Properties tab (default), then:
. Select Setup.

a
b. Select One File from the dropdown menu.

o

Enter a name, then select a location for the export file.

d. Select [Z] (*.txt) from the File Type dropdown menu.

IMPORTANT! You cannot export *.xml files.

6. (Optional) Click the Customize Export tab, then select the appropriate options.
7. Click Start Export,

8. When prompted, click Close Export Tool.

Create an  You can import plate setup data from an exported text file (*.txt) to complete the reaction
Experiment with  plate setup data for your experiment.
an Exported Text
File IMPORTANT! Be sure the exported text file you select contains only reaction plate setup
data and that the experiment types match.

Notes
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1. Import the reaction plate setup data from an exported text file:

a. Using a spreadsheet application (such as Microsoft® Excel software), open an
exported text file.

b. Replace the parameters of the text file as needed. When finished, save the file
as a tab-delimited text file.

c. From the Home screen, click Advanced Setup.

Note: If you do not see the Advanced Setup icon, click the arrow beneath the
Design Wizard icon to expand the Set Up menu.

d. Create a new experiment or open an existing experiment.

e. Select File » Import.

f. Click Browse, locate and select the text file (*.txt), then click Select.

g. Click Start Import. The setup data from the exported text file is imported into

the open experiment.

Note: If your experiment already contains plate setup information, the
software asks if you want to replace the plate setup with the data from the text
file. Click Yes to replace the plate setup.

2. Use Advanced Setup to finish setting up your experiment (see page 260).

3. Prepare the PCR reactions:

Experiment Type Action

Relative standard curve | a. Prepare the template.

Standard curve b. Prepare the sample dI|L.ltIO-nS. .
c. Prepare the standard dilution series.

d. Prepare the reaction mix.

e

. Prepare the reaction plate.

Comparative Cy . Prepare the template.

a
. b. Prepare the sample dilutions.
Genotyping P p ! u !
c. Prepare the reaction mix.
Presence/absence d. Prepare the reaction plate.

4. Run the experiment:
a. Load the reaction plate into the instrument.
b. Start the run
c. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.

Notes
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5. Analyze the data:

Open the experiment in the StepOne software.

a.
b. From the Experiment Menu, click Analysis.

o

If the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

Notes
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Advanced Setup

AIF
allele

allelic discrimina-
tion plot

amplicon

amplification

amplification
efficiency (EFF%)

amplification plot

Glossary

In the StepOne™ software, a feature that allows you to set up your experiment according
to your experiment design. Advanced Setup provides you with maximum flexibility in the
design and setup of your experiment.

See assay information file (AIF).
For a given target, any of the different sequences that occurs in the population.

Display of data collected during the post-PCR read. The allelic discrimination plot is a
graph of the normalized reporter signal from the allele 1 probe plotted against the
normalized reporter signal from the allele 2 probe.

A segment of DNA amplified during PCR.

Part of the instrument run in which PCR produces amplification of the target. For
quantitation experiments, fluorescence data collected during amplification are displayed
in an amplification plot, and the data are used to calculate results. For genotyping or
presence/absence experiments, fluorescence data collected during amplification are
displayed in an amplification plot, and the data can be used for troubleshooting.

Calculation of efficiency of the PCR amplification. The amplification efficiency is
calculated using the slope of the regression line in the standard curve. A slope close to
—3.32 indicates optimal, 100% PCR amplification efficiency. Factors that affect
amplification efficiency:

* Range of standard quantities — To increase the accuracy and precision of the
efficiency measurement, use a broad range of standard quantities, 5 to 6 logs
(10° to 10° fold).

* Number of standard replicates — To increase the precision of the standard
quantities and decrease the effects of pipetting inaccuracies, include replicates.

* PCR inhibitors — PCR inhibitors in the reaction can reduce amplification and alter
measurements of the efficiency.

Display of data collected during the cycling stage of PCR amplification. Can be viewed
as:

» Baseline-corrected normalized reporter (ARn) vs. cycle
» Normalized reporter (Rn) vs. cycle
» Threshold cycle (Cy) vs. well
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amplification stage

assay

Assay ID

assay information
file (AIF)

assay mix

AutoDelta

automatic baseline

automatic C;

Part of the instrument run in which PCR produces amplification of the target. The
amplification stage is called a cycling stage in the thermal profile and consists of
denaturing, primer annealing, and polymerization steps that are repeated.

For quantitation experiments, fluorescence data collected during the amplification stage
are displayed in an amplification plot, and the data are used to calculate results. For
genotyping or presence/absence experiments, fluorescence data collected during the
amplification stage are displayed in an amplification plot, and the data can be used for
troubleshooting. See also cycling stage.

In the StepOne™ and StepOnePlus™ systems, a PCR reaction mix that contains primers
to amplify a target and a reagent to detect the amplified target.

Identifier assigned by Applied Biosystems to TagMan® Gene Expression Assays and
TagMan® SNP Genotyping Assays.

Data file on a CD shipped with each assay order. The file name includes the number from
the barcode on the plate. The information in the AIF is provided in a tab-delimited format.

PCR reaction component in Applied Biosystems TagMan® Gene Expression Assays and
TagMan® SNP Genotyping Assays. The assay mix contains primers designed to amplify
a target and a TagMan® probe designed to detect amplification of the target.

In the run method, a setting to increase or decrease the temperature and/or time for a step
with each subsequent cycle in a cycling stage. When AutoDelta is enabled for a cycling
stage, the settings are indicated by an icon in the thermal profile:

e AutoDelta on: &
» AutoDelta off: A

An analysis setting in which the software calculates the baseline start and end values for
the amplification plot. You can apply the automatic baseline setting to specific wells in
the reaction plate. See also baseline.

An analysis setting in which the software calculates the baseline start and end values and
the threshold in the amplification plot. The software uses the baseline and threshold to
calculate the threshold cycle (Cy). See also threshold cycle (CT).

baseline In the amplification plot, a line fit to the fluorescence levels during the initial stages of
PCR, when there is little change in fluorescence signal.
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baseline-corrected
normalized reporter
(ARnN)

biological replicate

blocked IPC

calibrator
chemistry

colocated layout

Glossary

The magnitude of normalized fluorescence signal generated by the reporter:

1. In experiments that contain data from real-time PCR, the magnitude of normalized
fluorescence signal generated by the reporter at each cycle during the PCR
amplification. In the ARn vs. Cycle amplification plot, ARn is calculated at each
cycle as:

ARn (cycle) = Rn (cycle) — Rn (baseline), where Rn = normalized reporter

2. In genotyping experiments and presence/absence experiments, the difference in
normalized fluorescence signal generated by the reporter between the pre-PCR read
and the post-PCR read. In the allelic discrimination plot (genotyping experiments)
and the presence/absence plot (presence/absence experiments), ARn is calculated
as:

ARn = Rn (post-PCR read) — Rn (pre-PCR read), where Rn = normalized reporter
See also normalized reporter (Rn).

Reactions that contain identical components and volumes, but evaluate separate samples
of the same biological source (for example, samples from three different mice of the same
strain, or separate extractions of the same cell line or tissue sample).

When using biological replicate groups in a comparative C; study, the values displayed in
the Biological Replicates tab are calculated by combining the results of the separate
biological samples and treating this collection as a single population (that is, as one
sample). For AC; computations (normalizing by the endogenous control) in a singleplex
experiment, the separate biological samples are treated as unpaired data when computing
variability estimates of the single biological replicate. You can observe individual
contributions of the separate biological samples to the single biological replicate results
in the Technical Replicates tab.

Note: To view the Biological Replicates and Technical Replicates tabs, from the Study
Menu pane, select Analysis » Gene Expression.

In presence/absence experiments, a reaction that contains IPC blocking agent, which
blocks amplification of the internal positive control (IPC). In the StepOne ™ software, the
task for the IPC target in wells that contain IPC blocking agent. See also negative control-
blocked IPC wells.

See reference sample.

See reagents.

A system layout in which the StepOne™ or StepOnePlus™ instrument is directly
connected to a colocated computer by the yellow cable. In this layout, you can control the

instrument with the StepOne™ software on the colocated computer or with the instrument
touchscreen.
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comparative C;
(AAC;) method

Cr

custom dye

cycle threshold

cycling stage

data collection

delta Rn (ARn)
derivative reporter
(-Rn’)

Design Wizard

diluent

Diluted Sample
Concentration (10X
for Reaction Mix)

dilution factor

Method for determining relative target quantity in samples. With the comparative C;
(AAC;) method, the StepOne™ software measures amplification of the target and of the
endogenous control in samples and in a reference sample. Measurements are normalized
using the endogenous control. The software determines the relative quantity of target in
each sample by comparing normalized target quantity in each sample to normalized target
quantity in the reference sample.

See threshold cycle (CT).

Dye that is not supplied by Applied Biosystems. Custom dyes may be adapted for use in
experiments on the StepOne™ and StepOnePlus'™ systems. When using custom dyes, the
custom dye should be added to the Dye Library and a custom dye calibration performed.

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA™ dye as
reporter or quencher with the StepOne”™ system. TAMRA dye may be used as a reporter
or quencher with the StepOnePlus™ system.

See threshold cycle (CT).

In the thermal profile, a stage that is repeated. A cycling stage is also called an
amplification stage. For cycling stages, you can enable AutoDelta settings. See also
amplification stage.

A process during the instrument run in which an instrument component detects
fluorescence data from each well of the reaction plate. The instrument transforms the
signal to electronic data, and the data are saved in the experiment file. In the StepOne™
software, a data collection point is indicated by an icon in the thermal profile:

» Data collection on:

» Data collection off:
See baseline-corrected normalized reporter (DRn).

The negative first-derivative of the normalized fluorescence generated by the reporter
during PCR amplification. In the derivative reporter (—Rn”) vs. temperature melt curve,
the derivative reporter signal is displayed in the y-axis.

A feature in the StepOne™ software that helps you set up your experiment by guiding you
through best practices as you enter your experiment design.

A reagent used to dilute a sample or standard before adding it to the PCR reaction. The
diluent can be water or buffer.

In the StepOne™ software, a field displayed on the Sample Dilution Calculations tab of
the Reaction Setup screen. For this field, enter the sample concentration you want to use
to add to the reaction mix for all samples in the experiment. “10X for Reaction Mix”
indicates that the software assumes the sample or standard component of the reaction mix
is at a 10X concentration. For example, if the diluted sample concentration is 50.0 ng/uL
(10X), the final sample concentration in the reaction is 5 ng/uL (1X).

See serial factor.
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dissociation curve
EFF%

endogenous
control

endpoint read

experiment

experiment name

Glossary

See melt curve.
See amplification efficiency (EFF%).

A target or gene that should be expressed at similar levels in all samples you are testing.
Endogenous controls are used in relative standard curve and comparative Cy (AACy)
experiments to normalize fluorescence signals for the target you are quantifying.
Housekeeping genes can be used as endogenous controls. See also housekeeping gene.

When using multiple endogenous controls, the software treats all endogenous controls as
a single population, and calculates the experiment-appropriate mean to establish a single
value against which the target of interest is normalized. In comparative C experiments,
the mean calculated is the arithmetic mean of the C values. In relative standard curve
experiments, the C; values are converted to relative quantities prior to normalization; the
mean calculated is subsequently the geometric mean of the relative quantities.

Note: Arithmetic and geometric means are related and equivalent due to logarithmic
transformation of the data.

Variability estimates for multiple endogenous controls are computed separately. The final
variability estimate is a pooled combination of the individual variability estimates (similar
to computing pooled standard deviations).

See post-PCR read.

Refers to the entire process of performing a run using the StepOne™ or StepOnePlus™
systems, including setup, run, and analysis. The types of experiments you can perform
using the StepOne and StepOnePlus systems:

* Quantitation - standard curve

* Quantitation - relative standard curve

* Quantitation - comparative C (AAC)

* Melt curve

* Genotyping

* Presence/absence

Entered during experiment setup, the name that is used to identify the experiment.
Experiment names cannot exceed 100 characters and cannot include any of the following
characters: forward slash (/), backslash (\), greater than sign (>), less than sign (<),
asterisk (*), question mark (?), quotation mark ("), vertical line (]), colon (%),

semicolon (), and sign (&), percent sign (%), dollar sign ($), at sign (@), circumflex ("),
left parenthesis ( (), right parenthesis () ), or exclamation point (!).

IMPORTANT! If you run the instrument in standalone mode from the instrument
touchscreen, you cannot enter more than 32 characters in the Experiment Name field and
you cannot include spaces in the name.
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Glossary

experiment type

forward primer

holding stage

housekeeping gene

internal positive
control (IPC)

inventoried assays

IPC

IPC blocking agent
IPC+
made-to-order

assays

manual baseline

The type of experiment you are performing using the StepOne™ or StepOnePlus™ system:

» Standard curve
» Comparative C (AACy)
+ Relative standard curve
* Melt curve (not available in the Design Wizard)
* Genotyping
* Presence/absence
The experiment type you select affects the setup, run, and analysis.

Oligonucleotide that flanks the 5" end of the amplicon. The reverse primer and the forward
primer are used together in PCR reactions to amplify the target.

In the thermal profile, a stage that includes one or more steps. You can add a holding stage
to the thermal profile to activate enzymes, to inactivate enzymes, or to incubate a reaction.

A gene that is involved in basic cellular functions and is constitutively expressed.
Housekeeping genes can be used as endogenous controls. See also endogenous control.

In presence/absence experiments, a short synthetic DNA template that is added to PCR
reactions. You can use the IPC to distinguish between true negative results (that is, the
target is absent in the samples) and negative results caused by PCR inhibitors, incorrect
assay setup, or reagent or instrument failure.

TagMan® Gene Expression Assays and TagMan® SNP Genotyping Assays that have been
previously manufactured, passed quality control specifications, and stored in inventory.

In presence/absence experiments, abbreviation for internal positive control (IPC). In the
StepOne™ software, the task for the IPC target in wells that contain the IPC and do not
contain [PC blocking agent. See also internal positive control (IPC).

Reagent added to PCR reactions to block amplification of the internal positive control
(IPC).

See negative control-IPC wells.

TagMan® Gene Expression Assays or TagMan® SNP Genotyping Assays that are
manufactured at the time of order. Only assays that pass manufacturing quality control
specifications are shipped.

An analysis setting in which you enter the baseline start and end values for the
amplification plot. You can apply the manual baseline setting to specific wells in the
reaction plate.

manual Cy An analysis setting in which you enter the threshold value and select whether to use
automatic baseline or manual baseline values. The software uses the baseline and the
threshold values to calculate the threshold cycle (Cy).
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melt curve

melt curve stage
melting
temperature (Tm)
multicomponent
plot

negative control

(NC)

negative control-
blocked IPC wells

negative control-
IPC wells

no amplification
control (NAC)

no template control
(NTC)

nonfluorescent
quencher-minor

groove binder
(NFQ-MGB)

normalized quantity

normalized reporter
(Rn)

omit well

outlier

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative

Glossary

A plot of data collected during the melt curve stage. Peaks in the melt curve can indicate
the melting temperature (Tm) of the target or can identify nonspecific PCR amplification.
In the StepOne™ software, you can view the melt curve as normalized reporter (Rn) vs.
temperature or as derivative reporter (—Rn") vs. temperature. Also called dissociation
curve.

In the thermal profile, a stage with a temperature increment to generate a melt curve.

In melt curve experiments, the temperature at which 50% of the DNA is double-stranded
and 50% of the DNA is dissociated into single-stranded DNA. The Tm is displayed in the
melt curve.

A plot of the complete spectral contribution of each dye for the selected well(s) over the
duration of the PCR run.

In the StepOne™ software, the task for targets or SNP assays in wells that contain water
or buffer instead of sample. No amplification of the target should occur in negative control
wells. Previously called no template control (NTC).

In presence/absence experiments, wells that contain IPC blocking agent instead of sample
in the PCR reaction. No amplification should occur in negative control-blocked IPC wells
because the reaction contains no sample and amplification of the IPC is blocked.
Previously called no amplification control (NAC).

In presence/absence experiments, wells that contain IPC template and buffer or water
instead of sample. Only the IPC template should amplify in negative control-IPC wells
because the reaction contains no sample. Previously called IPC+.

See negative control-blocked IPC wells.

See negative control (NC).

Molecules that are attached to the 3’ end of TagMan® probes. When the probe is intact,
the nonfluorescent quencher (NFQ) prevents the reporter dye from emitting fluorescence
signal. Because the NFQ does not fluoresce, it produces lower background signals,
resulting in improved precision in quantitation. The minor groove binder (MGB)
increases the melting temperature (Tm) without increasing probe length. It also allows the
design of shorter probes.

Quantity of target divided by the quantity of endogenous control.

Fluorescence signal from the reporter dye normalized to the fluorescence signal of the
passive reference.

An action that you perform before reanalysis to omit one or more wells from analysis.
Because no algorithms are applied to omitted wells, omitted wells contain no results.

For a set of data, a datapoint that is significantly smaller or larger than the others.
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Glossary

passive reference

plate layout

point

positive control

post-PCR read

pre-PCR read

primer mix
primer/probe mix
pure dye
quantitation

method

quantity

A dye that produces fluorescence signal. Because the passive reference signal should be
consistent across all wells, it is used to normalize the reporter dye signal to account for
non-PCR related fluorescence fluctuations caused by minor well-to-well differences in
concentrations or volume. Normalization to the passive reference signal allows for high
data precision.

An illustration of the grid of wells and assigned content in the reaction plate. In StepOne™
systems, the grid contains 6 rows and 8 columns. In StepOnePlus"™ systems, the grid
contains 8 rows and 12 columns.

In the StepOne™ software, you can use the plate layout as a selection tool to assign well
contents, to view well assignments, and to view results. The plate layout can be printed,
included in a report, exported, and saved as a slide for a presentation.

One standard in a standard curve. The standard quantity for each point in the standard
curve is calculated based on the starting quantity and serial factor.

In genotyping experiments, a DNA sample with a known genotype, homozygous or
heterozygous. In the StepOne™ software, the task for the SNP assay in wells that contain
a sample with a known genotype.

Used in genotyping and presence/absence experiments, the part of the instrument run that
occurs after amplification. In genotyping experiments, fluorescence data collected during
the post-PCR read are displayed in the allelic discrimination plot and used to make allele
calls. In presence/absence experiments, fluorescence data collected during the post-PCR
read are displayed in the presence/absence plot and used to make detection calls. Also
called endpoint read.

Used in genotyping and presence/absence experiments, the part of the instrument run that
occurs before amplification. The pre-PCR read is optional but recommended.
Fluorescence data collected during the pre-PCR read can be used to normalize
fluorescence data collected during the post-PCR read.

PCR reaction component that contains the forward primer and reverse primer designed to
amplify the target.

PCR reaction component that contains the primers designed to amplify the target and a
TagMan® probe designed to detect amplification of the target.

See custom dye and system dye.

In quantitation experiments, the method used to determine the quantity of target in the
samples. In StepOne™ and StepOnePlus™ systems, there are three types of quantitation
methods: standard curve, relative standard curve, and comparative C; (AAC).

In quantitation experiments, the amount of target in the samples. Absolute quantity can
refer to copy number, mass, molarity, or viral load. Relative quantity refers to the fold-
difference between normalized quantity of target in the sample and normalized quantity
of target in the reference sample.
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quencher

QuickStart

R2 value

ramp

ramp speed

raw data plot

reaction mix

reagents

real-time PCR

Glossary

A molecule attached to the 3’ end of TagMan® probes to prevent the reporter from
emitting fluorescence signal while the probe is intact. With TagMan® reagents, a
nonfluorescent quencher-minor groove binder (NFQ-MGB) can be used as the quencher.
With SYBR® Green reagents, no quencher is used.

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA™ dye as
reporter or quencher with the StepOne™ system. TAMRA dye may be used as a reporter
or quencher with the StepOnePlus"™ system.

A feature in StepOne”" and StepOnePlus™ systems that allows you to run an experiment
without entering plate setup information. QuickStart requires a colocated layout with the
instrument powered on and an intact instrument-computer connection.

Regression coefficient calculated from the regression line in the standard curve. The R?
value indicates the closeness of fit between the standard curve regression line and the
individual C data points from the standard reactions. A value of 1.00 indicates a perfect
fit between the regression line and the data points.

The rate at which the temperature changes during the instrument run. Except for the melt
curve step, the ramp is defined as a percentage. For the melt curve step, the ramp is
defined as a temperature increment. In the graphical view of the thermal profile, the ramp
is indicated by a diagonal line.

Speed at which the temperature ramp occurs during the instrument run. Available ramp
speeds include fast and standard.

» For optimal results using the fast ramp speed, Applied Biosystems recommends
using fast reagents in your PCR reactions.

» For optimal results using the standard ramp speed, Applied Biosystems
recommends using standard reagents in your PCR reactions.

IMPORTANT! Fast reagents are not supported for presence/absence experiments.

A plot of raw fluorescence signal (not normalized) for each optical filter.

A solution that contains all components to run the PCR reaction, except for the template
(sample, standard, or control).

The PCR reaction components you are using to amplify the target and to detect
amplification. Types of reagents used on the StepOne"™ and StepOnePlus™ systems:

+ TagMan® reagents
» SYBR® Green reagents
» Other reagents

Process of collecting fluorescence data during PCR. Data from the real-time PCR are used
to calculate results for quantitation experiments or to troubleshoot results for genotyping
or presence/absence experiments.
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Glossary

reference sample

refSNP ID

regression
coefficients

regression line

reject well

relative standard
curve method

Remote Monitor

replicate group

replicates

reporter

reverse primer

In relative standard curve and comparative C (AAC;) experiments, the sample used as the
basis for relative quantitation results. Also called the calibrator.

Identifies the reference SNP (refSNP) cluster ID. Generated by the Single Nucleotide
Polymorphism Database of Nucleotide Sequence Variation (dbSNP) at the National
Center for Biotechnology Information (NCBI). The refSNP ID can be used to search the
Applied Biosystems Store for an Applied Biosystems SNP Genotyping Assay. Also called
an rs number.

Values calculated from the regression line in standard curves, including the R? value,
slope, and y-intercept. You can use the regression coefficients to evaluate the quality of
results from the standards. See also standard curve.

In standard curve and relative standard curve experiments, the best-fit line from the
standard curve. Regression line formula:

Cr=m [log (Qty)] + b
where m is the slope, b is the y-intercept, and Qty is the standard quantity.

See also regression coefficients.

An action that the software performs during analysis to remove one or more wells from
further analysis if a specific flag is applied to the well. Rejected wells contain results
calculated up to the point of rejection.

Method for determining relative target quantity in samples. With the relative standard
curve method, the StepOne™ software measures amplification of the target and of the
endogenous control in samples, in a reference sample, and in a standard dilution series.
Measurements are normalized using the endogenous control. Data from the standard
dilution series are used to generate the standard curve. Using the standard curve, the
software interpolates target quantity in the samples and in the reference sample. The
software determines the relative quantity of target in each sample by comparing target
quantity in each sample to target quantity in the reference sample.

A feature in the StepOne'™ software that allows you to monitor a StepOne™ or
StepOnePlus'™ instrument over the network. With the Remote Monitor, you can monitor
the instrument status, send an experiment to the instrument, monitor amplification plots
and temperature plots in real time, and download the results to your computer. You cannot
operate the StepOne or StepOnePlus instrument using the Remote Monitor.

A set of identical reactions in an experiment.

Total number of identical reactions containing identical components and identical
volumes.

Fluorescent dye used to detect amplification. If you are using TagMan® reagents, the
reporter dye is attached to the 5" end. If you are using SYBR® Green reagents, the reporter
dye is SYBR® Green dye.

An oligonucleotide that flanks the 3’ end of the amplicon. The reverse primer and the
forward primer are used together in PCR reactions to amplify the target.
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reverse
transcriptase

Rn

ROX™ dye

rs number

run method

sample

Sample DNA (10X)

Sample Library

Sample or Standard
(10X)

sample/SNP assay
reaction

sample/target
reaction

serial factor

Glossary

An enzyme that converts RNA to cDNA. Reverse transcriptase is added to the PCR
reaction to perform 1-step RT-PCR.

See normalized reporter (Rn).

A dye supplied by Applied Biosystems and precalibrated on the StepOne™" and
StepOnePlus'™ systems. ROX dye is used as the passive reference.

See refSNP ID.

Definition of the reaction volume and the thermal profile for the StepOne"™ or
StepOnePlus'™ instrument run.

The template that you are testing.

In the StepOne™ software, a reaction component displayed on the Reaction Mix
Calculations tab of the Reaction Setup screen. The software assumes the sample DNA is
added to the reaction mix at a 10X concentration. For example, if the reaction volume is
20 pL, the calculated volume of sample for 1 reaction is 2 uL.

In the StepOne™ software, a collection of samples. The Sample Library contains the
sample name and the sample color.

In the StepOne™ software, a reaction component displayed on the Reaction Mix
Calculations tab of the Reaction Setup screen. The software assumes the sample or
standard is added to the reaction mix at a 10X concentration. For example, if the reaction
volume is 20 UL, the calculated volume of sample or standard for 1 reaction is 2 L.

In genotyping experiments, the combination of which sample to test and which SNP assay
to perform in one PCR reaction. Each PCR reaction can contain only one sample and one
SNP assay.

In quantitation experiments, the combination of which sample to test and which target to
detect and quantify in one PCR reaction. In the Design Wizard, you can detect and
quantify only one target in one PCR reaction. Use Advanced Setup to detect and quantify
more than one target in one PCR reaction.

In the StepOne™ software, a numerical value that defines the sequence of quantities in the
standard curve. The serial factor and the starting quantity are used to calculate the
standard quantity for each point in the standard curve. For example, if the standard curve
is defined with a serial factor of 1:10 or 10X, the difference between any 2 adjacent points
in the curve is 10-fold.

series See standard dilution series.

slope Regression coefficient calculated from the regression line in the standard curve. The slope
indicates the PCR amplification efficiency for the assay. A slope of —3.32 indicates 100%
amplification efficiency. See also amplification efficiency (EFF%) and regression line.

SNP Abbreviation for single nucleotide polymorphism. The SNP can consist of a base
difference or an insertion or deletion of one base.
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Glossary

SNP assay

SNP Assay Library

spatial calibration

stage

standalone layout

standard

standard curve

standard curve
method

standard dilution
series

Used in genotyping experiments, a PCR reaction that contains primers to amplify the SNP
and two probes to detect different alleles.

In the StepOne "™ software, a collection of SNP assays to add to genotyping experiments.
The SNP assays in the library contain the SNP assay name, SNP assay color, and for each
allele, the allele name or base(s), reporter, quencher, and allele colors. The SNP assays in
the library may also contain the assay ID and comments about the SNP assay.

Type of StepOne™ and StepOnePlus™ system calibration in which the system maps the
positions of the wells in the sample block(s). Spatial calibration data are used so that the
software can associate increases in fluorescence during a run with specific wells in the
reaction plate.

In the thermal profile, a group of one or more steps. There are three types of stages:
holding stage (including pre-PCR read and post-PCR read), cycling stage (also called
amplification stage), and melt curve stage.

A system layout in which the StepOne™ or StepOnePlus™ instrument is not connected to
a computer by the yellow cable. In this layout, you control the instrument only with the
instrument touchscreen, and you use a USB drive or network connection to transfer data
between the instrument and computer.

Sample that contains known standard quantities. Standard reactions are used in
quantitation experiments to generate standard curves. See also standard curve and
standard dilution series.

In standard curve and relative standard curve experiments:

* The best-fit line in a plot of the C values from the standard reactions plotted
against standard quantities. See also regression line.

* A set of standards containing a range of known quantities. Results from the standard
curve reactions are used to generate the standard curve. The standard curve is
defined by the number of points in the dilution series, the number of standard
replicates, the starting quantity, and the serial factor. See also standard dilution
series.

Method for determining absolute target quantity in samples. With the standard curve
method, the StepOne"™ software measures amplification of the target in samples and in a
standard dilution series. Data from the standard dilution series are used to generate the
standard curve. Using the standard curve, the software interpolates the absolute quantity
of target in the samples. See also standard and standard curve.

In standard curve and relative standard curve experiments, a set of standards containing a
range of known quantities. The standard dilution series is prepared by serially diluting
standards. For example, the standard stock is used to prepare the first dilution point, the
first dilution point is used to prepare the second dilution point, and so on. In the StepOne "™
software, the volumes needed to prepare a standard dilution series are calculated by the
number of dilution points, the number of standard replicates, the starting quantity, the
serial factor, and the standard concentration in the stock. See also standard curve.
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standard quantity

starting quantity

step

study name

SYBR® Green
reagents

Glossary

A known quantity in the PCR reaction.

* In standard curve experiments, the quantity of target in the standard. In the
StepOne'™ software, the units for standard quantity can be for mass, copy number,
viral load, or other units for measuring the quantity of target.

* In relative standard curve experiments, a known quantity in the standard. Standard
quantity can refer to the quantity of cDNA or the quantity of standard stock in the
PCR reaction. The units are not relevant for relative standard curve experiments
because they cancel out in the calculations.

When defining a standard curve in the StepOne"" software, corresponds to the highest or
lowest quantity.

A component of the thermal profile. For each step in the thermal profile, you can set the
ramp rate (ramp increment for melt curve steps), hold temperature, hold time (duration),
and you can turn data collection on or off for the ramp or the hold parts of the step. For
cycling stages, a step is also defined by the AutoDelta status. With StepOnePlus™
systems, which contain the VeriFlex™ blocks, each step contains 6 temperatures (1 for
each VeriFlex block).

Entered during study setup, the name that is used to identify the study. Study names
cannot exceed 100 characters and cannot include any of the following characters: forward
slash (/), backslash (\), greater than sign (>), less than sign (<), asterisk (*), question mark
(?7), quotation mark ("), vertical line (]), colon (:), semicolon (;), and sign (&), percent sign
(%), dollar sign ($), at sign (@), circumflex (*), left parenthesis ( (),

right parenthesis () ), or exclamation point (!).

PCR reaction components that consist of two primers designed to amplify the target and
SYBR® Green dye to detect double-stranded DNA.
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Glossary

system dye

TaqMan® reagents

target

target color

Target Library

task

Dye supplied by Applied Biosystems and precalibrated on the StepOne™ or
StepOnePlus"™ system. Before you use system dyes in your experiments, make sure the
system dye calibration is current in the Instrument Maintenance Manager.

System dyes on the StepOne system:
« FAM™ dye
+ JOE™ dye
+ ROX™ dye
+ SYBR® Green dye
+ VIC® dye
System dyes on the StepOnePlus system:
« FAM"™ dye
« JOE™ dye
« NED™ dye
+ ROX™ dye
+ SYBR® Green dye
+ TAMRA™ dye
+ VIC® dye

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA™ dye as
reporter or quencher with the StepOne”™ system. TAMRA dye may be used as a reporter
or quencher with the StepOnePlus™ system.

PCR reaction components that consist of primers designed to amplify the target and a
TagMan® probe designed to detect amplification of the target.

The nucleic acid sequence that you want to amplify and detect.

In the StepOne™ software, a color assigned to a target to identify the target in the plate
layout and analysis plots.

In the StepOne™ software, a collection of targets to add to experiments. The targets in the
library contain the target name, reporter, quencher, and target color. The target in the
library may also contain comments about the target.

In the StepOne™ software, the type of reaction performed in the well for the target or SNP
assay. Available tasks:

* Unknown

* Negative Control

 Standard (standard curve and relative standard curve experiments)
* Positive control (genotyping experiments)

+ IPC (presence/absence experiments)

* Blocked IPC (presence/absence experiments)
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technical replicate

temperature plot

template

thermal profile

threshold

threshold cycle (Cy)

Tm
touchscreen

unknown

unknown-IPC wells

Glossary

Reactions that contain identical components and volumes, and that evaluate the same
sample.

In the StepOne ™ software, a display of temperatures for the sample, instrument cover, and
instrument block during the StepOne"™ or StepOnePlus"™ instrument run.

In the Design Wizard of the StepOne™ software (and in QuickStart for quantitation
experiments), the type of nucleic acid to add to the PCR reaction. The recommended
template varies according to experiment type:

* Quantitation experiments (standard curve, relative standard curve, and comparative
C1) — cDNA (complementary cDNA), RNA, or gDNA (genomic DNA)

For quantitation experiments, the template type selection affects the run method,
reaction setup, and materials list.

* Genotyping experiments — Wet DNA (gDNA or cDNA) or dry DNA (gDNA or
cDNA)

For genotyping experiments, the template type selection affects the reaction setup.
* Presence/absence experiments - DNA

For presence/absence experiments, Applied Biosystems recommends adding DNA
templates to the PCR reactions.

Part of the run method that specifies the temperature, time, ramp, and data collection
points for all steps and stages of the StepOne™ or StepOnePlus™ instrument run.

1. In amplification plots, the level of fluorescence above the baseline and within the
exponential growth region The threshold can be determined automatically (see
automatic CT) or can be set manually (see manual CT).

2. In presence/absence experiments, the level of fluorescence above which the
StepOne™ software assigns a presence call.

The PCR cycle number at which the fluorescence meets the threshold in the amplification
plot.

See melting temperature (Tm).
Instrument display that you touch to control the StepOne™ or StepOnePlus™ instrument.

In the StepOne™ software, the task for the target or SNP assay in wells that contain the
sample you are testing:

* In quantitation experiments, the task for the target in wells that contain a sample
with unknown target quantities.

* In genotyping experiments, the task for the SNP assay in wells that contain a sample
with an unknown genotype.

* In presence/absence experiments, the task for the target in wells that contain a
sample in which the presence of the target is not known.

In presence/absence experiments, wells that contain a sample and internal positive control
(IPC).
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VeriFlex™
Technology

y-intercept

Zone

The StepOnePlus™ instrument contains six independently thermally regulated VeriFlex
blocks, creating up to six different zones for the 96 sample wells. After you enable the
VeriFlex blocks in the StepOne™ software, you can set a different temperature for one or
more of the VeriFlex blocks.

In the standard curve, the value of y where the regression line crosses the y-axis. The y-
intercept indicates the expected threshold cycle (C;) for a sample with quantity equal to 1.

One of up to six sample temperatures among the 96 wells formed by independently
thermally regulated VeriFlex'" blocks during the StepOnePlus™ instrument run. You can
set a different temperature for one or more of the VeriFlex blocks, or you can set the same
temperature for each of the VeriFlex blocks.

Note: For melt curve steps, you need to set the same temperature for each of the
VeriFlex blocks.

zone boundary The edge of a zone for samples formed by the six independently thermally regulated

286

VeriFlex"™ blocks. In the StepOne™ software, the zone boundaries are displayed in the
plate layout as thick red lines.
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